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Pandora FMS: but what is it, exactly?

1.1. Pandora FMS: but what is it, exactly?
Pandora FMS is a monitoring software intended for all types of environments. To use the word
‘monitoring’, in its broad semantic sense, is somehow risky  as there are hundreds of tools
available each one of them adapted to a singular type of environment: It is not the same to monitor
a couple of printers in a small office than thousands of interfaces and switches in extremely high
network traffic at a data center with thousands of servers .
Pandora FMS is designed to adapt to every roll and to every organization. Its main aim is to be
flexible enough to manage and control, the complete infrastructure, without a further need to invest
any more time or money in any other monitoring tools.
FMS is an acronym for Flexible Monitoring System. Its purpose is to be able to monitor both
complex new generation tools and systems and outdated elements, of difficult access and scarce
compatibility, in the one platform.

Pandora FMS currently avails of agents for every ‘modern’ operating system on the market, that is:
from Windows NT4, to Windows 2008. Not forgetting all the modern Unices (AIX, Solaris, HPUX,
BSD, Linux) in every version and in all distributions.
Pandora FMS can, of course, be used successfully not only as a systems monitoring tool, but with all
sort of network devices, be it by using SNMP( versions 1,2,3) or via TCP protocol probes ?(snmp,
ftp, dns, http, https, etc), ICMP o UDP

1.2. About the documentation
All of this power and flexibility comes with an implicit difficulty at setup stages. In spite of
Pandora’s mostly graphic configuration, we are aware that to learn how to use it seems a little too
complicated at first. That is why we have divided the 800 pages of the user’s guide in several
chapters:
•
•
•
•

Chapter I. Understanding Pandora FMS.
Chapter II. Installation and Configuration.
Chapter III. Monitoring with Pandora FMS.
Chapter IV. Operating and Managing Pandora FMS.
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• Chapter V. Complex Environments and Best Performance.
• Chapter VI & VII. References and Technical Appendices.
Besides the official documentation, you can avail of our user’s forum at: http://openideas.info/smf
were you can post queries in English, Spanish and Japanese to other users. Were you to require
official training there is an official training program [1] imparted by the developers of Pandora.
We have compiled some quick reference guides guías rápidas to assist you to configure Pandora
FMS and to implement simple monitoring tasks with Pandora’s tool. You can also avail of quick
reference manuals for the installation of software agents, like Windows and Linux. Short videos are
also at your disposal, to carry you through some of the most technical parts of the configuration and
if necessary, you could avail of regular, scheduled workshops. More detailed information on all of
the above can be found in our web, at http://pandorafms.com

1.3. The evolution of Pandora as a Project
Pandora was created by Sancho Lerena in 2003. Since then it has gradually evolved to become the
resilient, innovative and flexible monitoring tool we offer today.
Originally written in 100% open source code, passed the growing experimental years and after a
strong demand for the product from large companies and corporations, we felt compelled to launch
the Enterprise version. This version offers some specific characteristics designed for conditions
which require to process large volumes of information and to be able to work with thousands of
environmental devices.
The company financing and coordinating all the back up work in Pandora’s FMS development is
Artica Soluciones Tecnologicas, a Spanish company, founded in 2005 by Pandora’s alma mater. The
open source version is, non the less, fully operative and functional as a production tool, and most
companies, in fact, who do not require professional support, or which are very well staffed, get by
well with the Open Source version.
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Pandora FMS can be found, to this day, among Sourceforge’s top rated, with thousands of
downloads and satisfied users all over the word. For more information on Pandoras’ evolution and
to see a road map of the project, please visit: http://pandorafms.com

1.4. A quick glance at Pandora FMS features

• Autodiscovery.In local setting, the plugins ‘by default’ of Pandora’s agents permit hard disk,
partitions, and data bases detections in a data server, among many other features.
• Autoexploration.By remote access and by using the web, it can detect active systems,
catalogue them according to its operating system and by applying a profile it is able to
commence monitoring them. It can even detect the typology of the web and come up with a
web map, based in route distribution.
• Monitoring. Pandora FMS’s agents are the most powerful in the market. They are capable of
obtaining information from the execution of a command to the call, at its most basic level
on Windows API.: events, logs, numerical data, process stages, memory and CPU
consumption. Pandora avails of a default monitors’ library, but one of the greatest
advantages of Pandora is its resourcefulness to add and create new monitors.
• Remote access. The agents, themselves, can activate services, delete temporal files or
execute processes. Commands can also be executed, remotely, from the console, like
stopping or starting services. Furthermore, it is also possible to program tasks that require
periodical execution. It is also possible to use Pandora FMS to access window machines
remotely (via VNC) or to access web systems or Unix through Telnet or OSSH, from a web
interface.
• Alerts and Notifications. Notification is just as important as failure detection. Pandora,
gives you an almost infinite variety of notification ways and formats. Including, but not
limited to: escalation, correlation of alerts and prevention and mitigation of cascading
events.
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• Analysis and Visualization. Monitoring is not just receiving a trap or visualizing a downed
service, but it is also to present forecast reports, correlated summary charts of long term
gathered data, to generate user portals, delegate reports to third parties or to define its own
charts and tables. Pandora incorporates all of those in a Web interface.
• Inventory making. Contrary to other solutions where the idea of CMDB is a prerogative, to
Pandora, it is just an option. The inventory is flexible and dynamic (it can autodiscover, it
accepts remote input, etc) It can notify changes ( e.g. uninstalled software) or be used,
simply, to make listings.
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2 INTRODUCTION TO MONITORING

27

Introduction to Monitoring

Every technical manual on Software will tell you, right from the start, about configuration, text
files, data bases, protocols, etc. We very often learn to configure at low levels remaining ignorant
towards its full potential, that is, to what can be done with it and in which situations. The purpose
of this section is to explain, in a concise but systematic way, the theory behind monitoring,
regardless of the software used for that purpose.

2.1. Types of Monitoring
When we talk about ‘how a certain element is’, be it a server, a data base, a Web element, or a
refrigerator, we can ask ourselves the following questions:
1. How do we obtain the information? Do we have something in place, to that effect? Or do we
have to ask along the way?
2. Are we interested in having to ask constantly or to wait for something to happen?
3. What sort of information does it give me? ¿Is it something I can measure in a graphic and
watch its progression?
All of these questions answer the three key points that condition the essence of our monitoring
model. The first question responds to weather we are going to use an agents based monitoring, to
be executed inside the devise we are controlling; or if, on the contrary, everything is being done
externally, by employing an internet connection. There are monitoring systems that operate one
way or another, and devices that can only be monitored in this or that way. Pandora FMS supports
all models.
The second question concerns to weather the monitoring is synchronous (every X number of
seconds it asks itself, regardless of any information changes taking place or not) or asynchronous (it
only receives information when something relevant has taken place). If I am using synchronous
monitoring with 10 million elements, collecting data at 5 minute intervals, the load will be
considerable, but if I do it every 50 minutes, instead, it will be much more manageable, the down
side of it being, that if something takes place in between, it can take 50 minutes before I realize it. If
I use asynchronous monitoring (e.g. with SNMP traps or logs) I can save in many resources, but I
will not be able to draw graphics or do historical graphs, except those directly related to the
incidents occurred. Many tools are based solely in one of the models, sometimes known as
‘performance’ or ‘capacity’ tools, and there are other tools based in events managing. They are not
often exchangeable in their functions. Pandora FMS supports both approaches. The third question
refers to what we are looking for in a given moment in time, it can be a text chain (a descriptive
event) a floating comma number (to be able to draw graphics) or simply a status (down, up). Being
able to work with different kinds of data allows more flexibility. Pandora FMS supports all types of
data. These three "paradigms" condition its environment greatly, as well as the tool chosen to
monitor it. Acknowledge the type of information needed and the best approach to obtain it. Plan
around the available information elements and on how to monitor them.
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2.2. Remote monitoring
When we speak of remote monitoring, we mean to say that it is Pandora FMS’ server the one that
probes, (‘polling’) in a synchronous way, the devices it intends to monitor. When we speak about
this mode, we are not refereeing to the ‘local’ monitoring, based in agents installed on the devises
we wish to observe.

Generally speaking, when we monitor remotely, we do it with two different purposes:
• To make sure they are ‘alive’ (e.g. interface, or active system)
• To obtain a numerical value (e.g. to measure Web traffic or the number of active
connexions)
This monitoring, when synchronous, is always done in the same direction: from the monitoring
server to the element monitored.
We can, also, be interested in the opposite process: that is, in receiving a warning when an incident
occurs. That is asynchrone monitoring, and in the case of remote monitoring, we usually refer to it
as SNMP’ traps. .
Synchronous monitoring is usually done using SNMP protocol, which is the most widely used in
Web equipment, But it can also be done through WMI, a similar protocol owned by Microsoft.
Both protocols work in a similar fashion, which is, basically, as follows: A server sends a request for
a particular configuration element of the ‘SNMP agent’ or ‘WMI service’ that it hears in the device.
This particular element is called OID, in SNMP and in WMI, it can be identified by a WQL query;
this can have to do with the free available memory, the router’s number of connexions, or the traffic
in a given interface.
If the monitoring is based mainly in internet environments, it is important to know SNMP in detail,
as it will be the function most widely used of the monitoring tool. The asynchronous monitoring
through SNMP is also vital. You will need, together with a monitoring tool, an external explorer of
SNMP devices, access to the MIBS collections from the makers of your Web devices (which are like
OID’S libraries) and, of course, a lot of patience to investigate, given that each device usually has its
own collection of OID’s but you will only be interested in some of those elements, among the
thousands that each device has.
If your monitoring is based in Windows servers’ and you are not interested in installing agents in
the machines, WMI remote monitoring would be very powerful and well suited. WMI interface is
even more potent (and better organized than SNPM’s) with WMI you will be able to obtain,
practically any data, status or event on your window servers.
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Unix and Windows systems can be also proved with SNMP, but the information returned is scarce,
besides, you will need to activate and configure the SNMP agents of the operating system, which
can be much more complex than simply installing a Pandora FMS monitoring agent.
Finally, you can always monitor web elements through the use of TCP or ICMP tests. ICMP is used,
mainly, for two purposes:
• To verify if a system responds (ping)
• To find out the latency time of that device (in milliseconds)
Through TCP tests, it is possible to test if a web server responds properly, or if a mail server (SMTP)
sends the mail well. These type of tests are not intended to just get the server to ‘open the port’ but
also to make it ‘communicate’: that is, that the sending mail command receives an O.K to confirm it,
or the answer from the web server is ‘200 OK’ (a valid reply in HTTP protocol)
There are a series of plugins, by default, for TCP testing, but it can easily implement its own tests,
by adapting its own scripts or developing new ones. The integration with Pandora FMS does not
require ‘API’, complex structures or proprietary libraries.
Web Transaction Monitoring, also remote monitoring, receives a separate, specific, chapter, given
its importance.

2.3. Local Monitoring (with agents)
When it concerns systems and applications, the best way to obtain information is, without a doubt,
from the system. This is done by executing commands, or querying the system data sources, from
the same engine we want to monitor. This means we have to execute a command or script, or to
investigate the system or the application. To that end, we use Pandora’s monitoring agent, a specific
software to take care of those small monitoring tasks.
The agents can only be installed on Unix and Windows operating systems. An agent can not be
installed in a cisco device, eg Los agentes sólo se pueden instalar sobre sistemas operativos Unix y
Windows. No se puede instalar un agente sobre un dispositivo cisco, p.e. According to the
nomenclature used by Pandora FMS, we use ‘agent’ to refer to the entity containing the information
and ‘software agent’ as the part of that software installed in that system to extract information and
report on to Pandora FMS’ server. The software agent executes, constantly, on the system (as
service) and reports information periodically.
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The agents, allow you to do more, besides obtaining information through commands, things like,
for instance, to obtain inventory information. It can also be configured to get them to react in case
of a problem or a failure, interacting, automatically with the system, deleting a temporary file or
executing a given command.
To obtain ‘precise’ and specific’ information, on that we are interested in, we will often have to refer
to the manuals of the application we want to monitor, because, even when we avail of ‘generic’
monitors, what we are looking for may not be so trivial.
Exist in Windows, an almost infinite variety of access to the information: WMI, Perfcounters,
Eventlog, system logs, registry, commands, powershell scripts, API (by Windows NT) etc. In fact,
Microsoft’s architecture is one of the easiest, more powerful and better documented, when it comes
to obtaining the information from the system. In Unix/Linux systems the capability of the software
agent to execute any command, allows us to benefit from the full shell power.

2.4. Monitoring procedure
Why do you, really, want to monitor, have you given it some thought? I mean, once you have
obtained data from your servers: when they fall, or, how much they consume. Have you thought of
what will you do? Because, may be, by asking yourself: What is the most critical? first, you will save
a lot of time that would, otherwise, have been spent ‘messing” or investigating issues that will not
be useful, in your day to day, later.
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Please dedicate five minutes to answering some questions. In your case, what do you think better
describes your monitoring needs?
• To avoid losses> availability.
• To analyze degradations>Performance.
• To evaluate growth> Capacity planning.
On each of those instances the focus will be in certain aspects.
Availability, on first instance. You are mostly interested in events based monitoring and remote
monitoring will probably be enough for your needs; is faster to deploy and will give you relatively
quick results. You are after SLA informs.
Performance, on second instance. Its field is graphics and numbers, information it obtains through
agents or remotely, even though you will probably require agents to get in depth information on
their systems. Group reports and combined graphics are your main priority.
Capacity Planning, on third instance. Much more specific, it needs to obtain data, as in the second
instance, but to play with it, with predictive monitors and very specialized projective reports.
Establishing early alerts will be of great help and you will need to have a good knowledge of the
WARNING and CRITICAL status meanings, besides elaborating serial event management policies to
prevent the problem before it happens, which is –without a doubt the most complex and interesting
case.
Once you know which model you are to follow, you are left to wonder what to do when the system
tells you the service is down, or worst even, What will happen when the server’s capacity reach the
limit next Friday?. You need to think in action procedures.

2.5. Action procedures
‘We call action procedures to something that can not be achieved through any tool (so far) which is,
basically, thinking and planning how to notify the incidents. In order to do that you will have to
consider several factors:
• Event urgency. You are to be able to discriminate between something unusual and
something critical.
• Notification format. Email, SMS or, why not, a mild shock to the operator to stop him from
falling sleep ( we are yet to implement it, but it would not be a difficult think to do…)
• Scalability: It basically consist of notifying someone first, hoping to get the incident solved,
if not so then a second person is informed and if the problem persist a third becomes
involved, usually some one respected by the former two.
Ideally, before any configuring is done. You should have those concepts in mind. Even better, gather
some patience and a virtual design tool (visio, opendraw…) and draw its critical elements and paint
with arrows how the information is obtained and who will be notified or what will be done with
that information.

32

Action procedures

By focusing first on the most critical, you reach the starting point to what is the most important for
your organization. Once you know what the most critical is, you can discover how to monitor it and
in the meantime you can think of who is responsible for the problems in those systems and how to
notify it.

2.6. Supervision models
By supervision models we understand the fact that a monitoring system is designed to report
information on an automatic system, but that, it is, in fact, watched by a human being in a direct or
indirect way. This person, often, receives the name of operator, who is the person who looks at the
screen or otherwise receives the events, be it by a ‘smartphone devise, or similar, or by email or
logs registered with another tool. The how to does not matter, the important thing is the fact of
having someone minding the system.
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There are certain people, on the other hand, who we call “system administrators’ in generall or
‘infrastructure personnel’, who are those who, when something happens, receive a call from the
operator saying: “hey, we have got a problem here’ or a direct notification, sent automatically, by
the system, warning them of something, which is, in most cases, an SMS, or an e mail.
Here we can see a great difference already:
• The direct supervision model implies a person, or several people, constantly watching the
system, so if something critical occurred it would be detected immediately. It can usually
notice small, non critical changes, and has a much greater flexibility. It is not necessary to
define ’notifications’ (alerts with Pandora) for each possible case, but it is enough with
looking at the events (some sort of visor to detect status changes) to have an idea of ‘what is
cooking’ in the system, at any given time. It is possible to define many screens and also to
define alerts to support that supervision. This model is used in large environments, given
that it does not matter how much we define an alert policy, a perfect, autonomous
supervision can never be warranted.
• The indirect supervision model, implies there is no one permanently looking at the screen,
so it is necessary to define, before hand, the automatic notifications (alerts) that the system
is going to have; given that the events, graphics, and maps will not be seen by anyone. This
system is suitable when we have few devises, or when we have identified, very closely, what
is critical and how to confront the problem (solution and notification)
For team work that involves operators, administrators, and third level personnel, Pandora FMS’
tools like: ticketing of events?, incidences creation, scaling of notifications, internal mail, notice
board and chat among Pandora FMS’ users, are very useful

2.7. And what now?
The following chapters are exclusively dedicated to Pandora FMS. Up to this point, we have been
discussing general matters which were important for you to know before we continued exploring
Pandora FMS. You will probably know many things already and may have used other monitoring
programs, you heard, perhaps, that this or that application is always monitored in a certain way
because that is the best possible way.
Maybe, but from our experience, each client does things a certain way and regardless of how much
we know about monitoring, I doudt we know more on how your infrastructure has been set up than
you do. Monitoring easy tasks presents no problems, the hard job is to adapt the monitoring to your
business without having to adapt your business to the monitoring, not a trivial one. More that 800
pages await, if you are to discover the best way to monitor your organization, with Pandora FMS, a
real challenge.
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3 PANDORA FMS ARCHITECTURE
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This chapter gives a general description of Pandora’s components, the way they relate among
themselves and on how to use Pandora FMS’ architecture to meet different challenges regarding the
typology of its infrastructure.
Pandora FMs is extremely modular and decentralized. The most important component is the
database, were everything is kept (it is only supported, at present, on MySQL production systems,
but PostgreSQL and Oracle are also supported) Each one of Pandora FMS’ components can be
replicated and function in a pure HA environment, be it passive or active, or in a clustered
environment (Active/Active, with load balancing) There are also method descriptions for a high
availability SQL backend.

Diagram of Pandora FMS’ global architecture
Pandora FMS is made of several elements, among them, the servers, which are those in charge of
collecting and processing data. The servers also introduce the collected and processed data into the
database. The console is the part in charge of displaying the data present in the database and of
interacting with the final user. The software agents are the applications that run on the monitored
systems (usually servers) and collect the information to send it to Pandora FMS’ servers.

3.1. Pandora FMS’ Servers
Pandora FMS' servers are the elements in charge of doing the pertinent checks. They verify and
change them according to their results. They are also in charge of firing the alerts established to
control the status of the database.
Pandora FMS’ data server can work with high availability and/or load balancing. In a very large
architecture, it is possible to employ several servers simultaneously, to be able to handle large
volumes of information distributed by geographic or functional zones.
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Pandora FMS servers are always working and permanently verifying if any elements have any
difficulties and if those are defined as alerts. On facing a problem, this executes the response
defined in the alert, like sending an SMS, an email or activating the execution of a script.
There can be simultaneous servers, one of them being a main server and the rest of the servers
being slave servers. Although there is a master and a slave server, they work simultaneously. The
difference between them is that when one is down (E.g. a network server) the master server is in
charge of processing all the down server’s associated data.
The server receiving the data file from the agent, or processing the information (if this is of the
remote type) is that who fires the associated alerts to that data which is after processing.
Pandora FMS automatically manages each server’s status, its loading levels and other parameters.
The user can monitor the state of each server, through the server’s status section of the web’s
console.
In Pandora FMS 3.x there are ten different servers, in total, specialized in and responsible for the
aforementioned tasks. The ten servers integrate in a single application, under the general name
’Pandora Server”, which is a multithreaded application (multiprocessing) that executes in sub
processes (threads) each one being different to the instances or to the specialized servers of
Pandora FMS.

3.1.1. Data server
It processes the information sent by the Software agents. The Software agents send XML data to the
server in different ways (FTP, SSH, or Tentacle) and the server periodically verifies if there are any
data files awaiting processing. This process uses a disk directory as a bonding medium for the
elements to be processed. It is possible to install different data servers in different systems or in the
same host (which will be different virtual servers) .Several servers can work together in very large
environments, making the most of the available hardware (E.g. multiple CPU’s environments)
The data server like the rest of servers accesses Pandora FMS’ database, which shares with the web
server and contains the processed data packets. The server executes as daemon or as service and
processes the gathered packets in its file system. In spite of its simplicity and its modest use of
resources, the data server is one of the elements critical to the system, as it processes all of the
agent’s information and generates system alerts and events according to that data. The data server
works only with the XML data from the software agents without doing any remote verification.

3.1.2. Web server
The web server executes remote monitoring tasks through the Web: ICMP tests (Ping, latency times)
TCP and SNMP requests. When an agent is assigned to a server is always to a Web server, not to a
data server, that is why it is very important that the engines executing the Web servers have ‘Web
visibility’ to be able to carry the monitoring tasks assigned to them. Making it possible for a server
to connect to a chosen web. For instance, if we create a module for a ping verification on
192.168.1.1 and the agent/ module is assigned to a server on 192.168.2.0/24 without Web access
to 192.168. 1.0/24 we will always get a DOWN reply, as it can not make contact with it.
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3.1.3. SNMP server (also known as Traps Console SNMP)
This server uses the standard daemon of the traps recollection system snmptradp'. This daemon
receives SNMP traps and Pandora FSM’ server processes and stores them in the data base. While
processing and analyzing them it can also fire the designated alerts in the SNMP console of Pandora
FMS.

3.1.4. WMI server
WMI is a Microsoft standard to obtain information from the operating system and Microsoft
Windows environmental applications. Pandora FMS has a dedicated server to make native WMI
calls in a centralized way. Thanks to that server it is possible to collect data from Windows systems
remotely and without an agent

3.1.5. Recognition server
The recognition server (Recon Server) is used to explore the Web regularly and to detect new
systems in operation. The recon server can also assign a monitoring template to those systems
recently detected and apply the modules by default automatically, as defined by that template, so
they can be used immediately to monitor the new system. By using the applications of the nmap,
xprobe and traceroute systems it is also capable of identifying systems by their Operating System,
based in the ports that are opened, and to establish the Web’s typology, guided by the systems it
already knows.
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3.1.6. Accessories server (Plugins)
It executes complex user tests, done in any language, integrated in Pandora FMS’ interface and
centrally managed. This allows the advanced user to define its own complex tests, developed by
himself, and to integrate them in the application so they can be used in an easy, integrated manner
from Pandora FMS.

3.1.7. Prediction server
It is a small component of Artificial Intelligence that implements, in an statistical way, a data
prevision based in past data with a scope of up to 30 days in four temporal references and that
allows to predict the value of an item of data in 1015 minutes intervals, knowing if a particular
data presents an anomaly at present based in its past historical performance. You will, basically,
have to construct a dynamic baseline with a weekly profile. This server also manages the service
monitoring calculations (BPM) from the 5.0 version of Pandora FMS.

3.1.8. WEB Test server (Goliat)
(Only Enterprise version)
The Web test server is used to do load testing. It does synthetic Web testing, that is, complete Web
testing, including: user identification process, parameters for data transfer, contents verification,
menu navigation, etc. It is used for verification tests (does it or does it not work) and to obtain
latency times of the complete Web navigation experience (including the resources linked to the
page: images, full texts, etc).

3.1.9. Export server
(Enterprise version only)
The export server of Pandora FMS permits the transfer of data from the monitored dispositive of a
Pandora FMS’ installation to another, making possible, facilitating a replicate of the data. This is
particularly useful with large deployments, with several Pandora FMS’ installations, when we want
to have some critical information centralized in just one of them.

3.1.10. Inventory server
(Enterprise version only)
The inventory server obtains and visualizes inventory information in the systems: Software
installed, installed patches, hardware memory chips, hard disks, services running in the system, etc.
It can obtain this information, both remotely or in a localized way, through the software agents.

3.1.11. Event correlation server
(Enterprise version only)
This special server can be used to correlate events and generate alerts. This is a special server that
does not monitor, and that like the others, can be specified in the configuration for its start up, or
left alone. This server, unlike the rest, does not avail of threads configuration or high availability.
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3.1.12. Enterprise Networl server for SNMP & ICMP
(Enterprise version only)
There are two additional servers using advance strategies to process ICMP (ping) and SNMP
(polling) requests in a way that offers a superior performance to the opensource version, in
exchange for some delicate requests (especially SNMP) as they work with previously validated OID’s
by the opened server.
They use low level binary tools to access the TCP/IP system of the server; in a much more efficient
way, by doing block surveillance.

3.2. Pandora FMS’ Web console
It is Pandora FMS user’s interface. This administration and operations console allows to different
users, with different privileges, to control the status of the agents, access statistical information,
generate graphics and tables of data, as well as managing incidences with its integrated system. It is
also capable of producing reports and defining new modules, agents and alerts, as well as creating
other users profiles, all of it done in a centralized way.
The Web console is programmed in PHP and does not require the end user to install any additional
software, neither Java, nor ActiveX. Graphics are, however, available in FLASH, and to be able to
see them in that format you will need the Flash application, on your navigator; which can be
accessed from any modern platform with HTLM and CSS support. We recommend Firefox 2.x or IE
7.x. The user experience with navigators like IE6 is very poor, and most of the features
implemented in Pandoras FMS 3.0’s console are lost.
The Web console can operate with multiple servers, this means we can add as many Web consoles
as we want, be it for load distribution or to facilitate access due to logistical problems (large Webs,
several groups with different users, geographical and administrative differences, etc.) Its one
prerogative is to have access to the data storage center were Pandora FMS compiles everything.
That is, access to the database, and in the case of the enterprise version, access to the agent’s
repository of configurations (via NFS) in a synchronized way.

3.3. Pandora FMS’ Database
Pandora FMS uses MySQL database. Pandora FMS keeps an asynchronous database with all the
information received, doing a temporary cohesion and normalizing of all the data received from
several sources. Each agent’s data module generates a data entry for each packet, which means a
real production system can have a scope of ten million units of data, or atoms of information.
This data is automatically managed from Pandora FMS, which carries on a periodical and automatic
maintenance service of the data base, allowing Pandora FMS to do without any sort of data base
administration system manually assisted, be it by an operator, or an administrator. This is done by
periodically purging any data after a certain date (90 days in a preset option) as well as a
compactacion of the data which is above a predetermined and configurable number of days (30
days in a preset option)
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3.4. Software Agents of Pandora FMS
When we are referring to an agent in Pandora FMS, we can distinguish three essential components
in the recollection of data:
• Agent.
• Software Agent (Software application, Pandora FMS agent running in a machine)
• Physical Agent (hardware)

3.4.1. Agent
Pandora FMS’ agent, itself, is basically an organizational element created with Pandora FMS’ Web
console and associated to a group of modules (seen as individual monitoring elements). This agent
can also have (optionally) one or more IP addresses associated to it.
The agent can have remote modules associated, which would have been obtained through Web
servers, WMI, Plugin, etc.
• Verification on whether the engine is connected or on line (PING).
• Verifications on whether a given port is open or closed.
• Verifications on whether a Web, hosted in a specific port of the hardware, is responding
correctly.
• Verification on whether a Web, hosted in a specific point of the hardware, has the desired
content.
• Hardware verifications throw SNMP (knowing the MIB)
• Latency time verification between the hardware and Pandora FMS’ servers.
The agent can also have local modules associated to it. Local modules are those defined in the
software agent’s configuration and which must also be defined in the Web console’s agent. If the
agent is in autolearning mode (default setting) these local modules are created automatically in the
Web’s console when a packet of data arrives, from the agent, for the first time. Therefore, an ‘Agent’
can contain modules of both the remote and local types. The remote type modules are executed by
those servers obtaining information remotely (prediction included) and the local modules are
obtained by the Data Server.

3.4.2. Software Agent
A software agent installed in a remote engine completely different from the one in
the server or in Pandora’s Web console. The software agent gathers ‘local’
information from the engine where it is executing throw commands which obtain
information on the system.

Pandora FMS’ software agents are based in the native languages of each platform: ShellScripting for
Unix —including GNU/Linux, Solaris, AIX, HPUX y BSD, as well as IPSO for Nokia (Check Point
Firewall’s operating system).
Pandora’s agents can be developed, practically, in any language, as long as it meets the data
exchange API with Pandora FMS’ data server (defined by the XML data exchange). The Window
agents operate in a free environment for C++ and employ the same interface and modularity than
the UNIX agents, although with several characteristic of their own.
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Illustration: Recollection of data in Pandora FMS

These scripts are built from submodules and each one of them recollects a portion of information.
Each agent collects several ‘portions’ of information. These are compiled into the one packet and
stored in a single file which we name ‘data package”.
The copy process of the data packet from agent to server is synchronously executed on a regular
basis That is, within regular intervals defined by the agent which can be modified in order not to
clutter the data base with superfluous information, overload the Web, or become detrimental to the
system’s performance.
The interval is set up at 300 seconds, which is the decimal equivalent of 5 minutes. Lesser values to
100 (seconds) are not recommended as it can affect the performance of the host system, as well as
overload the data base and the central processing system.
It is important to remember that Pandora FMS is not a’ real time system’, but a general monitoring
system for systems and applications in environments where ‘real time’ is not a critical factor. It can,
non the less, be adapted to operate in environments with response times of between 3 and 5
seconds.
Illustration: Logical diagram of an agent, physical agent
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Packet transfers are done throw Tentacle’s protocol, but they can also be transferred using SSH or
FTP.
With either SSH or Tentacle the process can be made secure, given that passwords do not travel
through the Web nor does unencrypted confidential data, assuring the confidentiality, integrity and
authentication of the connexions between agent and server. The codes generating process, to be
able to carry the SCP (SSH) transfer automatically and also throw Tentacle protocol is detailed in
the documentation on the installation and configuration of the Agents and the Server.
The transfer can be done throw FTP or throw any other transfer system for files; although we
choose Tentacle, due to the security this system offers, its user friendliness, and its multiple options.
Please check the annexes to the documentation to configure the transference through protocols.
Pandora FMS’ agents are designed to be executed in the agent from which they recollect data,
although the agents can recollect information stored in accessible engines from the host were they
are installed, also known as “satellite agent’.
It is also feasible to configure an engine so it has several of Pandora FMS agents simultaneously.
This predicament is quite rare. It occurs when, for instance, we have a software agent and a satellite
agent. The standard software agent monitors the engine were it executes, while the satellite agents
installed (there can be several) monitors remote systems through Telnet, SNMP or other proprietary
commands.

3.4.3. Data File XML
The data file has the following Syntax:
<nombredehost>.<nº de serie>.data

This data file is a XML structure and take its name from a combination of the host name, were the
agent is, a serial number, which differs in each packet, and the extension data which indicates that
is a data packet.
Illustration: Logical structure of the modules of a software agent
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<nombredehost>.<nº de serie>.checksum

The data file is the file with the extension: ‘.data’. The verification file with the extension: ‘.
Checksum’ contains a MD5 hash of the data file. These allow to make a final verification to ensure
the data has not been altered in anyway before they are processed.
The XML data file the agent generates is at the heart of Pandora. It contains a data packet with the
information gathered by the Agent. This packet of data has a compact design; light and flexible, that
allows any user to avail of Pandora FMS agents or to, by its own method, generate information to
be processed in Pandora FMS. The data file is an XML similar to the following one:
<agent data os_name=”SunOS” os_version=”5.8” timestamp=”300” agent_name=”pdges01”
version=”1.0”>
<module>
<name>FTP Daemon</name>
<type>generic_proc</type>
<data>0</data>
</module>
<module>
<name>DiskFree</name>
<type>generic_data</type>
<data>5200000</data>
</module>
<module>
<name>UsersConnected</name>
<type>generic_data_inc</type>
<data>119</data>
</module>
<module>
<name>LastLogin</name>
<type>generic_data_string</type>
<data>slerena</data>
</module>
</agent_data>

3.4.4. Physical Agent
Pandora FMS has a physical agent mounted on an Asus and an Arduino automaton. This tandem,
together with the sensors connected, facilitates, at present, the monitoring of the following
environmental features:

•
•
•
•

Humidity
Temperature
Ambient lighting
Presence

The sensors, being electrical, are easily calibrated, and their values can also be processed by
Pandora FMS without any difficulty The fact that the sensor is a nonwired router opens a world of
possibilities to this type of sensors, already present in the CPD’s of some companies

44

Typologies, schemes and monitoring models

3.5. Typologies, schemes and monitoring models
There are different models to address the monitoring process, both local and remote. We enumerate
the following common examples for different topologies in order to familiarize the reader with the
possible problems and the solutions Pandora has to offer. Each of the solutions is described in
successive chapters.

3.5.1. Accessible Webs
This is the norm in small, simple Webs but also in the very centralized and well organized ones.
This is the easiest model to implement.
• Web access for centralized remote monitoring. It implies that we can access every engine
from Pandora’s server to probe remotely.
• Web access for agent based monitoring. In this Web we can reach Pandora’s server from
the Pandora’s agents installed in the monitoring engine.

3.5.2. Limited access Webs
• Remote Web. This is a not reachable Web for remote testing by Pandora. We use, to that
end, a software agent, as a remote gatherer, to test other systems. We call these operating
modes: “satellite agent mode’ (when all testing is carried within the same agent) and ‘broker
agent mode’ (when it impersonates several agents, but every test is actually carried in the
same physical engine)

Deployment model for remote Webs non accessible in broker mode

• Software agents without access to Pandora’s server We will, in this case, use the proxy
characteristic of the software agents, allowing an agent without access to the server, to use
an agent with access to connect throw it.
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Deployment model for remote Webs by using the proxy agent mode

• Need to monitor Remote server monitoring for different Webs . In this situation we
mount several of the different Pandora's servers. Feeding from the same data base, one
server will execute a battery of predefined tests and a different one another. Both servers
operate in the same environment and are managed simultaneously from the console.

3.5.3. Special organizational characteristics
• A need to monitor several headquarters with monitoring equipment and different
configurations. We use, in this case, an export; to duplicate part of the monitoring in an
independent environment segregated from Pandora.

hierarchical export model with Export Server
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• Duality of reporting. We can configure additional agents to support two different Pandora
server’s although only one will be able to manage it.
• Fragmented management. Useful when you need to delegate the administration of part of
the equipment to different personnel, with different accesses. This is, more a management
issue than an architectural problem.. It can be resolved through the permits assigned on
management policies.

3.5.4. Large environments
• Large volume Web, with thousands of web testing processes that we are to distribute in
different "remote monitoring probes". Given their large numbers (over 50,000) we can’t
centralize them in a single server. To do that we use different servers in broker mode, that
distribute the remote testing load.
Distribution of remote testing model with agents in broker mode

Need to set up a HA server for security reasons, in case of a failure in the primary hardware. We
will study how to mount two servers: one ‘passive’, waiting on standby for the active one to stop
responding so it can start functioning .There are several ways to do it.
• Need to monitor a large volume of systems and manage them in a centralized way
(more than 2500 agents). To do that we configure different Pandora servers, coordinated by
the same system we call ‘metaconsole’. They can, in this way, be linearly escalated.
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Modelo de metaconsola
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4 PANDORA FMS GLOSSARY OF TERMS
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One of the things that are more difficult to understand at the beginning are the terms that we use. If
you came from another monitoring system or if you doesn't know any previous one, is quite
difficult. The main purpose of this glossary is to unify and define in a detailed way all the term
definitions usually used in Pandora FMS.

4.1. Agent
An agent in Pandora FMS is an organizing company. It is usually a machine, system or host (a
computer). The agent contains information and belongs to one group (to an only group). An agent
could also be an organizing unity, different from a computer. It could be a building, a vehicle or
anything else that "contains information". The agent has got information in different modules. The
agent could be linked to other agents through a parental connection (an agent could be son of
another agent). Therefore, the agent is an organizing unity inside Pandora FMS, a concept where
information from other information unities called modules is stored.

4.2. Software Agent
Though it's named the same as the previous concept, the software agent refers to the software that
is installed in the computers to collect information in an automatic way. This program is called
"Pandora FSM agent" and it's installed in all kind of systems: Windows, UNIX, etc. The software
agent is an appliance that generates a data file that is sent to the Pandora FMS through the
network, usually through the Tentacle protocol.

4.3. Module
One module is an atomic information entity that stores values (numerical, or alphanumeric/text).
Each module only stores one kind of data, from the same kind. That's to say, the module that stores
the traffic flow in one router, only store this value (numbers that increases as time goes on). The
agents are contained inside the agents, and they are always related to an only agent. An agent could
have N modules. The modules are not connected between them.

4.4. Remote Server
Server that is on net and that isn't the local server.

4.5. Server
Pandora FMS's server is the element that processes the collected information in different ways. They
are also the ones that execute alerts and send the data to the database. There are many subkinds of
Pandora servers, and each one does one operation. The servers kind network, for example, make
remote monitoring test (at distance, whereas the data servers process the collected XML).
Sometimes, we refer to "Server" when speaking about a system, to a computer.
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4.6. Console
The console, or WEB console is the WEB application that allows to manage Pandora FMS through
WEB.

4.7. Group
A group is an organizing element.The groups have agents, and the groups are used as reference to
fix which things an user could see and which ones couldn't. For example, when a report is defined
and it's associated with one group, only the users with access to this group could see this report.
The groups can also contain other groups, but this hierarchy couldn't be seen (at least in version 3.1
and previous ones) in any other way nor is it taken into account in the permission system.

4.8. Profile
It's a group of "permissions" on different operations that are possible at Pandora FMS: see an agent,
modify an agent, assign alerts, define reports, manage the DDBB, etc.

4.9. ACL
ACL is an acronym in English of Access Control List, or Listas de Control de Accesos (LCA in
Spanish), that in Pandora FMS are defined by assigning a profile on a group to one user.

4.10. Monitor
Is a module with an associated state. In Pandora FMS previous versions, only the boolean modules
had states (normal, when they were at 1 and critical, when they were at 0). At present all the
modules allow to define thresholds for three different states. When a module hasn't information
about associated state, it doesn't know when to change to critical or warning state, so it's simply a
module.

4.11. Datafiles / XML Data
An XML is a datafile generated by the Pandora FMS software agents. Besides containing the agent
modules information, it contains information about the agent itself (version, operative system, etc.).
The XML format is standard on computing, and it is useful to contain data. For more info about the
XML format, go to http://es.wikipedia.org/wiki/Extensible_Markup_Language.
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4.12. Alert
Is a request of an alert template associated to an specific module. It can have associated different
actions and has two possible states: fired and not fired. The alert, in Pandora FMS, does that when
something happens for example when a server is down , Pandora FMS interprets this and it sends
an email or an SMS to a person showing what had happened.

4.13. Alert Template
Is one of the three components of the alerts. It defines an alert configuration in a general way
(properly speaking we call alert to a template request). It allows to specify the firing condition, that
can depend on the value or the state of one module, and other details, such as the maximum
number of times that it will be fired in an specific interval or the recovery options.

4.14. Action
The action is one of the parts of the alert. Actions are request (that is, the particularity) of one
command. This particularity makes that the actions include specific parameters. For example, on
the command eMail we could define the actions Send an email to the administrator and Send an
email to the project distribution list, defining some of the fields that the command had, specifying
the administrator email or the email distribution list, following the previous example.

4.15. Command
Is another component of the Pandora FMS list. Excluding the Pandora FMS internal commands, that
allow to generate events, send emails, etc, a command represents a program or external utility that
the server executes.

4.16. Shell or Command Line
Interface that allows the introduction of commands through the keyboard.

4.17. Package
A package contains a program or group of programs packaged in an specific format ready to be
installed in an specific operative system and version. For example: an RPM package for OpenSUSE
linux.

4.18. Tarball
Same as one package, it contains a program or group of programs packed in TAR format, but
different from this, it hasn't information about how to install it, and on principle they aren't specific
for an specific operative system (though it's possible that the program that it has would be).
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4.19. SVN / Subversion / Code Repository
Is a version control system that stores one repository with the different version of the files that
integrate one project as long at it exist. The group of files in an specific moment in time is called
Revision, so two people that have the same revision of the project will have two identical copies of
the same files.

4.20. Database
Is a group of data that belong to the same context and that are kept systematically for its later use.
Pandora FMS uses relational database, where the place and the way that data is stored has no
particular importance and you can have access to them through an structured language of standard
request (SQL).

4.21. Database Sketch
Describes the database structure in a formal language. In a relational database, the sketch defines
the tables, the fields of each table, and the connections between fields and tables.

4.22. Tentacle
Is the data transfer protocol that the software agents use to send data to the Pandora FMS server.
Tentacle is multiplatform and is designed to be a protocol secure and easy to use. It uses port 41121
port (assigned by IANA) by default.

4.23. State
Usually we refer to the state of one module. It gives us information about the module at the present
moment. The state of an agent is get considering the worst of the state of all its modules as a group
(if it has 5 modules and one is in CRITICAL, two in WARNING and two in NORMAL) the module
state will be CRITICAL. Same for the state of one group.

4.24. States CRITICAL and WARNING
NORMAL, WARNING and CRITICAL are the three possible states of one module. The WARNING
and CRITICAL states usually show error conditions of different severity. Pandora FMS allows to
define in an independent way different thresholds for the WARNING and CRITICAL states of each
module.
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4.25. State Unkown
We say that one module is on state unknown if it doesn't get data from more than twice its interval.
This is,one module that sends data every 5 minutes is selected as unkown after 10 minutes of no
receiving any data. Although, the module still keeps its state NORMAL, WARNING or CRITICAL
depending on the last data that it got.

4.26. Alert threshold
It's the time interval where the defined restrictions are applied when configuring the alert template.
For example: an alert template that defines a 10 minutes threshold and a maximum number of
alerts of 5, warranties that in a 10 minutes interval the alert won't be fired more than 5 times.
Besides, except if the recovery is already configured, the alert will remain fired until this time
interval ends.

4.27. False positive/negative
When a check returns an error and this hasn't take place, then we consider it a false positive. When
it doesn't give back any error and it has taken place, we say that it's a false negative. For example,
we have a false positive if a module that returns 1 when the server is available and 0 when it isn't
returns 1 but the server is not available.

4.28. Flip/Flop Protection
The flip flop protection of one module shows the number of times that the state change condition
should be to the state change could be possible. This allow to protect one module from false
positives/negatives. For example, if we know that a module returns false positive, but never more
than two consecutives, we can configure the flip flop protection to three in order to avoid that the
false positives would do state changes.

4.29. Synchronous Monitoring
We consider a module as synchronous when it returns data at regular intervals. For example: a
temperature measurement every 5 minutes

4.30. Asynchronous Monitoring
We consider that one module is asynchronous when it returns data depending on its availability.
For example: it search an string in a log file. If it doesn't find the string, the module doesn't return
data. Another example very common is that of the SNMP traps, that are generated only when an
error takes place (for example, power supply failure).
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5.1. Minimum Hardware Requirements
5.1.1. Console and Server Requirements
• Up to 500 agents or 5.000 modules: 3GB of RAM, a singlecore CPU at 2.5GHz clock, and a
fast hard disk, 7200rpm or equivalent.
• Up to 2.000 agents or 10.000 modules: 4GB of RAM, a dual core CPU clock to 2.5GHz, and
faster hard drive (7200 rpm or more).
• For more than 4.000 agents: 12GB of RAM, a quadcore CPU to 3GHZ and very fast hard
drive (15,000 rpm or more).

It is *not* advisable to use Pandora FMS in virtualized environmennts, since the disk
access requirements are very strict. In case you are willing to do so, it is a must to assign
independent RAM, CPU and disks, instead of using part of the host resources. It is more
than advisable to use SAN disks in this kind of environments.

Is's only possible to use Pandora FMS in virtual enviroments for testing, certification or
development enviroments, but never in production systems

Disk size: A minimum of 15GB free space, it's recommended to have 25GB.

5.2. Software Requirements
5.2.1. Agent Requirement
The remote agent is able to run on any hardware that can run the minimum required operating
system:
•
•
•
•
•
•
•
•
•
•
•
•

Windows 2000 SP3
Windows 2003
Windows XP
Windows Vista
Windows 7
Windows 2008
SUSE Linux 10
Ubuntu Linux 8.04
Debian Linux
AIX 4.3.3
HPUX 11.x
Solaris 2.6

It is known that the agent has been implemented successfully in other operating systems,
but there is no official support. The agent does not work in Windows NT4. To monitor
previous Windows systems, you can install Cygwin environment and install the agent
for Linux, although the performance is much lower than native Windows agent.
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Furthermore on UNIX platforms, you must have installed:
• Perl 5.8 or greater.
• Optionally unzip package and executable via path by the user of Pandora FMS Agent. (This
package is required only if you will use file collection).

5.2.2. Server Requirements
Although you can work on any operating system with Perl 5.8 installed with iThreads enabled, it's
recommended and is supported only on Linux, being the recommended distributions SUSE (SLES or
OpenSuse) and Ubuntu / Debian. There have been people who have it working under BSD and
Solaris systems.
Should be noted that Pandora FMS requires a MySQL server to store all information. This server can
be installed on any platform supported by MySQL. This could be Windows, Linux, Solaris, etc.
It must have Perl 5.8 installed, at least for the server to work well. In addition to the operating
system SNMP packets (netsnmp) to use the Pandora FMS SNMP service, it also requires a database
(MySQL). Also required nmap packages and optionally xprobe2 to use the advanced features of
reconserver and traceroute Perl libraries to be able to selfdiscovery network. It is also necessary,
the WMI client binary for WMI queries against Windows systems. The client binary is part of the
SAMBA project (v4) and can be compiled, not without some difficulty in any Unix environment.

5.2.3. Console Requirements
Same as the server, we recommend its operation being on Linux systems, but like the web interface
it's a pure AMP application (Apache, MySQL and PHP), theoretically it could work on any system
that supports Windows, Unix, etc..

5.2.4. Requirements to Administer the Tool via WEB
It must have a web browser to install and verify operations of the console. To start it is not required
flash plugin installed in your browser, although it is recommended to make use of interactive
graphics in Flash.

5.2.5. Package Dependencies
Pandora FMS has a big dependency of the Linux operating system, but it also needs additional
packages that often are not installed by default. In the installation process there are a detailed list of
package dependencies for Debian / Ubuntu and OpenSUSE.

5.3. Issues before installation
5.3.1. Pandora FMS installation order
You should follow this order to install properly Pandora FMS:
1. Install console
2. Install server
The reason is because the MySQL database configuration is made during the Initial Configuration
fase of the console installation and for be sure the properly work of the server is recommended do
first the whole installation process of the console.
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Also, Pandora FMS server and Pandora FMS console could be hosted in different machines, because
you can configure the server to use a remote MySQL database through the server configuration file.
About the agent, you can install it before or after install the server and the console, because the
agent works independently and it can be installed in any machine.

5.3.2. Installing the Enterprise version
From version 4.0.2 the license number of Pandora FMS enables the use of the Enterprise features.
This means that if you have installed version 4.0.2 enterprise without a valid license number will
not work. You must first install the OpenSource version, get the license number and then install the
enterprise version 'in that order.' In summary:
• Install the console OpenSource.
• Access the console, go to the setup section and enter your license there (see the image
below).
• Install the Enterprise Console.
However, if you do it in another order, the screen wich reports you the error, could be used to enter
the licence. Remember that the license validation is performed only on the console. Not on the
server.
Enter the license here, in the main option configuration (setup):

5.4. Installing on SUSE
5.4.1. Configuring Software repositories
The installation of software on SLES is done via .RPM packets. These RPM packets can contain
official software, provided by the manufacturer  Novell , through the installation DVD/CD, HTTP /
FTP repositories or other nonofficial repositories, maintained by the community of developers and
users of SUSE (OpenSUSE). These repositories can only be accessed through the internet, but the
individual RPM packages can be downloaded, copied to servers and installed manually by command
line.
SLES uses a general management interface  YAST  for package management and software
repositories. This interface is used to manage the entire system SLES: disk partition, install
software, configure the network cards, etc... It can be used with graphical interface (X) or any
console or remote session via SSH.
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For this documentation we use the Zypper Suse tool, able to solve dependencies and download the
packages directly from the repositories on the Internet. If you don't have Zypper installed, you
should install it, is much more convenient and faster. If not, you will have to do all the manual
installation of packages using YaST and SUSE installation CD.

5.4.2. Previous Dependencies Installation
You have to install the following package dependencies, included in SUSE:
apache2 apache2-mod_php5 php5 php5-gd php5-gettext php5-json php5-mbstring php5-ldap
php5-mysql
php5-pear php5-snmp nmap perl-DBD-mysql perl-DBI perl-Date-Calc perl-Date-Manip
perl-HTML-Parser
perl-HTML-Encoding perl-HTML-Tree perl-IO-Socket-inet6 perl-Mail-Sendmail perlNetAddr-IP
perl-SNMP perl-TimeDate perl-XML-Simple perl-libwww-perl mysql-client mysql-Max
mysql
net-snmp xorg-x11-fonts-core php5-pear-db php5-zip graphviz graphviz-gd

OpenSUSE unlike SLES doesn't have mysql-max package, you can install Mysql
standard package without any problem.

To install all dependencies, run:
zypper install ..

Followed by the whole package list specified in the paragraph above. This will give you a screen like
this:
Getting repositories data...
Reading packets installed...
perl-DBI already installed.
perl-HTML-Parser already installed.
perl-TimeDate already installed.
perl-XML-Simple already installed.
perl-libwww-perl already installed.
xorg-x11-fonts-core already installed.
Resolving dependencies...
Following NEW packages will be installed:
apache2 apache2-mod_php5 apache2-prefork apache2-utils libapr1 libapr-util1
libdnet1
liblua5_1 libmm14 libmysqlclient15 mysql mysql-client mysql-Max net-snmp nmap
perl-Bit-Vector perl-Carp-Clan perl-Data-ShowTable perl-Date-Calc perl-Date-Manip
perl-DBD-mysql perl-HTML-Encoding perl-HTML-Tree perl-IO-Socket-inet6
perl-Mail-Sendmail perl-NetAddr-IP perl-SNMP php5 php5-ctype php5-dom php5-gd
php5-gettext php5-hash php5-iconv php5-json php5-ldap php5-mbstring php5-mysql
php5-openssl php5-pdo php5-pear php5-snmp php5-sqlite php5-tokenizer php5-xmlreader
php5-xmlwriter php5-zip php5-zlib t1lib
Total Size: 19.1 M. After the operation, additional 55.9 M will be used.
Continue? [Yes / no]:

59

Installing on SUSE

By clicking YES, Zypper start downloading and installing packages.
When finished, you need to install some extra packages. In OpenSuse not all packages you need for
Pandora FMS exist, so they are provided some additional RPM to satisfy these dependencies from
the Pandora FMS Sourceforge website, these files. Additional rpm are:
perl-time-format php-pear-xml_rpc wmic smstools perl-HTML-Tree perl-XML-Twig

Extra packages perl-HTML-Tree y perl-XML-Twig must be installed
manually.

Optionaly and only if you will use Recon Server you should install these packages:
perl-net-traceroute perl-net-traceroute-pureperl xprobe2

These RPM files can be found on the official site of distribution of Pandora FMS software in a
specific dependencies directory for OpenSuse.
NOTE: Be sure you download the correct packages for OpenSuse.
Place them in a directory, for example /tmp/extra. In that directory run the command:
rpm -i *.rpm

5.4.3. Agent Installation
You should have download from our web site a RPM package similar to this one ( some version
number or another details could be slightly different):
pandorafms_agent-3.0.0-1.noarch.rpm

In order to install it, simply execute this command:
rpm -i pandorafms_agent-3.0.0-1.noarch.rpm

If these phrases are shown:
Insserv:warning:script 'smsd' missing LSB tags and overrides Insserv:defaultstart undefined,
assuming default start runlevel (s) for script 'smsd'.
Do not worry. It is only a warning message. It is not an error.

5.4.4. Server installation
Same as with the agent.Execute:
rpm -i pandorafms_server-3.0.0-1.noarch.rpm
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If you have previously installed the agent, then you will obtain the following not important
warning:
useradd: Account `pandora' already exists.

5.4.5. Console installation
Same as before, execute the rpm installation tool for packages in order to install the package that
contains the Pandora FMS console:
rpm -i pandorafms_console-3.0.0-1.noarch.rpm

If you have any trouble installing Pandora FMS console caused by a wrong package name,
something like this:
error: Failed dependencies:
php5-pear-db is needed by pandorafms_console-3.1-1.noarch

You can force the installation using the flag nodeps.

5.4.6. Installing the Enterprise version
Same way, execute the rpm package installing tool to install the package that contains the
Enterprise version and the Pandora FMS Enterprise server:
rpm -i pandorafms_console_enterprise-3.0.0-1.noarch.rpm
rpm -i pandorafms_server_enterprise-3.0.0-1.noarch.rpm

You should restart the Pandora FMS server in order to detect the Enterprise version new
functionalities:
/etc/init.d/pandora_server restart

5.4.7. Installing the Keygen
The Keygen binary is needed to could use the automatic update feature of the Enterprise version. It
consist on a binary that codes, using a GNUPG (PGP)key a list of data composed by their ID an the
nº of agents that it has, sending them encoded to the Pandora FMS Open Update Manager central
server to it validates its authenticity.It it is OK, then you Update Manager client will be able to
download all the updates that he needs.
To install the keygen, you have only to install a package and configure your Pandora FMS console
in order that it uses the keygen in this location:
/usr/share/pandora/keygen
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To add the package, same as with the rest of packages:
rpm -i pandorafms_keygen-3.0.0-1.rpm

To ensure the keygen works properly follow these steps:
1. Get the credentials used by Pandora FMS console to access database:
Open the file /srv/www/htdocs/pandora_console/include/config.php
You will see several lines like these:
$config["dbname"]="pandora_db";
$config["dbuser"]="pandora";
$config["dbpass"]="abcdef";
$config["dbhost"]="localhost";

Copy the values of parameters: dbname, dbuser. dbpass and dbhost, we will use them later.
2. Test the keygen using the license key.
Go to keygen folder an execute the command without any parameters:
cd /usr/share/pandora
./keygen

The output will be something like this:
Usage: ./keygen serial host user password database

Now we can replace the parameters with the values copied above and execute the command again:
./keygen ABCDEFG12345 localhost pandora abcdef pandora_db

If all went fine you will see a GPG key, something like this, it means the keygen works properly:
hQQOA4fsMudwiK3sEBAAq8tJPsMsihw1lTgG7fpLcbq812WSPTBov+xM2 . . .

3. To finish the test is needed to delete some temporal files.
Go to /tmp folder and delete the files: pubring.gpg, pubring.gpg~, random_seed, secring.gpg
and trustdb.gpg:
cd /tmp
rm pubring.gpg pubring.gpg~ random_seed secring.gpg trustdb.gpg

5.4.8. Uninstalling Pandora FMS
You could uninstall any of Pandora FMS components with the following commands:
rpm -e pandorafms_agent
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rpm -e pandorafms_console
rpm -e pandorafms_server

Pandora FMS database will be not uninstalled if any of the Pandora FMS packages are unistalled.
All files ( also the configuration ones) from any package will be eliminated.

5.5. Installation in Red Hat Enterprise Linux / Fedora / CentOS
The installation process is nearly the same than the SUSE one. However, notice that
RHEL/CentOS/Fedora RPM packages are not the same than in SUSE.
Most of dependencies should be resolved using YUM or other automatic package. All dependencies
are marked as needed package in the RPM definition:
yum install php php-gd graphviz php-mysql php-pear-DB
snmp php-ldap php-common php-zip

php-mbstring php-ldap php-

yum install perl-HTML-Tree perl-DBI perl-DBD-mysql perl-libwww-perl perl-XML-Simple
perl-XML-SAX perl-NetAddr-IP net-snmp net-tools perl-IO-Socket-INET6 perl-Socket6
nmap wmic sudo xprobe

Some dependencies (like wmic or xprobe) are not in the official RHEL repositories, we provide in
our Sourceforge download page as Contributions/Tools.
Some other dependencies like graphviz, perlXMLSimple or perlHTMLTree are not in the official
RHEL repositories either, however they can be found in the CentOS base repository, so we would
only have to add this one to our repository list.
[centos_base]
gpgcheck = False
enabled = 1
name = CentOS Base
baseurl = http://mirror.centos.org/centos/6/os/i386/
http://public.planetmirror.com/pub/caosity/centos/6/os/i386/

Be sure you download the correct packages for Red Hat Enterprise Linux.
However, for Red Hat Enterprise Linux 6 we would only have to install these dependencies, since
most of the necessary packages for the console and the server are already included in the php and
perl dependencies by default:
yum install php php-common graphviz
yum install perl-HTML-Tree perl-DBD-mysql perl-XML-Simple perl-XML-SAX perl-NetAddrIP net-snmp perl-SNMP net-tools perl-IO-Socket-INET6 perl-Socket6 nmap wmic xprobe

If you are using a version prior to RHEL6, some dependencies could have another
name. For instance, perl-SNMP, in CentOS5, RHEL5, etc, would be called net-snmpperl.
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To install the RPM just use the rpm i commando or directly yum command, for example:
rpm -i pandorafms_server-3.2-2.noarch.rpm

or
yum install pandorafms_server-3.2-2.noarch.rpm

If you encounter any problem by the time you try to access the Pandora FMS Console installation
web page, please check if SELinux is active: in that case it is needed to deactivate it following the
FAQ procedures.

RHEL/CentOS 5.x by default uses PHP 5.1 and this is not compatible with Pandora
FMS, you need to use PHP 5.2 or higher.

To do that, we recommend to use the following repository for CentOS5/RHEL5, which contains
PHP 5.2:
[c5-testing]
name=CentOS-5 Testing
baseurl=http://dev.centos.org/centos/5/testing/$basearch/
enabled=1
gpgcheck=1
gpgkey=http://dev.centos.org/centos/RPM-GPG-KEY-CentOS-testing

5.6. Instalation in Debian/Ubuntu
It is recommended to install Pandora FMS over a 10.04 version or superior.

5.6.1. Previous installation of dependencies
In Debian/Ubuntu the dependencies are the following ones:
Server:
snmp snmpd libtime-format-perl libxml-simple-perl libdbi-perl libnetaddr-ip-perl
libhtml-parser-perl wmi-client xprobe nmap libmail-sendmail-perl traceroute
libio-socket-inet6-perl libhtml-tree-perl libsnmp-perl snmp-mibs-downloader libiosocket-multicast-perl

If the wmi-client package is not in the repositories, you should download it from
Pandora FMS sourceforge website
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Console
php5 libapache2-mod-php5 apache2 mysql-server php5-gd php5-mysql php-pear php5-snmp
php-db php-gettext
graphviz mysql-client php5-curl php5-xmlrpc php5-ldap

In order to install the Server package or the console one, you will have to fulfill the dependencies
before. This should be done installing all the packages before mentioned with the commandaptget,
having root priviledges, like this:
apt-get install snmp snmpd libtime-format-perl libxml-simple-perl libdbi-perl
libnetaddr-ip-perl \
libhtml-parser-perl wmi-client xprobe nmap libmail-sendmail-perl traceroute libiosocket-inet6-perl \
libhtml-tree-perl php5 libapache2-mod-php5 apache2 mysql-server php5-gd php5-mysql
php-pear php5-snmp \
php-db php-gettext graphviz mysql-client php5-curl php5-xmlrpc php5-ldap libsnmpperl snmp-mibs-downloader \
libio-socket-multicast-perl

The character \ is used as a line divider. You can do copy/paste of this documentation
directly on the console and the line breaks will be considered as such ones thanks to the
character \

This command would install all the dependencies needed to install the Pandora's FMS server and
console into a Debian/Ubuntu system.

5.6.2. Pandora FMS installation with .DEB packages
The installation with the deb packages is very easy. First you should download all the necessary
packages and after, simply you should execute the following commands in the same directory where
you have put them.
There is a serial of packages that are not included in the standard distribution of Ubuntu and that
need to be installed previously (dependencies, but that are not in the official distribution). They are
usually distributed with the Pandora FMS packages:
dpkg -i php-xmlrpc_1.1.0-1_all.deb libnet-traceroute-perl_1.10-1_all.deb libnettraceroute-pureperl-perl_0.10-1_all.deb

After we install the Pandora FMS packages. In this example they are installed all together, but could
be only one of them.
dpkg -i pandorafms-console_all.deb pandorafms-server_3.0_all.deb tentacle-perlserver_0.2.0-2_all.deb
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If once that the command has been executed you see that some dependencies are missing, then you
can try to solve them in an automatic way with the command:
apt-get -f install

This will try to download all the necessary packages that are missing for the automatic installation
of Pandora FMS into the system. Once the necessary packages have been installed, then we should
continue with the installation of all Pandora FMS components.

5.6.2.1. Console installation
In order to complete the installation of the Pandora FMS Console, you must access the console URL
and follow the installation wizard steps. If the console is installed in a server with IP 10.20.34.54
you will have to enter the following URL:
http://10.20.34.54/pandora_console

5.6.3. Uninstalling Pandora FMS
dpkg -r pandorafms-console-enterprise
dpkg -r pandorafms-console

5.7. Installation in FreeBSD
From version 3.2 of Pandora FMS supports FreeBSD.

5.7.1. Perl with ithread Installation
To execute the pandora server daemon, perl should be compiled with thread enabled. But, the
FreeBSD perl 5.8 package, perl5.8.x.pkg, is without thread. So, it can not be used.
You should compile and install perl 5.8 executable by using FreeBSD ports collection like this:
cd /usr/ports/lang/perl5.8
make config
-> Enable THREADS.
make
make install

5.7.2. Previous Dependencies Installation
In FreeBSD the dependencies are the following ones:
server:
databases/p5-DBI mail/p5-Mail-Sendmail net-mgmt/p5-NetAddr-IP textproc/p5-XML-Simple
devel/p5-Time-Format www/p5-HTML-Parser net/p5-Net-Traceroute-PurePerl
net/p5-IO-Socket-INET6 database/p5-DBD-mysql textproc/p5-XML-Twig security/nmap
net/xprobe sysutils/coreutils
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In order to install the pandora server, you will have to fulfill the dependencies before. This should
be done by using ports collection. Don't use packages.
You can install all dependencies linke this:
e.g.) p5DBI installation.
cd /usr/ports/databases/p5-DBI
make
make install

console:
www/apache22, lang/php5, net-mgmt/php5-snmp, www/php5-session, devel/php5-gettext,
converters/php5-mbstring, net/php5-ldap, databases/php5-mysql, graphics/php5-gd,
archivers/php5-zip,
archivers/php5-zlib, devel/php5-json, ftp/php5-curl, devel/pear, databases/pear-DB,
net/pear-XML_RPC,
graphics/graphviz (GTK, GDK_PIXBUF, PERL, PHP should be enabled.)

In order to install the pandora console, you will have to fulfill the dependencies before. You can use
ports collection or packages.

5.7.3. Console installation
There are no pandora console package file for FreeBSD. You should install the pandora console by
using installer.
How to install using installer is described in following section, "Manual Installation from Sources in
Linux/Unix".
On FreeBSD with apache22, pandora_console directory is:
/usr/local/www/apache22/data/pandora_console

5.7.4. Server installation
There are no pandora server package file for FreeBSD. You should install the pandora server by
using installer.
How to install using installer is described in following section, "Manual Installation from Sources in
Linux/Unix".
The file locations and startup script structure are different from Linux. We show FreeBSD specific
things below.
After installation, you should add following lines to /etc/rc.conf.
pandora_server_enable="YES"
tentacle_server_enable="YES"

To enable pandora servers, pandora and tentacle, these settings are needed. Otherwise, they are not
launched.
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On FreeBSD, most files of pandora server are installed in /usr/local.
pandora_server, tentacle_server:
/usr/local/bin/pandora_server
/usr/local/bin/tentacle_server

Startup script:
/usr/local/etc/rc.d/pandora_server
/usr/local/etc/rc.d/tentacle_server

Configuration file:
/usr/local/etc/pandora/pandora_server.conf

util:
/usr/local/share/pandora_server/util/*

Man pages:
/usr/local/man/man1/*

Other:
The data_in and log directories are the same as Linux.

5.7.5. Agent installation
There are no pandora agent package file for FreeBSD. You should install the pandora agent by using
installer.
How to install using installer is described in following section, "Manual Installation from Sources in
Linux/Unix".
The file locations and startup script structure are different from Linux. We show FreeBSD specific
things below.
After installation, you should add a following line to /etc/rc.conf.
pandora_agent_enable="YES"

To enable pandora agent, this settings are needed. Otherwise, it is not launched.
On FreeBSD, most files of pandora agent are installed in /usr/local.
Agent:
/usr/local/bin/pandora_agent
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Startup script:
/usr/local/etc/rc.d/pandora_agent

Configuration file:
/usr/local/etc/pandora/pandora_agent.conf

Plugins:
/usr/local/share/pandora_agent/plugins/*

Man pages:
/usr/local/man/man1/*

Other:
The data_out and log directories are the same as Linux.

5.8. Manual Installation from Sources in Linux/Unix
This option is specially important if you want to use the development version code or directly from
the code repositories.

5.8.1. Previous Installation of Necessary Software
So as you are going to build Pandora FMS from the sources, you will need the basic software in
order to compile and installe software from the code. Depending on the use of one distro or another
one, you will have to install packages such as make,gcc and others. Furthermore, it is recommended
to review the dependencies section corresponding to your distribution.
In debian/ubuntu there is a metapackage that contains all of them:
apt-get install build-essential subversion

In SUSE/Redhat/Fedora you should install several packages:
zypper install make automake subversion

5.8.2. Download from Sources
The easiest way is to download the sources in "tarball" format (.tar.gz, .tgz o .tar.bz2) and
decompress them. For it, you should go to Pandora official web site, download section at
http://pandorafms.org.
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Other interesting option if you want to keep well informed and use the latest code, stable or at
development, is using the client from Subversion (svn)code version system.For it you could visit the
development
version
at
Pandora
FMS
official
web
site
project
FMS
http://pandorafms.org/index.php?sec=community&sec2=development&lang=es.
To download the development version code using the commands line from the SVN client:
svn co https://pandora.svn.sourceforge.net/svnroot/pandora

5.8.3. Agent Installation
The agent does not requires neither compilation nor preparation. Once we have the agent
pandorafms_3.0_unix.tar.gz
1. Do root
su -

2. Copy to /tmp and at /tmp we should execute:
tar xvzf pandorafms_3.0_unix.tar.gz
./pandora_agent_installer --install

3. We start the agent manually
/etc/init.d/pandora_agent_daemon start

5.8.3.1. Custom agent installation
Starting with 3.1 version, the agent could be installed completely is a custom defined directory, like
for example /opt/pandora. This custom defined directory will contain everything agent has:
configuration files, logfiles, plugins, and even the man pages.
To use this method:
./pandora_agent_install --install /opt/pandora

The only file pandora will create outside it's defined directory is the main agent service launcher at
/etc/init.d/pandora_agent_daemon (or equivalente in other unix kinds), and the startup level link,
for example /etc/rc.d/rc2.d/S90pandora_agent_daemon.
Also it is possible to perform installation to execute agent with other user than root. For example to
execute with user Pandora, you have to install with the following command:
./pandora_agent_install --install "" pandora

5.8.4. Console Installation
Once we have the compressed file with the console that should be named pandorafms_console
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3.0.0.tar.gz o similar:
1. We do root
su -

2. We copy it to /tmp and at/tmp we execute:
tar xvzf pandorafms_console-3.0.0.tar.gz
cd pandora_console
./pandora_console_install --install

5.8.4.1. Enterprise Versión
Once we have the file compressed with
pandorafms_console_enterprise3.0.0.tar.gz or similar:

the

console,

that

will

be

called

1. We do root
su -

2. We copy it to /tmp and in /tmp we execute:
tar xvzf pandorafms_console-3.0.0.tar.gz

And we copy it to the directory where is installed our Pandora FMS Opensource console, either
/var/www/pandora_console for Debian or Ubuntu, or /srv/www/htdocs/pandora_console/ for
SUSE, RH, Fedora, etc (or in another directory depending on your distribution).
Debian:
cp -R enterprise /var/www/pandora_console

SUSE:
cp -R enterprise /srv/www/htdocs/pandora_console

3. Change the permissions in order that files would be for the web server user, for example:
Debian:
chown -R www-data /var/www/pandora_console/enterprise

SUSE:
chown -R wwwrun /srv/www/htdocs/pandora_console/enterprise

After that, we should proceed with Console Initial Configuration
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5.8.5. Server Installation
Once we have the compressed file with the server that will be called pandorafms_server
3.0.0.tar.gzor similar:
1. We do root
su -

2. We copy it to /tmp and at y /tmp we execute:
tar xvzf pandorafms_server-3.0.0.tar.gz
cd pandora_server
./pandora_server_installer --install

If there are problems with dependencies, then we should have to solve them before trying the
installation. We could force the installation ignoring the problem with dependencies, but Pandora
FMS will not work right.

5.8.5.1. Enterprise Version
Once we have the file compressed with the server,that will be named pandorafms_server_enterprise
3.0.0.tar.gz or similar:
1. We do root
su -

2. We copy it to /tmp and in /tmp we execute:
tar xvzf pandorafms_server_enterprise-3.0.0.tar.gz
cd PandoraFMS-Enterprise/
perl Makefile.PL
make
make install

If the installation has been done with a system with a Pandora FMS OpenSource that is already
functioning and we want that it consider the new features or the Enterprise version, we only have
to restart the Pandora FMS server:
/etc/init.d/pandora_server restart

If there are problems with dependencies, then we have to resolve them before trying the
installation. We could force the installation ignoring the problem with the dependencies, but
Pandora FMS will not work or will not work correctly.

5.8.5.2. Uninstallation / Manual wipe from server
If we have installed / updated several different versions, using different installation methods (RPM,
Tarball), it could come to a point in which we have various versions mixed up that could be using
wrong versions of libraries or of the server itself. The following procedure is aimed at detecting
which versions are there and manually erase them:
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Binaries should always be in /usr/local/bin, with a link to /usr/bin. To test this simply:
ls
ls
ls
ls

-la
-la
-la
-la

/usr/local/bin/pandora_server
/usr/local/bin/tentacle_server
/usr/bin/tentacle_server
/usr/bin/tentacle_server

Pandora's libraries depend on their distribution's version. The following command should allow to
know where they are and whether there are various ones:
find / -name "WMIServer.pm"

This will display a complete path where Pandora's library is installed, for example:
/usr/local/share/perl/5.10.0/PandoraFMS/WMIServer.pm

It could happen that various paths are displayed:
/usr/local/share/perl/5.10.0/PandoraFMS/WMIServer.pm
/usr/local/share/perl/PandoraFMS/WMIServer.pm

En such case we won't know which one is in use, so our best option is to remove the entire
directories and reinstall Pandora FMS:
rm -Rf /usr/local/share/perl/5.10.0/PandoraFMS
rm -Rf /usr/local/share/perl/PandoraFMS/

It is always a good idea to backup /etc/pandora/pandora_server.conf, just in case.

5.8.6. Server Code Update:Compilation and Manual Installation of the Server
There is another way besides the generic installation script. You could "compile" the Pandora FMS
code through the Perl interpreter of its system. This process simply install the libraries and the
minimum executables, but does not touch the starting script system , maintenance scripts,
configuration or any other thing besides the application and its libraries. This process is the
indicated one when has to update the server code but without overwrite its configuration.
For it, decompress your server code in /tmp, such as it has been said in the previous step.
1. We do root
2. We copy to /tmp and in /tmp we execute:
tar xvzf pandorafms_server-3.0.0.tar.gz
cd pandora_server
perl Makefile.PL
make
make install
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Observe the error exit from the screen. If any dependency is missing or there is any other problem,
then the system will notify to you. If you observe a message like this:
Warning: prerequisiete Mail::Sendmail 0 not found
Warning: prerequisiete Net::Traceroute::PurePerl 0 not found

Then it means that there are some Perl packages that Pandora FMS needs and that the system does
not have installed. Check the previous paragraphs in order to know how to install the previous
required dependencies to install Pandora FMS. Nevertheless you can "ignore" these errors (they are
warnings no errors) and force the installation. For sure you will have problems in one moment or
another because there is one component missing to work. But if you know the component that is
not installed and is not going to be used (f.e: traceroute is used only for the Pandora FMS Recon
Server) then you can go on.
After all this process, the files are automatically copied
/usr/local/bin/pandora_server
/usr/local/bin/pandora_exec

And several .pm files (Perl libraries) that Pandora FMS needs. These libraries .pm are copied into
several files, depending on its distribution version and on its distribution.For example in Ubuntu
9.04 they are copied to:
/usr/local/share/perl/5.10.0/PandoraFMS/

In SUSE/SLES 11 they are copied to:
/usr/lib/perl5/site_perl/5.10.0/PandoraFMS/

5.9. Windows Agent Installation
The agent is given as an selfinstaller in executable format (.exe). The basic installation does all the
required steps and it will be necessary only to accept all the options. To install the Pandora FMS
agent in Windows you only need to download and to execute it. The installer will guide you with all
the steps in the language that you choose. In the following example it is shown the installation for
Windows Vista. Remember that Pandora FMS works with any current Microsoft (2000 or upper)
platform.
Select the language:
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Follow the installer steps.

Accept the license terms and press Next:
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Select the path where the Pandora FMS agent will be installed. You can change it pressing
Browse...,after press Next:

Check the installation data and press Next:
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Wait mean while the files are being copied.

Configure the data for the agent as the IP (or name) of the Pandora FMS server that will receive the
agent data and the data entry path (if you are not sure of this value, then leave the default value).
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Choose if you want to start at the moment the Pandora FMS agent service. On the contrary, you will
have to do it in a manual way or else it will start when Windows reboots again.

When the installation has finished you can change the agent's parameters at file pandora_agent.conf
or trough the direct link at Pandora FMS menu:
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5.9.1. Windows Agent Unattended Installation
From versión 3 RC3, Pandora FMS includes the option of installing the Windows agent in an
unattended way . For it, you should execute the agent installator giving it the /mode Silent
parameter that shows that the installation should be done in an unattended way. Besides, you can
pass it the /prefix <Ruta> parameter to show it the installation complete path.
Execute the following command (where XXXXX) could change depending on the installator version,
and <Ruta> is the complete path where we want to install it (in inverted commas if it has spaces).
PandoraFMS_windows_agent_v3.0.XXXXX.setup.exe /mode Silent /prefix <Ruta>

For example, to install the current version, to install in c:\agente_pandora\, you should
execute:
PandoraFMS_windows_agent_v3.0.RC3.setup.exe /mode Silent /prefix c:\agente_pandora

This will install Pandora FMS with the default values in the showed path, and it start the Pandora
FMS service in the machine. It is necessary to execute this installing process with priviledges to
could install software/ services in the machine.

5.9.2. Unattended Uninstallation
The uninstaller that is an executable called uninstall.exe that remains in Pandora FMS
installation directory, also allows the unattended unistallation, for it, you have to execute the
unistaller with the /mode Silent option
For example, assuming that Pandora FMS is installed in the default path:
c:\archivos de programa\pandora_agent

You should execute:
“c:\archivos de programa\pandora_agent\uninstall.exe” /mode silent

5.9.3. Windows Agent Manual Installation
The Window's agent could be installed in a manual way. To learn how the manual installation
works serves also to understand how the Agent works at inside and to could reset later the
installation of some parameters.
Assuming that all the agent's necessary files are obtained and also their directory structure, that
summarizing is this one:
• PandoraAgent.exe: Pandora FMS service executable. We will see later that it accepts any
parameters that could be very useful for us.
• pandora_agent.conf: the configuration main file
• libcurl.dll: library used by Pandora FMS to upload the files through FTP.
• libeay32.dll: library used by Pandora FMS to cypher connections (SSH y Tentacle).
• zlub1.dll: Library used by Pandora FMS to compress data.
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• libodbc++.dll: library used by Pandora FMS for para ODBC checking
• pandora_agent.log: agent's main log
• pandora_debug.log: agent's main log (as debug )
• /util:In util directory there are several unix "typical" tools given to Win32, such as
grep,gawk, wc, head,tail, etc.
There is also placed the tentacle client, "tentacle_client.exe" that is the one used to send the
packages to the Pandora FMS server.
These files could be obtained from our code repository (subversion) at sourceforge, just as it's
described in our website.
Another easier solution is to make a zip with the contents of a currently installed agent. Just zip
contents of the directory c:\program files\pandora_agent and decompress into the destination
system.

5.9.3.1. Using PandoraAgent.exe from the Commands Line
If we execute pandoraagent.exe help, it will show something like this:
Pandora agent for Windows. Version 3.0(Build 090924)
Usage: pandoraagent.exe [OPTION]
Available options are:
--install: Install the Pandora Agent service.
--uninstall: Uninstall the Pandora Agent service.
--test-ssh: Test the SSH Pandora Agent configuration.
--test-ftp: Test the FTP Pandora Agent configuration.
--process: Run the Pandora Agent as a user process instead of a service.

To install the service (if it is not installed), execute following command from the directory where is
placed the .exe, like c:\program files\pandora_agent:
pandoraagent.exe --install

This will install the service in the machine building on the path where the .exe is located. If we
want to remove it, it is the same process, but:
pandoraagent.exe --uninstall

Depending on the kind of Windows system that it would be it is possible that you should have to
reboot the system after removing the service. In other systems the change is taken without having to
reboot.
If you want to try a ftp or ssh connection from the command line, then you can use the options
above mentioned.

5.9.3.2. Pandora FMS Window's Agent as Process
Is possible, for debugging reasons,tests and other unusual circunstances, to execute the agent in
"Process" way. This is done executing it from the command line:
pandoraagent.exe --process
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There are some restrictions in the execution to the process mode, so Pandora FMS is thought to
execute as service and as a user SYSTEM. If you execute it with other user without privileges, then
it will be functions that will not work properly.

5.9.4. Pandora FMS for windows NT4
This agent is a port of the Unix agent (in perl) compiled with ActiveState DevKit Perl compiler. This
is a standalone EXE with all the tools it will need to run. It has the same features than the Unix
agent, but running on a NT4 box. This means can execute commands and get the output to produce
data for Pandora FMS.
Could be used on any Windows machine (NT4, Win95, Windows 20002008, and of course
Windows 7), could be useful on windows embedded systems without WMI core, which makes
standard Pandora FMS windows agent to do not run properly.

5.9.4.1. Installing the agent
Copy all contents on a directory of your choice, for example c:\pandora.
Edit pandora_agent.conf and set your parameters, including the log file and the temporal directory,
should be something like c:\pandora\temp and c:\pandora\log. MAKE SURE that directories exists
before trying to start Pandora agent.

5.9.4.2. Running the agent
This agent does not run as a service, so you need to install in the startup menu or start by hand. The
shortlink you create must have a parameter, which is where is the main Pandora FMS agent
directory, in this scenario is c:\pandora, so the command to start will be :
c:\pandora\pandora_agent.exe c:\pandora

5.9.4.3. Install as a service
srvany.exe tool is provided to do this. Is a microsoft resource kit tool to be able to use any .exe as a
service. Just read the documentation about how to use srvany (provided in this package).
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6 INITIAL CONFIGURATION AFTER
INSTALLING
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The order you should follow after installing is:
1. Create the database through the Pandora FMS web console installation wizard.
2. Modify the server configuration including the access credentials to the BBDD that have been
generated by the previous step.
3. Start server Arrancar servidor.
4. Start local agent (if it is required).
5. Go to the Pandora FMS for first time to start using Pandora FMS.

6.1. Console Initial Configuration
Assuming we are going to execute all components (Database, Console, Server and Agent) on the
same machine. If you have not done it already, then start the Mysql server and create an admin
password (root).
/etc/init.d/mysql start

Now create the password, for example "pandora123" for your MYSQL root user:
mysqladmin password pandora123

Then start the Apache server in your server:
/etc/init.d/apache2 start

Now you can get to your server IP address trough web to do the Pandora FMS postinstallation
trough web. This postinstallation serves to create the Pandora FMS database and to configure the
access credentials (user password, BD name) in the Pandora server to the DDBB established by the
user.
If your server IP is, for example,"192.168.5.54" put in your browser:
http://192.168.5.54/pandora_console/install.php

From now you only have to follow the following steps in order to create the Pandora FMS DDBB.
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Press next.
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This screen is used to verify that it has all software dependencies well installed.
Note: if you need to install some dependencies, it will be necessary to restart the web server in
order to recognise them.

Here it configures the access data to your MySQL server. You should entry the root password that
you created in the previous step. (pandora 1234 in the example).
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6.1.1. License Application
Pandora FMS Entperise version has a different license key associated to each instalation. To use
Enterprise features and remote updates of console is needed to introduce the license code in console
configuration section.

6.1.1.1. License on versions older than 4.0.2
For versions previous to 4.0.2 the license is use on remote updates of console. To introduce the
license in a installation of Pandora FMS with a version older than 4.0.2 you must follow these steps:
1. Go to Administration menu and inside Setup submenu, select Update Manager Settings.

2. In the screen will appear a form with all data required to connect to update server. You must
introduce the license code in the field Customer Key and click on button Update.

87

Console Initial Configuration

3. To ensure the license code was added sucessfully go to Operation menu and in Extesions
submenu, select Update Manager, a screen like the following will appear:

If you get a screen like below showing and error related to keygen, you must install it following the
section Installing the Keygen.

6.1.1.2. Licencia on versions 4.0.2 and higher
For versions 4.0.2 or higher Pandora FMS license are used to updates and also to ensure the user is
using Enterprise code properly. Because of that is important to have a valid license. To introduce
your license key in Pandora FMS 4.0.3 or higher follow these steps.
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1. Go to Setup menu inside Administration section.

2. In the screen will appear a form with all data required to connect to update server. Search
License information parameter and enter your license code.

3. To ensure the license code was added sucessfully go to Operation menu and in Extesions
submenu, select Update Manager, a screen like the following will appear:

If you get a screen like below showing and error related to keygen, you must install it following the
section Installing the Keygen.
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6.2. Server Initial and Basic Configuration
Pandora FMS has configured your Database and created a MySql user to have access to it. It has
created a random password for "pandora" user that should be the one used to modify the password
that is defined in th Pandora FMS server.
For this last step, you have to edit the file /etc/pandora/pandora_server.conf from your Pandora
installation and look for the line:
dbpass pandora

And replace "pandora" for the password that has been created by the wizard.?Once that it has done
it and it has also recorded the file it can start the Pandora FMS server in this way:
/etc/init.d/pandora_server start

It should give an start like this:
Pandora FMS Server 3.0-dev Build PS090915 Copyright (c) 2004-2009 ArticaST
This program is OpenSource, licensed under the terms of GPL License version 2.
You can download latest versions and documentation at http://www.pandorafms.org
[*] Backgrounding Pandora FMS Server process.
Pandora Server is now running with PID 2085

6.3. Initial and Basic Configuration of the Agent
You could start your machine local agent(it comes preconfigured to send data to the same machine
where it is run, through tentacle), to start to collect data automatically:
/etc/init.d/pandora_agent_daemon start

Now you can have access to your Pandora FMS WEB console through the URL:
http://x.x.x.x/pandora_console

Where x.x.x.x is the IP of the machine where you have installed the Pandora FMS console.
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7 UPGRADING FROM PREVIOUS VERSIONS
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7.1. Upgrading between minor releases
A minor version is for example, when you upgrade from 3.1 to 3.1.1, or for example, upgrading
from a 3.1rc1 to 3.1final or 3.1rc2.
Upgrade/migrate process from same major level version implies that that versions doesnt have any
change in it's internal Database schema. You will only upgrade the software, not the database
schema or data.
Update/migration between same major version is very easy, just replace your current setup with
new release, for example from 3.1RC1 to 3.1RC2.The steps to follow are:
1. Backup your database (only as precaution, should not be necessary).
2. Backup your configuration files:
/etc/pandora/pandora_server.conf
pandora_console/include/config.php at your apache web root directory.
/etc/pandora/pandora_agent.conf
Any custom files (map images, plugins)

3. Use the method you prefer to update: RPM, DEB or tarball/sources

7.1.1. Updating/Upgrading from RPM
First you should know if it's an update or a reinstall. For this, first check the package version that is
installed in your system:
rpm -q -a | grep pandora

If you have installed pandora's packages, they will be shown as a list of the package name and
version, e.g:
pandorafms_console-3.0.0-1

This means that you have the "pandorafms_console" package in version "3.0.01". If you want to
install the same version that you have already installed, you can "reinstall" writting the command:
rpm -i --force <nombre_paquete.rpm>

Sometimes "updates" of version with the same name and same number are releases (so they are
development corrections, etc). For this, you should have to reinstall, forcing the installation with
force.
If it is the same package, but from a high version, you can update it with this command:
rpm -U <nombre_paquete.rpm>
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To force an update of a version that you have already installed, same very similar to the
reinstallation, but that will keep your original files if they have been modified and the new version
will have the same version that the packages that you installed in first place, you can force the
update:
rpm -U --force <nombre_paquete.rpm>

Be specially careful before reinstalling or updating any package and do security copies of:
• /etc/pandora/pandora_server.conf: On Pandora FMS Server.
• /etc/pandora/pandora_agent.conf: on Pandora FMS Agents.
Remember that if you're using the Enterprise version, you must also upgrade the enterprise
packages, using the same method as explained here.

7.1.2. Using .deb packages
If you are using a Debian or Ubuntu, or another system that uses .deb packages, just install the new
packages. Debian package system will manage the uninstall of previous version and wild ask you to
conserve the old version.
dpkg -i package_names.deb.

If you have dependency problems, resolve it with:
apt-get install -f

Install new packages and replace the configuration files with your backup.
Remember that if you are using the enterprise version will also have to upgrade packages using the
enterprise .deb packages.

7.1.2.1. Pandora Agent Unix
When you update a Pandora Agent Unix, in the final part of installation the system ask for to
overwrite the plugins files. Please check if this plugins have a modifications for to avoid overwriting.

7.1.3. From Tarball / Sources
7.1.3.1. WEB Console
For Console, first decompress tarball file which contains Pandora FMS console to /tmp
cd /tmp
tar xvzf pandorafms_console_3.1xxxx.tar.gz

Automated way
In SUSE (Vmware image or CD Appliance):
cd /tmp
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cd pandora_console
./pandora_console_upgrade -p /srv/www/htdocs/pandora_console

Second parameter (in this example /srv/www/htdocs/pandora_console), is the path where Pandora
FMS console is already installed.
In Ubuntu/Debian
cd /tmp
cd pandora_console
./pandora_console_upgrade -p /var/www/pandora_console

Manual way
Untar the pandorafms console tarfile to /tmp/pandora_console.
/tmp/pandora_console to Pandora FMS current directory.

Copy

contents

of

In SUSE (Vmware image ór CD Appliance):
cp -R /tmp/pandora_console /srv/www/htdocs/
chown -R wwwrun:root /srv/www/htdocs/pandora_console

In Ubuntu/Debian:
cp -R /tmp/pandora_console /var/www/
chown -R www-data:root /var/www/pandora_console

You can safely delete temp files from /tmp/pandora_console
rm -Rf /tmp/pandora_console

Versión Enterprise (Manual only)
In order to upgrade the Enterprise version, the /enterprise directory and all its contents must be
copied to the root directory of Pandora FMS Web Console.

7.1.3.2. Server
For server, first decompress tarball file which contains Pandora FMS Server to /tmp
cd /tmp
tar xvzf pandorafms_server_3.1xxxx.tar.gz

Automated way
Proceed to do the upgrade using the upgrade script
cd pandora_server
./pandora_server_upgrade --upgrade
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Manual
This procedure will install new biraries and libraries, this doesnt update/upgrade the very
important Pandora FMS tools. You will need to copy them one by one.
cd pandora_server
perl Makefile.PL
make
make install

And delete temporal files if doesnt need anymore.
rm -Rf /tmp/pandora_server

Enterprise version
The process is very similar to previous server upgrade. Just decompress the tarball and execute this
as root:
perl Makefile.PL
make
make install

This should upgrade your Enterprise server.

7.1.3.3. Agent
Decompress tarball file
cd /tmp
tar xvzf pandorafms_unix_agent_3.1xxx.tar.gz

Run the installation tool that will install the agent as a whole, as well as tools and plugins that it
contains. This installer makes an automatic backup of your configuration files in/etc/pandora/
pandora_agent.conf.yyyymmdd. Just run the script and copy the contents of your backup
configuration file in /etc/pandora/pandora_agent.conf.
cd pandora_agent
./pandora_agent_installer --force-install
cp /etc/pandora/pandora_agent.conf.xxxxxxx /etc/pandora/pandora_agent.conf

And delete temporal files if doesnt need anymore.
rm -Rf /tmp/pandora_agent

Experts only: You can replace only the agent executable /usr/bin/pandora_agent or c:\program
files\pandora_agent\pandoraAgent.exe to update the agent. Before, stop the process / service to
replace the executable. This is useful for a quick upgrade.
Remember that in the "minor" version releases, there are no changes to the database schema, , so
it's enough to replace/upgrade the files as described above. "Major" versions, for example 3.0 to 3.1,
2.1 and 3.0, have changes in the database schema and will require a database conversion.
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See the documentation for more details.

7.2. Update a major version
This is the same process as with a minor version, but you will need to UPGRADE your database
schema and data. This process is described below.

7.2.1. Upgrade database schema (Major Version only)
IMPORTANT: Upgrading from 3.1 to 3.1.1 and from 3.1.X to 3.2 need specifics steps described
in two sections below
A major version is when upgrade from 2.x to 3.x or when migrate from 3.0 to 3.1 for example. A
3.1 to 3.1.1 is not a major version and doesnt need a database upgrade.
Major version upgrade/migration needs to do a database upgrade. The database upgrade works
from the command line interface. This upgrade convert all information, you should not lost
anything in the upgrade, but anyway, ALWAYS do a fullbackup first (not only database, also
code and configuration. Follow the steps for upgrade as described below.
Install your the packages for your new version of Pandora FMS (including the enterprise packages).
Needed files for doing the database upgrade are in that packages, you can found in
{PANDORA_CONSOLE}/extras directory and {PANDORA_CONSOLE}/enterprise/extras (enterprise
only).
{PANDORA_CONSOLE} is your Pandora FMS console directory containing the console code. In a
SUSE is /srv/www/htdocs/pandora_console, in a Debian/Ubuntu is /var/www/pandora_console. It
depends on system.
Go to the directory extras there is a file called pandoradb_migrate_vX.Y_to_vX.Z.sql. This file has all
the SQL code needed to convert your X.Y.x database in a X.Z database ready to be used with a X.Z
console and a X.Z server. The steps needed to make the conversion are:
1. First of all: ¡Make a backup of your current database!.
mysqldump -u root -p pandora > backup_pandora_X.Y.sql

2. Stop your Pandora FMS server and Web server:
/etc/init.d/pandora_server stop
/etc/init.d/apache stop

3. Apply the upgrade script to update your database. This will ask your pandora user password for
Mysql (you can check it in your current /etc/pandora/pandora_server.conf file. We assume that your
Pandora FMS database is called "pandora" and it's running on the same machine you're running this
command:
cd /srv/www/htdocs/pandora_console (or equivalent)
cat extras/pandoradb_migrate_vX.Y_to_vX.Z.sql | mysql -u pandora -p -D pandora

After a few minutes/seconds, the database is ready to work with the latest version of Pandora FMS.
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In case of any problem, the backup can be restored to go back to your previous version with this
command:
mysql -u root -p
> drop database pandora;
> create database pandora;
> use pandora;
> source backup_pandora_X.Y.sql

7.2.2. Enterprise DB schema
The process is almost the same. In the /enterprise/extras directory you have a file called
pandoradb_migrate_vX.Y_to_vX.Z.sql. Use this file like the OpenSource migration explained above:
cd /srv/www/htdocs/pandora_console (or equivalent)
cat enterprise/pandoradb_migrate_vX.Y_to_vX.Z.sql | mysql -u pandora -p -D pandora

7.2.3. Update from version 3.2.1 to 4.0
After update Console from Tarballs, DEB or RPM and access to Web console could appear the
following errors:
Notice: Undefined index: dbtype in /var/www/pandora_console/include/functions_db.php
on line 32
Notice: Undefined index: dbtype in /var/www/pandora_console
/include/functions_db.php on line 48
Notice: Undefined index: dbtype in /var/www/pandora_console/include/functions_db.php
on line 625

For
resolve
these
errors
just
<pandora_console_path>/include/config.php:

add

the

following

line

in

file

$config["dbtype"]="mysql";

If you have the SSH extension in your setup please delete it, it's old and will not run with 4.0 (and it
will make console to crash).
rm -Rf < your pandora console root directory>/extensions/ssh_console*

Some 3.2 setups give problems in an autoincrement table, if it's your case, insert this in the SQL (by
using the SQL manager in the console, or using mysql command line client):
ALTER TABLE tsesion AUTO_INCREMENT = 1;

After upgrade the server, a new servers will be available for high speed monitoring with ICMP and
SNMP, for using that you need special requirements. Please read it carefully and disable it by
default configuring following lines in your pandora_sever.conf:
snmpserver 0
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icmpserver 0

7.2.4. Upgrade database schema only from 3.1 to 3.1.1
After install all components of Pandora FMS for 3.1.1, you must not run the Pandora FMS services.
Only for this new version of Pandora FMS you have to run a encoder script that encodes all sensible
data in you database to preserve html entities.
At this point you have done the installation of Pandora FMS console and Pandora FMS server, so
you only have to run the encoder script.
To run the script only go to util folder into your Pandora FMS server path and run
pandora_recode_db.pl, for example:
cd /usr/share/pandora_server/util (by default server path is
/usr/share/pandora_server)
perl pandora_recode_db.pl

After that, you can start all the services and run Pandora FMS as always.

7.2.5. Upgrade database schema only from 3.1.X to 3.2
After install all components of Pandora FMS for 3.2, you must not run the Pandora FMS services.
Only for this new version of Pandora FMS you have to run a encoder script that encodes all sensible
data in you database to preserve html entities.
At this point you have done the installation of Pandora FMS console and Pandora FMS server also
you had to executed the database migration script as described in section "Upgrade database
schema (Major Version only)". So you only have to run the encoder script.
To run the script only go to util folder into your Pandora FMS server path and run
pandora_recode_db.pl, for example:
cd /usr/share/pandora_server/util (by default server path is
/usr/share/pandora_server)
perl pandora_recode_db.pl

After that, you can start all the services and run Pandora FMS as always.
To avoid problems with unlinked modules (Enterprise only):
UPDATE tagente_modulo SET policy_linked = 1 WHERE id_policy_module <> 0;

7.3. Problems upgrading from a previous version (Perl Libraries)
Sometimes upgrade puts Pandora FMS libraries on different places where are installed old version,
so after a upgrade you have two different versions of Pandora FMS libraries and you cannot know
exactly what version will be used, if the old one or the new one. Best solution here is locate the
libraries, delete all of them, and reinstall/upgrade. For that ejecute:

98

Problems upgrading from a previous version (Perl Libraries)

find /usr -name "Core.pm"

This will show you a few lines like:
/usr/lib/perl5/site_perl/5.10.0/PandoraFMS/Core.pm
/usr/lib/perl5/vendor_perl/5.10.0/Bootloader/Core.pm

Pandora FMS libraries are placed on /usr/lib/perl5/site_perl/5.10.0/PandoraFMS/. Delete it safely
and reinstall again (from packages or tarball sources).
rm -Rf /usr/lib/perl5/site_perl/5.10.0/PandoraFMS/

Perl version and exact location may differ in each linux distro, so you will need to locate prior
deleting the directory written here.

7.4. Problems upgrading from a previous version (Database)
If you find a problem is probably because you are upgrading a 2.x version that comes from a version
1.x, or because it has made manual changes to the DB scheme. If you get a message like this:
ERROR 1005 (HY000) at line 101: Can't create table
'./pandora/talert_template_modules.frm' (errno: 150)

This is due because a problem in MySQL because some fields has no the expected type.
id_agente_modulo field in 2.1 should have bigint(10) type. If you have migrated from a 1.x before
you will have this problem. Before running the migration tool to 3.0, enter this command in the
mysql console:
ALTER TABLE tagente_modulo MODIFY id_agente_modulo bigint(10) unsigned NOT NULL
auto_increment;

And try to run again the upgrade tool. Please remember that you need InnoDB support for your
MySQL database server.
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8 SECURITY UPGRADES / PATCHES
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A security upgrade or security patch is a small patch usually for Console, but you can also have a
security patch for server. In both cases the source package to "patch" the problem can be presented
in several formats:

8.1. From distro packages
A package (RPM or DEB): just install the package:
Ubuntu/Debian
dpkg -i <package_name>

SUSE/RedHat/CentOS/Fedora
rpm -u <package_name>

8.2. From tarball or SVN
A package in tarball/Source format. This implies you know a bit more about the internals of
Pandora FMS, that means, you know "where" are the files you will replace. Using a tarball is just a
way to say, you have the source files and you will replace that for your installed Pandora FMS files.
In Console:
All
files
should
be
put
on
/var/www/pandora_console
(Ubuntu/debian),
/srv/www/htdocs/pandora_console (SUSE), or other directories, depending on distros.
In Server:
It depends on your version and install method, but the files you will need to replace should be
searched before:
• Libraries:
find
/usr
name
"PluginServer.pm",
usually
should
/usr/lib/perl5/PandoraFMS
• Binaries: find /usr name "pandora_server", usually should be at /usr/bin

be

at

8.2.1. Example of manual Console update
For example, if you have a tarball called pandorafms_console_3.1_securityfix_may2011.tar.gz, do the
following steps:
(Supposing you're on a standard SUSE system)
cd /tmp
tar xvzf /home/youruser/download/pandorafms_console_3.1_securityfix_may2011.tar.gz
cd pandora_console
cp -R /srv/www/htdocs/pandora_console
sudo chown -R wwwrun /srv/www/htdocs/pandora_console
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8.2.2. Example of manual Server update
For example, if you have a tarball called pandorafms_server_3.1_securityfix_may2011.tar.gz, do the
following steps:
(Supposing you're on a standard SUSE system)
cd /tmp
tar xvzf /home/youruser/download/pandorafms_server_3.1_securityfix_may2011.tar.gz
cd pandora_server

(Locate where are your Pandora library files)
sudo find /usr -name "NetworkServer.pm"
.
.
/usr/lib/perl5/site_perl/5.12.1/PandoraFMS/NetworkServer.pm

Whoah, that's not the default installation dir (because in this same it's installed from the sources,
not from RPM). We know now the location of Pandora FMS libraries, at
/usr/lib/perl5/site_perl/5.12.1/PandoraFMS/ directory, so copy all updated libraries overwriting
the old ones (this step is the same but with different directory names if you have your system
installed from packages instead from sources):
sudo cp -R lib/PandoraFMS/*.pm /usr/lib/perl5/site_perl/5.12.1/PandoraFMS/

Don't forget to copy also the binaries and tools
sudo cp -R bin/* /usr/bin

(Forget the warning message about skipping copy for PandoraFMS directory, it's normal).
sudo cp -R util/* /usr/share/pandora_server/
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9 CONSOLE UPDATES USING UPDATE
MANAGER
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9.1. OpenSource Updates
Since Pandora FMS 4.0.2 you can update, using OpenSource version, from weekly semiautomatic
updates. This feature is based on a improvement of Update Manager system, previously only
available with Enterprise version, now you can check online if there is a new update and download
and update your console automatically under request.
This feature has the following characteristics:
• The server which has Pandora FMS console must be connected to Internet.
• Update Manager will contact our server for new updates (on Sourceforge). Send anonymous
statistical data about the use of Pandora FMS (# of agents).
• An update from Sourceforge will be downloaded from weekly updates folder.
• The updates are incremental and they have the content of the whole console, so this process
could take a lot of time (the packages weight is about 25 MB).
• Updates are automatic: they are not reviewed by the team, in the 99% of cases no problem is
expected but we could not guarantee nothing if a problem occurs.
• The updates are only for console not for agents and server.

9.1.1. Console updating process
It's very easy. Just go to Extensions > Update Manager. The main screen allow you to check for
new updates available to be installed, also you can see the list with previous updates installed (in
this picture there is no previous updates yet). Click on install.

Click on install button.

To use Update Manager your server which hosts Pandora console must be connected to
Internet. By default Pandora will use WGET to download the packages (it's faster), it's
possible to use CURL method (you can change it in Pandora configuration) but it's
slower
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When the packages was downloaded and installed, you will return to main page which will be like
this. It shows the updates installed and a message saying there is no more updates available.
Congratulations, you have updated to a new version!.
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9.2. Enterprise updates
Unlike Open updates, Enterprise updates have several additional features:
• 100% tested by development team, so you can enjoy updates the same day (even a few
hours later) that an incident was open.
• Specific updates (incremental) which allow you to update only the part that is outdated,
without downloading heavy packages.
• Offline updates are allowed, downloading packages from support page for Pandora FMS
installation which are not connected to Internet (due to security reasons).
To use Enterprise version of Update Manager first of all you must configured your serial number
and the kaygen installed
Para poder usar Update Manager en la versión enterprise, primero ha debido configurar
correctamente su nº de serie y tener instalado el "keygen", y configurado éste adecuadamente, en la
pantalla de setup, tal y como se muestra aquí:

From Operation>Extensions>Open Update Manager, you can access to Update Manager. If you
have Enterprise versions installed you can use this interface, if not Open version will be displayed.
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In this page you can see the current version number of Pandora FMS and will notify you for new
updates available.
To update to a new version, click on "Update" button.
You can mark the checkbox "Overwrite local changes" which will overwrite any existing local
modification of the files.

9.2.1. "Offline" updates
You can download "offline" updates of Pandora which are packages with .OUM extension. To do
that go to Pandora FMS official support page and download .OUM files which will be like this:
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Upload it to the console using this control:

The update will be applied automatically.

9.3. PHP engine additional configuration to operate with Update Manager
To ensure Open Update Manager is executing properly it needs more memory than the amount
assigned by default. To assign more memory to PHP execution you must edit the php.ini file and set
the reserved memory to at least 64M.
The line is:
memory_limit = 64M

; Maximum amount of memory a script may consume (16MB)

Commonly, on Debian/Ubuntu systems the file is located in directory /etc/php5/apache2.
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10 PANDORA FMS INTERFACE
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10.1. Introduction
In this section we are going to provide you with the Pandora FMS interface base menus, and also
with all icons and required features to start to learn how to use Pandora FMS.

10.2. Pandora FMS start session screen
In the following image the Pandora FMS start session screen that is shown by default:

On it the Pandora FMS version number and build is shown in the lower right corner. The build nº
can be very useful to identify the date of the console version that is being executed, it translates to
(YEARMONTHDAY).
On the right side are the text entry boxes for the user and also their password with the session start
button (login).
Once the right credentials to start are introduced, the defaults are :
• User: admin.
• Password: pandora
In a predefined way the console will show the Pandora FMS main welcome page. Pandora FMS start
session screen can be customized. This will be explained in the Customized welcome screen
section.
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10.3. Pandora FMS Main Page
The Pandora FMS main page shows basic information about the system state and the number of
checks that it does.
Next, the Pandora FMS main screen is shown:

The static elements that do not change in different screensof the interface are:
•
•
•
•

Operation menu
Administration menu
Defined links
Header

The dynamic elementsthat change in different screens are:
• Header information:
• User information, pending messages, system notifications, etc. (this will be explained in the
subsection header below)
• Site news
• Web console last activity
• General basic information
• Checking main view in Pandora FMS
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10.3.1. Pandora FMS Customized Page
In Operation > Edit my user, Pandora FMS main page can be personalized.

Note: Shortcut bar functionality is implemented in Pandora 5.0
Available options:
•
•
•
•
•
•
•
•

Default. Pandora FMS main page by default.
Dashboard. You can choose a user dashboard.
Visual console. You can choose a user visual console.
Event list.
Group view.
Tactical view.
Alert detail.
Other. Users can customize the home page. By default, it will display Default view. Example:
Select \'Other\' and type sec=estado&sec2=operation/agentes/estado_agente to show agent
detail view.

10.3.2. The Operation Menu
The Operation menu allows to visualize all checking done by Pandora FMS agents, the visual maps,
the network maps, the server state, the inventory, see and manage the incidents (if you have
enough permissions), see the users, see the SNMP console, see the messages and use the extensions.
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In any submenu from the Operation menu could be other elements that will be displayed by
selecting the menu:

Any of these elements link to other pages with information. All of them will be explained in great
detail in the chapters about Operation with Pandora FMS.

10.3.3. The Administration Menu
The Administration menu allows users to see and manage the checking that Pandora FMS agents
do. It also allows to visualize the modules and components of these checks, the alerts that these
modules and agents can throw and how these alerts work, the existing policies, the users. the SNMP
console, the reports, the user's profiles, the Pandora FMS servers and their assigned tasks, the
system audit register. the Pandora FMS web console, the database maintenance and the console
extensions.
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In any submenu from the Administration menu could be other elements that will be displayed when
selecting the menu:

Any of these elements are links to pages with information. All of them will be explained in detail in
the Operation and management with Pandora FMS chapters.

10.3.4. Links Menu
The link menu just shows a link to default sites. These could be added, modified or deleted from the
Pandora FMS administration menu. These links allow to link Pandora FMS with other WEB
applications from its organization and make that Pandora FMS become a nuclear management
point.
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10.3.5. The Header
Pandora FMS header offers several quick links or direct access to important features of the system,
and also a search bar:

From left to right and from top to down, the header gives:
• The user who is connected. A direct link to his user page( in brackets).
• If the user has pending messages to read then a card will be shown and when you click it
then a modal window with the current messages will be shown.
• If there are pending system advises an alert icon will be shown, if you click it then a modal
window will be displayed with the current system advised. Between this information you can
find Update manager updates, system security problems or "by default" values notifications
(for example default console password).

A button for closing session.
Link to contextual general help of Pandora FMS.
Link to the system state, that shows the Pandora FMS servers state.
The autorefresh button that apart from updating the screen could be configured to auto
refresh in a chosen time interval. This allows that in any page you could define that it be
refreshed every X time, doing this the session does not get lost and it shows the updated
data.
• The search bar that allows to search in several elements: Agents, reports, alerts, maps,
combined graphs and/or users in Pandora FMS database.
• The link to the system event viewer. The link to the system state also notifies when a service
is down, changing the icon and showing how many services are down.
•
•
•
•
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By Pressing on the link, this goes straight to the servers state, informing of many details about
them:

The autorefresh button allows to update the page by pressing on it or also selecting an update
frequency:

Once this has been selected, the remaining time until the next update will be shown next to the link
name:

The search tool allows to look for entries in maps, reports, graphs, alerts, users and agents. The
information is shown classified with flaps for each kind of data, the agent flap will be selected in a
predetermined way:
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The direct link to events is the same as the one that the Operation menu gives. This shows events in
the system and allows their management if there are enough permissions. The event management
will be explained in the chapter " Management of the application".

10.4. Icons in Pandora FMS Interface
In Pandora FMS there are several icons next to text, with other icons, by themselves. In this section
we will explain the most important ones.

10.4.1. Help on line icon
The help on line icon gives a general help on the field it comes with or in the application form or
page where it is. It opens a pop up window (you should have the pop up windows activated in the
browser). It will give you full information. To show this help you have to click on the icon.
The icon is an interrogation mark on blue background and round shape:

10.4.2. Suggestion/Advise Icon
The suggestion, advise or contextual help icon gives some help on the field it comes with. This is
shown by clicking on the icon.
The icon is a yellow star:
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10.4.3. Management Icon
The management icon comes with some files of some tables and it represents a direct link to the
element configuration. To have access to the page that it links, you should click it.
The icon is a tool with a yellow handle:

10.4.4. Full Screen Icon
It is usually shown next to the title of the pages that has it and it represents the possibility of the
page to be shown as full screen. To use this functionality you must click on the icon.
The icon is a square with four arrows, one in each corner.

10.4.5. Magic Wand Icon (wizard)
The magic wand icon shows that the current functionality will be useful to apply in a easy way
(with an assistant) a large amount of items with a unique action. For example, there are wizards in
the reporting section (Enterprise version) that allow to create report items for a large number of
modules with one click. Also in the Visual console wizard it can be useful to create a lot of items in
a easy way.
The magic wand icon is:

10.4.6. Remote Configuration Edit Icon
There is a configuration option for the Pandora FMS software agents that allows to edit its
configuration remotely from the console ( in the Enterprise version). This option comes in two
different pages. The first one is the agent list in the management of them. You can have access to it
through Administration > Manage agents:

The R column shows if you press the icon on it, that the software agent could be configured in a
remote way from the console.
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The option is also shown if you try to edit the agent features. After pressing on the edit link below
its name:

In the following page, the agent details will be shown, and next to the name box, the agent remote
configuration edit icon will appear:

10.4.7. Update Icon (forced)
Pandora FMS remote checking has an update interval, but this could be forced by pressing on a
button. If it is forced, then the module will be updated, this interval will start to count from zero.

10.4.8. Refresh Icon (after a forced update action)
Once the forced update icon has been pressed it will change to show that it has been activated.

It will return to his usual state once the checking has been updated.

119

Icons in Pandora FMS Interface

10.4.9. Alternative Texts in the icons/images when putting the mouse over
Almost all Pandora FMS images have an alternative text that is shown when you put the mouse
pointer over them.In this way you could obtain alternative textual information as well as the
information that the images offer.

10.5. Images in Pandora FMS
The images in Pandora FMS could be graphs generated by the Pandora FMS standard graph engine
or Flash graphs generated by the Flash engine. These can be defined by the administrator in the
system visual configuration.
The current graphs(statics) give less information as they aren't interactive and don't show any text
under the mouse pointer. The flash graphs can't be used in the reports.

But the Flash graphs give this information
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When there isn't data to show in a graph, Pandora FMS shows an error message in the image:

10.6. Data missing for agent's data lists
When the agent has no data to show, it gives a warning message:

The above is an example of an agent without alerts.

10.7. States and possible values of agents, modules and groups
An agent has data, and this data could be in several states:
•
•
•
•
•

Right: green color
Warning/Notice: yellow color
Critical: red color
Unknown: grey color, with the information of the last contact in red.
Not started: it couldn't be seen. They only appear with blue color in management views.

This would be a data view of one agent, that in Pandora FMS is called modules. In it is shown the
module name, its state (a colored box) and its numeric or alphanumeric value.
Data view for one agent
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There is also the detailed agent view, this summarizes in a quick way the agent state " as a whole"
and also the summarized state of the modules. In this view we can see several agents in different
states:
Agent view

In this view the agent that is called "Artica_Sancho" has a configured module and a module in a
critical state. The agent, for having at least one module in a critical state is visualized as a red box.
The information of the agents, as two "1" separated by ":" shows a defined module and a module in
a critical state ( in dark red).
The "Sauron" agent has 7 modules and the 7 are in "unknown state ", represented as a 7 in light
grey color. As it has all elements at "unknown state", it is visualized in purple color.
The "SAP XIQ [QUALITY2]" agent has 11 defined modules, 9 in state OK, 1 in critical state. For this
reason it visualizes "11 : 9 : 1 : 1",in black, green, yellow and red colors, respectively. The agent is
visualized with a red box, because there is at least one element (module) in a critical state.
The "SAP_XID [DEVELOPMENT2]" agent, is similar to the one mentioned before, but without any
elements in a critical state, so the visualized colour is yellow as it has one element in warning state.
The "global" visualization of the agent state depends on the most critical state of the module group
that it contains. It will only be green if there are no elements in a Critical, Warning or Unknown
state.
The "SAMSAGAN" agent, for example, has 10 modules and all of them are in correct state
Group view
As before, the group view summarizes the status of all agents for each group.
In this group view we can see the following status:
•
•
•
•
•

Right: (green color) All agents are right.
Warning/Notice: (yellow color) At least one agent of this group has warning status.
Critical: (red color) At least one agent has critical status.
Unknown: (grey color) All agents of this group has unknown status.
Without modules: (white color) When the agents of the group don't have modules or they
are not initialized.

Module view
This view shows list with all modules of all agents. The list shows the modules status with the same
colors as above.
This view is very useful to compere information of a module between different agents, and has a lot
of filtering options.
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11 PANDORA FMS CONFIGURATION
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Pandora FMS has three basic components that should be configured for a correct operation. The
two first ones are the server and the web console, that should interact between them and the data
base to could introduce, process and show the stored data. There are also the software agents that
send the data to the Pandora FMS server.
In this chapter we are going to explain the configuration files of the three elements and also other
elements that are important for a correct performance of the application components.

11.1. Server
Pandora FMS server has a configuration file that allows to adjust several application parameters to
obtain an excellent performace. The configuration file pandora_server.conf is located in a
predetermined way at directorio /etc/pandora/.

11.1.1. Configuration File Elements
Pandora FMS configuration file is a UNIX standard plain text where the variables that aren't used or
the comments are preceded by a "#" character
Next we are going to explain all the configuration parameters.

11.1.1.1. servername
Pandora FMS server name. If it is commented, then we should use the name of the equipment or
"host". Please do not change the name of the server after executing it first time because all
references goes linked to the name (remote agent modules, and other information). If you change
it, you should reassign the server to all your agents.

11.1.1.2. incomingdir
XML data packages Incoming Directory. By default is /var/spool/pandora/data_in/. You can
improve performance by setting up a RAM disk or fast disk here.

11.1.1.3. log_file
Pandora FMS record file (log). By default is /var/log/pandora/pandora_server.log. This is the main
logfile, very important for debuggin.

11.1.1.4. snmp_logfile
Logfile of SNMP console of Pandora FMS. By default is /var/log/pandora/pandora_snmptrap.log.
This is a log file with SNMP traps received BEFORE Pandora FMS server process it, you should not
touch or edit this file.

11.1.1.5. errorlog_file
Pandora FMS error registry file (log). By default is /var/log/pandora/pandora_server.error. This
logfile stores all noncontrolled errors or non captured output from tools executed by the server,
also important to find problems and debugging.
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11.1.1.6. dbname
Name of database the server will connect to. By default is pandora.

11.1.1.7. dbuser
Username used in the Pandora database connection. By default is "pandora".

11.1.1.8. dbengine
Engine running the database (oracle, postgres or mysql). Mysql by default.

11.1.1.9. dbpass
Password for the connection against Pandora FMS Database

11.1.1.10. dbhost
Ip address or equipment name that host the Pandora FMS database. In reduced installations it is
usually the same equipment where the server is, that is localhost.

11.1.1.11. dbport
(Optional) Used to define a different port in your Database setup.

11.1.1.12. daemon
Shows if the Pandora server is executed as demon or not. If the server is launched with the option –
D, then it is also executed as demon.

11.1.1.13. verbosity
Detail level for the server and error messages, the register or log files. 0 is the predetermined one, 1
is the detailed, 2 is debugging, 310 noisy. When you have any problem with Pandora FMS put this
value to 10 to get the maximun detail. High values here (like 10) are not intended to use in
production because they have a great performance impact.

11.1.1.14. master
1 Say that is a master server, 0 that is an slave server that is part of a multiple server configuration
(for HA environment, go to "HA" documentation chapter for more information).

11.1.1.15. snmpconsole
1 Shows that the SNMP traps reception console is activated in the configuration.0 that it is not. The
console depends on snmptrapd UNIX service. Before starting Pandora FMS server, please check
snmptrapd process IS NOT running in your server.

11.1.1.16. networkserver
1 Shows that Pandora FMS network server is activated in the configuration. 0 that it is not.
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11.1.1.17. dataserver
1 Shows that Pandora FMS data server is activated in the configuration. 0 that it is not. This server
process the XML files coming from the agents, but do more tasks, so you should have this server
always running in your system.

11.1.1.18. reconserver
1 Shows that Pandora FMS network recon server is activated in the configuration. 0 that it is not. If
you don't want to use the reconserver, it's better to disable it.

11.1.1.19. pluginserver
1 Shows that Pandora FMS complement server is activated in the configuration.0 that it is not.

11.1.1.20. predictionserver
1 Shows that Pandora FMS prediction server is activated in the configuration.0 that it is not .

11.1.1.21. wmiserver
1 Shows that the Pandora FMS server of WMI is activated in the configuration.0 that it is not .

11.1.1.22. inventoryserver
(Pandora FMS Enterprise only)
1 Shows that Pandora FMS remote inventory server is activated in the configuration.0 that it is not.
The inventory data sent by the agents are processed with the data server and there is no need to
activate the remote inventory server.

11.1.1.23. exportserver
(Pandora FMS Enterprise only)
1 Shows that the Pandora FMS export server is activated in the configuration.0 that it is not.

11.1.1.24. webserver
(Pandora FMS Enterprise only)
1 To activate the checking WEB(webserver or also known as Goliat Server).0 that it is not.

11.1.1.25. eventserver
(Pandora FMS Enterprise only)
Enables (1) or disables (0) the event correlation server (1 by default).

11.1.1.26. icmpserver
(Pandora FMS Enterprise only)
Enables (1) or disables (0) the Enterprise ICMP server (0 by default). The Enterprise ICMP server
uses Nmap to perform block ICMP requests. The XML output of older versions (5.0 or previous) of
Nmap does not report roundtrip time.
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If all your ICMP latency modules return 0, set this configuration variable to 0.

11.1.1.27. snmpserver
(Pandora FMS Enterprise only)
Enables (1) or disables (0) the Enterprise SNMP server (0 by default). The Enterprise SNMP server
uses an external utility called braa to perform block SNMP queries. Modules that can't be processed
by braa will be marked as notinitialized and will be handled by the Network server. If you
experience additional problems with braa simply set this configuration variable to 0.

11.1.1.28. network_timeout
Is the timeout in seconds for the network server connections on network ICMP modules. Default
value is 2 seconds. If you are doing remote checks on WAN networks, you probably should increase
this value to avoid false results.

11.1.1.29. server_keepalive
Time before classify the server as down. In seconds. By default its value is 45.

11.1.1.30. server_threshold
The number of seconds of the main loop, in seconds. By default its value is 5. This is a very
important configuration token because it defines how many times Pandora FMS search in database
or disk for new data to process. From 5 to 10 is a good value for most cases, minimum value is 1,
and if you set to 1, system CPU will be very high. You can set 1 on specific situations like, when
your server has been down for a while and you need to process the pending XML files and Network
modules as quick as system can. Set this to 1, wait to be finish processing all pending
modules/XML, and set again to 5  15. This value, used in conjuntion with *server*_theads and
max_queue_files are used to adjust the performance of your server.

11.1.1.31. network_threads
Number of threads for the network server. Shows how many checks can be done at the same time,
but as it increases it needs much more processing capacity. Its predetermined value is 5. Do not use
more than 20  25 threads or the system could get inestable or have poor performance.

11.1.1.32. icmp_checks
Defines the pings number to each icmp_proc kind of module. At least one of these ckecks must give
back 1 to the module could be classified as correct. Its predetermined value is 1. If you set 5 here,
and the first ping it's OK, the other 4 are skipped.

11.1.1.33. tcp_checks
Number of TCP reattempts if the first one fails. The predetermined value is 1.

11.1.1.34. tcp_timeout
Specific timeout for TCP connexions. The predetermined value is 30.
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11.1.1.35. snmp_checks
Number of SNMP reattempts if the first one fails. The predetermined value is 1.

11.1.1.36. snmp_timeout
Specific expiration time for the SNMP connexions. The predetermined value is 3.

11.1.1.37. snmp_proc_deadresponse
Gives back DOWN if it is not possible to connect with a boolean SNMP module (proc) or if it gets
NULL.If it is set to 0 then it should be ignored.

11.1.1.38. plugin_threads
Number of threads for the complement server. Shows how many checks could be done at the same
time.Its predetermined value is 3.

11.1.1.39. plugin_timeout
Timeout for the checks with complements.After this time the module state will be shown as
unknown. Its predetermined value is 5. Probably you need to raise this value. If a plugin has a
higher value, the value used is this, instead the plugin value.

11.1.1.40. wmi_timeout
WMI checks timeout.After this time the module state will be shown as unknown. Its predetermined
value is 10.

11.1.1.41. wmi_threads
Number of threads for the WMI server. It shows how many checks could be done at the same time.
Its predetermined value is 2.

11.1.1.42. prediction_threads
Number of threads for the prediction server.

11.1.1.43. recon_threads
Number of threads for the network recon server. Shows how many checks could be done at the
same time. Its predetermined value is 2.

11.1.1.44. dataserver_threads
Number of threads for the dataserver. Shows how many threads of the XML file processor are at the
same time. Its predetermined value is 2.

11.1.1.45. inventory_threads
(Pandora FMS Enterprise only)
Number of threads assigned to the remote inventory server. It shows how many simultaneous
threads are assigned to this component.
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11.1.1.46. export_threads
(Pandora FMS Enterprise only)
Number of threads assigned to the export server. It shows how many simultaneous threads are
assigned to this component.

11.1.1.47. web_threads
(Pandora FMS Enterprise only)
Number of threads assigned to the WEB test server. It shows how many simultaneous threads are
assigned to his component.

11.1.1.48. mta_address
Mail Server IP address (Mail Transfer Agent)

11.1.1.49. mta_port
Mail server port (by default 25)

11.1.1.50. mta_user
Mail server user (if necessary for use with authentication)

11.1.1.51. mta_pass
Password for the mail server (if necessary with authentication)

11.1.1.52. mta_auth
Mail server authentication system( if necessary; the valid values are: LOGIN PLAIN CRAMMD5
DIGESTMD)

11.1.1.53. mta_from
Mail address from the mails will be send. In a predetermined way is pandora@localhost.

11.1.1.54. xprobe2
If it is given, is used to discover the operating system of the remote systems assigned to the
agents,when a recon network task is launched. The predetermined path is /usr/bin/xprobe2. If is
not provided, NMAP will be used instead, but it's much more imprecise.

11.1.1.55. snmpget
Needed for SNMP checks. In a predetermined way it is at /usr/bin/snmpget. It refers to the location
for the snmp standard client of the system. It is recommended not to touch it unless you know
exactly what are you doing.

11.1.1.56. nmap
Needed for the recon server.In a predetermined way is at /usr/bin/nmap.It is recommended not to
touch it unless you know exactly what are you doing.
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11.1.1.57. plugin_exec
Shows the absolute path to the program that execute the plugins in a controlled way in time. By
default /usr/bin/timeout, and it is recommend not to touch unless you know exactly what are you
doing. If your base system doesn't have timeout, you should change to use /usr/bin/pandora_exec
instead.

11.1.1.58. autocreate_group
Numeric id of the predetermined group for the new agents created with the data server through the
datafile reception.The default value is 2.

11.1.1.59. autocreate
If you put 1 then agents will be selfcreated when XML files are received for which there would be
no agents. Is it is set to 0 they will not be created and you will need to create an agent first (case
sensitive!).

11.1.1.60. max_log_size
Maximum size of Pandora FMS register file, in bytes. When this size is got, then the file should be
moved topandora_server.log.old and go on working on the original one. The predetermined size is
65536Bytes.

11.1.1.61. max_queue_files
Maximum number of XML datafiles from the directory that contains them will be not read. To avoid
overload the system. Although the directory don't be read it doesn't means that the files are not read
and that they continue being processed. The default value is 250.

11.1.1.62. use_xml_timestamp
Deactivated by default. If it is activated (value 1) use the XMLfile timestamp, generated with time
and date of the server in the moment of the reception of it, instead of the timestamp that the XML
file has internally and that was generated by the server. This is useful to deactivate globally the use
of the dates generated by the agents and use the date/hour (timestamp)of the server as a reference
for all data. In systems with problems with synchronization, systems with wrong date/hour, it's an
option that could solve almost all problems.

11.1.1.63. auto_restart
Deactivated by default. If it is activated (value in seconds), it forces the server to do an internal
restart each X seconds (1 day = 86400). This option is useful if you observe degradation or lost of
control of any thread or specific server of Pandora FMS.

11.1.1.64. restart
By default 0. If set to 1 the server will restart on critical errors after a given number of seconds.

11.1.1.65. restart_delay
By default 60. Number of seconds the server will wait before restarting after a critical error if
restart is enabled.
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11.1.1.66. self_monitoring
The server has a self monitoring flag, that creates a virtual agent in the server that monitors most of
the important parameters of a Pandora FMS serve. To activate it the parameter self_monitoring must
be set to 1.

11.1.1.67. update_parent
Also the sever has now (v3.1) a parameter to define if the agent can update it's parent by sending
the parent name on the XML, if this parameter is not defined or is 0 the agent information is
ignored, if not, when the server receives an XML with parent_name attribute, searches for an agent
with this name and if it's found updates the parent of the agent from the XML.

11.1.1.68. icmp_threads
(Pandora FMS Enterprise only)
Number of threads for the ICMP Enteprise server (3 by default).

11.1.1.69. snmp_threads
(Pandora FMS Enterprise only)
Number of threads for the Enteprise SNMP server (3 by default).

11.1.1.70. block_size
(Pandora FMS Enterprise only)
Block size for block producer/consumer servers, that is, the number of modules per block (15 by
default).

11.1.1.71. braa
(Pandora FMS Enterprise only)
Location of the braa binary needed by the Enterprise ICMP server (/usr/bin/braa by default).

11.1.1.72. event_window
(Pandora FMS Enterprise only)
Event window: It's the time window (in seconds) inside which the event server will look for events.
For example, if set to 3600 the event server will check events generated in the last hour.

11.1.1.73. wmi_client
Default wmi client used (wmic by default). You should not change this.

11.1.1.74. activate_gis
Flag to activate GIS (positional information for agents and maps) by default it is desactivated

11.1.1.75. location_error
Radius of error in meters to consider two gis locations as the same location.
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11.1.1.76. recon_reverse_geolocation_mode
Recon reverse geolocation mode [disabled, sql, file]
• disabled The recon task doesn't try to geolocate the ip discovered.
• sql The recon task trys to query the SQL database to geolocate the ip discovered
• file The recon task trys to find the geolocation information of the ip discovered in the file
indicated in the recon_reverse_geolocation_file parameter

11.1.1.77. recon_reverse_geolocation_file
Recon reverse geolocation file. This is the database with the reverse geolocation information using
MaxMind GPL GeoLiteCity.dat format).

11.1.1.78. recon_location_scatter_radius
Radius (in meters) of the circle in where the agents will be place randomly when finded by a recon
task. Center of the circle is guessed by geolocating the IP.

11.1.1.79. google_maps_description
This enable realtime reverse geocoding using Google Maps public api. This requires internet access,
and could have performance penalties processing GIS information due the connetion needed to
resolve all GIS input. NOTE: If you dont pay the service to google, they will ban your IP in a few
days.

11.1.1.80. openstreetmaps_description
This enable realtime reverse geocoding using Openstreet Maps public api. This requires internet
access, and could have performance penalties processing GIS information due the connetion needed
to resolve all GIS input. You can alter the code to use a local (your own) openstreet maps server.

11.1.2. Snmptrapd configuration
Pandora FMS SNMP Console uses snmptrapd to grab SNMP traps. Snmptrapd is a standard tool,
present on almost all UNIX systems, to grab traps and write a logfile. Pandora FMS configures
snmptrapd to write a custom logfile and reads it every x seconds, executing alerts if defined.
Previously, snmptrapd will accept all incoming notifications, and log them automatically (even if no
explicit configuration is provided). Starting with 5.3 release, access control checks will be applied to
incoming notifications.
If snmptrapd is run without a suitable configuration file (or equivalent access control settings), then
such traps will not be processed.
Probably you will need to configure your snmptrapd using the file /etc/snmp/snmptrapd.conf. If
doesn't exist, check /var/log/pandora/pandora_snmp.log file for warnings or errors.
A basic snmptrapd.conf could be like:
authCommunity log public

If doesn't work on your linux distribution, please check your version syntax to enable the reception
of traps in your snmptrapd daemon with
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man snmptrapd.conf

11.1.3. Tentacle Configuration
By default, Pandora FMS software agents send the data packages to the server through the Tentacle
protocol (port 41121/tcp assigned by IANA [1]). The agent could also be reconfigured to it send
data through alternative ways: local transfer (NFS,SMB),SSH or FTP, etc. IF you want that they
send the data packages through Tentacle protocol, then we should have to configure a Tentacle
server where this data will be received. By default, when a Pandora FMS server is installed, a
Tentacle server is also installed in the same machine.
If it would be necessary to adjust some parameters of the Tentacle server configuration, then it
could be done modifying directly the script that launches the Tentacle Server daemon that is in:
/etc/init.d/tentacle_serverd

Next, there is a list of the different options for Tentacle Server configuration:
PANDORA_SERVER_PATH
Path to the entry directory of data. In a predetermined way is /var/spool/pandora/data_in
TENTACLE_DAEMON
Tentacle daemon. In a predetermined way is tentacle_server.
TENTACLE_PATH
Path to the Tentacle binary. In a predetermined way is /usr/bin.
TENTACLE_USER
User the Tentacle demon will be launched with. In a predetermined way is pandora.
TENTACLE_ADDR
Direction to listen the data packages. If you fix 0.0.0.0. it will be listened in all of them. In a
predetermined way it is listen in all directions, this is , its value is 0.0.0.0.
TENTACLE_PORT
Listening port for the packages reception. By default it's 41121 (official port assigned by IANA).
TENTACLE_EXT_OPTS
Additional options for executing the Tentacle server. Here you can setup Tentacle to use
authentication with certs (x509) and/or simmetric password in both sides.
Simple file transfer with password authentication (not secure):
Extra parameters in the tentacle server setup
-x password

Extra parameters in the client side (TENTACLE_EXT_OPTS)
-x password
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Secure file transfer without client certificate:
Extra parameters in the tentacle server setup
-e cert.pem -k key.pem

Secure file transfer with client certificate:
Extra parameters in the tentacle server setup
-e cert.pem -k key.pem -f cacert.pem

Extra parameters in the client side (TENTACLE_EXT_OPTS)
-e cert.pem -k key.pem

Secure file transfer with client certificate and password authentication:
Extra parameters in the tentacle server setup
-x password -e cert.pem -k key.pem -f cacert.pem

Extra parameters in the client side (TENTACLE_EXT_OPTS)
-x password -e cert.pem -k key.pem

11.2. WEB Console
Pandora FMS web console has a configuration file that usually is created and configured when it's
installed.If the installations is done through the DEB or RPM packages or from the Pandora FMS
installation CD, then it is configured in an automatic way.If it is installed in a manual way,with the
tarball
package.
It
could
be
configured
from
the
web
assistant
through
http://ip_instalacion_consola/pandora_console/install.php
The configuration file config.php is at the directory/include/ in the console installation directory,
that
could
be
/var/www/pandora_console
(Debian,
Ubuntu)
or
/srv/www/htdocs/pandora_console/ (SUSE, RH, Fedora...), depending on the distribution.

11.2.1. Configuration file config.php
The configuration options in the file are in the header of it, and are these:
$config["dbname"]
Database name to connect to . In a predetermined way is pandora.
$config["dbuser"]
User name for the connexion against the Pandora database. In a predetermined way is pandora.
$config["dbpass"]
Password for the conexion against Pandora FMS database.
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$config["dbhost"]
Ip adress or equipment name that host Pandora FMS database. In reduced installation usually it is
the same equipment where the server is, this is, localhost.
$config["homedir"]
Directory where the Pandora FMS web console is. It usually is /var/www/pandora_console o
/srv/www/htdocs/pandora_console.
$config["homeurl"]
Base directory for Pandora FMS. It usually is /pandora_console.

11.2.1.1. Redirection to /pandora_console from /
If you only has one Pandora FMS in your Apache server, then, it's possible that you could benefit by
readdressing automatically /pandora_console when users connect with the URL of their server. To
do this, you could create the following file index.html and put it in the web server root directory
(/var/www ó /srv/www/htdocs):
When users connect with the URL / of their server. For it you can create the following file
index.html and put it in the web server root directory
<html>
<head>
<meta HTTP-EQUIV="REFRESH" content="0; url=pandora_console/index.php">
</head>
</html>

11.3. Pandora FMS software agents
11.3.1. What is an Agent ?
Pandora FMS software agents collect all data from the systems. They are executed in each local
system, but they also can collect remote information through the monitoring systems installation for
the agent in several different machines.
They are developed to work with a fixed platform, using the specific tools of the language that is
used:VBSCript/Windows scripting for Microsoft platforms (Windows 2000, Windows XP, Windows
2003 y Windows Vista), ShellScripting for UNIXincludes GNU/Linux, Solaris, AIX, HPUX y BSD,
and also the Nokia IPSO. The Pandora FMS agents could be developed in any language, as long as it
would be a system with an easy API and that it would be open code. There are modalities of the
Pandora FMS project that has been started for the agents creation in Posix C, Perl and Java for
those systems that require closed agents.
Pandora FMS are 100% open code, for example in the way the agents collect and send
information is documented and could analyze and/or modify the code for it could suit to your
needs. An agent could be created again in any programing language and could be easily updated to
improve aspects of the program that had been cover completely.
This document describes the agent installation in machines that work with the Windows and UNIX
operative systems.
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11.3.1.1. Software Agents Generic Role
The Software Agents generic role is based on obtaining information about the operative system in
which them are installed, collect this information and then send it to the server.
Pandora FMS software agents use the specific commands of the operative system in order to obtain
the information.Pandora FMS data server keeps and processes the data generated by these
commands and sent to the server in an XML file.
The information returned by these commands is kept in what is called «Module». f the agent has
been added in «learning» mode, the modules that have been sent and that are not defined
previously in the logical agent will be created automatically by the server.

11.3.2. Introduction to the agent configuration
The agent is controlled by an unique configuration file that has a syntax that is almost the same in
UNIX systems and in Windows Systems, this file is named pandora_agent.conf and is located in the
agent installation directory(in Windows Systems) and in /etc/pandora/pandora_agent.conf in Unix
systems.
This configuration file is a plain file text with different options that could be modify by the
administrator, to modify the performance or it, configure where data will be send, which things will
monitor and how it will do.

Configuration file encoding it's very important and must be the same that value set in
encoding configuration parameter. If encoding is set properly we will avoid to receive
data with wrong encoding characters

Next we talk about the general parameters for the Software agent and the monitoring modules that
are the ones that define how and what is monitored locally with the Software Agent.

11.3.3. Agent General Parameters
The Configuration of Agent General Parameters is defined in this section. Some of them are
commons for all systems and others are specifics for Windows or Unix. The general parameters are:

11.3.3.1. server_ip
Is the IP address or the name of Pandora FMS server host, where all data will be kept. The server
must be prepared to collect the data either by SSH (listening on port 22), Tentacle (port 41121),
FTP (port 21), SMB or NFS.

11.3.3.2. server_path
The server path is the comprehensive file path where the server keeps all data sent by agent.Usually
it is /var/spool/pandora/data_in.

11.3.3.3. temporal
This is the complete path of the folder where the agent keeps data locally before sending to the
server.
Please consider that the data packages, by default,they are deleted once the agent tries to contact
with the Pandora FMS server, not taking in account if the connection was successful or not ( though
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this performance could be changed, as we see later).
This is done to prevent an overload in the hard disc of the host system where the agent runs. The
location of the local file changes depending on the architecture of the host system. In UNIX system
is usually at n /var/spool/pandora/data_out, and in the Windows systems C:\program
files\pandora_agent\temp.The Windows installer by default will create this directory depending on
where decides to install Pandora FMS.
And in Windows systems the Windows installer will create this directory by default, depending on
where it decides to install Pandora FMS.

11.3.3.4. description
Send the description of the agent in the XML and Pandora FMS imports this description when it
creates the agent.

11.3.3.5. group
Send the name of the group we want the agent owns, and that is only used at creating the agent.
Pandora FMS server will automatically use this group to put the agent in the selected group.

11.3.3.6. temporal_min_size
If the free space (at mega bytes) of the partition in which the temporary directory is located is
smaller that this value, then it would continue generating data packages. In this way, it avoids that
the disk would become full if under any circumstance the connexion with the server is lost during
an extended interval.

11.3.3.7. logfile
The path to the Pandora FMS agent events record file. The file could be used to check the system
and to investigate other things.

11.3.3.8. interval
This is the time interval "in seconds" in which the agent will collect data from the host system and
will sent the data packages to the server. The ranks of recommended values are, from 300 (5
minutes) to 600 (10 minutes).This number could be greater, but it's important to consider the
impact of a higher number in the database. The execution is not recommended if it's below 3060
seconds.

11.3.3.9. debug
This parameter is used to check the creation of data in the files, forcing the agent to not copy data
from files for the server, so the data content of the files could be checked and also copy the XML
files data manually. No data is destroyed when the process has been done, so the data of the files
will be at the temporary directory. The activity is registered in the registry file. The registry file is
pandora_agent.log (see logfile above).

11.3.3.10. agent_name
This is an alternative name for the host. This parameter is optional so this has not been declared but
obtained directly from the system. The parameter could be used to overwrite the host name for
another one in case of a conflict.
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11.3.3.11. address
This is the IP addres of the software agent. Could be an IP addres with the format X.X.X.X, a domain
name as 'localhost', or 'auto'. If is an IP addres or a domain name, this will be added to the
addresses of the agent and will be established as main address. If is 'auto', it will obtain the IP
addres from the host and will be added to the agent as the previous case.

11.3.3.12. encoding
Install the kind of codification of the local system, such as iso885915, or utf8. This option is
available for the UNIX and Windows agents from Pandora FMS 2.0.

11.3.3.13. server_port
This parameter allows to identify the remote port of the server that is waiting. By default it is 41121
for Tentacle. In case that Tentacle is not used or that the server would be installed in other port, is
here where it should be changed.

11.3.3.14. transfer_mode
This parameter specifies the transfer mode we have to install in order send the agent data to the
server. The available modes are SSH (using SCP), Tentacle, FTP o local. The local mode is only for
systems where the agent is executed in the same machine that the server, because it is basically an
copy between directories. The local mode is available only for GNU/Linux agents.

11.3.3.15. server_pwd
Specific for the password of Windows FTP and for the Tentacle transference mode, although the
password at the last one is optional. Server password for authentication with password.

11.3.3.16. server_ssl
Specific for the Tentacle transfer mode. Allows to authorize (1) or deny(0) the connexions encrypt
through SSL.

11.3.3.17. server_opts
Specific for the Tentacle transfer mode. Allows to give additional parameters to the Tentacle client
for advanced configurations. They should be between "" (for example,"vr 5").
Coming with 3.2 agent version, tentacle supports optional use of a HTTP proxy (using CONNECT)
mode to send information to server. This is implemented using an advanced option, like this:
server_opts -y user:pass@proxy.inet:8080

This will force tentacle client to use proxy.inet at port 8080 using "user" and "pass" for
authentication, if you want to use a proxy in 192.168.1.2 with port 9000 without credentials, will
be:
server_opts -y 192.168.1.2:9000
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11.3.3.18. delayed_startup
This parameter allows to configure the Pandora FMS agent in order it start working after any
specific time (in minutes) after having executed it manually. It could be useful for systems with a lot
of load packages. By default it is deactivated, this is, the Pandora FMS agent will start to work from
the moment it will be executed manually. This option is only valid for UNIX agents.

11.3.3.19. pandora_nice
This parameter allows to specify the priority that the Pandora FMS agent process will have in the
system. It is only available for Unix/Linux agents.

11.3.3.20. autotime
If it is enabled (1) send a timestamp of special execution (AUTO) that makes that the server uses
the server local date /hour to establish the data hour, not paying attention to the hour sent by the
agent. This is necessary in those agents that by any reason have a wrong hour or a different hour
from the server.

11.3.3.21. cron_mode
With this parameter is possible to do that the agent use the Linux crontab to execute itself in a
specific interval instead of using the agent internal system to execute itself every certain time . It is
deactivated by default and it is not recommended to use it unless it would be strictly necessary.

11.3.3.22. remote_config
This parameter controls if it is possible to configure the agent remotely from the console or not. 1:
the remote configuration is activated, 0: the remote configuration is not allowed. By default is
deactivated.

11.3.3.23. xml_buffer
By default 0. If set to 1 the agent will save any XML data files that could not be sent and try again
later.
On Unix, if you are in a secured environment and want to enable the XML buffer you should
consider changing the temporal directory, since /tmp is world writable.
An example of the general parameters from a Unix configuration would be:
server_ip
server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

192.168.1.1
/var/spool/pandora/data_in
/var/spool/pandora/data_out
/var/log/pandora/pandora_agent.log
300
0
box01
41121
tentacle
1

An example of the general parameters from a Windows configuration would be :
server_ip

192.168.1.1
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server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

/var/spool/pandora/data_in
c:\archivos de programa\pandora_agent\temp
c:\archivos de programa\pandora_agent\pandora_agent.log
300
0
box01
41121
tentacle
1

11.3.3.24. timezone_offset
The agent now can set it's timezone offset with the server. This is very useful to have agents with a
different timezone synchronized with the same time with a server on another timezone. Agents will
sent the shifted timezone to the server.
# Timezone offset: Difference with the server timezone
timezone_offset 3

11.3.3.25. agent_parent_name
Also now it's possible (if the server allows it) to update the parent of an agent by sending in the
XML the name of the parent agent.
parent_agent_name parent_name

11.3.3.26. agent_threads <threads>
Number of threads the agent will launch to execute modules in parallel. by default there is a single
thread, to execute one module, and later the other, and go on until finish all of them. This is only
available in Unix agents.

11.3.3.27. include <filename>
Alternative configuration file path. This file can contain additional modules and collections besides
the main configuration file ones. This token is optional. As regarding perl agent, it allows filename
wildcards.

11.3.3.28. broker_agent <name>
It manages configurations and data collection from an agent like if they were multiple. A new
configuration file is created for each broker agent added in the main configuration file with the
name we have assigned to it. This token will be used only in the broker agent and not in the new
agents created by this. These new agents will start reporting after the next execution. This token is
optional.

11.3.3.29. pandora_user <user>
This parameter is optional and allow to execute the agent with the system user specified. This user
will have permissions to execute the agent and the associated resources.
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As we can see, most of the parameters from a Windows and a Unix agent are the same.

11.3.4. Secondary Server
An special kind of general configuration parameter is the definition of a secondary server. This
allow to define a server to which send data, in a complementary way to the server defined in an
standard way. The secondary server mode works in two different ways:
• on_error: Send data to the secondary server only if it cold not send them to the primary.
• always: Always send data to the secondary server, regardless if it can contact or not with the
main server.
Configuration example:
secondary_server_ip
secondary_server_path
secondary_mode
secondary_transfer_mode
secondary_server_port

192.168.1.123
/var/spool/pandora/data_in
on_error
tentacle
41121

11.3.5. UDP Server
Pandora FMS Windows agent allows to configure the agent for the listening of remote
commands.This server listen in a UDP port that has been specified by the user, and allows to get
orders from a remote system, ideally from the Pandora FMS, through the execution of alerts in the
server.
There are several options to configure the UDP remote server. They are at pandora_agent.conf
• udp_server:To activate the UDP server put it at 1. It is deactivated by default.
• udp_server_port: Port where it listen.
• udp_server_auth_address:Authorized IP address to send orders. For security reasons,
restrict the access to this agent from a unique IP.
• process_<name>_start <command>: Command that will start a process defined by the
user.
• process_<name>_stop <command>: Command that will stop the process.
• service_<name> 1: Allows that the service <name> could be stop or started remotely
from UDP server.
Configuration example:
udp_server 1
udp_server_port 4321
udp_server_auth_address 192.168.1.23
process_firefox_start firefox
process_firefox_stop killall firefox
service_messenger 1

The server accept the following commands:
* <START|STOP> SERVICE <name of the service>: Start or stop a service.
* <START|STOP> PROCESS <nombre del proceso>: Start or stop a process.
* REFRESH AGENT <nombre del agente>: Forces one execution of the agent, refreshing
data.
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For example:
STOP SERVICE messenger
START PROCESS firefox
REFRESH AGENT 007

There is an script in the server at /util/udp_client.plthat is the used by the Pandora FMS Server as a
command of an alert, to start process or services. It has this syntax.
./udp_client.pl <address> <port> <command>

For more information, please go to the Alert configuration section. ¡

11.3.6. Modules definition
Each piece of information that is collected should be perfectly defined in each module, using the
most precise syntax. You can implement as many values as it would be necessary in order they
could be collected, adding, at the end of the general parameters as many modules as the number of
values to compile. Each module is composed by several directives. The list that appears bellow is a
descriptive list of all available modules signals for UNIX agents (almost all of them could be also
apply to the Window agent).
The general syntax is the following:
module_begin
module_name NombreDelMódulo
module_type generic_data
.
.
.
module_description Ejecución del comando
module_interval Número
module_end

There are different kinds of modules, with different suboptions, but all modules have an structure
similar to this. The parameters module_interval and module_description are optionals and the rest
completely compulsories. We are going to see first the common elements.

11.3.6.1. Common elements of all modules
module_begin

Defines the beginning of the module. Compulsory.
module_name <name>

Name of the module. This is the module ID. Choose a name without blanks and not too long. There
is no specific limitation. (max.250 characters), but a short name would be easier to work with, this
name CAN NOT be duplicated ' with a similar name in the same agent. This name could be
duplicated with other modules in other agents. Same as with other things Pandora FMS is sensible
to the difference between capital and small letters.
It is compulsory.
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module_type

The data type that the module will use. There are several data types for agents:
• Numerical (generic_data). Simple numerical data, in floating comma or wholes. If the
values are floating type, these will be cut to its whole value.
• Incremental (generic_data_inc). The whole numeric data equals to the differential being
between the current value and the previous one. When this differential is negative, the value
is fixed to 0.
• Alphanumeric (generic_data_string). Collect alphanumeric text strings.
• Monitors (generic_proc). Useful to evaluate the state of a process or service. This type of
data is called monitor because it assigns 0 to a «Wrong» state and any value higher to 1 to a
«Right» state.
• Asynchronous Alphanumeric (async_string). Collect alphanumeric text string that could
entry at any moment without a fixed periodicity. The rest of parameters (generic*) have a
synchronous working, this is, they expect the data entry every XX time, and if they don't
come then it's said that they are in an unknown state (unknown). The asynchronous
modules can not be in this state.
• Asynchronous Monitor (async_proc). Similar to the generic_proc but asynchronous.
• Asynchronous Numerical (async_data). Similar to generic_data but asynchronous.
It is compulsory
module_min <value>

This is the minimum valid value to data generated in this module. If the module has not been
defined yet in the web console, then this value would be taken from this directory. This order is not
compulsory. This value does not eliminate the defined value in the agent. If the module does not
exist in the dashboard, then it will created automatically when the learning mode is used.
module_max <value>

This is the maximum valid value for data generated in this module. If the module has not been
defined in the web console, this value could be taken from this directory. This guideline is not
compulsory and is not supported by the Windows agent. This value does not eliminate the defined
value in the agent. If the module does not exist in the dashboard, then it will be created
automatically when the learning mode is used.
module_min_warning <value>

This is the minimum value that will make the module state goes to warning. This guideline is not
compulsory. If the module does not exist in the dashboard, then it will be created automatically
when the learning mode is used.
module_max_warning <value>

This is the maximum value that will make the module state goes to warning. This guideline is not
compulsory. If the module does not exist in the dashboard, then it will be created automatically
when the learning mode is used.
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module_min_critical <value>

This is the minimum value that will make the module state goes to critical. This guideline is not
compulsory. If the module does not exist in the dashboard, then it will be created automatically
when the learning mode is used.
module_max_critical <value>

This is the maximum value that will make the module state goes to critical. This guideline is not
compulsory. If the module does not exist in the dashboard, then it will be created automatically
when the learning mode is used.
module_disabled <value>

Indicates if the module is enabled (0) or disabled (1). This guideline is not compulsory. If the
module does not exist in the dashboard, then it will be created automatically when the learning
mode is used.
module_min_ff_event <value>

This is the interval between new changes of state will be filtered avoiding continuos changes of
module state. This guideline is not compulsory. If the module does not exist in the dashboard, then
it will be created automatically when the learning mode is used.
module_description <text>

This guideline will be employed to add a comment to the module. This guideline in not compulsory.
This value does not overwrite the value defined by the agent. If the module does not exist in the
dashboard, then it will be created automatically when the learning mode is employed.
module_interval <factor>

Since Pandora 1.2 introduced this new type, it is possible for each module to fix its own interval.
This interval is calculated as a multiplier factor for the agent interval.For example, if the agent has
interval 300 (5 minutes), and you want a module that will be processed only every 15 minutes,
then you should add this line: module_interval 3. The, this module will be preocessed every 300sec
x 3 = 900sec (15 minutes).
module_timeout <secs>

(Windows only)
In 3.1 version, Pandora FMS supports specifying in each module independently, the total of
seconds, Agent will wait for the execution of the module, so if it takes more than XX seconds, it will
abort the execution of the module (for avoid becoming "dead" in the implementation of a module).
In version 3.1 it's only supported on Windows, but future versions will also be implemented for
Unix agents.
module_postprocess <factor>

Same as in the definition of post processing of a module that is done from the console, here could
be defined a numeric value of floating comma that will send this value to Pandora FMS in order the
server will use it to multiply the received (raw) by the agent. If you want to multiply by 1024 the
value that the agent returns, put here "1024". If you want to divide it by 1024, then put here 1 /
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1024, that is 0,000976563.
module_save <variable name>

From version 3.2 it's possible to save the module returned value in an environment mode variable,
so it could be used later in other modules. It's important to consider that the values are updated
after the modules are executed, that is, in the same order that they are defined.
For example:

module_begin
module_name echo_1
module_type generic_data
module_exec echo 41121
module_save ECHO_1
module_end
module_begin
module_name echo_2
module_type generic_data
module_exec echo $ECHO_1
module_end

module_crontab <minute> <hour> <day> <month> <day of the week>

From version 3.2 it's possible to schedule modules in order they'll be executed in an specific date. To
do this, you should have to define the module_crontab' using a similar format to that of the
crontab file:(http://es.wikipedia.org/wiki/Cron_(Unix)#Sintaxis)
module_crontab <minute> <hour> <day> <month> <day of the week>
Being:
•
•
•
•
•

Minute 059
Hour 023
Day of the month 131
Month 112
Day of the week 06 (0 is Sunday)

It's also possible to specify intervals using the character as divider.
For example, in order to one module will be executed every Monday between 12 and 15, we could
use the following configuration:
module_begin
module_name crontab_test
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_end
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The module will be executed once during the interval. If we want that it'll be executed while the
interval is on, we could use the module_cron_interval 0 option in the following way:
module_begin
module_name crontab_test2
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_cron_interval 0
module_end

To execute a command every hour, in an hour and 10 minutes:
module_begin
module_name crontab_test3
module_type generic_data
module_exec script.sh
module_crontab 10 * * * *
module_cron_interval 0
module_end

module_condition <operation> <command>

From version 3.2 it's possible to define commands that will be executed when the module returns
some specific values. It's necessary to specify one of the following options:
• > [value]: Executes the command when the module value is higher that the given value.
• < [valor]: Executes the command when the module value is lower than the given value.
• = [valor]: Executes the command when the module value is the same as the given value.
• != [valor]: Executes the command when the module value is different to the given value.
• =~ [regular expression]: Executes the command when the module value coincides with the
given regular expresion.
• (valor, valor): Executes the command when the module value is ranged between the given
values.
It's possible to specify multiple conditions for the same module. For example:
module_begin
module_name condition_test
module_type generic_data
module_exec echo 2.5
module_condition (1, 3) script_1.sh
module_condition > 5.5 script_2.sh
module_end

Examples:
module_begin
module_name MyProcess
module_type generic_data
module_exec tasklist | grep MyProcess | wc -l
module_condition > 2 taskkill /IM MyProcess* /F
module_end
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module_begin
module_name PandoraLogSize
module_type generic_data
module_exec ls -la "c:\Archivos de programa\pandora_agent\pandora_agent.log" | gawk
"{ print $5 }"
module_condition > 10000 del "c:\Archivos de
programa\pandora_agent\pandora_agent.log"
module_end
module_begin
module_name Service_Spooler
module_type generic_proc
module_service Spooler
module_condition = 0 net start Spooler
module_end

• NOTE: On Windows platforms is recommended to use cmd.exe /c to execute the command
to ensure it is executed properly. For example:
module_begin
module_name condition_test
module_type generic_data
module_exec echo 5
module_condition (2, 8) cmd.exe /c script.bat
module_end

module_precondition <operation> <command>

if the precondition is true, the module will run. It's necessary to specify one of the following
options:
• > [value]: Executes the command when the module value is higher that the given value.
• < [valor]: Executes the command when the module value is lower than the given value.
• = [valor]: Executes the command when the module value is the same as the given value.
• != [valor]: Executes the command when the module value is different to the given value.
• =~ [regular expression]: Executes the command when the module value coincides with the
given regular expresion.
• (valor, valor): Executes the command when the module value is ranged between the given
values.
An example of a module using precoditions is the following:
module_begin
module_name Precondition_test1
module_type generic_data
module_precondition (2, 8) echo 5
module_exec monitoring_variable.bat
module_end
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Like postconditions is possible to use several precondition. The module will only be executed if all
preconditions are successfull:
module_begin
module_name Precondition_test2
module_type generic_data
module_precondition (2, 8) echo 5
module_precondition < 3 echo 5
module_exec monitoring_variable.bat
module_end

• NOTE: On Windows platforms is recommended to use cmd.exe /c to execute the command
to ensure it is executed properly. For example:
module_begin
module_name Precondition_test3
module_type generic_data
module_precondition (2, 8) cmd.exe /c script.bat
module_exec monitoring_variable.bat
module_end

module_unit <value>

This is a the unit of the value retrieved by the module.
Example:
module_unit %
module_end

Defines the end of the module. It is compulsory.

11.3.6.2. Specific guidelines to obtain information
Next there are the specific guidelines that could be specified for each module in order to obtain
information. In each module only could be use one kind of them.
module_exec <comand>

This is the general guideline «command to execute». Both for the Unix agent and for the Windows
agent.There is only one guideline to obtain data from a generic way, executing only one command
(it can be use pipes to readdress the execution to other command). This guideline executes a
command and keeps the returned value. This method is also available in the agents for Windows.
This is the general purpose method for both agents.
For the agents there are more guidelines to obtain data. They are the following ones:
module_service <service>

Checks if an specific service is being executed at the machine. Remember to use the «" "» characters
if the name of the service contains blanks.
module_begin
module_name Service_Dhcp
module_type generic_proc
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module_service Dhcp
module_description Service DHCP Client
module_end

The service is identified with the short name of the service (Service name),such as it appears in the
Windows services manager. There is other identifier, called "display name", longer and usually more
descriptive, but this is not the one used by Pandora FMS to identify the process. Neither it is the
process related to the server. In this snapshot we could see the short name (Service name) of the
service monitored in the previous example. It is important to stress that there is a difference in the
use of the "capital and the small letters so, for example it is not the same DHCP that Dhcp

Unix
In Unix works like Windows, but in Unix service and process is the same concept. For example, to
see if process sshd is running, module definition will be:
module_begin
module_name Service_sshd
module_type generic_proc
module_service sshd
module_description Process SSHD running
module_end

Service watchdog and service asynchronous detection is not possible in Unix agents.
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Asynchronous Way
Pandora FMS usually executes a test battery(each of them defined by a module) every X seconds
(300 seg.= 5 min.by default) so if a service is down just after an execution of Pandora, then it will
be take other 300 seconds to know it has get down. The asynchronous modules do that Pandora
notify "inmmediatly" the fall of this service. This is called asynchronous operation mode. For it, it
would be enough to add the guideline.
module_async yes

Watchdog of services
There is a watchdog mode for the services, so the agent could start them again if they stop. In this
case, the service that is restarted does not requires any parameter, because Windows already knows
how to do it.In this case the configuration is easier and this could be an example:
module_begin
module_name ServiceSched
module_type generic_proc
module_service Schedule
module_description Service Task scheduler
module_async yes
module_watchdog yes
module_end

module_proc <process>

Checks if an specific name of process is working in this machine. If the name of the process has
blanks no use «" " ». Consider that the name of the process should have the .exe extension. The
module will return the number of processes that are being executed with this name. It is important,
same as with other cases, that the name of the process would be exactly the same that the one
shown by the Windows task manager, including blanks, capital letters/small letters.For exemple it
will not be the same cmd.exe that CMD.exe
This would be an example of the monitoring of process cmd.exe:
module_begin
module_name CMDProcess
module_type generic_proc
module_proc cmd.exe
module_description Process Command line
module_end

Unix
In Unix this module works like the module_service. It doesn't support asynchronous and/or
watchdog mode.
Asynchronous mode
In a similar way to the services, monitoring processes can be critical in some cases. Now the
Window agent supports asynchronous checking for the module_proc. module. In this case, the agent
notify inmediatly when the process changes the state, without waiting for the agent executes again the
verification as it is configured in the agent interval. In this way, you can know the fall or critical
processes almost at the same time they take place. This would be an example of asynchronous
monitoring of processes:
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module_begin
module_name Notepad
module_type generic_data
module_proc notepad.exe
module_description Notepad
module_async yes
module_end

The difference is in the configuration token "module_async yes".
Processes Watchdog
A Watchdog is a system that allows to act immediately when an agent is down, usually picking up
the process that is down . The Pandora FMS Windows agent could act as Watchdog when a process
is down. This is called watchdog mode for the process:
Executing a process could need some parameters, so there are some additional configuration
options for these kind of modules. It is important to say that the watchdog mode only works when
the module type is asynchronous. Let's see an example of configuration of a module_proc with
watchdog.

module_begin
module_name Notepad
module_type generic_data
module_proc notepad.exe
module_description Notepad
module_async yes
module_watchdog yes
module_start_command c:\windows\notepad.exe
module_startdelay 3000
module_retrydelay 2000
module_retries 5
module_end

This is the definition of the additional parameters for module_proc with watchdog:
• module_retries:number of consecutive attempts for the module will try to start the process
before deactivating the watchdog. If the limit is achieved , then the watchdog device for this
module will be deactivated and will never try to start the process, even if the process is
recovered by the user ( at last until the agent will be reboot). By default there is no limit for
the nº of reattempts of the watchdog.
• module_startdelay:number of milliseconds the module will wait before starting the process
by first time. If the process takes lot of time at starting , then it will be a great idea to order
the agent through this parameter that it "wait" until start checking again if the process has
got up. In this example wait 3 seconds.
• module_retrydelay: Similar to the previous one but for subsequent falls/reattempts, after
having detect a fall. When Pandora detects a fall, relaunch the process, wait the nº of
milliseconds pointed out in this parameter and check again if the process is already up.
It is important to say that Pandora FMS is executed as service and if you want to use the Watchdog
functionality to execute processes that allow to interact with the desktop, then we should arrange,
in the Pandora FMS service functionalities, the box "Interactive access with desktop", as it is shown
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in the following snapshot:

Same way, it is necessary to understand that Pandora FMS as service, is executed under the count
"SYSTEM" and that the executed process will do it with this user and environment, so if it wants to
execute an specific process that requires be used with an specific user,he should encapsulate in one
script (.bat or similar) the previous processes for starting the environment, environment variables,
etc) and execute this script as a watchdog action.

module_cpuproc <process>

(Unix only)
Return the CPU usage of a specific process.
module_begin
module_name myserver_cpu
module_type generic_data
module_cpuproc myserver
module_description Process Command line
module_end

module_memproc <process>

(Unix only)
Return the memory used by a specific process.
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module_begin
module_name myserver_mem
module_type generic_data
module_memproc myserver
module_description Process Command line
module_end

module_freedisk <unit_letter:>|<volume>

This module works in Unix and Windows. It checks the free space in the disk unit (don't forget «":"»
after the unit_letter) or the unix volume, p.e /var.
module_freepercentdisk <unit_letter:>|<volume>

This module returns the free disk percentage in a windows unit: (don't forget the ":") or on a Unix
system, the volume, like /var.

module_begin
module_name freepercentdisk
module_type generic_data
module_freepercentdisk C:
module_end
module_begin
module_name disk_var
module_type generic_data
module_freepercentdisk /var
module_end

module_occupiedpercentdisk <unit_letter:>|<volume>

(Unix only)
This module returns the occupied disk percentage in a Unix volume, like /var.
module_begin
module_name disk_var
module_type generic_data
module_occupiedpercentdisk /var
module_end

module_cpuusage <cpu id>

This works in Unix and Windows. It gives back the CPU usage in a CPU number. If there is only one
CPU, let it blank or use the 'all'. It is also possible to obtain the use average of all CPU in a
multiprocessor system:
module_begin
module_name SystemCPU
module_type generic_data
module_cpuusage all
module_description Average CPU use in systme
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module_end

To check CPU usage in CPU #1
module_begin
module_name SystemCPU_1
module_type generic_data
module_cpuusage 1
module_description Average CPU use in system for CPU #1
module_end

module_freememory

Supported in Windows and Unix. Gives back the free memory in the whole system.
module_begin
module_name FreeMemory
module_type generic_data
module_freememory
module_description Non-used memory on system
module_end

module_freepercentmemory

Supported in Unix and Windows. This module gives back the free memory percentage in one
system:
module_begin
module_name freepercentmemory
module_type generic_data
module_freepercentmemory
module_end

module_tcpcheck

(Windows only)
This module tries to connect with the IP and port specified.It returns 1 if it had success and 0 if it
had other way.You should specify a time out.
module_begin
module_name tcpcheck
module_type generic_proc
module_tcpcheck www.artica.es
module_port 80
module_timeout 5
module_end
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module_regexp

(Windows only)
This module monitors a record file (log) looking for coincidences using regular expressions, ruling
out the already existing lines when starting the monitoring . The data returned by the module
depends on the module type:
• generic_data_string, async_string: Gives back all the lines that fit with the regular
expression.
• generic_data: Gives back the number of lines that fit with the regular expression.
• generic_proc: Gives back 1 if there is any coincidence, 0 if other way.
• module_noseekeof: With a 0 value by default, with this configuration token active, in each
module execution, independently from any modification the target file suffers, the module
will restart its check process without searching for the EOF flag of the file, so it will always
extract to the XML output all those lines matching our search pattern.
module_begin
module_name regexp
module_type generic_data_string
module_regexp C:\WINDOWS\my.log
module_pattern ^\[error\].*
module_noseekeof 1
module_end

To obtain more information about the syntax of the regular expressions, please have a look at this:
[2]
module_wmiquery

(Windows only)
The WMI modules allow to execute locally any WMI query without using an external tool. It is
configured through two parameters:
• module_wmiquery: WQL query used.Several lines could be obtained as a result, that will be
placed as several data.
• module_wmicolumn: Name of the column that that is going to be used as a data source.
For example, we could obtain a list of the installed services.
module_begin
module_name Services
module_type generic_data_string
module_wmiquery Select Name from Win32_Service
module_wmicolumn Name
module_end

Or of the current CPU load:
module_begin
module_name CPU_speed
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
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module_end

module_perfcounter

(Win32 only)
Obtains data from the performance counter through the PDH interface (the library pdh.dll should be
installed in the system. PDH.DLL is a Windows library. If you have not installed it then you would
have to install the Windows performance analysis tool (that usually is installed by default).
module_begin
module_name perfcounter
module_type generic_data
module_perfcounter \Memory\Pages/sec
module_end

The Windows performance monitor is a powerful tool that has hundreds of parameters that could
be used to monitor. Each manufacturer also adds his owns monitors, so this is a powerful, versatile
and easy to use tool to monitor the system parameters and also the devices that run on it.
The syntax of the perfcounter elements depends on the language, this is, in a German version
,Windows will have specific identification strings, and in an English version, Windows will have
other ones. This makes difficult to use it at system with heterogeneous languages.
To explore the different values that could be used, you can use the the Windows tool "Performance"
to see which strings of performance you could monitor.
In this snapshot you can see the Windows performance monitor.

And in this snapshot see how the interface show things when we want to add a new monitoring
element.
Here we could visualize (in spanish) several parameters of the Procesador(in spanish at original
version) and that has different sub elements, of which them we have selected % of processor time
and in several sub elements. In this case, we are interested in the total _ Total.
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In this way, surfing with the SO tool, we could get different elements of the system performance.
For this specific example, the module would be:
module_begin
module_name Processor_Time
module_type generic_data_inc
module_perfcounter \Procesador(_Total)\% de tiempo de procesador
module_end

By default the raw value of the counter is shown, to get the cooked value add the module_cooked
1 parameter:
module_begin
module_name Disk_E/S_Seg
module_type generic_data
module_cooked 1
module_perfcounter \DiscoFísico(_Total)\E/S divididas por seg.
module_end

Many of the data that it returns are counters, so you should use generic_data_inc as data type. It
can also returns values in very high data scales (several millions), so you could reduce these values
using the module post process, with values like 0.000001 or similar.
module_inventory

In Linux/Unix is implemented as agent plugin
Using predefined WMI consults and queries on the registry.This module obtains information about
the different aspects of a machine. From software to hardware.
The module can get different parameters to mark the kind of information that it gets. Here is the
parameter list and the kind of information that it gives:

157

Pandora FMS software agents

• Cpu: Gets information about the system CPUs( processor name, watch frequency, and
description).
• CDROM: Gets information about the CDROM(name, description and unity letter).
• Video: Gets information about video cards(description, RAM, and processor).
• HDs: Gets information about the hard disks(model, size and name in the system).
• NICs: Gets information about the network interface controllers(description, MAC address
and IP address).
• Patches: Gets information about the installed patches(identifier, description and
comments).
• Software: Gets information about MSI packages installed(name and version).
• RAM: Gets information about RAM modules(tag, capacity and name).
• Services: Gets information about the installed services. The short name shown in the first
column is the name of the service that Pandora FMS uses to could monitor services.
Additional Module Parameters:
• module_interval: This module has an additional line to specify the interval, in days, where
he can obtain the information for the module.
An example of the use of this module would be this:
module_begin
module_name Inventory
module_interval 7
module_type generic_data_string
module_inventory RAM Patches Software Services
module_description Inventory
module_end

module_logevent

(Windows only)
This new module allows to obtain information from the Window event log file. It returns those
elements that agree with a given pattern, allowing also to filter by the source and event type. The
module that exists in version 2.0 has been improved, using now the Win32 native API to have
access to the events from the file, instead of using the subsystem WMI (much slower). This method
is quicker and allow to work in systems with many elements. The new implementation also allows
to filter through much more fields that in the previous version. The standard format of the module
is the following:
module_begin
module_name MyEvent
module_type async_string
module_logevent
module_source <logName>
module_eventtype <event_type/level>
module_eventcode <event_id>
module_application <source>
module_pattern <text substring to match>
module_description
module_end

To avoid showing that has been already shown, we only consider those events that had taken place
from the last time the agent was executed, as it happens with other modules (regexp, p.e).
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module_logevent accepts the following parameters (all of them casesensitive):
•
•
•
•
•

module_source: Event source (System, Application, Security). This field is compulsory.
module_eventtype: Event type(failure, information). It is an optional field.
module_pattern: Pattern to search (substring). It is an optional field.
module_eventcode: It is a numeric ID of the event, p.e: 5112. It is an optional field.
module_application: Application source of the event. Watch out not mistake with
module_source that shows the name or the source or log file where the events are looked
for.

For example, for showing all events of an error type system we should define the following module:
module_begin
module_name log_events
module_type generic_data_string
module_description System errors
module_logevent
module_source System
module_eventtype error
module_end

To show all events that have the word PandoraAgent:
module_begin
module_name log_events_pandora
module_type async_string
module_description PandoraAgent related events
module_logevent
module_source System
module_pattern PandoraAgent
module_end

Another example, filtering the event showed in the snapshot:

module_begin
module_name MyEvent
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module_type async_string
module_source Application
module_eventtype Information
module_eventcode 6000
module_application Winlogon
module_pattern unavailable to handle
module_description
module_end

It is very important to understand that Pandora FMS is not a system to collect logs and that this
tool should be used to select those critical or important events for monitoring, and that collect all
events, without classify them, from, a common source, as could be the "System" one, will only cause
problems so the DDBB will be collapsed and the system will work in a very bad way.It is extremely
important understand that the event collection with Pandora FMS should be done taking this in
account and not using Pandora FMS as a generic event collector.
module_odbc

(Windows only) (only for 32 bits ODBC drivers)
NOTE: For 64 bits Windows systems it is needed to use a 32 bits ODBC system that it's called
odbcad32.exe and set it like a file DSN.
Generic module of access to the database through ODBC interface in Windows agent. This allow to
do now SQL queries to the database servers that have this system, as Microsoft SQL Server, Oracle,
MySQL or PostgreSQL between others.
In order to could use ODBC modules, first you have to define the ODBC connector in the main
section of the agent configuration, with some lines like these:
# ODBC connections
# Configuring "ExampleDSN" DSN. Notice that this DSN connection must be configured
# under Control panel -> Administrative tools -> ODBC -> DSN
odbc_ExampleDSN_username UserNameForDsn
odbc_ExampleDSN_password Password1234

This create a "ExampleDSN" handler that we could use after in the modules. Let see an example of a
module that uses the handler previously created.
# ODBC query example using ExampleDSN connection defined above.
# This module gets the first row in example_table.
module_begin
module_name SQL query example
module_type generic_string
module_odbc ExampleDSN
module_odbc_query SELECT * FROM database.example_table
module_description The first row of example_table
module_end

At present, the ODBC module only allows to return the first line of each query exit.
NOTE: THE SYNTAX database.example_table IS REQUIRED TO ACCESS THE TABLE USING
ODBC MODULE
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module_plugin

Is a parameter to define the data that is obtained as an exit of a plugin agent. It is an special case of
module, that builds all its XML and that does not requires any other delimiter,such as type
module_begin, module_type, etc.They follow this format:
module_plugin plugin_filename parámetro_1 parámetro_2 parámetro_3

Each plugin has its own syntax. We are going to describe one of the plugins that comes by default
with the Agent, the regular expressions plugin:
module_plugin grep_log /var/log/syslog Syslog ssh

In this example, the name of the plugin is "grep_log "and will search in the file "/var/log/syslog" the
regular expression "ssh" and will kept it in a module called "Syslog".
Another example in windows systems, (solo version 3.1 o superior)
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\df_percent.vbs"

File collection and plugins
When you use file collections, this also works at the same level, but you need to know where are the
collection files stores the files. File collections uses a "handle" or short name, generated when you
first create the collection, and has a name similar to "fc_2". Let's see some examples of
module_plugin usage, using file collections:
Unix:
module_plugin /etc/pandora/collections/fc_1/always_1.sh

Windows:
module_plugin cscript //B "%ProgramFiles
%\pandora_agent\collections\fc_2\df_percent.vbs"

It's very important to remark that plugin execution output could return more than one module,
because it returns a full XML structure. This is, for example, the plugin output of the /util/df.vbs
plugin in windows:
<module>
<name><![CDATA[C:]]></name>
<description><![CDATA[Drive C: free space in MB]]></description>
<data><![CDATA[2361]]></data>
</module>
<module>
<name><![CDATA[D:]]></name>
<description><![CDATA[Drive D: free space in MB]]></description>
<data><![CDATA[32020]]></data>
</module>
<module>
<name><![CDATA[Z:]]></name>
<description><![CDATA[Drive Z: free space in MB]]></description>
<data><![CDATA[10168]]></data>
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</module>

module_ping <host>

(From version 4.0.1 onwards, Windows only)
This module pings the given host and returns 1 if it is up, 0 otherwise. It is a wrapper for ping.exe.
Is supports the following configuration parameters:
• module_ping_count x: Number of ECHO_REQUEST packets to be sent (1 by default).
• module_ping_timeout x: Timeout in milliseconds to wait for each reply (1000 by default).
• module_advanced_options: Advanced options for ping.exe.
Example:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.1.1
module_ping_count 2
module_ping_timeout 500
module_end

module_snmpget

(From version 4.0.1 onwards, Windows only)
This module performs an SNMP get query and returns the requested value. It is a wrapper for
snmpget.exe.
It supports the following configuration parameters:
•
•
•
•
•

module_snmpversion [1,2c,3]: SNMP version (1 by default).
module_snmp_community <community>: SNMP community (public by default).
module_snmp_agent <host>: Target SNMP agent.
module_snmp_oid <oid>: Target OID.
module_advanced_options: Advanced options for snmpget.exe.

Example:
module_begin
module_name SNMP get
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.1.1
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.148
module_end
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11.3.7. Examples
Example of a Windows module, checking if the EventLog works. It could be:
module_begin
module_name ServicioReg
module_type generic_proc
module_service Eventlog
module_description Eventlog service availability
module_end

An example of a Unix module would be:
module_begin
module_name cpu_user
module_type generic_data
module_exec vmstat | tail -1 | awk '{ print $14 }'
module_min 0
module_max 100
module_description User CPU
module_end
Tipos de agentes software

11.3.8. Advanced issues about software agents
With Pandora FMS it is possible to monitor any system. This could be done, either with a Software
agent installed in the system, that collect data straigh from the system to be monitored, or using a
"Satellite Agent" that consist of an agent that is executed in a server and monitor some parameters
of systems that have adjacents, through SNMP or commands defined by the user.
The software agents could be Windows or UNIX agents. The agents could be installed using any of
the agents described in the following lines. To use a satellite agent, it will be enough if you install a
software agent and define configured modules to collect data from an external system, through, for
example, the snmpget tool or through ping.

11.3.8.1. Unix/Linux Agents
Unix has several command line tools that allow that get data through commands would be a very
simple thing.The Unix agents are based in this premise.There are two kinds of Unix agents:
• ShellScript: with a shellscript defined for each kind of SO, based on bash, ksh or csh. In the
classic Unix Systems (Solaris, AIX, HPUX) all functionalities are not implemented. But in
Linux and MAC they are.
• Perl: there is a unique multiplataform agent, based on Perl 5.8 that functions equally in all
Unix systems. They should necessarily have a Perl 5.8 system or another higher to operate.
The shellscript agents have been designed to function even in the oldest UNIX versions: HPUX11.0,
AIX 4.1, Solaris 6... They work, but are limited with some features, such as not having the Tentacle
client and having to use the FTP system or SSH to upload the monitoring data to the server.
Pandora FMS Unix Agents Configuration

There is hardly any difference between AIX, Solaris and GNU/Linux. We are going to describe some
of their most important parameters and paths.
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After starting the installator, the agent main directory or "home" directory is
/usr/share/pandora_agent/ where the Pandora FMS agent would be installed. In the system where
this would be not possible by politic reasons, we recommend to create a link to this path from the
installation real path,p.e /opt/pandora > /usr/share/pandora_agent
The other important folders are:
• /var/spool/pandora/data_out: Folder where the data collected by agents is kept
• /etc/pandora/pandora_agent.conf: Main agent configuration folder. Where the data that is
collected is defined, with the command that will be used for the collection of data.
• /usr/local/bin/pandora_agent: the current Pandora FMS agent. This file is a shellscript that
collects the configured data in the pandora_agent.conf files.It also send the data packages to
the Pandora Server. It usually has a link to /usr/bin/pandora_agent
• /usr/local/bin/tentacle_client: The agent add the Tentacle client to could send the data files
to the server.This is a client in Perl 5.8. Usually it has a link to /usr/bin/tentacle_client.
• /etc/init.d/pandora_agent_daemon: Script of start/ stop. This make a call to pandora_agent.
This gives to options, start/stop. In the AIX systems the daemon is
/etc/rc.pandora_agent_daemon .
• /var/log/pandora/pandora_agent.log: Text file where the activity of the Pandora FMS agent
is kept, when the agent is executed in depuration mode
• /etc/pandora/plugins: Directory that keps the agent plugins. It is link to directory
/usr/share/pandora_agent/plugins
Initial Execution of Unix Agent

When you start the Pandora FMS agent, this should copy the data file to the Pandora FMS server
through
the
dispatch
system
that
is
specified
in
the
configuration
file
/etc/pandora/pandora_agent.conf. This dispatch system (Tentacle,SSh,FTP) should be configured
previously.
To start the agent you need only to execute:
/etc/init.d/pandora_agent_daemon start

For IPSO systems the agent will be launched with a priority of 10, so it turns into the process with
the lowest priority in the system CPU It will be executed when other processes with a higher priority
will be waiting in the CPU system queue.The IPSO agent has an special parameter (harmless_mode )
for an special management of the CPU process at systems Checkpoint/NOKIA. This is a very special
case.
In the BSD systems the highest priority is +20 and the lowest 20.
To stop the agent, execute:
/etc/init.d/pandora_agent_daemon stop

Advanced Configuration for the Unix Agent

The Pandora FMS's real power is on the agent capacity to start working the user defined scripts.
This could be used to collect specific data or to make an operation that gives back any wanted
value. This is the aim of the agent plugin structure. For more information check the Annex on
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Creating Agent plugins.
Examples of Implementation for Unix Agents

Example #1: calculate the number of displays at the Apache Web server main page (it could
degrade the running of huge records):
module_begin
module_name WEB_Hits
module_type generic_data_inc
module_exec cat /var/log/apache/access.log | grep "index" | wc -l
module_end

Example #2: checks if the process of the DNS(named) is working or it is down:
module_begin
module_name DNS_Daemon
module_type generic_proc
module_exec ps -Af | grep named | grep -v "grep" | wc -l
module_end

Altering the way Unix Agents obtain system information

This is only valid for Unix Perl agents (version 3.2 or higher).
There are some modules which works like "blackboxes", thus, make things and the user doesn't have
to know what is really doing. These modules are:
•
•
•
•
•
•
•
•
•

module_procmem
module_freedisk
module_freepercentdisk
module_cpuproc
module_proc
module_procmem
module_cpuusage
module_freememory
module_freepercentmemory

Modules like module_cpuusage, for example, return a % of current system CPU usage. But the user
doesn't need to use a command, Pandora "already knows" what to do, on windows and in Unix
systems.
Pandora Unix Agents have a "predefined" commands to do that, for example, to do this, is done in
different ways depending on the OS:
linux => 'vmstat 1 2 | tail -1 | awk \'{ print $13 }\,
solaris => 'vmstat 1 2 | tail -1 | awk \'{ print $21 }\,
hpux => 'vmstat 1 2 | tail -1 | awk \'{ print $16 }\

Could happen that your system is slightly different from the tested system, and the command is not
valid. You can use your own command with a simple module_exec or redefine internal pandora
commands to do that. For that, you need to edit some lines of Pandora FMS Unix Agent code, but
doesn't worry, is Perl code, and it's a very basic edition.
Pandora agent is usually in /usr/bin/pandora_agent. Edit with vi or nano (they are common text
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editors for console), and search for "Commands to retrieve" text. You should see something like:
# Commands to retrieve total memory information in kB
use constant TOTALMEMORY_CMDS => {
linux => 'cat /proc/meminfo | grep MemTotal: | awk \'{ print $2 }\,
solaris => 'MEM=`prtconf | grep Memory | awk \'{print $3}\'` bash -c \'echo
$(( 1024 * $MEM ))\,
hpux => 'swapinfo -t | grep memory | awk \'{print $2}\
};

This is the piece of code which defines how pandora get information from system to get total
memory. AIX is not defined because we don't have information on how to get this information in a
AIX system. If you see a bit more below:
# Commands to retrieve partition information in kB
use constant PART_CMDS => {
# total, available, mount point
linux => 'df -P | awk \'NR > 1 {print $2, $4, $6}\,
solaris => 'df -k | awk \'NR > 1 {print $2, $4, $6}\,
hpux => 'df -P | awk \'NR > 1 {print $2, $4, $6}\,
aix => 'df -kP | awk \'NR > 1 {print $2, $4, $6}\
};

These are the commands to get disk information in KB (total, free and mount point). To change any
of predefined values to get information, just edit the command, but be careful with:
1. Check that lines ends with ";"
2. Check that commands are between ' ' symbols.
3. Check that any ' symbol you use, is escaped with \ symbol, for example this command:
df -P | awk 'NR > 1 {print $2, $4, $6}'

Will be
df -P | awk \'NR > 1 {print $2, $4, $6}\'

It's the same used above, so see how it is written in the code.

11.3.8.2. Pandora FMS Windows Agents
Checking of the Windows agent working

The exit of the Pandora FMS Windows agent can be checked at the file C:\archivos de
programa\pandora_agent\pandora_agent.log,plain text file that includes information about the
agent execution flow.
To check if Tentacle or SSH are working well, you can use the command tentacle_client or the
parameter testssh on the binary.The first command will give an error so neither the address or the
file to send is specified, but it checks that the Tentacle client, tentacleclient is in the system. The
second one will force to Pandora FMS to connect using SSH internally and copy a file called ssh.test.
Remember that you shoul configure SSH correctly if you want to use it, generating the needed keys
and importing them in the server.
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Checking of Pandora FMS Agent service

The Pandora FMS 3.0 version has been carefully checked and "debugged" in order to avoid all kinds
of memory leaks, handles,of processes , files or TCP/IP ports. It is very stable and has been tested in
all Windows platforms where it has to operate. Nevertheless, in some systems could happen that the
service fall a few times. For it we have tried to give some solutions to those users that require a
restart system or a supplementary control of the agent.
There are two ways of having more control over the agent. The first one is to force the restart of the
agent every X days through the Windows internal programmer for tasks through the AT command.
Restart with AT
In English
To schedule a restart on Mondays and Fridays:
at 00:00 /every:Monday,Friday "c:\program
files\pandora_agent\scripts\restart_pandora_agent.bat"

In Spanish
For example, to schedule an every day restart:
at 00:00 /every:L,M,Mi,J,V,S,D "c:\archivos de
programa\pandora_agent\scripts\restart_pandora_agent.bat"

To see a list of the scheduled tasks, write in the command line
at

This will give you the scheduled tasks.
Automatic control of the service in case of falls
Windows gives an additional way of controlled restart of the service if this, by any reason falls. This
allow to say to the Windows service that if this fall, then it pull it up again automatically. For it you
have to go to the Windows services dashboard, go to the Pandora FMS agent and click at properties.
In the flap " Recovery", we should change the default values to these ones:
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This does that if the service falls, it restart it automatically, but only once a day, so it falls more
times it does not pull it up, avoiding by this that the system would be overload or forces the
execution that downs too much and that could be caused by a problem in the system, because
Pandora FMS should never be down,and of course, not so frequently. In any case, you can adjust
these parameters to do that when the Pandora FMS service fall be controlled by the system and this
way be sure that you will always have the agent running.
Configuration of Pandora FMS Windows Agent

The whole installation is done through file pandora_agent.conf. This file is a list of pairs of
keys/values that have been described before. Here is an example of this file.

# General Parameters
# ==================
server_ip mypandoraserver.host.com
server_path /var/spool/pandora/data_in
temporal "c:\windows\temp"
interval 300
agent_name myagent_name
# Module Definition
# =================
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# Counting OpenedConnections (check language string)
module_begin
module_name OpenNetConnections
module_type generic_data
module_exec netstat -na | grep ESTAB | wc -l | tr -d " "
module_description Conexiones abiertas (interval 2)
module_interval 2
module_end
# Is Eventlog service running ?
module_begin
module_name ServicioReg
module_type generic_proc
module_service Eventlog
module_description Servicio Registro de sucesos
module_end
# Is lsass.exe process alive ?
module_begin
module_name Proc_lsass
module_type generic_proc
module_proc lsass.exe
module_description LSASS.exe process.
module_end
# Received packets.
# Please notice that "Paquetes recibidos" string must be replaced by
# the correct string in your Windows system language.
module_begin
module_name ReceivedPackets
module_type generic_data
module_exec netstat -s | grep "Paquetes recibidos " | tr -d " " | cut -f 2 -d "="
| tr -d "\n"
module_description Conexiones abiertas (interval 2)
module_end
# Free space on disk
module_begin
module_name FreeDiskC
module_type generic_data
module_freepercentdisk C:
module_description Free space on drive C:
module_end
module_begin
module_name FreeMemory
module_type generic_data
module_freepercentmemory
module_description Amount of free memory.
module_end

Extending the agents functionality of agents with VBS code

Starting witn 3.1 version, Windows agents have plugins, like the Unix agents, but don't forget that
they have also the possibility of executing the external scripts, based in VBScript as simple modules.
See the VBS code that obtains the CPU total use of a system:
strComputer = "."
Set objWMIService = GetObject("winmgmts:" _
& "{impersonationLevel=impersonate}!\\" _
& strComputer & "\root\cimv2")
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Set object1 = objWMIService.Get( _
"Win32_PerfRawData_PerfOS_Processor.Name='_Total'")
N1 = object1.PercentProcessorTime
D1 = object1.TimeStamp_Sys100NS
Wscript.Sleep(1000)
set object2 = objWMIService.Get( _
"Win32_PerfRawData_PerfOS_Processor.Name='_Total'")
N2 = object2.PercentProcessorTime
D2 = object2.TimeStamp_Sys100NS
' CounterType - PERF_100NSEC_TIMER_INV
' Formula - (1- ((N2 - N1) / (D2 - D1))) x 100
PercentProcessorTime = (1 - ((N2 - N1)/(D2-D1)))*100
Wscript.Echo PercentProcessorTime

We keep it a file called "CPUTotal.vbs" and located at c:\program files\pandora_agent\util.
Now we create a new module tipe module_exec with this content:
cscript.exe /NoLogo c:\program_filespandora_agent\util\CPUTotal.vbs

We already have a new module that returns the CPU total use obtained through the external script
in VB. There are plenty of things that can be obtained throug VBScript. Microsoft has an excellent
documentation on line about VBS that you can check in MSDN [3].
Running Pandora FMS Agent under a different user than SYSTEM

You can setup the Windows agent to run under a different user, to do that, you need to configure
the service startup with a different user, and give that user special privileges. THat user should be
included in the Group "administrators".
In the WMI console, all users from group "administrators" have ALL permissions enabled.
This is an example of a user, and the settings of WMI for ROOT space. By default, branches will
takes (by hierarchy) the permissions of the root:
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Some Microsoft links related with this issue on : [4] [5]

11.3.8.3. Autoupgrading Software Agents
Pandora FMS 3.2 has a new feature called "File collection". File collections are described in a few
chapters below, they are a "centralized file distribution system" to copy files (binary, scripts, data)
from the console to the agents running the Pandora FMS software agent.
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Using that mechanism and a very special tool, we can provide a way to "autoupgrade" the software
agents. This works in this way:
1. Agents receive new binaries in the filecollection incoming dir, for example:
c:\program files\pandora_agent\collections\fc_1\pandoraAgent.exe

2. The agent uses a special module to execute the pandora_update tool. This tool receives a single
parameter, it's the FileCollection handle (or short name), in this scenario, is fc_1, and check for a
file called pandoraagent.exe (or pandora_agent in unix) and see the size and contents (by using a
HASH) of both files, the running pandora_agent and the binary provided in the file collection. If
they are different, pandora_update stop the agent, replace the binary and restart the agent again,
using the new binary.
3. Pandora_update also writes to a small log the update event, to be able to recover in the next
execution and warn the user, by using a async_string module, about the agent update process.
This means that modules used to do the update process, could be configured to have a high interval.
Unix standar installation
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec nohup /etc/pandora/plugins/pandora_update fc_1 2> /dev/null && tail -1
nohup.out 2> /dev/null
module_description Module to check new version of pandora agent and update itself
module_end

Unix custon installation
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec nohup /var/opt/PandoraFMS/etc/pandora/plugins/pandora_update fc_1
/var/opt/PandoraFMS 2> /dev/null && tail -1 nohup.out 2> /dev/null
module_description Module to check new version of pandora agent and update itself
module_end

NOTE: The second parameter of pandora_update command the installation path of Pandora FMS.
This parameter is required only when you have installed Pandora FMS in another path different
from default path.
Windows
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec pandora_update.exe fc_1
module_description Module to check new version of pandora agent and update itself
module_end

NOTE: At Unix, if it has the agent in a non "standard" path, it will have to modify some of the
pandora_update utility values, specifically the following lines:
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# Setup your particular paths / process settings here
# [SETUP BEGIN] 12:46, 23 November 2010 (UTC)12:46, 23 November 2010 (UTC)12:46, 23
November 2010 (UTC)12:46, 23 November 2010 (UTC)12:46, 23 November 2010 (UTC)12:46,
23 November 2010 (UTC)12:46, 23 November 2010 (UTC)12:46, 23 November 2010
(UTC)12:46, 23 November 2010 (UTC)12:46, 23 November 2010 (UTC)
# Location of binaries
# Unix
my $running_binary = "/usr/bin/pandora_agent";
my $updated_binary = "/etc/pandora/collections/$fc_path/pandora_agent";
# Unix style
my $start_pandora = "/etc/init.d/pandora_agent_daemon start";
my $stop_pandora = "/etc/init.d/pandora_agent_daemon stop";

And fix manually the paths to the one that fits with your system.

11.3.8.4. Process to Auto_Upgrade Agents from versions Previous to the 3.2
The first thing is to get the runnables from the Pandora FMS agent and from the pandora_update
tool (pandoraAgent.exe and pandora_update.exe in Windows and pandora_agent and
pandora_update in Unix)
Many of the steps that we are giving here means the following things:
1. You have a way to copy files to the systems that you want to update. This is a feature that the
Pandora FMS 3.2 version provides (File Collection) but just now you want to migrate to the 3.2
version, because it hasn't this feature. It's assumed that you have other alternative mechanism.
2. The agent configuration remote management is activated and working. This will be useful, and
you should create several directories and configure a new module in your Pandora FMS agent
configuration.
Windows Platforms
We should copy pandora_update to one directory of the system path or to the carpeta /util of our
pandora (in Windows)
Supposing that we have Pandora FMS installed at:
C:\Archivos de programa\pandora_agent

We have to copy pandora_update.exe in the directory:
C:\Archivos de programa\pandora_agent\util

Then we create two directories:
C:\Archivos de programa\pandora_agent\collections
C:\Archivos de programa\pandora_agent\collections\fc_1
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And after this, we should copy the new agent binary to the last directory that we have created:
C:\Archivos de programa\pandora_agent\collections\fc_1\PandoraAgent.exe

We create one module in the agent as the one that follows:
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec pandora_update.exe fc_1
module_description Module to check new version of pandora agent and update itself
module_end

This special module that uses the pandora_update executable, executes an special tool
(pandora_update) that compares the current executable with the one that already exist in the
directory /collections/xxxx, where xxxx is a parameter that is passed to the module. This location is
the one that is specified with the file_collections.After, using the 3.2 version, the distribution of the
new .exe of the agents will be done through filecollections and this identifier will be necessary to
"locate" in which File Collection is our executable.
UNIX Platforms
In a similar way to the Windows platforms, we have to copy the executable of the Unix agent and
the pandora_update feature. If it has a non_standar installation and it has customized paths, then
you should have to pay lot of attention to the previous paragraph, where it says which files should
be modified.
You have to copy pandora_update in your agent plugins/folder:
/etc/pandora/plugins/pandora_update

And now create directories/collection/fc_1 on the base directory of your /etc/pandora
/etc/pandora/collections/
/etc/pandora/collections/fc_1

The call to pandora_update will be done on its system paths to the plugins, in this case, the
standard is /etc/pandora/plugins/pandora_update
The module for the Unix case will be the following one:
module_begin
module_name Pandora_Update
module_type async_string
module_interval 20
module_exec nohup /etc/pandora/plugins/pandora_update fc_1 2> /dev/null && tail -1
nohup.out 2> /dev/null
module_description Module to check new version of pandora agent and update itself
module_end

NOTE: You should check that both pandora_update and pandora_agent have suitable permissions
and owners. Executing permissions and the same user that the pandora_agent executable.
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11.3.9. Pandora FMS Drone Agents
11.3.9.1. What is a Drone Agent ?
Pandora FMS Drone Agent is a running mode of Pandora FMS Software Agent. This running mode
only works on Windows and Linux machines.
Pandora FMS Drone Agent was developed to deal with complicated environments with restricted
access to the machines. The Drone Agent has two main features:
• Proxy mode
• Broker mode
Furthermore running this mode Drone Agent can report data and use all features of standard
Pandora FMS Software Agent.
The picture below shows an architecture of Pandora FMS using Drone Agents:

Proxy Mode

Proxy Mode is very useful for networks that have restrictions in their communications. The agent
running this mode enabled a Tentacle Proxy Server to allow agents communicate with Pandora FMS
Server through itself.
The new Tentacle version supports proxy usage (HTTP/Connect mode), so agents can contact
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directly with the server using an intermediate standard proxy. You also can use a new tool called
Tentacle Proxy Server, which as its name says, is used to centralize all communication between
Pandora FMS and the agents, allowing the file management and remote configuration for policy
basedmonitoring. You can see more about Tentacle Proxy Server here.
With this feature you get all functionalities of a proxy but managed by Pandora FMS Software
Agent. This mode has two requirements and are that the agent must cannot be run by the root
and if you want to use the proxy mode with Unix agent then must be installed with a user
without root privileges (the same user will execute later the agent in proxy mode).
All parameters to configure Tentacle Proxy Server are available trough agent configuration file, and
are the following:
server_ip
Is the IP address or the name of Pandora FMS server host. Be careful with Proxy Mode enabled
this parameter cannot take values such as: 127.0.0.1, locahost, 0.0.0.0, or related.
proxy_mode
Proxy mode status. If proxy_mode is 1 Proxy feature of Drone Agent is activated, If proxy_mode is 0
Proxy feature is off. By default this feature is disabled.
proxy_max_connection
Number of proxy simultaneous connections. By default 10 connections are allowed.
proxy_timeout
Timeout for proxied server. By default 1 second.
11.3.9.1.1.1.

Usage Examples

I only have one connection to Pandora FMS Server
This situation is not a problem for Pandora FMS Drone Agent. To configure Proxy Mode just set
server_ip to Pandora FMS IP and proxy_mode parameter to 1. If is needed you can configure some
parameters like the number of connections and timeout. With this configuration you will have the
agent and the Tentacle Proxy Server up and running in the machine that can connect with Pandora
FMS Server.
To configure the other agent just set server_ip parameter to IP address of Drone Agent with proxy
mode enabled and that all. The agents will use Drone Agent to connect with Pandora FMS Server.
I must do a double proxied connection
If you need you can connect a Drone Agent to another Drone Agent, and it is very easy.
To perform the double proxy you must configure Drone Agent which can connect to Pandora FMS
Server setting server_ip to Pandora FMS IP address, proxy_mode to 1 and the other parameters if
you need.
To configure the second Drone Agent just set server_ip to first Drone Agent and of course enable the
proxy mode by setting proxy_mode to 1.
With this configuration, an agent connected to the second Drone Agent can send data to Pandora
FMS Server through the two proxies.
Broker mode

Broker mode is designed to "recreate" diferent agents (as entity) from a single software agent
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installed in a server. Broker agent execute different setups, like if it has different personalities or
different agents installed in the same server with different configurations. Each configuration file is
independent and can have it's own plugins, inventory modules, etc. Of course it can be remotely
managed, as any other agent. This is perfecto to monitor servers / comm devices nearby the Broker
mode, and useful when you cannot reach a router but can install an agent in a nearby host. You can
for example, monitor ten routers from a single agent, and have eleven agents in your Pandora FMS
console (10 routers + 1 host).
Is important to note that in the configuration of the agent set like a broker agent the broker_agent
token will be ignored.
The main features of "broker mode" are:
• Send local data with another agent name. Useful to monitoring different instances of a
software applicationn as independent agents.
• Send data from remote devices/checks executed from a single hosts, and have it in Pandora
FMS like them are different independent agents.
Examples

Send data to server with different agent names, using different configurations
Modify your pandora_agent.conf with following lines:
broker_agent router_1
broker_agent router_2
broker_agent router_3

Automatically (in next execution or restart) you will have three new files: 'router_1.conf',
'router_2.conf' y 'router_3.conf', will be an exact copy from origial "pandora_agent.conf" file,
excepting "agent_name" which will be selected from broker_agent call.
You now have four agents, with different configuration files, you can now add different modules in
each configuration file, for example, edit “router_1.conf” and add:
Sample of remote check
Add to remote configuration file 'pandora_agent.conf' following line:
broker_agent server_1

A new file will be created, called 'server_1.conf' and we will edit it to add specific modules for this
broker agent:
module_begin
module_name Check SSH Status
module_type generic_proc
module_tcpcheck 192.168.1.1
module_port 22
module_timeout 5
module_end

This configuration can interest us when making checks against another remote machine even has an
agent installed Pandora, is unattainable by the server.
This feature is available since 4.0 version.
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12.1. Monitoring with Pandora FMS
All the user interaction with Pandora FMS is done through the WEB console. The Pandora FMS
console is a WEB console that follows the last standards and WEB technologies, so it requires an
advanced browser and the optional use of Flash. It is recommended to use Firefox 2.x or higher.
You can also use Internet Explorer 8 or higher, although it gives an uncomfortable user experience,
due to its peculiar way to manage some WEB controls.
In a generic way, it is possible to say that monitoring consists in the execution of processes (through
modules) in any system in order to send its resultant data to the server. The server will process
these resultant data the frontend (WEB console) will display them to the user.
Pandora FMS is an scalable monitoring tool. It would be possible monitoring around 1200/1500
agents with an unique server, although with the correct architecture (Meta Console), the
monitoring process number could grow without restrictions.

12.1.1. Monitoring with software agent vs. Remote monitoring
There are two main monitoring procedures with Pandora FMS, the software agent based (local) and
the remote one.
The software agent based includes a piece of software (module) into the monitored system, e.g. the
measurement of the percent of CPU use in a certain system. While the remote monitoring is done
through network tests without use of modules, e.g. checking if a certain host is active.
The main difference between these two types is that whereas the software agent based is executed
from the from the monitored system, the remote monitoring is executed from the Pandora FMS
server against the target system.

12.1.2. Agents at Pandora FMS
All the monitoring that is done by Pandora FMS is managed through a generic entity called "agent",
that is into a more generic block, called group. An agent can only belong to one group.
The information is arranged in a logical way throug a hierarchy based on groups, agents, module
groups and modules. There are agents based only in the information given by a software agent and
installed in the System, and agents with exclusive network information, information that does not
come from a software agent, where installing software is not necessary , and that executes the
network monitoring tasks from Pandora FMS network servers.
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In the same way, there are agents that have network information and also information obtained
through software agents.
The information is collected in modules that are assigned (in a logical way) to Pandora FMS agents
in the console. It is important to distinguish between the concept of agent (where the modules that
contain the collected info hang ) from the software agents that are executed in remote systems.

12.1.3. Status/Event monitoring
With Pandora FMS 3.0 a new important functionality is added. It changes the way in which Pandora
FMS has been working until now. Pandora FMS allows that the user fix standars to define any data
in three possible status: NORMAL, WARNING y CRITICAL.
In an automatic way, all modules kind *proc are kept as NORMAL if they have a value of 1 or bigger
than 1, and as CRITICAL if they have a value lower than 1 (0 or a negative value).
But, what happens with a value of CPU usage? How could the system know if it is a NORMAL,
CRITICAL or WARNING value?. It does not know it by default, it only gets a numeric value and if
nothing has been said, for it all the values would be "right", this is, in NORMAL status.
There are two status fields in the agent configuration that have not mentioned before.These are the
fields:
• Warning status
• Critical status
These two fields have two values each of them, minimum and maximum. Configuring them
correctly you will get that some values will show a module as warning status and other ones as
critical status:

To understand better these options is better to see an example. The CPU module will be always on
green in the agent status , so it simply informs of a value between 0% and 100%. If we want that
the module of CPU usage will be shown in yellow (warning) when they reached the 70% of its use,
and in red when they reached the 90%. We should configure:
• Warning status:70
• Critical status:90
With this, when you reach the 90 value, the module will be in red (CRITICAL), and if it is between
70 and 89.99 it will be in yellow (WARNING9, and under 70 in green (NORMAL).
If we have a module with string type you can configure the status using regular expression in Str
fields of Warning Status and Critical Status parameters. For example we have a module that returns
OK, ERROR connection fail or BUSY to much devices, depending on the query result.
To configure the WARNING and CRITICAL module status we will sue the following regular
expressions:
Warning Status: .*BUSY.*
Crirical Status: .*ERROR.*
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You must take care because this regular expressions are case sensitive. With this module
configuration the status will be WARNING when the data contains the string BUSY and the status
will be CRITICAL when the data string contains ERROR.
If by any chance both status are configured with the same values, the critical value will have
preference, this is, the Warning state will be never reached so the Critical state is more important.
This is an example of modules in each of the status:

It is obvious that these fields have no sense for modules that only return boolean values (1 or 0).
These values are shown in the main screen of the monitor view, and you could know with a quick
look how many checks are in Normal, Warning or Critical status.

12.1.4. Other Common Monitoring Parameters
12.1.4.1. Historical

Pandora FMS allows to keep (optionally) the historical of any data, in an individual way. By default
all modules keep an historical(so they could do graphs, include them in reports kind
historical/evolutive, etc). But in a very big implantation that needs to monitor many data, it could
be possible that you do not need to keep the historic from some data, allowing this way to use less
resources.
This option allows to deactivate the historical of those modules where you do not need to keep an
historical. Even if you deactivate the historical, the alerts will continue working exactly the same,
same as the event generation and the view of the current state of this monitor.
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12.1.4.2. FF Threshold

The FF Threshold parameter (FF=FlipFlop) is used to "filter" the continuous changes of state in the
creation of events/status, so you can indicate to Pandora FMS that until an element is not at least X
times in the same status after having changed from an original status, it will not consider as if has
changed. Lets see a classical example: one ping for a host where there is loss of packages. In an
evironment of this kind, it could give results as these:

1
1
0
1
1
0
1
1
1

However, the host is alive in all cases. What we really want to say to Pandora is that until the host
does not say that is at least three times down, it does not show it as this, so in the previous case it
would never be as down, and it would only be this way in this case:
1
1
0
1
0
0
0

From this point, it will show it as down, but no before.
So the FLip_Flop protections is useful to avoid these disturbing fluctuations. All modules implement
it and its use is to avoid the change of status ( limited by its defined limits or automatic limits, as in
the case of the *proc modules).
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13.1. Agent Configuration
By default, Pandora FMS agents have a local configuration, so their maintenance will be managed
from the monitored machine, editing their configuration file.

13.1.1. Remote Configuration
On the enterprise version, there is the remote agent configuration feature. That allows, in a
centralized way from the server console, their configuration file management.
The configuration is composed by two files, their file names are <md5>.conf and <md5>.md5,
where <md5> is the agent's name hash code. Those files are stored in
"/var/spool/pandora/data_in/conf" & "/var/spool/pandora/data_in/md5" folders respectively.
Those files are composed by plain text, and could be edited from the console, which regenerate
them when there is any change. Comunication is always from the agent to the server, thus that
functionality is controlled by the agent.

In order to enable remote configure, you should edit the remote_config parameter, setting to 1,
from the pandora_agent.conf file. Once done that change, agent's configuration file will be ignored,
since detecting a change in the configuration, it will download the new version from from the
server. A good way to force the server to get the agent's local configuration is to delete both
configuration files from the server.

13.2. Common configuration parameters
At Pandora FMS software agents section you can find a complete explanation about agent
configuration. In this section there are explained the common parameters used to configure the
software agent.
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The most used parameters are:
• server_ip: IP direction of Pandora FMS Server.
• server_path: Path of incoming folder for Pandora FMS server. By default
/var/spool/pandora/data_in.
• temporal: Software agent's temporal folder. By default /var/spool/pandora/data_out.
• logfile: Software agent's log file. By default /var/log/pandora/pandora_agent.log
• interval: Agent's execution interval. By default 300.
• intensive_interval: Intensive module execution interval. By default 300.
• debug: Debug mode enable. By deafult 0 (disabled).
• agent_name: Agent name. By default hostname is taken.
• server_port: Tentacle server port. By default 41121.
• transfer_mode: File transference mode. By default tentacle.
• remote_config: Remote configuration enable. By default 0 (disabled).
An example of the general parameters from a Unix configuration would be:
server_ip
server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

192.168.1.1
/var/spool/pandora/data_in
/var/spool/pandora/data_out
/var/log/pandora/pandora_agent.log
300
0
box01
41121
tentacle
1

An example of the general parameters from a Windows configuration would be :
server_ip
server_path
temporal
logfile
interval
debug
agent_name
server_port
transfer_mode
remote_config

192.168.1.1
/var/spool/pandora/data_in
c:\program files\pandora_agent\temp
c:\program files\pandora_agent\pandora_agent.log
300
0
box01
41121
tentacle
1

13.3. Custom fields
Custom fields are an easy way to personalized agent's information. You can create custom fields at
Administration > Manage agents > Manage custom fields.
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If you want to create a custom field you have to click on "Create field" button and fill the fields
described bellow:

• Name: Name of the custom field.
• Display on front: With this field checked the custom field will be displayed in front of the
agent like in the screenshoot bellow:
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13.4. Monitoring with the software agent
Data collected by the software agents is kept in small information pieces called «modules».Each
module keps only a kind of data. Each module value is the value of a supervised variable. Once the
agent starts sending information, data will start to consolidate at database and you will have access
to them.
Check the Software Agents Installation Section to obtain more information about them.
The Pandora FMS software agents use the Operative system specific commands to obtain
information. The Pandora FMS data server keeps and processes data generated by these commands
that are send to the server in an XML file. The information that has been returned by these
commands is contained in what we call «Modules».

In agent configuration file the modules are defined by the following structure:
module_begin
module_name cpu_user
module_type generic_data
module_exec vmstat 1 2 | tail -1 | awk '{ print $13 }'
module_description User CPU Usage (%)
module_end

The parameter that indicate how to get the module information is module_exec. This parameter
specifies the command that the agent should execute in order to get the information from the
system. An example could be:
module_exec vmstat 1 2 | tail -1 | awk '{ print $13 }'
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The agent will execute the command as an operator will do to collect the information:
$> vmstat 1 2 | tail -1 | awk '{ print $13 }'

Then the agent gets the value returned by the command and appends it to the XML as the module
data. Of course the agent can execute any program or script that returns the monitoring value. For
example the field module_exec could be:
module_exec myScript.pl --h 127.0.0.1 -v cpu

Again the agent will execute the command and collects the returned value, in the same way as an
operator will type in the shell:
$> myScript.pl --h 127.0.0.1 -v cpu

When the software agent is executed for the first time, it sends an XML to the Pandora FMS data
server, that recives it through Tentacle, SSH or FTP in the server entry directory. The data server
checks this directory every X time, and when it finds a file, it processes it. At opening this data file,
consisting on an XML, it identifies the agent by its name, in a unique way, this is, each agent needs
to have a completely unique name, where the capital and small letters are distinguished by Pandora
FMS.By default, the server creates automatically all agents from which it receives data and that are
not logged in at the DDBB. In the same way, if the agent has been added in the «learning» mode,
then the modules that have not been previously defined in the agent will be created automatically
by the server.

Configuration file encoding it's very important and must be the same that value set in
encoding configuration parameter. If encoding is set properly we will avoid to receive
data with wrong encoding characters

13.4.1. Kinds of modules
There are several kinds, mainly classified in two: data with origin at software agents and data with
origin at network modules executed by a network server. Those identified as «generic» are modules
with origin at software agents and those identified as «remote» are network modules.
generic_data
Kind of numerical data. It is useful to keep numerical data(whole numbers and in floating
comma)obtained through one Pandora FMS agent module.
generic_data_inc
Kind of increasing numerical data.It keeps data that are the result of the difference between the last
agent data and the current data.Pandora FMS server calculates and keeps the rate by second in an
automatic way. All of the modules ended in «inc» are of incremental kind. These kind of data is
used to count the "nº of times " of something, for example the entries in a log, bytes/sec,
connexions/sec, etc.
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generic_proc
Also generically called "monitors". They are a boolean kind of data. Where a value 0 means false or
«Bad value», and values higher than 0 means right or « right value».The «Generic Proc» kinds are
also called monitors, because they can show if something is right or not without needing to
interpret it or stablish alerts on it. They are displayed in the agent view as small lights. Red if it is
zero, green if it is higher than zero. All of the modules ended in «proc» are monitors.
generic_data_string
Kind of alphanumeric data (text).
async_data
Kind of asynchronous numeric data. Same as the generic_data but for asynchronous data, that are
updated only when there is a change. The asyncrhonous data kinds have not a defined periodicity
when we can obtain data.
async_string
Kind of asynchronous alphanumeric data. Same as the generic_string but for asynchronous data,
that are only updated when there is a change. Is the kind of data that we should use to monitor
searches in logs or event viewers, so we could have one data by second or not having one in many
days.
async_proc
Kind of asynchronous boolean data. Same as generic _proc but for asynchronous data, that are only
updated when there is a change.
The software agent comes already configured to send certain data from the system where it is
installed. These usually are (depending on the version):
•
•
•
•

System CPU
Free space at disk
Free memory
Monitor of the program and/or services state

Depending on the software agent would be for an operative system or another, they use to have
more modules or different checkings.
All these information is located in the file pandora_agent.conf. This file is in the
directory/etc/pandora/ in GNU/Linux and in the predetermined Windows installation directory
(C:/Archivos de Programa/pandora_agent/ o C:/Program Files/pandora_agent/, o similares).
Next we are going to explain the data for some of the modules:
CPU usage percentage at GNU/Linux
# CPU usage percentage (GNU/Linux)
module_begin
module_name cpu_user
module_type generic_data
module_interval 1
module_exec vmstat 1 2 | tail -1 | awk '{ print $13 }'
module_max 100
module_min 0
module_description User CPU Usage (%)
module_end

It could be seen that the kind of module is generic_data, and that it executes a GNU/Linux console
command to obtain the result (module_exec). It is known that the maximum is 100 and the
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minimum 0. The interval (module_interval) represents the number or iterations between the
execution of each module, if it is different from 1, the module will only start the execution of agent
every these number of times. This is, if the agent execution time is 300 and the module interval is 3,
then the module will be executed every 3* 300 = 900 seconds.
CPU usage percentage in Windows:
# CPU usage percentage (Windows)
module_begin
module_name CPUUse
module_type generic_data
module_cpuusage all
module_description CPU#0 usage
module_end

It is possible to check that the module is completely different in Windows and in GNU/Linux. In
Windows it is an internal agent command, where module_cpuusage all represents the CPU usage
in all CPU. Using module_cpuusage it will calculate the CPU usage only in the CPU #0. The rest of
the fields are optionals.
To add one more module,please check the agent configuration and create a valid module block.
Once done this, keep the agent configuration file and restart the agent, would be this the UNIX
daemon or the Windows service.

13.4.2. Conditional monitoring
Pandora FMS software agent supports the execution of script as postcondition depending on the
module value. Also the sofware agent has a feature to evaluate a precondition before the module
execution. In this section both features will be explained with examples.

13.4.2.1. Postconditions
The parameter module_condition defines a postcondition on module execution. It means that this
parameters defines the command that will be executed depending on the value returned by the
module. The structure in the configuration file is:
module_begin
module_name CPU_Usage_Condition
module_type generic_data
module_exec get_cpu_usage.pl
module_condition < 20 add_processes.sh
module_end

You can define multiple postconditions for the same module. For example:
module_begin
module_name CPU_Usage_Condition
module_type generic_data
module_exec get_cpu_usage.pl
module_condition (90, 100) remove_processes.sh
module_condition < 20 add_processes.sh
module_end

190

Monitoring with the software agent

Some examples:
Execution when the module data is less than 20:
module_begin
module_name CPU_Usage_Condition
module_type generic_data
module_exec get_cpu_usage.pl
module_condition < 20 add_processes.sh
module_end

If the script get_cpu_usage.pl returns 18, then the software agent will execute the script
add_proceses.sh, otherwise not.
Execution with two preconditions:
module_begin
module_name CPU_Usage_Condition
module_type generic_data
module_exec get_cpu_usage.pl
module_condition < 10 start_new_server.sh
module_condition < 20 add_processes.sh
module_end

If the module returns 15, the software agent will only execute the script add_processes.sh. But if the
value is 6 the script will execute both scripts start_new_server.sh y add_processes.sh

13.4.2.2. Preconditions
The parameter module_precontition defines a precondition to evaluate before a module execution,
depending an the result of this precondition the software agent will execute the module or not. The
structure in the configuration file is:
module_begin
module_name CPU_Usage
module_type generic_data
module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_end

You can define multiple preconditions for the same module. For example:
module_begin
module_name CPU_Usage
module_type generic_data
module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_precondition = 1 important_service_enabled.sh
module_end

Some examples:
Module execution only when the precondition is above 10:
module_begin
module_name CPU_Usage

191

Monitoring with the software agent

module_type generic_data
module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_end

In this example first of all the software agent executes the script number_active_processes.sh, if the
returned value is greater than 10 then the module is executed. If the returned value is lower than
10 the module will never be executed.
Module execution only if two preconditions are accomplished:
module_begin
module_name CPU_Usage
module_type generic_data
module_exec get_cpu_usage.pl
module_precondition > 10 number_active_processes.sh
module_precondition = 1 important_service_enabled.sh
module_end

In this example we have two preconditions. All preconditions must be accomplished to execute the
module, in this case both. The module will only be executed when the script
number_active_processes.sh returns a value greater than 10 and when the script
important_service_enabled.sh returns 1.

13.4.3. Intensive monitoring
(Only available in 5.0 version or higher)
For some modules certain values are very important, while others are not. For example, when you
are monitoring a system service, you want to be notified as soon as possible if the service goes
down, but you don't need to be reminded the service is up every ten seconds.
This is what intensive modules are for. Intensive modules run with an interval of intensive_interval
seconds while intensive conditions are met, the rest of the time they run with an interval of interval
seconds like the rest of the modules.
For example, if you want to check whether the sshd system service is running every 10 seconds, but
want to be notified every 10 minutes if the service is fine, you can configure the agent like this:
intensive_interval 10
interval 600
module_begin
module_name SSH Daemon
module_type generic_data
module exec ps aux | grep sshd | grep -v grep | wc -l
module_intensive_condition = 0
module_end

If the service goes down, you will be notified in the next 10 seconds, but if the service is up, you will
be notified in the next 10 minutes.
This can save a lot of space in Pandora FMS's database.
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13.4.4. Programmed monitoring
The software agent support the definition of programmed modules that are executed in the instants
defined. The syntax is the same as crontab http://es.wikipedia.org/wiki/Cron_(Unix)#Sintaxis. The
module structure is the following:
module_begin
module_name crontab
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_end

In this example the module is executed once, every Monday from 12 to 15.
If you want a module that is executed during all the interval we must set the option
module_cron_interval to 0 in this way:
module_begin
module_name crontab
module_type generic_data
module_exec script.sh
module_crontab * 12-15 * * 1
module_cron_interval 0
module_end

If we need to execute the module every hour past ten minutes we can use this module definition:
module_begin module_name crontab module_type generic_data
module_crontab 10 * * * * module_cron_interval 0 module_end

module_exec

script.sh

13.4.5. Windows platforms specific monitoring
The software agent for Windows platforms has specific features for this platform to make
monitoring easier. Following these feature are explained with some examples.

13.4.5.1. Monitoring processes and process watchdog
Monitoring de processes

The parameter module_proc chekcs if a process with given name is running in this machine. The
module definition is:
module_begin
module_name CMDProcess
module_type generic_proc
module_proc cmd.exe
module_description Process Command line
module_end

If the process name has blanks, don't use «" "». The process name is the same as showed in
Windows Task Manager (taskmngr) including the .exe extension, its very important to use the
same uppercase and lowercase.
If you want the software agent to notice you immediately when a process is not working you must
add the parameter module_async yes, the module definition would be:
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module_begin
module_name CMDProcess
module_type generic_proc
module_proc cmd.exe
module_async yes
module_description Process Command line
module_end

Process watchdog

The watchdog feature on Pandora Agent for Windows, allows to react immediately to the crash of a
process, raising it again. It is important to remark that the watchdog only works if the module is
asynchronous.
The definition of a module with watchdog would be like this:
module_begin
module_name Notepad
module_type generic_data
module_proc notepad.exe
module_description Notepad
module_async yes
module_watchdog yes
module_start_command c:\windows\notepad.exe
module_startdelay 3000
module_retrydelay 2000
module_retries 5
module_end

In the previous sample, the watchdog will only activate each time notepad.exe process is not
running, and will execute the command c:\windows\notepad.exe each time. Other parameters
configured for the watchdog execution are to try 5 times, with a warmup time (delay before try) of
3 seconds, and a time between attempts of 2 seconds.

13.4.5.2. Service monitoring and service watchdog
Service monitoring

The parameter module_service checks if a specified service is running in the machine. The
definition of this module is:
module_begin
module_name Service_Dhcp
module_type generic_proc
module_service Dhcp
module_description Service DHCP Client
module_end

Remember to use «" "» if the name of the service has blanks. To find the service name you can look
at the Service Name field in Windows Service Manager. Its important to respect uppercase and
lowercase.
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As with the processes if we want the software agent to notice us immediately when a service is
down we must add the parameter module_async yes. The module definition would be:
module_begin
module_name Service_Dhcp
module_type generic_proc
module_service Dhcp
module_description Service DHCP Client
module_async yes
module_end

Service Watchdog

As with processes there is a watchdog mode for services that allow you to detect and restart a down
service almost in realtime. A module definition example using watchdog is like this:
module_begin
module_name ServiceSched
module_type generic_proc
module_service Schedule
module_description Service Task scheduler
module_async yes
module_watchdog yes
module_end

The watchdog definition for services doesn't need any extra parameter because they are in the
service definition.

13.4.5.3. Monitoring basic resources
This section describes how to monitor basic variables of a Windows machine.
Monitoring CPU

To monitor the CPU you can use the parameter module_cpuusage that returns the percentage cpu
usage.
Its possible to monitor the cpu based on its id with the following module definition:
module_begin
module_name CPU_1
module_type generic_data
module_cpuusage 1
module_description CPU usage for CPU 1
module_end

Also you can monitor the average of CPU usage from all system with the module:
module_begin
module_name CPU Usage
module_type generic_data
module_cpuusage all
module_description CPU Usage for all system
module_end
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Monitoring memory

To monitor the memory you can use two parameters module_freememory that returns the amount
of free memory in the system and module_freepercentmemory that returns the percentage of free
memory.
An example module usgin module_freememory would be:
module_begin
module_name FreeMemory
module_type generic_data
module_freememory
module_description Non-used memory on system
module_end

A module using module_freepercentmemory would be defined in this way:
module_begin
module_name FreePercentMemory
module_type generic_data
module_freepercentmemory
module_end

Monitoring disk

To monitor the disk space you can use two parameters: module_freedisk that returns the amount
of free space and module_freepercentdisk that returns the percentage of free space. Both
parameters require the unit to monitor as an input, don't forget the character «":"».
A module that uses module_freedisk is define in this way:
module_begin
module_name FreeDisk
module_type generic_data
module_freedisk C:
module_end

An example moudel that uses the parameter module_freepercentdisk is defined with this
structure:
module_begin
module_name FreePercentDisk
module_type generic_data
module_freepercentdisk C:
module_end

13.4.5.4. WMI queries and SQL queries via ODBC
Pandora FMS software agent allows you to extract information using WMI queries and ODBC
connexions, very common technologies used to store information related to the system or external
to it.
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WMI queries

Using the parameter module_wmiquery the software agent allows you to execute any local WMI
query you want. To do the query you must set the parameter module_wmiquery with the query
that will be performed and module_wmicolumn with the column which has the information to
monitor.
For example, we can get a list with the services installed:
module_begin
module_name Services
module_type generic_data_string
module_wmiquery Select Name from Win32_Service
module_wmicolumn Name
module_end

Using WMI we can also get the CPU load:
module_begin
module_name CPU_Load
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
module_end

ODBC queries

This module allows you to get generic information from a database using the ODBC interface. This
module only works with 32 bits driver for ODBC so if you are using a 64 bits version of Windows
you must ensure that you are using the 32 bits driver for ODBC.
This module makes easy the access to data no matter what database server you are using Microsoft
SQL Server, Oracle, MySQL o PostgreSQL.
To use ODBC modules you must define an ODBC handler first in the main section of software agent
configuration file, an example would be like this:
odbc_WebDSN_username UserNameForDsn
odbc_WebDSN_password Password1234

With this two parameters we create the DSN handler called "WebDSN" that we will use later:
An example performing a query could be:
module_begin
module_name Web_Users
module_type generic_data
module_odbc WebDSN
module_odbc_query SELECT COUNT(*) FROM webdb.users_logged
module_description Get users logged
module_end

This example performs a query to a database called webdb and counts the number of users logged in
the system.
• NOTE: Nowadays the ODBC module only returns the first row of the query.
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You can monitor data from multiple databases creating other ODBC handlers and any modules you
need.

13.4.6. Remote checks with software agents
Remote check performed by the agent make easy to monitor clompex network with special
requirements for example related to security issues. This sections explains how to use this feature of
software agent.

13.4.6.1. ICMP checks
ICMP or ping checks are very useful to know if machine is connected to a network. This way one
software agent can monitor the status of the whole network easily.
Unix
Using Unix software agent you can use the system commands to create a module that performs a
ping check. The module definition would be:
module_begin
module_name Ping
module_type generic_proc
module_exec ping -c 1 192.168.100.54 >/dev/null 2>&1; if [ $? == 0 ]; then echo 1;
else echo 0; fi
module_end

In this example module we perform a ping checl to the host 192.168.100.54, if you want to check
another host you only need to change the IP.
Windows
The software agent for Windows platforms has some parameters to configure the ping checks and
are the following:
• module_ping_count x: Number of ECHO_REQUEST packages to send (By default 1).
• module_ping_timeout x: Timeout in miliseconds (By default 1000).
• module_advanced_options: Opciones avanzadas para ping.exe.
An example of a module configuration could be:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end

In this example we perform the same check that in the previous one, but now we use the software
agent for Windows platforms.
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13.4.6.2. TCP checks
TCP checks are useful to verify if a port of a host is open. It could be interesting to know if an
application is connected to the network or not.
Unix
With the software agent for Unix platforms we could perform the TCP check with the following
module:
module_begin
module_name PortOpen
module_type generic_proc
module_exec nmap 192.168.100.54 -p 80 | grep open > /dev/null 2>&1; echo $?; if [ $?
== 0 ]; then echo 1; else echo 0; fi
module_timeout 5
module_end

With this module we check if the port 80 of the host 192.168.100.54 its open or closed.
Windows
If we are using the software agent for Windows we have some parameters to configure the TCP
check. The parameters are:
• module_tcpcheck: Host to be checked
• module_port: Port to be checked
• module_timeout: Timeout for the check
An example of a module definition would be:
module_begin
module_name TcpCheck
module_type generic_proc
module_tcpcheck 192.168.100.54
module_port 80
module_timeout 5
module_end

This module is the equivalent for the Windows software agent to perform the check on 80 port of
host 192.168.100.54

13.4.6.3. SNMP checks
SNMP checks are commonly used to monitor network devices to check interface status,
inbound/outbound bytes, etc.
Unix
If you are using the software agent for Unix platforms you can create the module using the
command snmpget like the following:
module_begin
module_name SNMP get
module_type generic_data
module_exec snmpget 192.168.100.54 -v 1 -c public .1.3.6.1.2.1.2.2.1.1.148 | awk
'{print $4}'
module_end
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This module returns the value for OID .1.3.6.1.2.1.2.2.1.1.148 of the host 192.168.100.54.
Windows
For Windows software agent we have the following parameters to configure the module:
•
•
•
•
•

module_snmpversion [1,2c,3]: SNMP version (By default 1).
module_snmp_community <community>: SNMP community (By default public).
module_snmp_agent <host>: Host to monitor.
module_snmp_oid <oid>: OID.
module_advanced_options: Advanced options for snmpget.exe.

An example module could be:
module_begin
module_name SNMP get
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.148
module_end

This module is the equivalent for Windows platforms to do the last check performed using Unix
software agent.

13.4.7. Proxy Mode
Pandora FMS software agents have a Proxy Mode that allows them to act as proxies redirecting the
the communication of several agentrs to Pandora FMS server. The software agent that has Proxy
Mode enabled can perform monitoring task too.
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The Proxy Mode is very useful when you are dealing with a network in which only one machine can
communicate with Pandora FMS server. In this situation all software agents installed in machines
without access to Pandora FMS server will send the XML files to the agent working as a proxy and it
will redirect all files to Pandora FMS server.
In addition to XML file redirection the Proxy Mode supports Remote Configuration and File
Collection features.
To enable the Proxy Mode in a software agent you must configure the parameters:
• server_ip: IP of Pandora FMS server. With Proxy Mode enabled the IP can't take this value:
127.0.0.1, localhost, 0.0.0.0, o similar.
• proxy_mode: If is set to 1 enabled Proxy Mode. By default is 0, disabled.
• proxy_max_connection: Max. number of connections for proxy, by default 10.
• proxy_timeout: Proxy tiemout, by default 1 second.
An example of configuration could be:
server_ip 192.168.100.230
proxy_mode 1
proxy_max_connection 20
proxy_timeout 3

To reditect an software agent connection you only must to set the IP address of software agent with
Proxy Mode enabled as the IP address of Pandora FMS server in the agents with limited access. For
example:
Our agent with Proxy Mode enabled has this IP: 192.168.100.24
In the software agent that can't connect directly with Pandora FMS server we configure the
parameter server_ip with this IP:
server_ip 192.168.100.24

This configuration allows the software agent with limited access to use the other software agent
with Proxy Mode enabled to communicate with Pandora FMS server.
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13.4.8. Broker Mode
The software agent has a Broker Mode that allow one agent to monitor and manage the
configuration as if several software agents would be installed.

The software agent with Broker Mode enabled has an auxiliary configuration file, similar to
software agent main configuration file, for each broker defined. In this way the software agent
behaviour is the same as if several software agent would be installed in the same machine, it means,
each broker works in the same way that a software agent does. This feature is very useful to
manage several devices remotely only installing one software agent, in this way is possible to
monitor several devices with different configuration files but installing only one software agent.
The main features of Broker Mode are:
• Send local data as other agent. Very useful to monitor different software instances as
different agents.
• Send data collected from remote checks to other machines as if a software agent had been
installed on them.
To create a broker you only need to add a line with the parameter broker_ Para crear un broker
sólo tiene que añadir una línea con el parámetro broker_agent <nombre_broker> como estas:
broker_agent dev_1
broker_agent dev_2

Once the brokers were created the configuration files dev_1.conf and dev_2.conf will be created with
the same content that in the original software agent only the agent name will be changed. Adding
or deleting modules from configuration files dev_1.conf and dev_2.conf we can customize the checks
performed by the brokers.
Inside Pandora FMS web console the brokers appear and are managed as the other agents. It
means that if we have a software agent installed with two brokers, in the web console we will see
three different agents with their modules, configurations, etc.
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13.4.8.1. Examples of use
Monitor a local database as a different agent

We want to monitor the basic parameters of a machine (CPU, memory and disk) and also there is a
database installed that we want to monitor separately.
To perform this monitoring we will use the following structure:
• Software agent installed: monitoring CPU, memory and disk.
• Broker for database: monitoring internal status of database.
To do this we install the software agent in the machine to monitor CPU, memory and disk. In the
software agent configuration we add the following line:
broker_agent DBApp

With this line we create a broker agent called DBApp because of that a configuration file named
dbapp.conf will appear. In this configuration file we add the modules to perform checks to
database:
module_begin
module_name Num Users
module_type generic_data
module_exec get_db_users.pl
module_end
module_begin
module_name Num slows queries
module_type generic_data
module_exec get_db_slows_queries.pl
module_end

With this you will see two agents in Pandora web console one with the name of the machine and
with the modules CPU memory and disk and the other called DBApp with the modules Num Users
and Num slows queries.
Monitor devices remotely using brokers

For this example we have a software agent installed in a Windows machine monitoring (CPU,
memory and disk) and we need to monitor a router with IP 192.168.100.54 without installing an
agent inside. To solve the problem we can use brokers.
We create a borker using the parameter;
broker_agent routerFloor5

With this line we create a boker agent with the name routerFloor5 and because the software agent
were installed in a Windows machine we can monitor the router using the ping and snmp modules
available for Windows software agents. To do that we modify the file routerFloor5.conf adding the
lines:
module_begin
module_name Ping
module_type generic_proc
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module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name Eth 1 up
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.1
module_end
module_begin
module_name Eth 2 up
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.2
module_end

In this example the web console of Pandora FMS shows two agents, one is the Windows machine
with the modules CPU, memory and disk and the other is routerFloor5 with the modules: Ping, Eth
1 up and Eth 2 up.
Remote monitoring of network with restricted communication

In some cases is needed to monitor devices remotely but Pandora FMS Remote Server can't access
to them directly.

In this example we must monitor remotely the devices of one of the company sites from the
headquarters. Pandora FMS server is in the headquarters connected to the other company sites
using a VPN, due to some restrictions the Pandora Remote Server can't access the machines
remotely. To monitor the company sites we will use the Broker Mode that allows a software agent
to send XMLs to Pandora server as if it would be several different devices.
In the configuration file of software agent we add as many brokers as devices to be monitored. A
configuratio example could be:
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broker_agent
broker_agent
broker_agent
broker_agent
...

device_1
device_2
device_3
device_4

Once the broker were created we can customize the monitoring for each devices modifying the
configuration file of each broker. For example the configuration for the Windows machine called
device_1 is:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name CPU_Load
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
module_end
module_begin
module_name Mem_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Memory
module_wmicolumn FreeMemory
module_end
module_begin
module_name Disk_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Disk
module_wmicolumn FreeSpace
module_end

With this configuration we can use remote configuration feature and we can send monitoring
information to Pandora FMS server despite of the restrictions in communication between the
different company sites.
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Share monitoring load through brokers

The Broker Mode is very useful to distribute the monitoring load within several network points.

In this example our architecture has several networks named from A to Z with 1000 devices each
one. The capacity of Pandora FMS Remote Server is about 2000 agents, because of that we decide
to use software agents with Broker Mode enabled to distribute the load. These software agents with
Broker Mode enabled monitor remotely all devices from the network and send the data in XML
format to Pandora FMS central server.
For each network we have an agent with Broker Mode enabled, inside it we create as many brokers
as devices to be monitored, configuration for the software agent Broker_Agent_Net_A would be:
broker_agent
broker_agent
broker_agent
broker_agent
...

device_1
device_2
device_3
device_4

In addition for each broker we will add the modules to monitor the devices. For example the broker
device_1 which is a router would have this configuration:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name Eth 1 up
module_type generic_data
module_snmpget
module_snmpversion 1
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module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.1
module_end
module_begin
module_name Eth 2 up
module_type generic_data
module_snmpget
module_snmpversion 1
module_snmp_community public
module_snmp_agent 192.168.100.54
module_snmp_oid .1.3.6.1.2.1.2.2.1.1.2
module_end

Another example would be the broker device_2 which monitors a Windows machine with the
following modules:
module_begin
module_name Ping
module_type generic_proc
module_ping 192.168.100.54
module_ping_count 2
module_ping_timeout 500
module_end
module_begin
module_name CPU_Load
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Processor
module_wmicolumn LoadPercentage
module_end
module_begin
module_name Mem_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Memory
module_wmicolumn FreeMemory
module_end
module_begin
module_name Disk_Free
module_type generic_data
module_wmiquery SELECT LoadPercentage FROM Win32_Disk
module_wmicolumn FreeSpace
module_end

Using software agents with Broker Mode enabled we can share the load to collect data from
thousand of devices easily.

13.4.9. Inventory using software agents
Pandora FMS software agent support inventory features for both hardware and software. The
inventory system allows you to get a history of CPU, cards, memory, patches, software, etc … used
in the company servers. Furthermore is possible to generate alerts when a change occurs in the
inventory, for example if a disk was replaced or if an application was deleted.
You can find more information in section Local Inventory with Software Agents .
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13.4.10. How to ask agent for information on demand
Until 3.2 version, you didn't have any way for asking the remote software agent for information,
you should wait to the agent to reach its interval limit and wait it to send its information. Windows
agent 3.0 has a non very known feature called "UDP Server" which allow to receive communications
from outside to ask for information and to force the agent to refresh its cycle, forcing it to send the
information to the server.
Now, in 3.2 version we have implemented the same feature: REFRESH AGENT in the Unix agent as
well, and we have included a "default" alert template and command to make it easy. You now can
setup your agents (Windows and Unix) to receive orders from the console to report data
immediately, without waiting for it's interval.
This feature is pretty simple, first you need to setup your agent (windows or Linux) to accept
outside connections on a specific UDP port, from a specific IP address (or 0.0.0.0 for anyone). In
Windows you can also define other possible things the agent can execute, as a result of a remote
command. On Unix the only supported (at this time) operation is "REFRESH AGENT". That will
result on an immediate agent execution, skipping its interval.
This is a sample of the UDP server settings in the Unix software agent v3.2 :
udp_server 1
udp_server_port 41122
udp_server_auth_address 0.0.0.0

Enable the server with 1 and disable with 0 in "udp_server" option. Set 0.0.0.0 as source ip address
to enable any IP address.
This is a sample of the UDP server settings in the Windows software agent v3.x:
udp_server 1
udp_server_port 41122
udp_server_auth_address 192.168.1.23

Is exactly the same, and in this case, we use the address 192.168.1.23 as the only authorized IP
address to refresh this agent.
Pandora FMS server has a small script, which send the order to the agent. In the default command
we have created, its fully operational and ready to be used. This script is a small Perl script which
acts as a small client to communicate with the simple UDP server embedded in the agent and sent
commands passed in command line.
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We also provide a default alert template to assign "manual" alerts to an agent, that means, an alert
which never will be fired automatically. You will use "manual alerts" to force execution manually
using the round button on the agent main view, to force the execution of the alert command.

We have created a default alert action called "Restart agent", which call to the remote agent
command. This action pass the REFRESH AGENT command to the command, and uses the main IP
address of the agent to reach, using the default port for the UDP server (41122/UDP):
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Follow these steps to enable the software agent remote refresh option:
1. Set up the options in the configuration file for the software agent (Unix or Windows). Please take
care of the authorized ip address (is Pandora FMS server behind a NAT?), or put 0.0.0.0 to allow
any IP address to force refresh the agent.
2. Restart the software agent.
3. You need to setup the IP address on your agent item in the Pandora FMS console. Alert action
will use the IP address to connect the software agent running in the remote system.
4. Set an alert to any of the modules of that agent (no matter which), using this screenshot as a
sample guide:

5. You're ready now to force a refresh for that agent using the main view, clicking in the round
green button at the left of the alert you've just defined:

Anytime you want to get the information from the agent "at once" without waiting for agent
interval, just click in the button and wait a few seconds. Agent will be contacted and forced to
execute, XML will be transferred to your Pandora FMS server and it will be processed, depending on
your system load, it will be processed in 15 secs and displayed in the console.

13.4.11. Using software agent plugins
Agent plugins are executed by the software agent, and could report several information (modules)
at once. Each plugin works in a different way and you should test how it works before using it.
Default instalation of Pandora FMS comes with a bunch of plugins. Of course, Unix agents and
Windows agents comes with different plugins, some of them works very similar.
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13.4.11.1. On Windows systems
In 3.2 version, windows agent comes with following plugins:
• df.vbs: Reports disk space in bytes. Report different modules for each harddisk found on
system. If you want only to report specific units, just use parameters after the module_plugin
call.
• df_percent.vbs: Very similar to previous one, but will report free space on %. Will generate
modules with a name like "DiskFree_C".
• logevent_log4x.vbs: Read eventlog entries and generate log4x data.
• ps.vbs: It will require process names, and check if that process are running. For example: if
you execute it with "iexplorer.exe mucommand.exe other.exe" will check for three processes
and will return different modules for each of them, reporting if proccess is down or alive.
In windows, all default plugins are coded in VBScript. To run it you will need to use the correct
interpreter for console VBScript, sometimes referred as Windows Scripting Host
These are examples of usage of previous plugins:
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\logevent_log4x.vbs"
Aplicacion System 300
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\df.vbs"
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\ps.vbs"
iexplore.exe myapp.exe

13.4.11.2. On Unix systems
In 3.2 version, generic Unix agent comes with following plugins:
• files_indir: This plugn receives a target directory, for example "/tmp" and will return two
modules, one called "FS_/tmp/" (boolean) returning 1 if contains the same number of files
than in the previous execution, and other module "NumFiles_FS_/tmp/" with the number of
files in that directory.
• grep_log: Is a generic log parser, it takes tree arguments: <file_to_process>
<module_name> <reg_exp>. It will generate information inside a async_string
moduletype called <module_name> using all data which match the <reg_exp> regular
expression. See example below on this plugin.
• pandora_df: Very similar to the Windows plugin, will report available space on all mounted
partition on system. It also takes information from the NFS mounts. By default information
for all filesystems is returned, but one or more filesystems may be specified as plugin
parameters.
These plugins are very similar to Windows plugins. We don't need to use the full path to plugins,
because module_plugin directive look for "plugin" directory under the agent's home dir. For execute
them, we use this syntax:
module_plugin grep_log /var/log/syslog Syslog .
module_plugin pandora_df tmpfs /dev/sda1
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And some special plugins working on Unix:
• nagios_plugin_wrapper: This is not really a "plugin"; this is just a wrapper used to execute a
Nagios plugin and process the output to generate a pandora module. It takes the standard
output and put the result in the module description and gets the errorlevel to process a
module_proc (boolean) module with its results. Just call the nagios plugin as parameter to
nagios_plugin_wrapper with all it's needed parameters and it will generate a Pandora Fms
module.
• inventory: This is used in the inventory system. It will create a Inventory XML with
information about the system, could be modified to gather different information, but default
works only in Linux and gets packages, services in default runlevel and other options.
Checkout the inventory documentation for more information.
• pandora_update: This is used to use the autoupdate feature on software agents, checkout
the agent configuration section for more information.

13.4.11.3. Examples using plugins
The plugins for software agents can return one data or a group of them. An example of a plugin that
only returns one data could be the plugin ps.vbs for Windows. With the following line we execute
the plugin:
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\ps.vbs"
IEXPLORE.EXE

The result will be a module that return 0 if the process is down and 1 if the process is running:
<module>
<name><![CDATA[IEXPLORE.EXE]]></name>
<description><![CDATA[Process IEXPLORE.EXE status]]></description>
<data><![CDATA[1]]></data>
</module>

An example of a plugin that returns several data could be the plugin df.vbs for Windows. The line to
execute the plugin would be:
module_plugin cscript.exe //B "%ProgramFiles%\Pandora_Agent\util\df.vbs"

The plugin returns a module per disk found, the result would be:
<module>
<name><![CDATA[C:]]></name>
<description><![CDATA[Drive C: free space in MB]]></description>
<data><![CDATA[8050]]></data>
</module>
<module>
<name><![CDATA[D:]]></name>
<description><![CDATA[Drive D: free space in MB]]></description>
<data><![CDATA[900]]></data>
</module>
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13.4.12. How to create your own agents plugins
The plugins can be developed in any programming language. They must respect this two
restrictions:
• Whatever you want to do, it must be automatic (no interactive processing from the user),
and must be done from the commandline (shell). You can use any kind of scripting language
or compiled language, but in that case you must provide a standalone executable with all it's
dependencies (libraries, dll, etc).
• Plugin must report the information to the standard output (just using echo, printf, or the
equivalent in your language), and use the XML syntax for Pandora FMS agent information,
this is an example of a generic_data (numerical information) XML:
<module>
<name><![CDATA[Sample_Module]]></name>
<type><![CDATA[generic_data]]></type>
<data><![CDATA[47]]></data>
<description><![CDATA[47]]></description>
</module>

The <![CDATA[xxx]]> are used to "enclose" data and protect the XML from nonvalid characters
like <,>,& or %.
Before trying to create your own plugin, take a look at our Pandora FMS plugin library at
http://pandorafms.org, and if you want to create your own, please upload to Pandora FMS public
library to allow others use your plugin!.

13.4.13. Using nagios plugins from the agent
Nagios has a lot of amazing plugins you can use with Pandora FMS. One way is to use remote
plugins with the Plugin Server, using the nagios compatibility, but they only get it's status, doesnt
use the descriptive output which some plugins for nagios have.
Using the wrapper for use nagios plugins in the software agent will solve this problem. The wrapper
comes with default with 3.2 Unix agent. A equivalent plugin for Pandora FMS Windows agents can
be downloaded from our website at http://pandorafms.org resource library at [1]).
What does the plugin wrapper for nagios plugins ?
Execute the nagios plugin, using it's native parameters, and converting the output in a data useful
for Pandora FMS, it has two kind of information:
• Status information: NORMAL (1), CRITICAL (0), WARNING (2), UNKNOWN () and other
(4). By default, it will use a proc module, so NORMAL and CRITICAL values are working "by
default"; if you want to have information on WARNING and OTHER values you should setup
the module thresholds manually.
• Descriptive information: Usually string information, will be put on the description field on
module, this is usually something like "OK: successfully logged in" or similar.

13.4.13.1. Example
You have a pop3 plugin (in /tmp/check_pop3_login) with exec permissions, which checks if pop3
account is working, just by connecting a remote host, send a user and password and see if
everything is ok, so if you execute it from command line:
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/tmp/check_pop3_login

mail.artica.es sanler@artica.es mypass

It will return something like:
OK: successfully logged in.

And if it's not ok, will return :
Critical: unable to log on

Using the wrapper is simple, just need to put the wrapper and the module name you want before
the call:
/etc/pandora/plugins/nagios_plugin_wrapper sancho_test /tmp/check_pop3_login
mail.artica.es sanler@artica.es mypass

It will generate a full XML for agent plugin:
<module>
<name>sancho_test</name>
<type>generic_proc</type>
<data>0</data>
<description><![CDATA[Critical: unable to log on]]></description>
</module>

Or:
<module>
<name>sancho_test</name>
<type>generic_proc</type>
<data>1</data>
<description><![CDATA[OK: successfully logged in.]]></description>
</module>

The full entry in the pandora_agent.conf will be something like:
module_plugin nagios_plugin_wrapper POP3_artica.es /tmp/check_pop3_login
mail.artica.es sanler@artica.es mypass

This will be seen like this in the module like (on fail event):

13.4.14. Monitoring with KeepAlive
There is an special module. It has an unique kind called "keep_alive" and is useful to give
information when there is no agent contact. Is useful to know when an agent has stopped to send
214

Monitoring with the software agent

information and to notify us this.
When there is a module, remote or local, that gets information from the agent, the date of the last
"contact" with the agent is updated, in a way that there is always data, though it is only a module of
the total, the agent will have updated its date of last contact, that is usefule to know if the agent
"does not answer". To be precise, an agent is considered "dead" when it has not updated its data in
the double of time of its interval, that is, if it has a 5 minutes interval and more than 10 minutes
have been past from there is no update, then the agent is considered "dead".
In this case, it would be when the keepalive module will appear, firing it and being in the Critical
state in the monitor.
The configuration of these kind of modules is very easy, you need only to create a new module kind
"dataserver":

Once created, if the agent has data, in its interval, it will be always in "NORMAL" (green) status.

If the agent stop sending data (in this example, it has interval of 1 minute), the it will automatically
pop and it will be on CRITICAL status (red):
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It is important to say, that if we have a remote module, for example one Ping, apart from the data
reported by the agent, the keepaliva module will never pop, so we are continually updating the
agent through the Ping.
Apart from that, the keepalive module works the same as any other module. It could be associated
to an alert and it could be used for any other element: reports, maps, etc.
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14 REMOTE MONITORING
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14.1. Introduction
Pandora FMS network server is an essential key piece so it allows to execute test in a remote and
centralized way. On the contrary that the data server, the network server executes the tasks
assigned to it through a multiprocess queue systme. And a network server can also work with other
network servers balancing the load and acting as a support in case that another network server falls,
doing the work that the fallen server had to do. To know more about the HA in PandorA, please
take a look at the corresponding chapter.
The network server works only with those network modules assigned to it.Obviously, and because
they are network tests, the network server should have a complete visibility (IP adresses and ports)
over which we are going to do the tests. There is any sense at all doing tests against a sytem with
ports that can not be see or over which we do not have the paths. The existence of firewalls or paths
in the network has nothing to do with Pandora FMS and the problems generated by these reasons
have neither to do with an specific configuration of Pandora FMS.

14.2. Remote Network Modules
Pandora FMS network modules execute remote monitoring tasks. The remote execution tasks can
be summarize in three blocks:
ICMP Tests
If a machine answer to Ping(remote_icmp_proc) or the latency time of a system in milliseconds
(remote_icmp). In both cases the tests are executed by the network server to which the agent that
contains these networks modules was assigned.
TCP Tests
In a remote way it is checked that a system has open the TCP port that was specified in the modules
definition.In an additional way a text string can be sent (using the string «^M» to replace the
CR).And you can expect by receiving a response substring to check that the communication is
right.This allows to implement easy protocol checkings. For example, we could check if a server is
alive sending the string GET / HTTP/1.0^M^M and waiting to receive the «200 OK» string.
SNMP Tests
It is possible to launch remotely SNMP petitions (SNMP Polling)that have their SNMP service
activated and accessible to obtain data as state of the interfaces, network consume by interface, etc.
There is a section for SNMP with Pandora FMS. (see forward).
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To summarize, we can say that the network server is which execute the different network tests
assigned to each agent. Each agent is assigned to a network server, and it is this which will execute
it, placing the results in the DD.BB of the Pandora FMS system.

14.3. Generic Configuration of a Module for Network Monitoring
To monitor an equip or an equip service (FTP, SSH, etc.) in a remote way, first you should create
the correspondent agent to monitor the service.
In Pandora FMS section for console administration press on Manage agents:

In the following screen, press button Create agent:
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Fill data for your new agent an press button Create agent:

Once you have created the agent, press on the upper flap of the modules (Modules). In it, select
create a new network module and press the Create button:

In the following form select a network component module, and when the dropdown menu at
right,look for the checking you need. In this example we select Host Alive, that represents a ping for
the machine, a simple checking to know if the machine is connected to Internet or not.

We left the advanced options for later.Consider that the modules has obtained the agent IP address.
If you want this could be different.Once you have finished to define the module. press the Create
button.
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In the following screen the modules for the agent are shown, the predetermined Keepalive that is
created with the agent and the module Host Alive added:

As you see,there is a warning on modules. The warning only means that any data has been received
at the module yet, so they have been just added now.Once we start to receive data the warning will
disappear.
To see the data from the module that has been just created, press the upper flap View, and from it
go to the bottom where data will be shown once them start being received:

To add another kind of network checking, do the same as before but selecting another kind of
modules.

14.4. ICMP Monitoring
The previous example is an example of ICMP monitoring. These are the more basic and simple
checkings that give us an important and precise information.There are two kinds of ICMP checking:
• icmp_proc, host (ping)checking,that allows to know if an IP address responds or not.
• icmp_data , or latency checking. Basically it informs about the time in millisecond that the
IP address takes for answering a basic ICMP consult.
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14.5. TCP Monitoring
The TCP checking allows to check the state of a port or a TCP service.
There are two specific fields for TCP tests:

The TCP checking by default simply looks if the destination port is open or not. Optionally you
could send a text string and wait to receive something that will be processed directly as a data.
It is possible to send a text string(using the «^M» string to replace the CR)and you can wait when
receiving an answer substring to check that the communication is right. This allows to implement
simple protocol checking. For example, we could check if a server is alive sending the string:
GET / HTTP/1.0^M^M

And waiting to receive the string
200 OK

This is codified in TCP Send and TCP receive fields.
TCP send
Field to configure the parameters to send to the TCP port. It accept the ^M string to replace it for
the sending of a CR.To send several strings in sequence send/response, you should separate them
with the character
TCP receive
Field to configure the text strings that we expect receiving in the TCP connexion. If they
send/receive in several steps, each step should be separated by the | character.
Through the Pandora FMS TCP checking you can do more things than only see if a port is open or
waiting for an answer from a simple request.It is possible to send data, waiting to receive
something,to send something after, waiting to send something and this way to the step we want.
Only if all the process is right we can validate the result.
To use the Pandora FMS dialog/response checking system, you can separate the different petitions
with the | character.
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Lets see an example of a SNMP conversation.
R:
S:
R:
S:
R:
S:
R:
S:
R:
S:
S:
R:
S:
R:

220 mail.supersmtp.com Blah blah blah
HELO myhostname.com
250 myhostname.com
MAIL FROM:
250 OK
RCPT TO:
250 OK
DATA
354 Start mail input; end with .
.......your mail here........
.
250 OK
QUIT
221 mail.supersmtp.com Service closing blah blah blah

If you want to check the first protocol points, the necessary fields to emulate this conversation
would be:
TCP Send
HELO myhostname.com^M|MAIL FROM: ^M| RCPT TO: ^M

TCP Receive
250|250|250

If the three first steps are OK (code 250), then the SMTP is ok.You do not need to send a complete
mail (but you could, in any case). This allow to do TCP checkings based on the protocol, that could
be used for any protocol that uses plain text conversations.

14.6. SNMP Monitoring
14.6.1. Introduction to the SNMP Monitoring
When we talk about the SNMP monitoring, the most important thing at the beginning is to separate
the testing concepts (polling) and the traps.The SNMP testing implies to order that Pandora execute
a snmpget command aganist a SNMP device, such as a router or an switch ( or even a computer
with an installed snmp agent),this is a synchronous operation(every X seconds). On the contrary,
receiving an SNMP trap is an asynchronous operation(that could or not happens in a million years),
commonly used to receive "alerts" coming from a device. like, for example, when a switch knock
down a port or its fan is too hot.
To use the SNMP testing monitoring, you only need to add an SNMP module in Pandora, creating a
new network module. The majority or the SNMP items that report data in an incremental way
(generic_data_inc), this is that when it ask for a value, this reports the "global" quantity of
information, for example, if a total of bytes collected from the moment the device start. So, this
would be necessary to extract the last quantity of bytes known from the one that is working and
divide it between the seconds from last known data. This will give the data of Bytes/second that are
needed. This operation is done with Pandora using generic data inc.
Using the SNMP Traps is something totally diferent. It is possible to receive traps from any device,
without the necessity of configuring anythin (except the SNMP console).When ta trap is received,
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this will appear in the SNMP console.
It is possible to define an alert, based on OID (the code that identifies a trap, something similar to
3.4.1.1.4.5.24.2), in a IP agent or in a custom data (data that could be in the trap). It is also possible
to order Pandora that it copies the information in an special text module in the agent. If the agent is
defined, this operation is called SNMP Traps transfer.
Pandora FMS can work with any device that supports SNMP. Currently works with SNMP v1, v2,
v2c and v3 versions.
Pandora FMS works with SNMP using individual OID. For Pandora FMS each OID is a network
module. This is, if we want to monitor a Cisco Catalyst switch of 24 ports and know the operative
system of any port and also the entry and exit port, we have to define a total of 72 modules (24 x
3).
To work with SNMP devices you need:
• To know what is and how works the SNMP protocol. This is described in depth in the
RFC3411 published by the IETF:
• To know the IP and the SNMP community of the remote device.
• To activate the SNMP management of the device so that from the network server we could
do SNMP queries.
This network server should be the one assigned for the agent when we are going to define the
network modules. You need also to consider that if we want that other network servers do queries
in case the assigned server falls, they will do the queries with other IP address.
• To know the specific OID of the remote device that we want to check.
• To know how managing the data that the device returns. The SNMP devices return data in
different formats.
Pandora FMS could manage almost all of them, except the timetick that it manage as a numeric
format without converting them to date/hour. Data kind counter are the ones that Pandora
manages as remote_snmp_ inc and they are of special importance, so as they are counters they
could not be considered as numeric data. The majority of the SNMP statistic data are counter kind
and it is necessary to configure them as remote_snmp_inc if we want to monitor them properly.

14.6.2. Monitoring SNMP from Agents
Since version 3.2, there it's possible to get SNMP information, that is available in the Windows
agent. In the Unix/Linux snmpget is usually available, so it could be get in an automatic way, not as
in the Windows systems, where it's necessary an external utility that isn't always easy to get or to
install.
We have packaged in the Windows agent "by default" the utility snmpget.exe (part of the netsnmp
project, with BSD license), and we've added the basic "mibs" and a wrapper or script to wrap the
call to the snmpget.exe utility
Using this call, we can monitor SNMP from an agent, getting information of any remote system to
which the agent has access to, being able to work in this way as a "satellite agent" or "proxy agent" (
as manuals says).
In Windows the syntax for execution is:
module_exec getsnmp.bat <comunidad_SNMP> <ip de destino> <OID>
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Some examples of SNMP modules executed by Windows agents are:
module_begin
module_name SNMP_if3_in
module_type generic_data_inc
module_exec getsnmp.bat public 192.168.55.1 .1.3.6.1.2.1.2.2.1.10.3
module_end
module_begin
module_name SNMP_if3_desc
module_type generic_data_string
module_exec getsnmp.bat public 192.168.55.1 IF-MIB::ifDescr.3
module_end
module_begin
module_name SNMP_Sysup
module_type generic_data
module_exec getsnmp.bat public 192.168.55.1 DISMAN-EVENT-MIB::sysUpTimeInstance
module_end

The same examples executed from Unix agents:
module_begin
module_name SNMP_if3_in
module_type generic_data_inc
module_exec snmpget -v 1 -c public 192.168.55.1 .1.3.6.1.2.1.2.2.1.10.3
module_end
module_begin
module_name SNMP_Sysup
module_type generic_data
module_exec snmpget -v 1 -c public 192.168.55.1 DISMAN-EVENT-MIB::sysUpTimeInstance
module_end

It's important to say that only the "basic" OID are translatables for their numerical equivalent, and
it's advisable to use always numerical OIDS, so we don't know ir the tool would be able to translate
it or not. In any case, the mibs could be always get at /util/mibs directory in Windows, or at
/usr/share/snmp/mibs in Linux.

14.6.3. Monitoring with Network Modules like SNMP
To could monitor any element through SNMP, we should know, that at least its IP and its SNMP
community. It would be also very interesting to know the OID that we want to monitor, although
we could obtain it through a SNMP Walk, as long as we know where each OID comes from.
To monitor an element through SNMP, first you have to create an agent for it.If you have already
one, then simply add a new network module following the previous instructions.
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Once the module has been created, you should select a SNMP data kind in the configuration
module form.See the image:

Any of the three SNMP data kinds are valid, simply select the one that coincides with the kind of
data that you want to monitor.
Once you have selected a SNMP kind of data, the form will expand showing the additional fields for
SNMP:

Next you should define the fields:
SNMP community
SNMP community. Necessary to monitor the element. It acts as it if were a password.
SNMP version
SNMP protocol version of the device. It could be 1, 2, 2c and 3.
SNMP OID
The OID identifier to monitor. They can be numeric values. The alphanumeric values are
transformed internally by the system into numeric values(that are the ones used to do the petition)
through a dictionary called MIB.
An OID alphanumeric can be similar to this one:
iso.org.dod.internet.private.transition.products.chassis.card.slotCps.cpsSlotSumma
ry.cpsModuleTable.cpsModuleEntry.cpsModuleModel.3562.3
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The numeric equivalent would be this:
1.3.6.1.4.868.2.4.1.2.1.1.1.3.3562.3

Without a MIB the alphanumeric format is not good, and to install a MIB in the system is not a
trivial thing, so this is better to work directly with numeric identifiers, although it is more cryptic
this is much more portable and it does not gives any problem because it does not need a MIB.
SNMP walk
Path through all OID of the element. This will be dumped in the control
Introduce the SNMO community data and the SNMP version and if you do not know the exact OID,
then press the SNMP walk button and you will obtain a list of all OIDS of that element. If the
system is able to "translate" them ( because it has a MIB for these values, it will show the elements
in Text format, if not in numeric format:

Pandora FMS includes some OID in its database, that could be used directly. For example, when you
are going to create the module, select the MIBs Cisco component to show a list of the available MIB
for Cisco:
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Once you have selected this component, you can choose between the available MIB for it:

By doing this, the fields will be full with the necessary information.
There are more MIB included in Pandora FMS an with the Enterprise version there are included
MIB packages for different devices. Once you have introduced the data, press on the button Create.
To see the data of the module that has been just created, press on the upper flap View, and in it go
to the bottom, where the data will be shown once they start being received.

To see the data of the modules text string kind (In the example, the System Description) go to the
upper flap of the data Data

The data received by the SNMP System Description data module are stressed in red colour.

14.6.4. MIB Study with External Tools and Integration in Pandora FMS
To do an analysis of the possible OID to use them in Pandora FMS, it is recommended to use a MIB
browser to analyze the MIB given by each manufacturer. These MIB browsers are screen tools that
read, process, analyze and show to the user the complete tree of each MIB OID, allowing to search
and understand which OIDS are the necessaries to monitor our devices.
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We propose the following MIB management tools:
• iReasoning MIB Browser (Windows, Linux, Java): [1]
• GetIf Free MIB Browser (Windows): [2]
• TKMib: Para UNIX, estándar en la mayoría de las distribuciones de GNU/Linux.
The shown snapshots have been done working on the iReasoning tool.
In the first snapshot you can see a request of the device with a MIB load (MIB2 default) that
recognizes some of the existing OID. These OID are represented as string or in a numeric way.
Pandora FMS understand both, but it is only able to resolve the alphanumeric OID if it has the right
MIB loaded in the operative system. The best option, and the most portable one, is to use numeric
OID.

In the second snapshot, we can see the result of doing a recursive walk on a branch on which we do
not habe MIB. It results in a serial of numeric OID that are not useful at all, so we do not have idea
what are them for , or which kind of data they offer.

Apart of all we can do with a MIB exploring tool, we can use OID references through OID index
(some manufacturers have MIB and OID references), or through links that store interesting OID.
Other manufacturers of SNMP batteries, document with natural language their SNMP records, and
they are easy to understand and so we can easily obtain the OID that we need ( it is the case UCD
SNMP, the SNMP battery that use the majority of the UNIX systems). Lot of other SNMP batteries of
operative systems like AIX or Windows are also widely documented.
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Recommended links to work with SNMP
•
•
•
•

Full OID Catalog for CISCO (extremadamente útil): [3]
HP Printer MIB: [4]
Nagios Exchange  SNMP [5]
Algunos OID SNMP frecuentemente usados en routers: [6]

14.7. Common Advanced Features of the Network Modules
The following screen shows the advanced features for the network module configuration:

Description Module description. There is already a default description, that could we change.
Custom ID
Customizable identifier that is necessary it you wish that the server sends multicast messages with
information about agents, or use this field to integrate the Pandora FMS data in an system of
external information, such as a CMDB.
Interval
Execution interval of the module. It could be different from that of the agent, as in the example.
Post process
Module post processing.It is useful to multiply or divide the returned value, as for example, when
we obtain bytes and we want to show the value in Megabytes.
Min. Value
Minimum value of the module. Any value lower that this will be considered as invalid and it will be
ruled out.
Max. Value
Maximum value of the module. Any value higher than this will be considered as invalid and it will
be ruled out.
Export target
It is useful to export the values returned by the module to a export server. It is only available in the
Pandora FMS Enterprise version, and if we have previously configured a export server. Go to the
section that refers to the export server to obtains more details.
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14.8. Remote Windows Monitoring with WMI
To monitor a system or a Windows system service in a remote way through SMI. The queries are
done in WQL, a Microsoft specific SQL language for internal queries to the operative system, and
you can do any query that is shown in the Microsoft database. There are tools, such as WMI
Explorer that allow to explore the tree of WMI values completely, and that could be very useful to
locate those WMI values that interest us , so the "standard" Windows servers could have more than
1,000 different queries, and with additional software, with its own WMI sources it will be increased.
For this, it is not enough to have a record of modules that have been already done, but to have the
tools to find the things that we consider the most useful for us.
WMI Explorer snapshot working on Windows

NOTE: to use the monitor service through WMI, we have to activate it in the configuration file of
pandora /etc/pandora/pandora_server.conf, in the following way:
# wmiserver : 1 or 0. Set to 1 to activate WMI server with this setup
# DISABLED BY DEFAULT
wmiserver 1
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To start monitoring through WMI, first we should create the corresponding agent to monitor the
service, so you should start from there.
In the Pandora FMS console administration section, press on Manage agents.

In the following screen press on Create agent:

Fill in the data for your new agent and press on Create agent:
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Once that you have created the agent, press on the upper flap of the modules (Modules). In it,
select create a new network module and press on Create:

In the following form are the necessary fields to could monitor the Window system remotely
through WMI. You should fill in the necessary fields, like:
Name
Module name
Type
Kind of monitored data
Target
Remote system IP to monitor.
Namespace
Space of WMI names. In same queries this field is different from empty string (by default),
depending of the information source of the application that we monitor.
Username
Name of the administrator user or of another user that has priviledges to execute WMI queries in a
remote way.
Password
Password for the administrator user or the given user.
WMI Query
WMI query, similar ot a sentence in SQL. We can see some examples:
SELECT LoadPercentage from Win32_Processor WHERE DeviceID = "CPU0"
SELECT SerialNumber FROM Win32_OperatingSystem
SELECT AvailableBytes from Win32_PerfRawData_PerfOS_Memory
SELECT DiskWriteBytesPersec from Win32_PerfRawData_PerfDisk_PhysicalDisk WHERE name
= "_Total"

Key string
OPtional, fiel to compare with the string returned by the query, and in case that it exist, the module
will return 1 ó 0. instead of the string itself.
Field number
The number of the returned field, starting from 0 (the WMI queries could return more than one
field). Most of the times it is 0 or 1.
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Fill in the required fields:

The advanced options are the same as for all network modules. Please, go to the network advanced
fields section if you need to obtain more information. Note that the module has got the agent IP
adress. If you want, this could be different. Once you have finish to define the module, press on
Create.
If you do not know the exact parameters, you could sect one of the default ones included in the
Pandora FMS database. For it, select the WMI module component:

And after, select a WMI check of the possible ones:

The information that is needed is fill in automatically, except the user and the password. Consider
that you should introduce an user with administration permisions and its password. On the
contrary the module could not return any value:
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Once you have finish to configure the module, click on Create. In the following screen the modules
for the agent will be shown, and the module Windows version added:

As we can see, there is a warning on the modules. The warning only means that any data on the
module has been received yet, so they have been just added. Once we start to receive data. the
warning will disappear.
To see the just created module data, click on the upper flap View, and in it go below, where the
data will be shown, once they start to be received.

To see the module data kind string text (in the example, the System Description) go to the data
upper flap Data:

Pandora FMS Enterprise version has more than 400 WMI modules of remote monitoring for
Windows, availables for the following technologies:
• Active Directory
• BIOS
• Información del sistema
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•
•
•
•
•
•

Información de Windows
Impresoras
MSTDC
IIS
LDAP
Microsoft Exchange

14.9. Monitoring with Plugins
Unlike with the rest of components, in a default way Pandora FMS does not include any pre
configured complement, so first you should create and configure a complement to could after add it
to the module of an agent. But Pandora FMS includes plugins in the installation directories, but as
have already been said, they are not configured in the database.
To add a pluginthat already exists to Pandora FMS, go to the console administration section, and in
it, click on Manage servers. After doing this, click on Manage plugins:

Once you are in the screen of the plugin management, click on Create a new plugin, so there will be
no one.

Fill in the plugin creation form with the following data:
Name
Name of the plugin, in this case Nmap.
Plugin command
It is the path wher the plugin command is. In a default way, if the installation has been an standard
one, there will be in the directory /usr/share/pandora_server/util/plugin/. Though it could be any
path
of
the
system.
For
this
case,
writte
/usr/share/pandora_server/util/plugin/udp_nmap_plugin.shin the field.
Pandora server will execute this script, so this should have permissions of access and execution on
it.
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Plugin type
There are two kinds of plugins, the standard ones and the kind Nagios. The standard plugins are
scripts that execute actions and accept parameters. The Nagios plugins are, as their name shows,
Nagios plugins that could be being used in Pandora FMS.The difference is mainly on that the Nagios
plugins return an error level to show if the test has been successful or not.
If you want to use a plugin kind Nagios and you want to get a data, not an state (good/Bad), then
you can use a plugin kind Nagios is the "Standard" mode.
In this case (for the NMAP example plugin), we have to select Standard.
Max. timeout
It is the time of expiration of the plugin. If you do not receive a response in this time, you should
select the module as unknown, and its value will be not updated.It is a very important factor when
implementing monitoring with plugins, so if the time it takes at executing the plugin is bigger than
this number, we never could obtain values with it. This value should always be bigger than the time
it takes usually to return a value the script/executable that is used as plugin. In there is nothing
said, then you should used the value that in the configuration is named plugin_timeout.
In this case, we write 15.
IP address option
It is useful to define the crossing interface of the IP adress parameter that is given to the plugin. All
plugins should get at least the destination IP adress of the test, that is given when we linked a
module kind plugin to an agent.
In order that Pandora would known how to pass this parameter to the plugin, you should show it
with which parameter it has to be pass, and this always depends on the plugin and its interface, in
this case, it will be pass with t.
Port option
Same as in the previous case, it is necessary to define the interface that the plugin uses. In this case,
the destination port of the test, that could be optional. In this example, we use p to pass the TCP
destination port of the Nmap test.
Password option / User option
More interface parameters, used as fields user and password respectively. In this case we won't use
it and left it blank.
Description
Plugin description. Write a short description, as for example:Test # UDP open ports, and if it is
possible, specify the complete interface of parameters to help to someone that will after check the
plugin definition to know which parameters accept.

237

Monitoring with Plugins

Click on Create and check that the plugin has been correctly created.

The plugin code could be seen in the given address, It is:
#!/bin/bash
# This is called like -p xxx -t xxxx
HOST=$4
PORT=$2
nmap -T5 -p $PORT -sU $HOST | grep open | wc -l

That basically uses the IP address given Parameters and a port option to execute a quick UDP (sU)
nmap (T5) and that has (wc_l) the open ports quantity (grep open).
Once that the plugin has been created, to could use it on an agent, you should create an agent in
case that you have not done this before. In the Pandora FMS console administration section click on
Manage agents:
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In the following screen click on Create agent:

Fill in the data for your new agent and click on Create agent:
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Once you have created the agent, click on the modules upper flag (Modules). In it, select create a
new network module and click on Create:

In the following form, fill in the blank fields, select the module kind Generic module to adquire
numeric data, eliminate the user options and the password, specifying the IP address against which
to do the analysis and also the port on which to do this:

Once you have finish this, click on Create.
In the following screen will be shown the modules for the agent, the module Nmap añadido:

As you can see, there is a warning on modules. The warning only means that no data in the module
has received yet, so they have been just added. Once that data start being received, the warning will
disappear.
To see the data of the just created module. click on the upper flap View, and in it go below, where
data will be shown once they start being received.
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To see data of the modules kind text string (in the example, the System Description) go to the data
upper flap, Data:

14.9.1. Example #1: Plugin Module for MySQL
This is another example, a more complex one, of how to implement a plugin. In this case, other
plugin that comes by default with Pandora, the MYSQL check plugin.
Create a plugin module (Administration > Manage servers > Manage plugins)for MySQL, with
the following data:
•
•
•
•
•
•
•
•

Nombre: MySQL
Plugin command: /usr/share/pandora_server/util/plugin/mysql_plugin.sh
Plugin type: Standard
Max. timeout: 10
IP address option: s
User option: u
Password option: p
Description: q Connections

-q Com_select
-q Com_update
-q Innodb_rows_read
The plugin will be as follows:
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This plugin gives four checks:
•
•
•
•

q Connections: Connections
q Com_select: Number of select queries from start
q Com_update: Number of update queries from start
q Innodb_rows_read: Innodb files readings

Create a module in the system agent where Pandora FMS is installed and assign it; its name will be
Mysql Connections,using as complement itself (MySQL), as Ip localhost, as Pandora user, and as
password, the Pandora database password. In the field Plugin parameters, introduce the following:–
q Connections.
The module to create would be like this:

Once you have created it, it will be next to the Nmap module:

And the information in the main page (View tab):
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And the detailed information (Data tab):

14.9.2. Example #2: SMTP Server remote plugin
From version 4.0.2 this plugin is included as standard. If you are using an older version, you can
install/download it from the Module Library published in Pandora FMS (see pandorafms.org).
This plugin sends an email using a remote server, you can specify server IP, port, username and
password and authentication scheme, as well as email destination and destination. Returns 1 if it
works and 0 if it fails, that is, using the type should be used generic_proc.
This is an screenshot of the module definition using this plugin:

14.9.3. Example #3: DNS Server remote plugin
From version 4.0.2 this plugin is included as standard. If you are using an older version, you can
install/download it from the Module Library published in Pandora FMS (see pandorafms.org).
This plugin checks the IP address of a given domain (eg artica.es) is a fixed IP, using as reference an
external DNS. In this way we can validate whether the domain is returning the correct IP to avoid
unnecessary balancing, DNS attacks, etc.. Returns 1 if it works and 0 if it fails, that is, using the type
should be used generic_proc.
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This is an screenshot of the module definition using this plugin:

14.9.4. Example #4: UDP Port remote plugin
From version 4.0.2 this plugin is included as standard. If you are using an older version, you can
install/download it from the Module Library published in Pandora FMS (see pandorafms.org).
This plugin checks for a given address and UDP port. Returns 1 if it works and 0 if it fails, that is,
using the type should be used generic_proc.
This is an screenshot of the module definition using this plugin:
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15 VIRTUAL ENVIRONMENT MONITORING
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15.1. Monitoring Amazon EC2 environments Monitoring
This specific monitoring uses CloudWatch API to monitor your instances in Amazon EC2 service.
You need to have activated the cloudwatch enabled in your instance. You can the free plugin in the
pandorafms.org module library section (search for EC2).
The main idea of this remote server plugin is to get information from your instances using the
network plugin server, that means you will need to register the plugin in the server, and make
different modules to grab the information of your EC2 servers.
This is an example of the execution:
/home/slerena/ec2_plugin.sh -A AKIAILTVJ3S26GTKLD4A -S
CgmQ6DxUWES05txfe+juJLoM57acDudHogkLotWk -i i-9d0b4af1 -n AWS/EC2 -m CPUUtilization

It will return a % un numeric value of the metric "CPUUtilization" in the instance i9d0b4af1
To install you will need:
1. To have a running JAVA setup, and now its JAVA home directory. In the Pandora FMS Appliance
(Vmware/Image) is set in /usr/
2. Copy this plugin to a path, and set the permissions to 755, and set the base path on the
AWS_CLOUDWATCH_HOME variable present in the first lines of the plugin. You need to edit the
plugin first lines.
The plugin has several files:
/ec2_plugin.sh  Plugin itself /bin/*  Components of Amazon CloudWatch (Monitoring) Command
Line Tools, included in this bundle. This scripts are distributed under the Apache Licence.
Put the whole package on a dir in the server, for example:
/usr/share/pandora_server/plugin/ec2

And set the AWS_CLOUDWATCH_HOME to /usr/share/pandora_server/plugin/ec2
If you have doubts about if it's correctly installed, execute directly this command:
/usr/share/pandora_server/plugin/ec2/mon-cmd --version

Should returl something like:
Amazon CloudWatch CLI version 1.0.9.5 (API 2010-08-01)

If you get the same string, you're ready to use the plugin.
If not, you probably need to install and configure properly the Amazon CloudWatch (Monitoring)
Command Line Tools. Follow these steps to do it:
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15.1.1. Installation
1. Ensure that JAVA version 1.5 or higher is installed on your system: (java version) 2. Unzip the
deployment zip file 3. Set the following environment variables: 3.1 AWS_CLOUDWATCH_HOME 
The directory where the deployment files were copied to check with: Unix: ls $
{AWS_CLOUDWATCH_HOME}/bin
should
list
monlistmetrics
...)
Windows:
dir %AWS_CLOUDWATCH_HOME%\bin should list monlistmetrics ...) 3.2 JAVA_HOME  Java
Installation
home
directory
4.
Add
${AWS_CLOUDWATCH_HOME}/bin
(in
Windows: %AWS_CLOUDWATCH_HOME%\bin) to your path

15.1.2. Configuration
Provide the command line tool with your AWS user credentials. There are two ways you can
provide credentails: AWS keys, or using X.509 certificates.

15.1.3. Using AWS Keys
1.
Create
a
credential
file:
The
deployment
includes
{AWS_CLOUDWATCH_HOME}/credentialfilepath.template.

a

template

file

$

1. . Edit a copy of this file to add your information.
2. . On UNIX, limit permissions to the owner of the credential file: $ chmod 600 <the file
created above>.
2. There are several ways to provide your credential information:
1. . Set the following environment variable: AWS_CREDENTIAL_FILE=<the file created in 1>
2. . Alternatively, provide the following option with every command awscredentialfile <the
file created in 1>
3. . Explicitly specify credentials on the command line: I ACCESS_KEY S SECRET_KEY

15.1.4. Using X.509 Certs
1. Save your cetificate and private keys to files: e.g. mycert.pem and mypk.pem.
2. There are two ways to provide the certificate information to the command line tool
1. .Set the following environment variables:
EC2_CERT=/path/to/cert/file
EC2_PRIVATE_KEY=/path/to/key/file

1. . Specify the files directly on commandline for every command
<command> --ec2-cert-file-path=/path/to/cert/file --ec2-private-key-filepath=/path/to/key/file

15.1.5. Setting custom JVM properties
By setting the environment variable SERVICE_JVM_ARGS, you can pass arbitrary JVM properties to
the command line. For example, the following line sets proxy server properties in Linux/UNIX
export SERVICE_JVM_ARGS="Dhttp.proxyHost=http://my.proxy.com Dhttp.proxyPort=8080"

247

Monitoring Amazon EC2 environments Monitoring

15.1.6. Running
1. Check that your setup works properly, run the following command:
$ mon-cmd --help

You should see the usage page for all Monitoring commands
$ mon-list-metrics --headers

You should see a header line. If you have any metrics defined, you should see them as well.

15.2. Monitoring WMware environments
Virtual environments are very important for IT architectures of companies, because of that their
monitoring is crucial. With Pandora FMS Enterprise you can get the VMware Monitoring Plugin
that allows you to control VMware architectures easily.

15.2.1. WMware Architecture to Monitor
With this system, it's possible to monitor architectures as the one that is shown in the following
sketch:

It is possible to see that in the sketch we can have so many ESXi servers as we need, and also, in ech
ESXi server we can have as many virtual machines as we need. Also, it will be necessary to have a
vCenter Server server, so it is the one that centralizes all the resources and send the data through
datacenters.
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15.2.2. Prerequisites to the Installing
Before installing the vSphere SDK for Perl, we should install some dependencies. If it would be any
problem during the installing of the dependencies previously mentioned, or with the vSphere SDK ,
then it will be necessary to check the VMware guide in the following link:
http://communities.vmware.com/community/vmtn/developer/documentation

RedHat

In RedHat, we need to install the LibXML2 and the OpenSSL package to build, that is installed with
the following command:
yum install openssl-devel libxml2-dev

SLES

For SLES, we need to have installed the OpenSSL package to build. We can install it with the
following command:
yast -i openssl-devel

Debian/Ubuntu

In Debian/Ubuntu the following packages are needed:
libssl-dev perl-doc liburi-perl libxml-libxml-per libcrypt-ssleay-perl perl-doc

That we should install with this order:
sudo apt-get install libssl-dev liburi-perl libxml-libxml-perl libcrypt-ssleay-perl
perl-doc

If we have a 64 bits, then we have to install the package additionally, as follows:
sudo apt-get install ia32-libs

15.2.3. Installing the VMware vSphere SDK for Perl
In order to install the SDK, first download 4.1 version from the VMWare:
http://communities.vmware.com/community/developer/downloads

Once that it is downloaded, unzip the package and execute the following command:
sudo perl vmware-install.pl
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If it would be any problem while installing, both with the SDK or with the previous dependencies,
then it will be necessary to follow the VMWare official documentation.

15.2.4. Monitoring with VMware Monitoring Plugin
The Environment Monitoring with WMvare is based on two things:
1. One recon task that is able to extract the ESXi host and the virtual machines that are
availables through the VMWare vCenter.
1. One plugin that gets the information to monitor as modules for each ESXi and virtual
machine that has found in the recon task.
With this system we get a remote agent for any ESXi host or virtual machine found. This will allow
us to manage them as independent things, not matter the links that are between them in the
virtualizing architecture. And also, each agent will have the corresponding modules for its
monitoring depending on if it would be ESXi,Datastore or virtual machine.
• NOTE: To use VMware plugin and the recon script activate pluginserver and reconserver
is required.

15.2.4.1. Plugin Internal Working
As we have said before, the Pandora FMS WMware plugin extracts the information through the
vCenter. In order to avoid an overload in the vCenter database, the plugin creates an intermediate
buffer for each agent. This intermediate buffer consists on a file for agent host in the file /tmp that
is updated every 300 seconds (5 minutes).This way, only one query will be done to the vCenter
when the file will be too old.
• NOTE: It's very important to consider that the files with name kind
xxx_pandora_vmware.txt are used by the plugin to extract data. If these files are deleted
the performance of the vCenter database could decrease.

15.2.5. Plugin Registration
15.2.5.1. Plugin Registration using PSPZ packages
To register the VMware Monitoring Plugin we will use the authomatic plugin register through
pspz packages. To do this, we should click Register plugin in the submenu of the Manage Servers
menu.
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After this, we will see the following image, where we should choose the vmwareplugin.pspz file
and press the Upload button.

If the operation is successful, then it will show the following screen to verify the operation.

If we press on the Manage plugins submenu from the Manage Server menú, we will check that the
VMware Monitoring Plugin plugin will be shown in the plugins list.

In the plugins list it will appear one field as the one that is shown in the following image showing
that the VMware Monitoring Plugin is already installed.

With this, we have registered the plugin that allow us to get info from the VMware architecture.
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15.2.5.2. Manual registration
If you want to register the plugin in a manual way, you can follow the steps described in this section
Monitorización con Plugins
The values of the different fields are the following:
• Name: VMware Monitoring Plugin
• Plugin Command: /var/www/pandora/attachment/plugin/vmwareplugin.pl (Path where
vmwareplugin.pl file)
• Plugin type: Standard
• Max. timeout: 300
• IP address option: server
• Port option: <empty>
• User option: username
• Password option: password
• Description: This plugin gets information of VMware vCenter.
NOTE : In order the VMware plugin extension works right, it's important that the plugin name
would be exactly WMWare Monitoring Plugin

15.2.6. Recon Script Registration
Now we have to register the Recon Script that does the ESXi host and the virtual machines search.
To do this, we have to select the Manage recon script submenu of the Manage Servers menu.

Once we see the Manage recon script initial screen in the submenu, we have to press the Add
button.

After this, we will see the window to fill in the data of the new Recon Script', where we fill the data
as in the example following. In the Script fullpath field, it is necessary to specify the interpreter or
program with which the script will be executed (for us it will be Perl), and the full path where the
script is located. Once the form is filled in, we should press on the Create .
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Once the script is registered, we will see one screen that will inform us of that the operation is
working fine and it will show the script registered in the list.

15.2.7. Creating the Recon Task
To automatize the discovery of host and virtual machines of the VMware virtualized architecture to
monitor, we should create a Recon Task that will be executed from time to time looking for new
host and virtual machines that would be in this architecture. To create a Recon Task we have to
press on the Recon Task submenu from the Manage Servers menu
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After doing this we will see the following image, that shows the Recon Taskgeneral view. In it we
press on the Createbutton to create a new task.

After pressing the Create button, it will show a form as the one of the following image. In it we
should fill in the fields in an suitable way. In the field mode, it's important to select the Custon
Script option, so it will allow us to select the script that we already registered in the previous step
( for us the VMware recon script) in the field Recon Script

The Script field fields are reserved for the parameters of the script that we have registered.
Specifically, the script for the VMware discovery needs the following compulsory fields:
server: IP of the server where the VMware vCenter is located.
username: User to have access to the vCenter.
password: Password to have access to the vCenter.
datacenter: Name of the datacenter to monitor.
pluginname:Name with which was registered the VMware plugin (in the authomatic register
it's always the VMware Monitoring Plugin).
• pandoraconf: Path where the Pandora FMS configuration file is located.
• reconconf: Optional parameter that shows the path where the Recon Script configuration file
is. If a configurion file is not specified, then the recon script will create all the modules with
the values by default.
•
•
•
•
•
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If you want to monitor several datacenter, then it will be necessary to create one Recon Task for
each of them, specifying the datacenter name in the parameter of the right script.
Finally, we press the Addbutton to create the new Recon Task.
When pressing the button the following screen will be shown. It will inform you that the operation
was successfull and the new Recon Task will be shown in the list.

Now we have a recon task Recon Task that will be executed with the selected interval and that will
create the appropriate agents extracting the information from the VMware virtual architecture.

15.2.8. Monitoring the VMware Virtual Architecture
To see the Recon Task result, we only need to check that an agent has been created for each virtual
machine and ESXi host. For doing this we need to go to the Agent Detail submenu from the
Monitoring menu.
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Then it will show the list with all the agents where will be the agentes of the VMWare virtualized
system that the recon script has found. In our case we have two ESXi machines and two virtual
machines. In the list, <brthe ESX host are with the ESX_ prefix and they are named according with
their IPs. For the virtual machines is used the name of the machine writting the VM_ prefix before.

If we press on the name of an agent we will see the Pandora FMS agent view, where we can see
parameters such as the agent IP and in its description we see that it is an agent discovered with the
Recon Script for VMware virtual architectures.
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If we pay attention to the module list that is created by default for a virtual machine, we can see
some ones like: Host Alive, Free Disk, Host Name, Connection State, and more...

If we press on an agent that corresponds with a ESXi host, we will see a module list as in the
following image, where we can see modules such as:bootTime, memorySize, uptime...

In the following section we are going to explain the information that reports each module in detail.
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15.2.9. VMware Virtual Architecture Agent Modules
The available modules for each element of the WMware architecture are the followings:

15.2.9.1. Modules for Agents kind Datastore
• Capacity: Maximum capacity of the Datastore in bytes
• Free Space: Datastore free space percentage
• Disk overallocation: Disk overallocation percentage

15.2.9.2. Modules for Agents kind host ESXi
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Boot Time: Last time the host was booted.
CPU Info: CPU general information ( it's created one module per each ESXi CPU).
Memory Size: Total amount of the host physical memory in Bytes.
Overall CPU Usage: Addition of the use of all CPUs in Mhz.
Overall Memory Usage: Physical memory used in the host in MB.
Power State: State of the host power.
SSL Thumbprint: host SSL print.
Uptime: Host Uptime in seconds.
VNIC Info: Information about the host virtual network interfaces.
Host Alive: Module Keep Alive kind which value is 1 if the ESX is connected and 0 if it's not.
Connection State: State of the host connection
Disk Read: Rate of readed Kbps of the disk
Disk Write: Rate of written Kbps of the disk
Disk Read Latency: Latency of the disk reading in miliseconds
Disk Write Latency: Latency of the disk writing in miliseconds
Data received: Range of host received Kbps
Data transmitted: Range of host sent Kbps
Packages Received: Number of packages received in the interval
Packages Transmitted: Number of packages sent in the interval
CPU Status: Status of the host physical cpus (Hardware Status de VMware) one by CPU.
Disk Status: Status of the host physical status (Hardware Status de VMware)one by disk.
Mem Status: Status of the host physical memory (Hardware Status de VMware) one by
memory.

15.2.9.3. Modules for agents kind Virtual Machine
These modules provide information from VMware architecture point of view. If you want to monitor
other paremeters related to a virtual machine you must consider other option such as Monitoring
with software agents or Remote Monitoring.
Boot Time: Last date where the virtual machine was booted.
Connection State: Connection state.
Consumed Overhead Memory: Memory consumed by the virtual machine in MB.
CPU Allocation: Information about the resources assigned to the virtual machine CPU.
Disk Free: Virtual Machine Free Disk Percentage. (It will be one module for each disk that
that the virtual machine contains).
• Guest State: Host operative system operating way
• Host Info: Information about the VMware host.
• Host Alive: Module kind Keep Alive that is 1 if the virtual machine is on execution and 0
otherwise.
•
•
•
•
•
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•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

Host Memory Usage: Consumed memory by the virtual machine in MB.
Host Name: Name of the Host Operative system.
IP Address: System IP address (It will show one per network interface available).
MAC Address: System MAC address It will show one per network interface available).
Max CPU Usage: Maximum limit of the virtual machine CPU usage.
Max Memory Usage: Maximum limit of the virtual machine RAM Memory.
Memory Allocation: Limit of the resources for the memory.
Memory Overhead: Memory used by the virtual machine above the requirements of the host
operative system in Bytes.
Overall CPU Demand: Basic statistics on the CPU performance in Mhz
Overall CPU Usage: Basic statistics on the CPU usage in Mhz.
Power State: Current state of the virtual machine power.
Private Memory: Memory in MB that is given to the virtual machine of the non shared
memory.
Shared Memory: Memory in Mb that is given to the virtual machine of the shared memory.
Tools Running Status: Current state of the VMWare Tools execution installed in the host
operative system.
Triggered Alarm State: State of the VMware alarms.
Uptime Seconds: Virtual machine Uptime in seconds.
Virtual Image Path:Virtual machine configuration file path(.vmx).
Disk Read: Rate of the disk read Kbps
Disk Write: Rate of the disk written Kbps
Disk Read Latency: Disk Reading latency in miliseconds.
Disk Write Latency: Disk writting latency in miliseconds.
Data received: Host Kbps received range
Data transmitted: Host Kbps sent range
Packages Received: Number of packages received in the interval.
Packages Transmitted: Number of packages received in the interval.

15.2.10. VMware Virtual Architecture Management and visualization
Together with the VMWare plugin, two extensions are distributed VMware Manager and VMware
View.VMware View allows to visualize all the VMware architecture components in an easy way.
Besides, with WMware Manager you could manage virtual machines, stopping, starting, reseting or
canceling the activity from the Pandora FMS console. These extensions are optional an only work
with Pandora FMS 4.0 or higher.

15.2.10.1. Installing VMware Manager and VMware View Extensions
To install the extensions, you will only have to copy the content of the extensions file that you'll find
when unzipping the plugin in the extension file in the Pandora FMS console enterprise section. The
commands to execute are the following ones:
cp -R extensions/* <pandora_console_dir>/enterprise/extensions/

From this moment the WMware plugin extensions will be availables.
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15.2.10.2. Using the VMware View Extension
To begin using the WMware architecture visor, click on the WMware View submenu in the
Monitoring menu.

The WMware View extension will show a map similar to the one bellow with all the VMware
architecture that was discovered with the Recon Task

The map contains the elements of the VMware architecture(virtual machines, ESX,Datastores and
Datacenters) with different icons that identify them and also the Pandora FMS agents state that
represent each element. Besides it's showed the relationship that exists between the virtual
machines, ESX and DataCenter. This way, with a quick view you could see the state of the VMware
architecture in a very easy way.
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This extension has some options that help to improve the architecture visualization hidding
elements, enlarging the letter size and allowing to do zoom to could see the elements closer.

Using the previous options we could see only the Datacenter and the ESX with a font size 14 and
with a zoom of 2x

15.2.10.3. Using the VMware Manager Extension
To use the VMware Manager extension you should go to the operating view of one agent that
corresponds with a virtual machine in the VMware architecture. In this view you could see an icon
with the WMware symbol the corresponds to the extension.

The VMware Manager extension allows to manage virtual machines from the Pandora FMS console.
The extension shows the current state of the virtual machine with a color code (green= on,
orange=off and grey=stopped), besides, in a combo it shows the available status and allows to
change the state of the virtual machine selecting it clicking on the Change Status button.
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With this extension we could stop a virtual machine that is on selecting the Stop status as in the
following image

This will cause that the machine will stop and that the view of the VMware Manage extension view
change, showing that the machine that now is stopped as now we can see in the following image:

15.2.11. Recon Script Configuration
By default, the WMware Recon Script adds all the checkings previously explained. To could choose
which checkings you want to include and which ones are not availables, the Recon Script can read
your configuration of one file. To show to the Recon Script which is your configuration file, you
should add the parameter reconconf <path_file> to the call created in Pandora FMS.

15.2.11.1. Recon Script Configuration file
The configuration file has modifications or restrictions to the Pandora FMS modules that are created
by default. So, if one module is not in the configuration file, it will be added with the default values.
With the Recon Script configuration file we can fix maximum and minimum values for the Warning
and Critical status, or disable the module.
The configuration file structure is separated by kinds of items of the WMware architecture
(Datastores, ESXi y Máquinas Virtuales) as follows:
#These lines are comments
#Datastore Modules
Datastore
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capacity disabled
freeSpace name = Espacio Libre; desc = % Espacio libre datastore; limits = 70 90 91
100
#ESX Modules
ESX
uptime disabled
#VM Modules
VM
ipAddress disabled
macAddress disabled
maxCpuUsage name = Uso CPU; desc = Desc Uso CPU; limits = 60 70 71 100

Each line of the file corresponds to the available options for one module. As you can see, there are
two possible options:
• <module> disabled: The module will be NOT create
• <module> name = <nombre>; desc = <description>; limits = <min_warning>
<max_warning> <min_critical> <max_critical>: The module will be created with the
name and the description given and the tresholds will be also be defined for the maximums
and minimums of the Warning and Critical values.
It is very important to consider the structure of the lines of the configuration file and above all,
see that the character ; is close to the module name and description. Theser two lines ARE NOT
EQUIVALENTS (See the blanks before the character ;):
maxCpuUsage name = Uso CPU; desc = Desc Uso CPU; limits = 60 70 71 100
maxCpuUsage name = Uso CPU
; desc = Desc Uso CPU
; limits = 60 70 71 100

The modules are referenced by their short name, a name equivalent easier to write in the command
line. The correspondence table between short and expanded names is in the following section.
Lets analyze the configuration file of example:
For the Datastores we have decided that the Capacity module doesn't have any interest for us, and
so we choose the disabled option. Also, the Free Space module will be created with these values:

*
*
*
*
*
*

Name: Free spaceEspacio Libre
Description: % free datastore space
Min Warning: 70
Max Warning: 90
Min Critical: 91
Max Critical: 100

To monitor the ESXi we have decided to disable the Uptime module because we consider it's not
necessary. The rest of the available modules will be shown with the default parameters.
For the virtual machines we have disabled the modules IP Address and MAC Address. Besides, we
have defined the parameters for the modules Max CPU Usage. Remember that the modules that
aren't disabled will be created with the default values.
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NOTE: All the errors related to the configuration file are shown as events in the Pandora FMS
console, so in the event screen you can see if some problem has occurred when reading the
configuration file.

15.2.11.2. Example of the Configuration File
File with all Modules disabled
#These lines are comments
#Datastore Modules
Datastore
capacity disabled
freeSpace disabled
overallocation disabled
#ESX Modules
ESX
bootTime disabled
cpuInfo disabled
memorySize disabled
overallCpuUsage disabled
overallMemoryUsage disabled
powerState disabled
sslThumbprint disabled
uptime disabled
vnicInfo disabled
hostAlive disabled
connectionState disabled
diskRead disabled
diskWrite disabled
diskReadLatency disabled
diskWriteLatency disabled
netReceived disabled
netTransmitted disabled
netPkgRx disabled
netPkgTx disabled
cpuStatus disabled
storageStatus disabled
memStatus disabled
memoryAllocation disabled
#VM Modules
VM
bootTime disabled
connectionState disabled
consumedOverheadMemory disabled
cpuAllocation disabled
diskFree disabled
guestState disabled
host disabled
hostAlive disabled
hostMemoryUsage disabled
hostName disabled
ipAddress disabled
macAddress disabled
maxCpuUsage disabled
memoryAllocation disabled
memoryOverhead disabled
overallCpuDemand disabled
overallCpuUsage disabled
powerState disabled
privateMemory disabled
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sharedMemory disabled
toolsRunningStatus disabled
triggeredAlarmState disabled
uptimeSeconds disabled
virtualImagePath disabled
uptimeSeconds disabled
diskRead disabled
diskWrite disabled
diskReadLatency disabled
diskWriteLatency disabled
netReceived disabled
netTransmitted disabled
netPkgRx disabled
netPkgTx disabled

15.2.11.3. Correspondence Table of Short Names
Datastores

Expanded name
Short name
Capacity
capacity
Free Space
freeSpace
Disk Overallocation overallocation
ESX

Expanded Name
Boot Time
CPU Info
Memory Size
Overall CPU Usage
Overall Memory Usage
Power State
SSL Thumbprint
Uptime
VNIC Info
Host Alive
Connection State
Disk Read
Disk Write
Disk Read Latency
Disk Write Latency
Data received
Data transmitted
Packages Received
Packages Transmitted
CPU Status

Short name
bootTime
cpuInfo
memorySize
overallCpuUsage
overallMemoryUsage
powerState
sslThumbprint
uptime
vnicInfo
hostAlive
connectionState
diskRead
diskWrite
diskReadLatency
diskWriteLatency
netReceived
netTransmitted
netPkgRx
netPkgTx
cpuStatus
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Disk Status
Mem Status

storageStatus
memStatus

Virtual Machines

Expanded name
Boot Time
Connection State
Consumed Overhead Memory
CPU Allocation
Disk Free
Guest State
Host Info
Host Alive
Host Memory Usage
Host Name
IP Address
MAC Address
Max CPU Usage
Memory Allocation
Memory Overhead
Overall CPU Demand
Overall CPU Usage
Power State
Private Memory
Shared Memory
Tools Running Status
Trigger Alarm State
Uptime Seconds
Virtual Image Path
Uptime Seconds
Disk Read
Disk Write
Disk Read Latency
Disk Write Latency
Data received
Data transmitted
Packages Received
Packages Transmitted

Short name
bootTime
connectionState
consumedOverheadMemory
cpuAllocation
diskFree
guestState
host
hostAlive
hostMemoryUsage
hostName
ipAddress
macAddress
maxCpuUsage
memoryAllocation
memoryOverhead
overallCpuDemand
overallCpuUsage
powerState
privateMemory
sharedMemory
toolsRunningStatus
triggeredAlarmState
uptimeSeconds
virtualImagePath
uptimeSeconds
diskRead
diskWrite
diskReadLatency
diskWriteLatency
netReceived
netTransmitted
netPkgRx
netPkgTx
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16 MONITORING WEB USER EXPERIENCE
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16.1. Introduction
This is one feature of the Enterprise version that allow you to monitor the user experience of a
website. Its based on transactions to check the different steps produced when you are surfing on a
website.It reproduces the complete browsing "process" truly. It could include features such as to
authenticate in a form, do click in a menu option, fill in a form, verifying that each process returns
an specific text string. Any mistake in a moment of the process, will have as result a failure in the
checking. The complete transaction includes the download of all the resources(graphs, animations,
etc), that the real browsing has. In addition to check the availability and the latency of a website
you can get values from the website to monitor them.
Goliat is the name of Pandora web check server. Goliat can monitor either HTTP and HTTPS
transparently if you have the libraries OpenSSL installed in your system.

16.2. How to create web modules
To monitor a web page in a remote way, first you should create the corresponding agent in order to
monitor the service. So you should start with this.
In the Pandora FMS console administration section press on Manage agents.

In the following screen press on Create agent:
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Fill in the data for your new agent and press on Create agent:

Once you have created the agent, press on the upper flap of the modules. In it, select create a new
network module and press on Create:

Once you have pressed on Create, a form will appear in which you should fill in the fields that are
necessary to could monitor a web.
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Next the form fields are detailed:
Name
Checking name
Type
Check type:
• Remote HTTP module to check latency: gets the total time that it takes from the first request
until the last one is checked (in a WEB test there is one or several intermediate requests that
complete the transaction, If in the checking definition are several request, then it will be
used the average time of each request.
• Remote HTTP module to check server response: obtains a 1 (OK) or a 0 (FAILED) as the result
of checking all the transaction. If there are several attempts and any of them fails, then, we
consider that the test as a whole fails.
• Remote HTTP module to retrieve numeric data: retrieves a numeric value from an HTTP
response using a regular expression.
• Remote HTTP module to retrieve string data: retrieves a string from an HTTP response using a
regular expression.
Web checks
The whole of the web checks to do (by default only one).
The WEB check is defined by several steps, or simple request.
These simple petitions should be written in an special format in the Web checks field. The checks
are started with the task_begintag, and they end with the task_end tag.
It is possible to check if it is a string in a web page. For this, you have the check_stringvariable.
THis variable does not allow to check HTML iftself. An example of the use of this variable could be
this: search in the http://www.example.com web page if there is th eSection 3 string. If the string
does exist.. The variable will be configured this way:
check_string Section 3
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To check forms, there are several extra variables:
•
•
•
•

resource (1 ó 0):download all the web resources (images, videos, etc).
cookie (1 ó 0): keeps a cookie , or an open session for later checks.
variable_name : name of a variable in a form.
variable_value: value of the previous variable in the form.

With these variables, it will be possible to send data to forms and check that they work right.

In some cases domain redirection couldn't work, to solve this problem you must create
the module using the final domain address after all redirections.

16.3. String Check in a Web page
The check to look up the Section 3 string in the http://www.example.com web page would be this:
task_begin
get http://www.example.com
check_string Section 3
task_end

The complete form in Pandora FMS will be this:
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And the check, once being executed, will be shown in the View menu, by clicking on the flap, and in
it, bellow, where the data will be shown once they start being received.

Syntax for "check_string" is not a regular string, it's an "regular expression" (regexp).
This is a special notation to code searches. If you, for example, are trying to search for
"Pandora FMS (4.0)", this should be something like: Pandora FMS \(4.0\). This allows
you to make complex searches, not only regular words, but you need to escape nonalphanumeric characters before use, escaping with "\" character.

16.4. Check the latency of a web
If you want to check latency of a web you only need to select the module type: Remote HTTP module
to check latency.
For example we want to know the latency of the web http://pandorafms.com checking the string
pandora, the code would be:
task_begin
get http://pandorafms.com
check_string pandora
task_end

The complete form in Pandora FMS would be:
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The result of this module showing the latency would be like this:

16.5. Checking webs through a Proxy
You can also do web checks through a Proxy. To configure the Proxy you must add the proxy URL in
the field Proxy URL which you will find after click in Advanced options:

An example of the URL could be
http://proxy.domain.com:8080

If the proxy requires an authentication you can use an URL like this:
http://my_user:my_pwd@proxy.domain.com:8080

16.6. Retrieving Google's stock quote
To retrieve Google's stock quote we need to create a Remote HTTP module to retrieve numeric data
module with the appropriate regular expression:
task_begin
get http://finance.google.com/finance/info?client=ig&q=NASDAQ%3aGOOG
get_content \d+\.\d+
task_end

The output will be something like this:
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Starting from Pandora FMS 4.1 you can specify the part of the regular expression that will be
returned to retrieve data from more complex HTTP responses:
task_begin
get http://finance.yahoo.com/q?s=GOOG
get_content_advanced <span id="yfs_l10_goog">(\S+)</span>
task_end

The part of the regular expression (defined in get_content_advanced) to be returned
must be enclosed in parentheses

16.7. Form checking in a Web page
One check that is more interesting is a web form check. Though it is more complex than the simple
check of a text in a web page. The check of the example will use a Pandora FMS public demo page,
start session an ckeck that it has done it sucesfully.
To could do this kind of checks, you need to have the required credentials in order to could start
session. You should also go to the page and get the HTML code to could see the variable names.
The web page is http://galaga.artica.es/pandora/index.php?login=1,and, once you are there, you
could observe see that the variables are:
• nick: user name
• pass: user password
You should use the variables variable_name y variable_value together to could validate the form.
The complete example would be:
task_begin
post http://galaga.artica.es/pandora/index.php?login=1
variable_name nick
variable_value demo
variable_name pass
variable_value demo
cookie 1
resource 1
task_end

With the previous task you have managed to have access to the web page and validate in it. Now
you should check that you are correctly registered in the page by searching something in it that
would be only possible to see if you are registered:
task_begin
get http://galaga.artica.es/pandora/index.php?
sec=messages&sec2=operation/messages/message
cookie 1
resource 1
check_string Read messages
task_end
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And it would be possible to do another check, that would be to end the session in the page and exit:
task_begin
get http://galaga.artica.es/pandora/index.php?bye=bye
cookie 1
resource 1
check_string Logged Out
task_end

With this the complete check in Pandora FMS would be this:

Once the checks are added, these could be seen in the module list:
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To see the check state, go to the View menu, Press on the flap and it it bellow, where data will be
shown once they start to be received.

You can also see more data on modules. For this, you should press on the Data flap, and it it a list
like this one will be shown:

In this image you can see both checks, their name, the interval in which each of them are executed
(that could be different from the agent interval), and the data. In the web checks,the Data column
refers to the total time that the check has taken.
In the following screen are shown the advanced options for the web monitoring, that is partially
different to the rest:

The advanced features fields are similar to the other kind of modules, but there are some different
fields that are specific for the WEB checks:
Timeout
Is the expiration time while the petition is done. If this time is over, the check petition will be ruled
out.
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Agent browser id
Is the web browser identificator to use, so some specific pages only accept some web browsers (see
zytrax.com to obtain more information).
Requests
Pandora will repeat the check the number of times that this parameter fix. If any of the checks fails,
the check will be considered as wrong.Depending on the quantity of checks in the module, we will
get an specific number of pages,this is, if the module has three ckecks, then three pages will be
download, and if in the Request field we have fix some value, then the number of downloads will be
multiplied by this. Is is important to consider this to know the total time that the module will take
to complete the operations.

16.8. HTTP Simple authentication
Some web pages can require HTTP auth. This is not a "normal" user/password form. This is, for
example, when you enter a site and get a "popup" requiring a username and password for a Realm
or Domain.
This is coded in the web task, using a few new tokens, like this example:
http_auth_serverport artica.es:80
http_auth_realm Private area
http_auth_user admin
http_auth_pass xxxxxx

• http_auth_serverport  This means, domain and http port which is listening in.
• http_auth_realm  Realm name.
• http_auth_user  User
• http_auth_pass  Password
This is a full example:
task_begin
get http://artica.es/pandoraupdate4/ui/
cookie 1
resource 1
check_string Pandora FMS Update Manager \(4.0\)
http_auth_serverport artica.es:80
http_auth_realm Private area
http_auth_user admin
http_auth_pass xxxx
task_end

16.9. HTTPS (HTTP with SSL) monitoring
Goliat can check both http as https. To could do safe checks on this web (https), you will only need
to specify this protocol in the URL. For example:
task_begin
get https://www.google.com/accounts/ServiceLogin?
service=mail&passive=true&rm=false&continue=https%3A%2F%2Fmail.google.com%2Fmail%2F
%3Fui%3Dhtml%26zy%3Dl&bsv=zpwhtygjntrz&ss=1&scc=1&ltmpl=default&ltmplcache=2
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cookie 1
resource 0
check_string Google
task_end

16.10. Advanced options
16.10.1. Modifying HTTP headers (Available on next version 4.0.2)
With the header option you can modify HTTP headers or create custom ones. For example, to
change the Host HTTP header:
task_begin
get http://192.168.1.5/index.php
header Host 192.168.1.1
task_end

16.10.2. Debugging web checks(Available on next version 4.0.2)
If you want to debug a web check, add the debug <log_file> option. The files log_file.req and
log_file.res will be created with the contents of the HTTP request and response respectively. For
example:
task_begin
get http://192.168.1.5/index.php
debug /tmp/request.log
task_end

The web check above will generate files /tmp/request.log.req and /tmp/request.log.res.
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17 SERVICE MONITORING
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17.1. Introduction
17.1.1. The concept of service monitoring
A service is a way to group your IT resources basis on their functionalities. For example a service
could be your official website, your CRM system, your support application, or even your printers.
Services are logical groups which can include hosts, routers, switches, firewalls, CRMs, ERPs, webs
and of course another services. You can see what is a service more clearly with the following
example.
Chip Company sells computer through it's website all around the world, and it has three big
department: Online Shop, Support and Management.

As you can see there are three services which are offered to customers: Online Shop, Support and,
indirectly, Management. All services are crucial for the business because if one fails the others can
be affected and the company could lost a lot of money even customers. And at the end as you know
a happy customers could give back to your company more customers.
To monitor the service of Chip Company we need to know more in deep each service.
The Online Shop department is responsible to guarantee that the shop website is online, that all
products prices are right, create the product categories and overall to ensure that all information
about products, delivery and payment methods is right on the website to make easy the shopping.
From this service we want to monitor ther following parameters:
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The Support department have to solve all customer's problems with the computers they had bought.
Some tasks of this department are: helping customers to configure their computers, manage the
replacement of computer parts and manage the return of products delivered. This department
joined to Online Shop are the services in the client side so they are very important to be percived as
a high quality company. From the support service we want to monitor the following parameter:

The third department is Management inside it there is Marketing, Commercial, HHRR and other
department focused on internal management. Their principal job is ensure all process inside the
organization are right. The services of this department are crucial because is the coordinator of all
departments. The most interesting parameters for Management services are:

To monitor our services we make some maps thanks to Pandora FMS Visual Console and the
pictures we have about services hierarchy of Chip Company. These maps are calculated in real time,
so you will always known the status of your services everytime. First of all we made the map of each
service.
The next picture shows the map of Online Shop service with the status of each parameter. As you
can see the parameter called Content Updated has a red dot and it means there is a problem with
it. About the other paremeters we can say they are right because they have green dots. With the
green arrow you can go to the map of general view, you will see it in the next steps.
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If you want to see what is the problem you can click on the red dot and you will see the technical
view with which you can know more about the problem. This technical view shows the data
gathered by Pandora FMS from a lot of sources such as: CRM, ERP, SAP Servers, Databases
(MySQL, Oracle, etc), even from devices like PC, servers and routers.
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We also made another maps for Support Service which you can see in the picture below. As you can
see all the important paremeters of Support service are ok because all of them have green dots.

To finish with the serices map we made the service map for Management Service which you can see
in the next picture. Again it shows all the important paramenter with their dots in this case all the
dots are green so thath means the paramenters of the service are right.

Furthermore we made a general map with all the services, you can see it in the next picture. In this
map you can see the service hierarchy of Chip Company with the status of each service. Also, if you
click on each dot you will see the specific map of each service. With all these maps we have created
a full navigation map of all the service of Chip Company. The status of each service is the same that
is showed in the specific map for each service and as you can see Management and Support service
are ok but Online Shop Service has problems, as you can see the status of the services climbs up
inside the hierarchy until the top.
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17.2. Services in Pandora FMS
17.2.1. How services work in Pandora FMS
Unlike as with the "specific" monitoring, where there are kept specific values from specific
indicators, the service monitoring with Pandora FMS is though to monitor "groups" of elements,
from different kind, with certain "margin of error", based on the failure accumulation.
To understand better in which the service monitoring consist on, we are going to show an example.
We want to monitor if the service that we are giving, through a WEB cluster, is "Ok". This cluster
consist of the following elements:
•
•
•
•
•

Two routers in HA.
Two switches in HA.
Twenty WEB Apache servers
Four Weblogic appliance servers
One MySQL cluster of two storage nodes and two SQL processing nodes

It's possible to monitor each element in an individual way and, in fact it's the first thing we will
need to activate the service monitoring "globally". Each element included in the service should be an
"standard" monitor of the ones monitored with Pandora, that is, it's something PREVIOUS to the
service monitoring.
The need of monitoring services as something "abstract" appears when we ask ourselves this
question: What happens when an element that initially is not critical? such as, for example, one of
the twenty Apache servers. Firstly, we could not to warn, in fact, could be it has frequent falls, so
there are 20 nodes, it shouldn't warn us for the fall of only one node ( let's imagine that this
warning wake up someone who is sleeping. In fact, a service with so many redundance is for giving us
more peace, not more work. It should only warn us if a more critical element is down (such as a
router) or if "several" WEB servers are down, for example, four or five of them.
In this way, if we put "weights" to each element from our example:
• Switches and routers: 5 points for each one when there are in critical, and 3 points if they
are in warning.
• WEB servers: 1.2 point for each one in critical. We don't consider the warning status.
• WebLogic Servers: 2 points for each one in critical.
• MySQL cluster: 5 points for each node, 3 points in warning.
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We fix a warning threshold for the service of 4, and a critical threshold of 6. In this way, and
supposing that all things are going ok the service would be "OK" if all the monitored elements are
OK.
Now, suppose that ONE APACHE WEB server:
• 1 x Apache server in CRITICAL x 1.2 point = 1.2 so 1.2 < 4 (Warning), the service is still in
the OK status
See what happens if a WEB server and a Weblogic are down:
• 1 x APache server in CRITICAL x 1.2 point = 1.2
• 1 x Weblogic server in CRITICAL x 2 = 2
Summarizing: 3,2 is still < 4, so the service is still in Ok status and without waking up the operator
from the bed.
See what happens if two WEB servers and one Weblogic are down:
• 2 x Servidor Apache en CRITICAL x 1.2 point = 2.4
• 1 x Servidor Weblogic en CRITICAL x 2 = 2
Then, 4,4 is now > 4 and the service for the WARNING status. It's possible that a urgent SMS has
not been received from the operator yet, but it's sure that at least someone will receive an email.
Let's continue with the example.
Supposing that besides the previous thing, one Router is down:
• 2 x Apache server in CRITICAL in x 1.2 point = 2.4
• 1 x Weblogic server in CRITICAL x 2 = 2
• 1 x Router in CRITICAL x 5 = 5
We have already a 9,4 higher to the 8 threshold for CRITICAL, so the service is in critical and our
operator has no other option than to wake up.
The service monitoring is a feature only for the Pandora FMS Enterprise version.

17.2.2. Creating a new service
The service represents an association of agent modules and their value is calculated in real time.
Because of that first of all you need to have all your devices that make a service monitored and with
their module's values normalized to three status: Normal, Warning and Critical. You can learn more
about them in their wiki sections: Monitoring with Pandora FMS and Monitoring with policies.
When you have all the devices monitored you can make group of them with the service. Inside each
service you can add all modules you need to monitor the service. For example if you want to
monitor the online shop service you need a module that monitors the content, another which
monitors the comunication status and so on. Trough the next steps you can see how create a service
with Pandora FMS.
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To create a new service click on the service tab of Operation menu.

The list of services will appear, the image below shows the list without services.

To create a new service just click on botton Create. Then you can create the service filling the fields
of the form below.
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At this moment we have a service created without items, so we have to add items to the service. To
add a new item click on the oragne tool an the right top of Service Management tab and after in the
botton Create. Then the form below will appear. In this form you must select a module of an agent
to add. Also you must fill the fields related to the weight of this module inside the service for
Normal, Warning and Critical status. The heavier a module the more important is within the
service.

When all fields are filled click on button create and the next picture will appear with the succesful
message.
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You can add all items you need to monitor your service. For example we have added elements of
this service with the proper weights and the result is like in the next picture.

Once you have your service created you can go to Service Operation tab clicking.

Then the service opeartion list will appear like the image below. This view is calculated in real time
and the parameters showed are:
•
•
•
•
•
•
•

Name: name of the service.
Description: description of the service
Group: group the service belongs to
Critical: limit value from which the service is in critical state.
Warning: limit value from which the service is in warning state.
Value: value of the service. It's calculated in real time.
Status: state of the service depending on its value and the critical and warning limits.
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If you click on a service name you will see the sepcific service view. As you know the value of a
service is calculated as the addition of the weights associated to the state of each module. Services,
same as modules, has associated an state depending on its value. This view shows the status of each
service item and with following parameters:
•
•
•
•
•
•
•
•

Agent Name: name of the agent the module belongs to.
Module Name: name of the module.
Description: free description.
Weight Critical: weight when the module is in a critical state.
Weight Warning: weight when the module is in warning state.
Weight Ok: weight when the module is in normal state.
Data: value of the module.
Status: state of the module.
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It's also possible to create modules associated to services, with the advantages that this implies
(calculation periodicity, integration with the alert system, etc). The way to associate one module to
a service is to follow the following steps:
1. Create the individual monitors that make up the service and make sure that they work well.
2. Fix the individual thresholds for each monitor to define CRITICAL and/or WARNING states.
3. Create a servoce with those monitors that we want, and define thresholds for the service and
weights for each monitor included in the service.
4. Go to the agent where we want to "locate" the monitor associated to the service.
5. Create a new module of "prediction" kind associated to this agent, using the module editor
of the Prediction server, in order to associate it to one of the services of the list.
6. If we want to associate alerts to the service, then we should do it on the module that is
associated to the server. The server, as it is, has no possibilities of adding alerts, neither
graphs or reports. All these has to be done through the monitor that is linked to the service,
as we have described before.
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After you have all your services created you can create Visual Maps to show the status of your
services at everytime in a visual way. You can see more informatio about Visual Maps of Pandora
FMS in their wiki section: Data display and reporting
With this tool we have made the maps you have seen in the introduction and which represent the
service of Chip Company. Below you can see the map of Chip Company services.

Furthermore is you need a more technical map you can create maps more detailed with Visual Map
Console of Pandora FMS. You can add icons, graphs, status dots, tags and simple data. In the
picture below you can see the technical map of Online Shop service with the status of all devices.
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17.2.3. Services groups
The services are logic groups which are part of the company business structure. Because of that, it
could be necessary make groups of services because sometimes services alone do not have a
complete meaning. To create service groups you have to add each service to an existing agent, in
this case a service will be a module of the agent. With these groups we can create a new logic
structure, a group of services.
These groups can help us to create visual maps, configure alerts, apply monitoring policies, etc. So,
we can create alerts which trigger an alarm when the status of the company is critical because our
salesmen can not do their job properly, or when one of our headquarters can not work properly
because technical problems with their ERP.
To see it more clear, below you can see two example of services groups.

17.2.3.1. Several services inside the same company
Following the previous example, we could suppose that we also have salesmen who sell the WEB
service our clients and they have to access to a CRM to manage their clients.
Our CRM service is made with:
• Two routers HA.
• Two Apache WEB servers.
• MySQL cluster 2 nodes for data and 2 nodes for processing SQL.
For the example we can suppose that the CRM architecture is monitorized and that the CRM service
was created.
At this moment we have two services:
1. WEB Cluster Service (for our clients)
2. CRM Service (for our sales deparment)
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To use service groups the best option is create a new agent called, for example, "Company" which
has Cluster Service and CRM Service as modules. Thus the services will be grouped in this way.

17.2.3.2. Different services through several headquarters
Another example could be that we want monitor the different headquarters of a company, and each
headquarter has his own services.
For this example we could suppose that there is three headquarters with the following services:
CRM, ERP and Internal Web. Services are configured with specific needs of each headquarter. At
this point, we have all services monitored for each headquarter like in the following picture.
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But, we could need another logic representation that grouped the services of each headquarters
together to get a structure closer to your company inside Pandora FMS. To do that we could create
an agent for each headquarters with a module for each service of this headquarter. With this
approach we obtain the following groups. Pero puede surgir la necesidad de crear agrupaciones
lógicas que representen a las diferentes sedes de la empresa para poder tener en Pandora FMS una
estructura más fiel a la que existe en la realidad. Para ello podemos crear un agente por sede cuyos
módulos sean los diferentes servicios de dicha sede, obteniendo los siguientes grupos.

With this way to grouping services, we can create the logic structure present in the real world inside
Pandora FMS. Furthermore we obtain a full monitorization of all services.
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18 OPERATION WITH SNMP TRAPS
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18.1. Introduction
Pandora FMS has a trap reception console that allows to display traps sent by monitored objects and
add alerts to such traps. SNMP traps are recieved through the operating system demon that Pandora
FMS's SNMP server starts when Pandora's server starts. This server, usually stores traps in a logfile
/var/log/pandora/pandora_snmptrap.log.
Traps are usually recieved in "raw" format, that means, with numeric OID's, unless a MIB installed
in the Operating System is capable of solving them. Pandora FMS Enterprise's SNMP console,
enables rule creation for renaming numeric OID's to alphanumeric OID's or simple descriptive text
strings (e.g.: Interface is down) in order to make working with TRAPS more intuitive. Pandora FMS
allows to load Trap MIB's of any manufacturer in order to automatically define such rules.

18.2. Access to trap reception console
To go to the trap reception console go to Operation > SNMP console where is the list of traps that
have been received. There is an icon( an eye) that allows to display all the trap information, same
as with the events. Here we could see the detailed info of a SNMP trap.

For each trap following columns are displayed:
Status:
Green box if trap is validated or red one if not so.
SNMP Agent
Agent which sent the trap. An address of the agent is obtained from the agentaddr field of the
protocol data unit (PDU) if sent trap is SNMPv1. Otherwise, a source address of the packet is used.
OID
Sent trap's OID. If sent trap is SNMPv1, the enterprise field of the PDU is used. Otherwise, the
snmpTrapOID filed is used.
Value
Value field of sent trap. A trap can only send a data in this field. Not used in SNMPv2 Trap.
Custom OID, Custom Value
Customized fields sent in the trap. They could be very complex data, that have an specific logic
depending on the device that send the trap. A trap can sent several data in these field.
Time Stamp
Time elapsed since trap reception.
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Alert
Yellow box if any alert was launched with this trap or grey one if no alert was launched.
Action
Field for deleting or validating the trap.
On top of that, traps have different colors depending on the trap type.
•
•
•
•
•

Blue: Manteinance traps.
Lila: Information traps.
Green: Normal traps.
Yellow: Warning traps.
Red: Critical traps.

18.2.1. Trap Filtering
In the upper part of the trap console option “Toogle Filter” is displayed. Clicking on that option trap
filtering fields appear or dissappear.

It is feasible in the trap console to filter by following fields:
Agent: Combobox where Pandora agentes are displayed.
OID: Combobox where OIDs are displayed.
Alert: Combobox to select either triggered or nontriggered alerts.
Search value: Combobox to freely input any text.
Severity: Combobox where the different trap types are displayed: Maintance, Information,
Severity, Warning y Critical.
• Status: Combobox to select between alert SNMP validated, not validated or all.
• Free search: search by any alphanumeric field in the trap.
• Type: type filter in SNMP alerts. Could be: Cold start, Warm start, Link down, Link up,
Authentication failure or Other.
•
•
•
•
•

On top of these search fields there is the option “Block size of pagination”, that allows to define the
ammount of traps to be displayed per page.
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18.2.2. Trap Validation
In order to effectively manage the traps, it is possible to validate them, so the administrator can
discriminate between the traps she's already seen and the pending ones.
In order to validate a trap, click on the green circle at the left of the trap.

It is also possible to validate multiple traps marking them all and clicking on the green “validate”
button.

18.2.3. Trap Deletion
It is possible to delete traps once they have been treated.
To delete a trap, click on the red cross at the left of the trap.

18.3. SNMP Trap Alerts
It's possible to associate an alert to a trap, so Pandora FMS warns us on arrival of a specific trap. To
298

SNMP Trap Alerts

manage alerts associated to traps, go to Administration>Manage SNMP Console. SNMP traps have
got nothing to do with the rest of the system alerts, even if both reuse the actions' system.

18.3.1. Alert creation
To add an alert associated to a trap go to Administration>Manage SNMP Console and click on
“Create”.
The SNMP alert traps have several fields that could be used to "search" data in the SNMP trap. The
fields that could be used, both separately and in combination are:
• Description: Combox for an alert's description.
• OID: main Trap OID.It's a regulara expresion. If a regular expression is not used, it'll look for
the exact string. If you look for a piece of the OID, a regular expression should be used, so if
we want to search, for example 1.21.34.2.3 in a larger OID, we could use the regular
expression .*1.21.34.2.3.*
• Custom Value/OID: This search in the trap "Value" fields, and also in the fields "Custom
OID" and "Custom Value", that is, in the rest of the TRAP fields. Here it works, the same, the
substring "Testing TRAP" with the regular expression "Testing.*TRAP.*"
• SNMP Agent: IP of the agent that send the trap. Same way, we can use a regular expression
or a substring.
• Trap type: Filter by trap type: Cold start, Warm start, Link down, Link up, Authentication
failure o Other.
• Single value: Filter by trap value. In this example is .666
• Custom OID/Data #1: It's a regular expression. It is possible to use selectors in order to
select a part of the regular expression that will be load in _snmp_f1_ macro. You can use this
macro in Field #1 (Alias, name), Field #2 (Single Line) and Field #3 (Full Text).
• Custom OID/Data #2: It's a regular expression. It is possible to use selectors in order to
select a part of the regular expression that will be load in _snmp_f2_ macro. You can use this
macro in Field #1 (Alias, name), Field #2 (Single Line) and Field #3 (Full Text).
• Custom OID/Data #3: It's a regular expression. It is possible to use selectors in order to
select a part of the regular expression that will be load in _snmp_f3_ macro. You can use this
macro in Field #1 (Alias, name), Field #2 (Single Line) and Field #3 (Full Text).
• Custom OID/Data #4: It's a regular expression. It is possible to use selectors in order to
select a part of the regular expression that will be load in _snmp_f4_ macro. You can use this
macro in Field #1 (Alias, name), Field #2 (Single Line) and Field #3 (Full Text).
• Custom OID/Data #5: It's a regular expression. It is possible to use selectors in order to
select a part of the regular expression that will be load in _snmp_f5_ macro. You can use this
macro in Field #1 (Alias, name), Field #2 (Single Line) and Field #3 (Full Text).
• Custom OID/Data #6: It's a regular expression. It is possible to use selectors in order to
select a part of the regular expression that will be load in _snmp_f6_ macro. You can use this
macro in Field #1 (Alias, name), Field #2 (Single Line) and Field #3 (Full Text).
• Field 1: Field 1 to set the parameter of the alarm's command.
• Field 2: Field 2 to set the parameter of the alarm's command.
• Field 3: Field 3 to set the parameter of the alarm's command.
• Min. Number of Alerts: Field to define the minimal amount of traps that have to arrive for
299

SNMP Trap Alerts

the alarm to be triggered.
• Max. Number of Alerts: Field to define the maximal amount of times the action will be
executed.
• Time Threshold: Field for defining the time to elapse before resetting the alarm counter.
This counter is the one used for field Min. Number of alerts.
• Priority: Combobox for establishing the alarm priority.
• Alert Action: Combobox for selecting the action that will execute the alert.If you select an
event, the normal event of alert creation will be not created.

In this situation, when an alert is defined using an event and the field 1 to generate the information,
the result would be an event like the following:
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Once the fields are filled in, click on “Create”

18.3.2. Alert Edition
To edit an alert associated with a trap, go to Administration>Manage SNMP Console, select the
alert you want to edit and click on the tool icon.

A page with the alert's configuration is shown. Fields to be changed are changed, then click on
Update.

18.3.3. Alert Deletion
To delete an alert associated with a trap go to Administration>Manage SNMP Console, select the
chosen alert, then click on the red X.
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18.4. Customising SNMP Traps
In order to make the operator understand better the traps sent by the monitored devices, it is
possible to either load the manufacturer's MIBs to Pandora FMS or edit the traps as it likes.

These are Pandora FMS Enterprise features

18.4.1. Renaming/Customising Traps
"Editing traps" is a process where the operator is allowed to "customise" the appearance a trap has
in the console.
If you take a look at the following screenshot, it could happen that all of your traps are difficult to
distinguish due to the mess received as the data they contain. Could we rename them, so we could
identify them as "Blue box" instead of a huge amount of senseless encrypted data?

To edit a trap, go to Operation > SNMP Console and click on the OID field of the chosen trap.
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A page like the following will appear:

This way, when the SNMP Console finds traps with OID ".1.3.6.1.4.1.2789.2005", it will display
them as "Blue box sample" and it will be way more readable by the human eye. It's content
(included the original OID) won't be changed at all.
Keep in mind that all the older traps won't change their appearance. This feature will start working
only with new incoming traps in the system from now on.
From the same place, new traps can be created from zero with the "create trap" option. For this, you
only have to go to the trap editor, as shown in this screenshot. In that section we can alter or
remove a trap definition.

Finally, this is how a user redefined trap would be seen:
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18.4.2. Load the manufacturer's MIBs
These are Pandora FMS Enterprise features

This option is useful to upload trap MIBS (only) and do the internal translating Pandora FMS
database bigger, so when a trap comes, it will be automatically translated by its description.
To upload the manufacturer MIBs, click on "Examine", choose the file that should be with txt
extension and click on “Upload MIB”.

Once it has been uploaded, the system will incorporate it to its trap library.

18.5. Alerts with complex SNMP traps
The alerts described previously are used only where the trap is correctly defined, is always the
same, and it doesn't have a relevant data to recover.
However, in certain situations, we might find a trap with the following structure:
OID: .1.3.6.1.4.1.2789.2005 Value: 666 Custom data: 1.3.6.1.4.1.2789.2005.1 = STRING: "ID
00342" .1.3.6.1.4.1.2789.2005.2 = STRING: "Automated check" .1.3.6.1.4.1.2789.2005.3 =
STRING: "NIC Offline" .1.3.6.1.4.1.2789.2005.4 = STRING: "4897584AH/345"
This is a "complex" trap which, besides a OID and a value, contains complex data, based in many
other OIDs and values. A trap can contain, in its complex part, a completely random structure,
based in OID/value pairs (counters, numeric, alphanumeric, dates...).
This trap would be seen in the trap console this way:
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If we pay close attention to the extended info (Custom data), there are some pieces of useful data.
For instance, in the first field, with the OID ending in 2005.1, that looks like an identifier. The third
field with OID ending in 2005.3 looks like an error message. Fields 2 and 4 don't look pretty useful,
since they seem to be an unknown code for us.
Let's think we can create an event from a trap, placing specific parts of the trap data in the text. For
instance, let's suppose we want to build an event containing the following information:
Chassis Alert: <error message> in device <identifier>
The challenge is to make an alert which does a "match" in those fields, obtaining the piece of data
and using it later to create a message in the alert. We can do this with Pandora FMS, using
advanced regular expressions, using selectors. You can find more info about regular expressions
here: [1].
The selectors, using (), allow us to "copy" information, using a search expression.
The regular expression to obtain fields 1 and 3 would be the following:
.*.1.3.6.1.4.1.2789.2005.1 \= STRING\: \"([09\\_AZaz]+)\".*.1.3.6.1.4.1.2789.2005.3 \=
STRING\: \"([\sAZaz]+)\".*
Once we've got the data fields, we must use them in the alert. With this purpose, the special macros
_snmp_f1_, _snmp_f2_ and _snmp_f3_ are used. Using these macros doesn't have any sense out of
SNMP trap alerts.
To build the message, we would use the following string:
Chassis Alert: _snmp_f2_ in device _snmp_f1_
In resume, this is how the complete alert would be created:

305

Alerts with complex SNMP traps

And this is how it would be seen in the event viewer.

In order to successfully make this kind of alerts, it is needed a good knowledge of regular
expressions, since a simple blank space, a symbol or another character in the wrong place could
make it work wrong. Always remember the SNMP alerts implies the use of regular expressions.
The way to establish an easier alert, using regular expressions, would be the following:
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This alert would be "Compatible" with the previous one in a way that, for the same trap, two
different events could be displayed:

18.6. Trap association to the rest of Pandora alerts / SNMP Agent trap
forwarding
The alerts defined on traps are completely independant from Pandora's alert engine, so correlations
of kind “trigger an alarma if temperature reaches 29 degrees and the trap for secondary power
supply is on” cannot be established. This kind of alerts can neither be displayed (since they are
eventually not associated to any Pandora FMS module, and thus, trap console monitoring cannot
be related to elements such as reports or maps.
Special ModuleModule SNMPTrap,with the trap sent from the SNMP console:

In order to achieve this, a method called "Agent SNMP Trap Forwarding" exists. This (server wide)
option forwards the trap to a special agent's module named "SNMPTrap" as a text string, if and only
if, the trap's origin IP address is defined as agent IP. Whenever this occurs, the trap arrives as a text
line to the agent inside that module, which is a module that's only defined at arrival of the first trap.
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Text alerts can be specified on that module, being these completely standard, just as any other
module. This enables for customization of SNMP monitoring in order for certain traps from certain
origins to be treated as yet another module, and thereby integrate it in the rest of the monitoring,
including alert correlation.
SNMPTrap data sample':

This is a Enterprise feature, and could be activated in the main setup screen, as shown here:
Configuration option to activate the trap forward to the agents:

If this setting is changed, Pandora FMS server needs to be restarted to enable it.
Another solution is mounting an alert on the trap to activate an agent's module. For example, be the
trap a "1" written in certain logfile, and there is an agent reading that file ready to run when it finds
a "1". This way, the module will be triggered when the desired trap arrives and the correlation can
be established basing on the arrived trap.

18.7. Trap Filtering in the Server
Some systems gets a high number of traps. From this ones, we are interested only at monitoring a
tiny percentage. From the Pandora FMS 3.2. version it's possible to filter the traps that the server
gets in order to avoid loading the application in an unnecessary way.
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From Administration>Manage SNMP Console>SNMP Filters, it's possible to define different filters.
One trap that goes with any of them, it will be only automatically ruled out for the server.

The filter is applied as a regular expression over the corresponding entry of the trap in the SNMP
log (by default /var/log/pandora/pandora_snmptrap.log), that has the following format:
SNMPv1 Trap:
%4y-%02.2m-%l[**]%02.2h:%02.2j:%02.2k[**]%a[**]%N[**]%w[**]%W[**]%q[**]%v\n

SNMPv2 Trap:
%4y-%02.2m-%l[**]%02.2h:%02.2j:%02.2k[**]%b[**]%v\n

Being:
•
•
•
•
•
•
•
•
•
•
•
•
•

%y: Current year.
%m: Current month (numerical).
%l: Day of the current month.
%h: Current hour.
%j: Current minute.
%k: Current second.
%a: Origin address (only traps from version 1).
%b: Origin address (source address of the packet)
%N: OID.
%w: Kind of trap (numerical).
%W: Trap description.
%q: Trap's Subkind (numerical)
%v: variable list in tab separated format (custom OID).
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Note that if trap is SNMPv2, trap OID is contained in the %v as 2nd parameter, and 3rd and
following are parameters actual part of the variable list (custom OID).
For example, to filter all the sent traps by host 192.168.1.1 we could define the following filter:

18.8. External SNMP Trap Handler
The SNMP console is only to get traps, so it only processes TRAP as individual item, but one trap
can have lot of information. Sometimes, it happens that the only monitoring we could do is based
on traps. For doing it, we could choose to "post processing" the information that is got in one trap
through an external script, that works as a plugin.
To process the data of one trap in detail, you can send all the information of one trap to an script,
as a result of an alert. I have used this trap for the example. It's the trap view as it would be in the
Pandora's SNMP console log:
20100826 12:01:46 pandora 10.201.246.2 .1.3.6.1.4.1.1722 .1.3.6.1.4.1.1722.2.10.1.1.1 233 .
1.3.6.1.4.1.1722.2.10.1.1.3 = STRING: AIX_Software_Failure .1.3.6.1.4.1.1722.2.10.1.1.2 =
STRING: 08 25 2010 08:23:43:697685 .1.3.6.1.4.1.1722.2.10.1.1.8 = STRING: 1: A software error
PERM with label CORE_DUMP, identifier C69F5C9B occurred at Wed Aug 2 5 10:22:28 DFT 2010 on
dvs02 for resource SYSPROC. Cause is SOFTWARE PROGRAM ABNORMALLY TERMINATED. .
1.3.6.1.4.1.1722.2.10.1.1.6 = STRING: 8 .1.3.6.1.4.1.1722.2.10.1.1.11 = STRING: An application
may not work properly .1.3.6.1.4.1.1722.2.10.1.1.10 = STRING: An application may not work
properly .1.3.6.1.4.1.1722.2.10.1.1.12 = INTEGER: 4 .1.3.6.1.6.3.1.1.4.3.0 = OID: .1.3.6.1.4.1.1722
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In the screenshots you can see how an special alert would be created. It executes an script with the
complete contents of the trap (_data_) and how the SNMP alert kind is created. In this case it has
been mapped for the Specific OID (.1.3.6.1.4.1.1722.2.10.1.1.1) but it could have been more
general, for example (.1.3.6.1.4.1.1722) to call the script when there would be any kinds of traps
like these (.1.3.6.1.4.1.1722, I suppose it would be part of the AIX specific MIB)
An script that processes these data is executed. It also "analyzes" the trap to write data in Pandora
FMS directly, creating an XML and putting it at /var/spool/pandora/data_in as data, as it would
come from an agent. A basic script for this case would be, for example, to generate complex
information, so we already have enough information in this trap, that is:
• Origin IP
• Main Event (Cold start)
• Secondary Events (descriptives): AIX_Software_Failure, 1: A software error PERM with label
CORE_DUMP, identifier C69F5C9B occurred at Wed Aug 2 5 10:22:28 DFT 2010 on dvs02
for resource SYSPROC. Cause is SOFTWARE PROGRAM ABNORMALLY TERMINATED, An
application may not work properly, An application may not work properly.
When designing an script that "parses" each of these data, for example "miscript.pl" and that store at
/var/spool/pandora/data_in in the XML with a generic name plus one random number,
e.g.snmp_gateway.31415.data
The generated XML should be like this:

<?xml version='1.0' encoding='ISO-8859-1'?>
<agent_data description='' group='' os_name='aix' os_version='' interval='300'
version='3.1(Build 100608)' timestamp='2010/08/26 12:20:26'
agent_name='10.201.246.2'>
<module>
<name><![CDATA[Critical_Event]]></name>
<description><![CDATA[]]></description>
<type>async_proc</type>
<data><![CDATA[1]]></data>
</module>
<module>
<name><![CDATA[events]]></name>
<description><![CDATA[]]></description>
<type>generic_string</type>
<datalist>
<data><value><![CDATA[AIX_Software_Failure]]></value></data>
<data><value><![CDATA[A software error PERM with label CORE_DUMP, identifier
C69F5C9B occurred at Wed Aug 2 5 10:22:28 DFT 2010 on dvs02 for resource
SYSPROC.]]></value></data>
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<data><value><![CDATA[Cause is SOFTWARE PROGRAM ABNORMALLY TERMINATED, An
application may not work properly, An application may not work
properly.]]></value></data>
</datalist>
</module>
</agent_data>

The application is endless, but, any script should be customized, so it would have a very dynamic
structure. In lot of systems the information that is get is not only text, but also numerical, so it could
feed numerical information modules in order to could represent graphics, etc. Please, consider that
all data is always asynchronous.

18.8.1. Practical Sample: ESX Monitoring using traps
One of the most problematic things to monitor is "distributed" infraestructure, more if each version
changes it's implementation to gather information, like VmWare ESX. In this small chapter we try to
explain how to monitor ESX systems using an external SNMP Trap handler.
ESX traps are like this:
.1.3.6.1.4.1.6876.4.3.301 = STRING: "host" .1.3.6.1.4.1.6876.4.3.302 = STRING: "c700006
01.tsm.inet" .1.3.6.1.4.1.6876.4.3.303 = "" .1.3.6.1.4.1.6876.4.3.304 = STRING: "Green" .
1.3.6.1.4.1.6876.4.3.305 = STRING: "Yellow" .1.3.6.1.4.1.6876.4.3.306 = STRING: "Host cpu usage 
Metric Usage = 1%"
.1.3.6.1.4.1.6876.4.3.301 = STRING: "host" .1.3.6.1.4.1.6876.4.3.302 = STRING: "dl360
00.tsm.inet"
.1.3.6.1.4.1.6876.4.3.303
=
""
.1.3.6.1.4.1.6876.4.3.304
=
STRING:
"Yellow".1.3.6.1.4.1.6876.4.3.305 = STRING: "Green" .1.3.6.1.4.1.6876.4.3.306 = STRING: "Host
memory usage  Metric Usage = 84%"
.1.3.6.1.4.1.6876.4.3.301
=
STRING:
"host"
.1.3.6.1.4.1.6876.4.3.302
=
""
.
1.3.6.1.4.1.6876.4.3.303 = "" .1.3.6.1.4.1.6876.4.3.304 = STRING: "Red" .1.3.6.1.4.1.6876.4.3.305
= STRING: "Green" .1.3.6.1.4.1.6876.4.3.306 = STRING: "Datastore usage on disk  Metric Storage
space actually used = 55%"
As you can see, traps could be used to gather information from CPU, Disk or Memory. The global
idea behind the trap handler is to write a small script able to "understand" the trap and create a
XML simulating a software agent. So for each technology you should write a trap handler, but all
the process is common. The process to understand this is explained in four steps.
1. Create the handler script. You can base your work on the script provided below.
2. Create an alert command.
3. Create an alert action using previous command, sometimes with custom options for each
"destination" agent you want (if you have several farms of ESX; you will like to have data in
different agents.
4. Create a SNMP Trap alert which maps the enterprise OID (information trap contains for all
kind of this specific technology) and / or the source trap IP address.
Let's see the first step: Creating the trap handler script:

18.8.1.1. Trap handler: esx_trap_manager.pl
#!/usr/bin/perl
# (c) Sancho Lerena 2010 <slerena@artica.es>
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# Specific Pandora FMS trap collector for ESX
use POSIX qw(setsid strftime);
sub show_help
print
print
print
print
exit;
}

{
"\nSpecific Pandora FMS trap collector for ESX\n";
"(c) Sancho Lerena 2010 <slerena@artica.es>\n";
"Usage:\n\n";
"
esx_trap_manager.pl <destination_agent_name> <TRAP DATA>\n\n";

sub writexml {
my ($hostname, $xmlmessage ) = @_;
my $file = "/var/spool/pandora/data_in/$hostname.".rand(1000).".data";
open (FILE, ">> $file") or die "[FATAL] Cannot write to XML '$file'";
print FILE $xmlmessage;
close (FILE);
}
if ($#ARGV == -1){
show_help();
}
$chunk = "";
# First parameter is always destination host for virtual server
$target_host = $ARGV[0];
foreach $argnum (1 .. $#ARGV) {
if ($chunk ne ""){
$chunk .= " ";
}
$chunk .= $ARGV[$argnum];
}
my $hostname = "";
my $now = strftime ("%Y-%m-%d %H:%M:%S", localtime());
my $xmldata = "<agent_data agent_name='$target_host' timestamp='$now' version='1.0'
os='Other' os_version='ESX_Collectordime ' interval='9999999999'>";
if ($chunk =~ m/.1.3.6.1.4.1.6876.4.3.302 \= STRING\: ([A-Za-z0-9\-\.]*)\s\.1/){
$hostname = "_".$1;
}
if ($chunk =~ m/Host cpu usage \- Metric Usage \= ([0-9]*)\z/){
$value = $1;
$module_name = "CPU_OCUPADA$hostname";
}
if ($chunk =~ m/Host memory usage \- Metric Usage = ([0-9\.]*)\z/){
$value = $1;
$module_name = "MEMORIA_OCUPADA$hostname";
}
if ($chunk =~ m/Datastore usage on disk \- Metric Storage space actually used \=
([0-9\.]*)\z/){
$value = $1;
$module_name = "DISCO_OCUPADO$hostname";
}
$xmldata .=
"<module><name>$module_name</name><type>async_data</type><data>$value</data></module
>\n";
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$xmldata .= "</agent_data>\n";
writexml ($target_host, $xmldata);

18.8.1.2. Step 2: Create the alert command
In this example, I've put the command script in /tmp, put on a safer place, and be sure it's
executable (chmod 755):

18.8.1.3. Step 3: Create the alert action
Create specific action to send all information to a specific agent traps. In this case information will
be sent an agent named WINN1247VSR. The above command accepts as parameters the name of
the agent that will go all the information (ESX Virtual Center), and "chunk" of data from the TRAP,
which can be unlimited and includes all the information you send the trap.

314

External SNMP Trap Handler

18.8.1.4. Step 4: Create the SNMP alert
Set alert traps using the action you have just created.

In order to process all the traps of ESX Tecnology, this will find, using the specific OID .
1.3.6.1.4.1.6876.4.3.301 to map ESX traps. We may also filter by source IP for each VirtualCenter,
by filtering for IP address origin (send in the trap).
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18.8.1.5. Data visualization
This is a sample on how information will see. With this data, you can manage as standard modules.
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19 OTHER KIND OF MONITORING
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19.1. Introduction
In addition to features like remote monitoring, agent based monitoring or web monitoring, Pandora
FMS offers other advanced resources to improve the monitoring. With this resources you can
forecast the value of a module based on historical data or create new modules doing arithmetic
operation with existing modules.

19.2. Monitoring with synthetic modules
This is an Enterprise version feature. A synthetic module is a module which obtains its value from
already existing data in other modules. Let's see some examples:
• A module called "Traffic sum" which sums the values of the incoming and outcoming traffic
of a router, generating a new module with the total traffic of the interface.
• A module called "Total users" which sums the values of ten modules called "Connected users"
in each of the five servers where the number of connected users is monitored.
Synthetic modules are in the end, modules built from other modules' data, which could be in the
same agent or in different ones. The operations we can make are arithmetics (sum, substraction,
multiplication, division) between modules and/or with absolute values.
The first step to create a synthetic module is going to the management section of an agent, in the
module flap, where we'll pick the choice of creating a new module with predictive type.

In our first example, we'll create a fictitious module which will contain the arithmetic average value
of two modules from two different agents: CPUUse (SanchoXP) and cpu_user (garfio). That
module in each machine measures the use percentage of the CPU and they are two Windows and
Linux machines respectively. The final result will be a module stored in agent SanchoXP which will
contain the average of both values.
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In the second example, a new module is created, called "Total accesses" with the average value
extracted from the modules "Apache_accesses" from two different agents, called SanchoXP and
SanchoXP_2.

Another easier, but useful example, is the one which has been used to create the module "Total
accesses" in SanchoXP_2. It simply "copies" the value of a module with the same name in Sancho
XP to produce the value.
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In order to operate with other logical operations (Multiplication, substraction, division), we simply
have to keep in mind the order of the operators. Play with the interface to see how any other
arithmetic operation between different modules can be made. Besides, we can use a fixed value (see
screenshot) to add it to our logical operations.
You can select multiple agents from the box on the left side (using control) so in the central box, all
the "common" modules from the selected agents will be shown. This can be pretty useful to make
"averages" from common modules in a server group. (i.e: CPU or disk space).

19.3. Predictive Monitoring
In order to monitor an element with a prediction module, you should have a module prior to make
the predictions on it. A good module for it could be the free disk or RAM quantity in a system,
because the lack of them could cause a bad performance in itself. Another interesting module could
be the latency that exists between the Pandora FMS Server and a Internet server, such as Google.
Because of this, an agent will be created, and inside of it, a prediction module that monitors the
latency between our server and Google. Please, in order to do this, check the network module
creation section. In order to get the prediction to make sense, it is necessary to have a pattern in the
information to predict, preferably a pattern that is repeated in time, daily or weekly.
Withprediction server we can work in two lines:
• Predict which would be an acceptable value, in a 510 minutes time range (or more, but
with the worse the approach, the longer the time we consider for the future).
• To say if there is an anomaly or not in the value that has been collected by the "source"
module that is being analyzed.
Let's see how a predictive module can be defined.
In the Pandora FMS Console Management section, click on Manage agents.

In the next screen click on Create agent:
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Fill in data for your new agent and click on Create agent:

Once you have create the agent, press on the modules upper flap. In it, select create a new network
module and press on Create:

Once you have press on Create, a form will be shown in which you should fill in the required fields
in order to create a prediction module.
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Next we detail the form fields:
• Name: module name
• Disabled: shows if a module is deactivated.
• Type: kind of data that the module will monitor; these could be booleans and numeric.
Depending on the kind, we will act as an anomalies detector (boolean module kind) or as a
"predictor" of the module value in the future (numeric data kind module).
• Module Group: group for the module.
• Source module: the module that will monitor data. The group is useful to do an small
previous filter. You should select an agent and a module.
• Interval (in advanced features): the interval will show the number of seconds in the future
(if it is kind predictor, not anomalies detector), from which we want to obtain the data.
As we can see, we have selected the module Host Latency from a previously created agent called
Google. These are the agent Googledata:

And the data that has been obtained for the two modules, in an specific moment, are the following:
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Doing a tracking of the latency data, clicking on the box with a D below the Raw Data column, we
will see the raw data received for the last day:

Though we don't have much data, in this case we can see that the media is going to be between 13
and 15 seconds. If this media gets altered from these values, then the prediction module will notify
us about it. Nevertheless we need at least, a week of data in order to get the prediction to
work.
Following this, we will explain in detail how the module works:
The Pandora FMS artificial intelligence and prediction server implements in an statistical way a
data prevision based in past data (up to 30 days in four temporary references).
A complementary data model to the one of Pandora FMS has been designed. It allows the modules
which contains prediction data to be fed of real module data. Modules of predictive type are
processed by a server that works only with data of the same type in a throughly modular way, so it
is very easy to implement (even in different languages) several cores of the information processing
to make predictions much more complete in base on the neuronal bayesian networks.
By now, the prediction has two kind of modules: a numerical data prediction based in a temporary
margin (defined as interval in the new predictive module), or a detection in the alteration of the
"normal" performance in a temporary margin defined as 1/2 of the defined interval. The widest the
temporary margin, the more possibilities of errors the prediction will have and widest possible value
range will be considered.
These two modules are implemented, with boolean modules, which belong to the second kind of
prediction (anomalies); numeric and incremental numerics, belonging the last ones to the second
kind of prediction.
In order to get the prediction working, it should have at least data from a week. Otherwise, it is not
possible to predict it. The prediction is done through the average value calculation of the module in
an specific interval, in four time moments, t1, t2 , t3, t4. Being t1 the value for a week ago, t2 the
value for two weeks ago and so to t4.
For the anomalies calculation, it is also possible to calculate the typical deviation for these samples
with values different from 0, and to compare the real value on the «predicted» +/ the typical
deviation.
The amount of samples are adjustable (though Pandora FMS usually does not keep useful values
older than a month).
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An essential parameter in the prediction is the interval of itself, available in the advanced options of
the module:

The rest of the fields of the advanced features are the same that the rest of modules.

19.3.1. Monitoring with Netflow
This is a special case of monitoring with prediction server and it's an Enterprise version feature.
Netflow modules can calculate the average traffic on an interval for a pattern defined on a Netflow
filter. The average is calculated in bits per second.
The first step is define the filter. For example, to configure a module to return the web traffic
average every 10 minutes, click on Administration>Netflow>Filters Create a new filter with the
following configuration:

Keep in mind that the fields Aggregate by and Output format only affect to the graphs of Netflow,
not to the modules.
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Then, we create a module: Administration>Manage agents Select an agent and click Modules:

Select Create a new prediction server module and click Create:

Finally configured as a source Netflow, select the filter and config an interval of 600 seconds (10
minutes).
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20 AUTOMATIC NETWORK DISCOVERY
WITH RECON SERVER
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20.1. Introduction
Pandora FMS Recon Server was introduced by first time in version 1.3. From then, it has had
several updates and improvements.The Recon Server is used to explore the network,using ICMP
(Ping) through tasks defined by the user in order to find new systems (identified by an IP address)
and it add them to the supervision,using the « Plugin Templates» to assign modules automatically to
the new agent.This way, a new system is recorded and a new set of network modules will be
assigned to it so it will be monitored by "itself".
It is important to add that it uses the IP address in order to identify which agents are already
supervised by Pandora FMS. This is the reason why from Pandora FMS 1.3 the agents could have
more than one IP address.
The Recon Server also allows to detect the topology of the detected systems and it add these
systems to the last host known in the path from Pandora FMS to the new host, identifying (by IP)
all the intermediate hosts, defining as host father of the new monitored system as the last known
host before getting to the new system.
The Recon Server sets up a system for the Operative System detection through Xprobe (if it is
already installed) that with the detection (optional) of open ports (done with Nmap), allows to
identify and recognize only any specific systems (e.g:Solaris with port 23, or Windows with 139 and
445 open).

20.2. Recon Tasks
Recon Tasks are defined in the menú Administration > Manage servers servidores > Manage
recontask..

You can create a new task on the screen by pressing on Create , or you can edit the ones that
already exist by pressing on their names:

If you choose to edit or create a new task of network recon, then you should fill in the required
fields in order the task could be processed properly.
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Task name
Name of the discovery task. It's only a descriptive value to could distinguish the task in case it
would have several of them with different values of filter or template.
Recon server
Recon Server assigned to the task. If you have several Recon Servers, then you have to select here
which of them you want to do the recon task.
Network
Network where you want to do the recognition. Use the network format/ bits mask.For example
192.168.1.0/24 is a class C that includes the 192.168.1.0 to 192.168.1.255 adress.
Interval
Repetition interval of systems search. Do not use intervals very shorts so Recon explores a network
sending one Ping to each address. If you use recon networks very larges (for example a class A)
combined with very short intervals (6 hours) you will be doing that Pandora FMS will be always
bomb the network with pings, overloading it and also Pandora FMS unnecessarily.
Module template
Plugins template to add to the discovered systems. When it detects a system that fits with the
parameters for this task (OS, Ports), it will register it and will assign all the included modules in the
defined plugin template.
OS
Operative system to recognize. If you select one instead of any (Any) it will only be added the
systems with this operative system.Consider that in some circumstances Pandora FMS can make a
mistake when detecting systems, so this kind of "guess" is done with statistic patterns, that
depending on some other factors could fail (networks with filters, security software, modified
versions of the systems).To could use this method with security, you should have installed Xprobe2
in your system.
Ports
Define some specific ports or an specific range, e.g: 22,23,21,8090,443,8080.If you use this
field,only the detected hosts that will have at least one of the ports here mentioned will be detected
and added to the system. If one host is detected but it has not at least one of the ports opened, then
it will be ignored. This, along with the filter by OS kind allows to detect the systems that are
interesting for us,e.g: detecting that it is a router because it has the ports 23 and 57 opened and the
system detect it as a "BSD" kind.
Group
It is the group where we should add the discovered systems. It will must assign the new systems to
one group. If it has already one specific group to locate the unclassified agents, then it could be a
good idea to assign it there.
Incident
Shows if by discovering new systems it create an incident or not. It will create one incident by task,
not one for detected machine,summarizing all the detected new systems, and it will create it
automatically in the group previously defined.

329

Recon Tasks

Comments Comments about discovery network task.

Once you have finish,press on "Update" if you are editing a task already created, or "Create" if you
are creating one.
Before defining a new task, it should be a Recon Server started in the system. To assign new agents
to a network server automatically, you also need to start a Network Server.
The plugin and assigned groups to new host templates in this sweeping allows to display a network
recon that explores large networks in minutes or hours.You will be able to detect and start
monitoring a complete network with only some steps.
Once the Recon task have been defined you should fired them in order to obtain information from
the network systems. For it go to the Operation > Pandora servers menu:
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To see the state of the servers. You can also press on the head element All systems that will lead you
tho the same screen:

This screen shows the state of Pandora FMS servers:

Search the Recon server configuration details in the console, and press on it. You will see an screen
with the state of the recon tasks like this:

You should press on the right button of the console to start the recon tasks. Once done this, the
ending of them will take some time.
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20.2.1. Network Topology
Recon allows to do not only a discovery of organization host but doing it in a way that it could
detect how they are connected between them. This means that, as long as it would be well
implemented, Pandora FMS could detect, monitor and represent its network with accuracy,
regardless the nº of systems that its network has got.
This is an snapshot of the systems monitored by Pandora FMs in one of our development servers
that monitor about 1000 systems:

To do this successfully you need to plan the monitoring by levels, such as if would be an onion, in a
way that the levels that are closer to Pandora will be detected in first place, in order that it
recognize them when it will detect the systems that are behind them and this way it could associate
them to the modules already detected.
For doing this, first you should create network tasks for the more immediate communication
systems, and after for the following ones. Once you have detected the more basic systems, create
recon tasks more complex based in architectures and/or systems (by application or by SO),
assigning them predefined network templates, well adapted to the systems that it found: f.e:
creating a template for web servers that monitor the server state through an advanced TCP checkup,
verifying the latency time and the network response, and monitoring service ports such as the SSH
or the FTP. If you have defined WMI checking or suitable Plugins, you can also add them.
If you applies a template that contains a module that is not applicable to a system that has been
detected by first time, it will remain "not started" until it will be deleted automathically by the
systems through the daily maintenance script, where the modules that have never obtained data (or
not " started") will be deleted.
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20.2.2. Example of use
If there would be four C kinds for network servers and a B kind with several work stations, a
«Plugin template» could will be defined for any of these five networks.
For example:
• Template number #1: is used for a Windows server. It could have five modules:
SNMP to know the CPU usage in the Windows server. SNMP to know the available memory in the
Windows server. SNMP to know the network interface data entry. SNMP to know the network
interface data exit. ICMP checks that it continues working.
• Template number #2:Is used to check the UNIX HTTP servers.
ICMP checks that it is working TCP checks that the port 80 is working and if it responds to the
HTTP commands. TCP checks if the port 22 is working and responds to SSH. SNMP to know the
CPU usage. SNMP to know the network interface data entry. SNMP to know the network interface
data exit.
• Template number #3: used to check UNIX Oracle servers:
ICMP checks if it is working TCP checks ir an specific TCP port is working and responding to the
Oracle commands. TCP checks if an specific port is open. SNMP to know the CPU usage. SNMP
module to know the available memory.
• Template number #4: used to check CIFS Windows Servers:
ICMP checks if it is working. SNMP to know the CPU usage. SNMP module to know the available
memory. Several TCP to check the CIFS availability. SNMP to know the network interface data
entry. SNMP to know the network interface data exit.
• Template number #5: used to check the activity of all work stations:
ICMP check that it works TCP checks that the ports that are specifically «forbidden» are closed, such
as the 21,22, 80, 8080, 5900, P2P etc.
Create five supervision tasks, four for each kind of server in each network or subnetwork assigned
to this kind of servers. Assign each task to a different group and assign its network profile. The last
one for the work station, assigns to the all B class and to another different group. Use a shorter
analysis interval (half a day, one day) for the work stations and a longer one for the servers (23
days or one week).
The supervision servers use a ICMP internal analyzer to check if the machine works. When an agent
is created, it tries to solve the IP address to put «hostname» as the name of the agent.

20.3. Recon Scripts
20.3.1. Introduction
The "ReconScripts" new feature allows doing something much more flexible than the network
monitoring and the automatic discovery that the classical recon server did. The recon scripts are
developped in an individual way with completely specific targets, such as the network plugins or the
agent plugins. Each ReconScript is different and has one purpose.
Its basic idea consist on "detect" things in the system it recognizes and automatically log in one
monitoring (network, plugin or wmi) so in a completely customized way we could automatically log
in requests in an Oracle database, new virtual host in a VmWare that is managed with VirtualCenter
or we also can detect new requests in an WebLogic application Server.
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It is possible to do an script or application that does the task that are wanted and schedule its
execution through the Recon Server.
Each ReconScript is customized and very specific, for only one technology. We have developped one
that is completely OpenSource, and we call it SnmpDevices. This script can be found at
/usr/share/pandora_server/util/plugin_reconserver/snmpdevices.pl.
This system allows to check a given IPs interval and create agents for each SNMP system that
answer to it ( given a SNMP community) and also it will automatically create some network
modules (SNMP) depending on the results that it gets, so for each host that it recognizes it will
create four SNMP modules:
•
•
•
•

SysUptime: System Uptime del sistema (nº of seconds from when the system started).
SysName: System name.
Local InReceives: Received Bytes in the system /seg.
Local OutRequests: Transmited Bytes from the system/seg.

And for each recognized interface (it will automatically detect the interface name) it will be created
another three SNMP modules in a host:
• Status: Status (working or not).
• Inbound bps: Entry Bytes in the interface/ seg.
• Outbound bps: Exit Bytes in the interface / seg.

20.3.2. Examples of use
This script could be used in two different ways: from the Pandora FMS console and from the shell.

20.3.2.1. Use from the shell
Using syntax:
./snmpdevices.pl
<custom_field2>

<task_id>

<group_id>

<create_incident_flag>

<custom_field1>

Example of use:
./snmpdevices.pl 3 8 0 192.168.100.0/24 community2010
Doing a recon task with ID 3 to which it'll be associated to. The created agents will be assigned to
the group with Id 8 (Databases). The incident creation has been deactivated with the third
parameter to 0. It will ve check on network 192.168.100.0 with mask 24, so it'll be checked from IP
192.168.100.1 to 192.168.100.254 and this check will be done with the community
"community2000".
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20.3.2.2. Use from the Pandora FMS console
The first step to use a recon script from the Pandora console is to go to the Manage servers >>
Manage recon scripts. In this section we'll associate all the scripts that we want to use adding one by
one the complete script paths.

Once the example script has been added, we continue creating a recon task associated to it. If in the
recon task creating form we select the "Custom script" mode, then we should select some common
data with a normal recon task, as they are the associated server, the task execution interval, the
group to which the agents that are created will belong, and if there would be created or not
incidents and additional comments.
Apart from this information, we should configure a serie of the script own parameters, as the script
that we want to use of the ones previously added ( for us Snmpdevices) and the customized fields
that we will pass to this script ( up to 4 ).
We should pass automatically the Id of the already created task to our script and regarding to the
creating form checks the selected group and the flag that determines if incident will be or not
created. Besides, from the four possible customized fields, it will use the two first ones, being the
first one the network where it will track and the second one the SNMP community of the devices
from which we expect results.
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Once thes two customized fields have been filled in, and optionally, also the comments that you
want add, the task recon associated to the Snmpdevices test script will be created, so it will start the
track and the agents and modules previously explained will be created.

336

Recon Scripts

21 ALERTS
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21.1. Introduction
An alert is a Pandora FMS's reaction to a module's value «out or range». Such reaction is
configurable and can result in sending an email or an SMS to the administrator, send an SNMP
trap, record the incident in the system's log, etc. An alert is, basically, any action able to be
triggered by a script configured in the Operating System where the Pandora FMS's server which
processes the module runs. Pandora FMS 3.0 allows to «chain» alerts in a logic sequence, so called
Composed Alerts. Alerts can be disabled individually or by disabling a whole agent group. If an
agent is disabled, it won't trigger alerts either. Alert management is performed in section
Administration > Manage Alerts, located at the right hand side of Pandora FMS's web console:

21.2. Command
Pandora FMS's reaction to a value “out of range” can be of diverse kinds: record in a syslog, email
or SMS sending, or the execution of any script hosted in Pandora FMS's machine that can be
processed.
The different reactions Pandora can adopt are configured in option Command of Manage Alerts
within the Administration part.

In this section one can modify or add its own commandos for the Alerts.
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21.2.1. Command Creation for an Alert
New alert commands are created clicking on the Create button in Command option of Manage
Alerts menu located in Administration menu.
Once clicked on Create a screen as follows appears.

Next, the fields are introduced:
Name
The command's name. It is important to be descriptive, yet short. For example: «Log,
Comunications»..
Command
Command to be executed as reaction to a module “out of range”. It is possible to use macros to
replace the parameters configured in the alert declaration. The available macros are:
• _ﬁeld1_: Usually assigned as user name, phone, file, or destination for an email.
• _ﬁeld2_: Usually assigned as a short event description, such as an email's subject.
• _ﬁeld3_: It is a descriptive field, in case of an email or an SMS it can be used for the
payload.
• _agent_: Compelete agent's name.
• _timestamp_: A standard representation of date and time. Automatically replaced at alert's
execution.
• _data_: The values of the data that triggered the alert.
When it comes to creating the commands for the alerts, one must bear in mind that such commands
are executed by the Pandora FMS's server which processes the module of the processed agent. Be it
a data server or a network server. Alerts will also be executed with the priviledges of the user
executing the Pandora FMS's server. It is advisable to test in the command line interface at
command definition time, if the command's execution is successful and if it produces the desired
result (send an email, generate an entry in the logfile, etc).
Description
Long description of the alert command for information purposes.
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Once created, click on the Create button.

21.2.2. Edition of a command for an alert
It is possible to edit the alert commands created from option Command at the Manage Alerts menu of
Administration menu.
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To edit an alert command just click on the command name.

Once the chosen alert has been modified, click on the Update button.
The ”eMail”, “Internal Audit” and “Pandora FMS Event” alerts cannot be modified.

21.2.3. Delete an Alert Command
In order to delete an alert click on the red cross located at the right hand side of the alert.

”eMail”, “Internal Audit” and “Pandora FMS Event” alerts cannot be deleted.

21.2.4. Predefined Commands
There are some Predefined commands, which could be adjusted if the system don't have the internal
commands for executing these alerts. The development team has tested these alerts with Red Hat
Linux, CentOs, Debian and Ubuntu Server.
eMail
Sends an email from Pandora FMS server.Uses the Perl sendmail.Pandora FMS works with the
system specific tools for execute almost all alerts. It will be necessary that you check that the
libmailsendmailperl xprobe2 package is already installed in your system.
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Internal audit
This is only an «internal» alert that generates an small entry in Pandora FMS internal audit system.
This is kept in the Pandora FMS database and it could be check with the event viewer from the
console.
Pandora FMS Event
This alert create an special event into Pandora FMS event manager.
Pandora FMS Alertlog
This is a default alert to write alerts
/var/log/pandora/pandora_alert.log

in a

standard

ASCII

plaintext

log

file in

SNMP Trap
Sends a SNMP trap when the alert occurs.
Syslog
Sends an alert to the system registry.Uses the sytem command «logger».
Sound Alert
Plays a sound when an alert occurs.
Jabber Alert
Send jabber alert to chat room in a predefined server (configure first .sendxmpprc file). Uses field3
as text message, field1 as useralias for source message, and field2 for chatroom name.
SMS Text
Sends an SMS to an specific mobil telephone. But, of course, it will need to define an alert before
doing this possible, and also a gateway for sending configured and accesible SMS from Pandora
FMS. It is also possible to install one using Gnokii to send SMS, directly by using a Nokia telephone
with an USB wire. The process is described further on.
Validate Event
Validate all the events relationed with a module. The name of the agent and the name of the
module will be given.

21.2.5. Examples of Commands
21.2.5.1. Integrating alerts with Jabber IM
It is very easy to set up Pandora FMS to send alerts through a Jabber server. Jabber can be a system
to get real time alerts as well as a historic log, allowing a group of people to receive those alerts
simultaneously.
Installing Jabber services

From the client side:
1. Install a Jabber client, like for example Gaim (now Pidgin).
2. Register an account (using Pidgin: configure the account clicking on "Accounts" tab).
3. Login that account.
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From Pandora FMS Server side:
1. Install sendxmpp. With this tool your Pandora FMS server can send messages to Jabber
services.
2. Create the file .sendxmpprc inside the folder /home.
3. Edit that file and insert the following text:
useraccount@jabber.org password

1. Change that file permissions:
chmod 0600 .sendxmpprc

Now you can send private messages using the command line, for example:
$ echo "Hello" | sendxmpp -s pandora useracount@jabber.org

To register the alert at Pandora FMS Web Console, add a new command and configure its variables.
It is a good idea to do as follows:
• Field_1: Jabber address.
• Field_2: Text.
The alert will be defined as follows:
echo _field2_ | sendxmpp -s pandora _field1_

More examples of Jabber usage

Send a message to a chat room:
$ echo "Dinner Time" | sendxmpp -r TheCook --chatroom test2@conference.jabber.org

Send the log lines to a Jabber destination, as they appear:
$ tail -f /var/log/syslog | sendxmpp -i sysadmin@myjabberserver.com

NOTA: Be careful not to flood public Jabber servers or you can be banned from them.

21.2.5.2. Sending emails with Expect
Sometimes it is necessary to use an authenticated SMTP to send emails. It will be probably easier
and more versatile to use a simple EXPECT script instead to configure sendmail to use an
authenticated SMTP. This is an exaple using EXPECT to send emails using an Exchange server.
Then, a file called /etc/snmp with the following content is created:
#!/usr/bin/expect -f
set arg1 [lindex $argv 0]
set arg2 [lindex $argv 1]
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set arg3 [lindex $argv 2]
set timeout 1
spawn telnet myserver.com 25
expect "220"
send "ehlo mymachine.mydomain.com\r"
expect "250"
send "AUTH login\r"
expect "334"
send "2342348werhkwjernsdf78sdf3w4rwe32wer=\r"
expect "334"
send "YRejewrhneruT==\r"
expect "235"
send "MAIL FROM: myuser@domain.com\r"
expect "Sender OK"
send "RCPT TO: $arg1\r"
expect "250"
send "data\r"
expect "354"
send "Subject: $arg2\r"
send "$arg3 \r\r"
send ".\r"
expect "delivery"
send "quit"
quit

The file permissions are changed to allow the execution.
chmod 700 /root/smtp

Before trying to use it, please make sure that /usr/bin/expect works right.
To use this with Pandora FMS, you will need to create a new command (or modify the one that
already exists, this is, the email alert sending) and specify the following fields in the Pandora FMS
Alert command definition, in the “Command” field. It will write:
/root/smtp _field1_ _field2_ _field3_

And of course,the script could be located in any place of the system.You will only need to consider
that the alert script is launched by the server that processes the data: if it is a network data, then it
will be the network server. If it is a data that comes from an agent, through an XML data file, then it
will be the dataserver the one that will launch it.
If you have several physical servers, then it is possible that you will need to copy the same script in
the same location, with the same permissions and the same user owner in all the systems where you
have a Pandora FMS server that you want to execute this alert. Also consider that the Pandora FMS
network servers need to be executed as root ( to could do ICMP latency tests) and the data server
could be executed as a user without priviledges.
The alert will be executed by the user who is executing the process of the Pandora FMS server.

21.2.5.3. Sending SMS with Gnokii
You could use Gnokii, it is necessary to use a Nokia mobile or a mobile that should be compatible
with Gnokii ( check the compatible hardware in the Gnokii project page). You will also need a USB
data wire to which you have to connect the mobile phone and the Pandora FMS server you want to
send SMS alerts.
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Gnokii supports a large variety of Nokia phones ( and some from other manufacturers).
With Gnokii, you can send SMS from the command line. This way is very easy and quick to send
SMS directly from a Pandora FMS server, avoiding the use of gateways sending SMS through the
internet (not quite useful if the network is down) or GSM hardware solutions for sending messages
that are very expensive.
Another alternative to the use of Gnokii is the Gammu project.
Example of SMS sending with Gnokii from the command line:
echo "PANDORA: Server XXXX is down at XXXXX" | gnokii --sendsms 555123123

Gnokii can not send SMS with attached images, but it can send a URL HTTP/Wap for it could be
visualized when a message is received, such as:
echo "Image capture sample" | gnokii --sendsms 555123123 -w
http://artica.homelinux.com/capture.jpg

It could send a URL from one image or a URL that leads to a light version of the console to have
access to the console from the mobile device and analyze data.
The development team has tested SMS sending from a Nokia 6030 phone, sending SMS alerts when
the internet connection was not possible. The Nokia 6030 phone uses the module 6510 definition in
the gnokiirc file, and it takes about four seconds to send an SMS.
It is possible to install a much more powerful sending gateway using Gammu.

21.2.5.4. Executing a Remote Command in Another System (UNIX)
Sometimes, it is interesting to execute the command in another system, to do it, use the
ssh.command. The system in which the command will be executed should be UNIX, and it should
have the ssh demon installed, started and accesible.
To avoid storing the password of access to the machine that executes the command in Pandora
Console, the first thing you should do is to copy the server public key where you want to execute
the remote command in the Pandora server.
Once this have been done, we should put as command:
ssh user@hostname [_field1_]

Using _field1_ as variable, you can use the command you want.
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21.3. Actions
Actions are the components of alerts where a command (which is described in the previous section)
is linked with the generic variables Field 1, Field 2 and Field 3. These actions will be used later in
the alert templates that are the ones that associate a data condition with an specific action.

21.3.1. Creating an action
New Actions are created pressing the Create button from Action in the Manage Alerts menu from
Administration menu.

Once you have pressed on Create, one screen as the following will be shown:
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Next are the fields that you should fill in:
• Name: Name of the action.
• Command: In this field is defined the command that will be used in case the alert will be
executed . You can choose between the different commands that are defined in Pandora.
• Field 1: In this field is defined the Field 1 variable value, that will be used in the command
if necessary.
• Field 2: In this field is defined the Field 2 variable value, that will be used in the command
if necessary.
• Field 3: In this field is defined the Field 3 variable value,that will be used in the command if
necessary,
• Command Preview: In this field, not editable, will automatically appear the command that
will be executed in the system.
Once you have filled the fields, press on the Create button.

From Action in the Manage Alerts menu from Administration menu, it is possible to edit the actions
that have been created.
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21.3.2. Editing an action

To edit the action, you will only have to press on the name of the Action.

Once these changes have been done, update pressing on the “Update” button.
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21.3.3. Deleting an Action
To delete an Action, press on the red "x" that is on the Action right.

21.4. Alert Template
Templates are alerts with all the parameters defined. They only need the agent to which they are
assigned and the module that is used to activate the command or the reaction when a value is "out
of range". Templates are used to do the administrator management easier, so when they are done
they could be assigned easily to the required agents.
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21.4.1. Creating a Template
The new Templates are created pressing on the Create button at Templates, in the Manage Alerts
menu, from the Administration menu.

Once you have pressed on Create, a new screen as the following will appear.
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Here are detailed the fields to fill in:
• Name: The name of the template.
• Description:Describes the template function and is useful to identify the template from
others in the alert general view.
• Priority: Field that gives information about the alert. It is useful to search alerts. You can
choose between the following priorities:
•
•
•
•
•

Maintenance
Informational
Normal
Warning
Critical

• Condition Type: Field where the kind of condition that will be applied on the alert is
defined.The required combos will be added according to the chosen kind.There are the
following fields:
• Regular Expression: The regular expression is used. The alert will be fired when the
module value perform a fixed condition expresed using a regular expression, this is the
condition used to fire on string/text data. The other conditions are for status or numerical
data.

By choosing the regular condition it appears the possibility to select the Trigger box when matches
the value. In case of select, the alert will be fired when the value matches, and in case of not
selecting it, the alert will be fired when the value does not match.
• Max and Min: A maximum and a minimum value are used.

By choosing the regular condition the possibility to select the Trigger box when matches the value
will appear.In case of selecting it, the alert will be fired when the value is out of the range selected
between the maximum an the minimum.In case of not selecting it, the alert will be launched when
the value would be between the range selected betweeb the maximum and the minimum.
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• Max: A maximum value is used. The alert will be fired when the module value would be
bigger than the maximum value selected.

• Min: A minimum value is used. The alert will be fired when the module value would be
lower than the minimum value selected.

• Equal to: The value Equal to is used. The alert will be fired when the module value would be
the same as the selected one. It is used ONLY for numerical values (for example 0 or 0.124).

• Not Equal to: Similar to previous but adding a logical NOT.
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• Warning Status: The module state is used.The alert will be fired when this state would be
Warning.

• Critical Status: The module state is used.The alert will be fired when this state would be
Critical.

Once the fields have been filled, press on the "Next" button and this way you will have access to the
following screen.
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Next we are going to detail the fields to fill in:
Days of Week
Days when the alert could be fired.
Use special days list
Enable/disable use of special days (holidays and special working days) list.
Time From
Time from which the action of the alert will be executed.
Time To
Time until the action of the alert will be executed.
Time Threshold
Defines the time interval in which it is guaranteed that an alert is not going to be fired more times
than the number fixed in Maximum number of alerts. If the defined interval is exceeded, an alert
will not recover if it comes to an specific value, except if the alert Recover value would be activated.
In this case it is recovered inmediatelly after receiving an specific value,regardless the threshold.
Min number of alerts
Minimum number of times that the data has to be out of range (always counting from the number
defined in FlipFlop parameter of the module) to start firing an alert. Default is 0, which means that
the alert will be fired when the first value satisfies the condition. It works as a filter, necessary to
eliminate false positives.
Max number of alerts
Maximum number of alerts that could be sent consecutively in the same time interval (Time
Threshold).
Field 1
Defines the value for the "_ﬁeld1_" variable. Here could be used the list of macros that is described
next.
Field 2
Defines the value for the "_ﬁeld2_" variable.
Field 3
Defines the value for the "_ﬁeld3_" variable.
Default Action
In this combo is defined the action by default that the template is going to have. This is the action
that will be automatically created when the template would be assigned to the module. You can put
none or one, but you can not put several actions by default.
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Next are the fields that you should fill in:
Alert Recovery
Combo where you can define if the alert recovery is enabled or not.In case that the alert recovery is
enabled, when the module would have again values out of the alert range, the alert that matches
with the Field 1 defined in the alert and with the Field 2 and 3 that are defined next, will be
executed.
Field 2
Defines the value for the "_ﬁeld2_" variable in the alert recovery.
Field 3
Defines the value for the "_ﬁeld3_" variable in the alert recovery.
Once the fields have been filled in, press on the "Finish" button.

21.4.2. Replaceable Macros in Field1, Field2 and Field3
It is possible to use the following macros in all cases of the fields Field1, Field2 and Field (in the
alert template, in the command and in the action). These are "words" that are replaced when
executing by a value, that will change depending on the moment, value, agent that fires the alert,
etc.
•
•
•
•
•
•
•
•
•
•
•
•
•

_field1_ : User defined field 1.
_field2_ : User defined field 2.
_field3_ : User defined field 3.
_agent_ : Name of the agent that fired the alert.
_agentdescription_ : Description of the agent who fired alert
_agentgroup_ : Agent group name
_address_ : Address of the agent that fired the alert.
_timestamp_ : Time when the alert was fired (yymmdd hh:mm:ss).
_data_ : Module data that caused the alert to fire.
_alert_description_ : Alert description.
_alert_threshold_ : Alert threshold.
_alert_times_fired_ : Number of times the alert has been fired.
_module_ : Module name
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•
•
•
•
•
•
•
•
•
•
•

_modulegroup_ : Module group name.
_moduledescription_ : Description of the module who fired the alert
_alert_name_ : Alert name
_alert_priority_ : Numerical alert priority
_id_agent_ : Id of agent, useful to build direct URL to redirect to a Pandora FMS console
webpage.
_id_alert_ : Numerical ID of the alert (unique), used to correlate on third party software
_policy_ : Name of the policy the module belongs to (if applies).
_interval_ : Execution interval of the module.
_target_ip_ : IP address of the target of the module.
_target_port_ : Port number of the target of the module.
_plugin_parameters_ : Plugin Parameters of the module.

21.4.2.1. Orders for the replacement of the Macros and _field*_ fields
After describing what are commands, actions and templates, probably you are questioning yourself
about the necessity of defining the fields Field1, Field2 and Field3 in each of them and what is the
sense of all of this.
When an alert is fired, the field* values are brought from the action to the command, and from the
template to the command. This is, if in the action the _field1_value is different from an empty
string, then it will ignore the command that is brought from the template and this will not have
effect. If the _field1_ value of the command is a value different to _field1_ this means that it will
ignore any parameter that comes from the field1 from the action or from the template, and that
neither the action nor the template will be able to redefine it. As it has got _field1 as value. this
means that it is ordering the command that insert in this field whatever comes from the action or
from the template.
In the action the same thing happens, but in a more subtle way. If this field is empty, this means
than any thing that is brought to it from the alert screen will be brought to the command. But if this
field is different from the empty string, then it will use the values from this field and the values that
comes from the template will be ignored.
This has been thought this way to offer the possibility to establish some "fixed" parameters by
command or action and have always the possibility of doing them flexibles.

21.4.2.2. Complete example of alert with replacement macros
Supposing you want to create an entry in a LOG where in each line appears the following format:
20091224 00:12:00 pandora [CRITICAL] Agent <agent_name> Data <module_data> Module
<module_name> in CRITICAL status
Command Configuration
echo _timestamp_ pandora _field2_ >> _field1_

Action Configuration
Field1 = /var/log/pandora/pandora_alert.log
Field2 = <En blanco>
Field3 = <En blanco>
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Template Configuration
Field1 = <En blanco>
Field2 = [CRITICAL] Agent _agent_ Data _data_ Module _module_ in CRITICAL status
Field3 = <En blanco>

In the recovering section:
Field2 = [RECOVERED] [CRITICAL] Agent _agent_ Data _data_ Module _module_ in
CRITICAL status
Field3 = <En blanco>

This way when executing an alert the following line will be placed in the LOG:
2009-10-13 13:37:00 pandora [CRITICAL] Agent raz0r Data 0.00 Module Host Alive in
CRITICAL status

And the following line when recovering the alert:
2009-10-13 13:41:55 pandora [RECOVERED] [CRITICAL] Agent raz0r Data 1.00 Module Host
Alive in CRITICAL status

21.4.3. Editing a Template
It is possible to edit the templates that have been created from Templates in the Manage Alerts
menu from the Administration menu.

To edit the template you only need to press on the name of the template.
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21.4.4. Creating a duplicate of a Template
Is possible to duplicate a template that has been created from Templates in the Manage Alerts menu
from the Administration menu.
To duplicate the template you will only need to press on the icon that is on the right of the kind of
template.

21.4.5. Deleting a Template
To delete a template press on the red cross that is on the right side of the alert.
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21.5. Assigning Alert Templates to Modules
Until now we have defined the commands and actions as the response that Pandora FMS gives for
an "out of range" value.Through these templates we define when a value is "out of range" and which
circumstances should be given in order that Pandora FMS could work.In this section it is described
the way for relating the Templates and the Actions with Pandora agents and with the modules of
these agents. This operation is the one that finally does that Pandora FMS "reacts" when it is a date
out of an specific range.
The alerts could be assigned in two ways from the Alerts submenu or from the Manage Agents
submenu, both of them in the Administration menu, but we can also assign them from the submenu
Policy Administration menu as we will see in the chapter Monitoring with policies.

21.5.1. Alert management from Alert submenu
21.5.1.1. Assigning Alerts from Alert Submenu
Alert assignment for modules is done filling the required fields and pressing on the "Add" button at
Manage Alerts from the Administration menu.
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Next are the fields that should be filled in:
Group: Through a combo you can choose the group the agent belongs to.
Agent: Writing the name of the Agent for assigning the alert to it.
Module: Writing the module that will be used in order the alert could be fired.
Template: Through a combo you can choose the template that you want to use to configure
the alert.
• Actions:Allows to choose between all the alerts that have been configured. The selected
action will be added to the action that is defined in the template. It is possible to choose
more than one action.
•
•
•
•

At the moment we select an action two new fields will appear.These fields are From and to. In these
fields is defined the number of alerts that should be in order to could execute the action.

21.5.1.2. Modifying alerts form the Alert Submenu
Once an alert has been created, it is only possible to modify the actions that have been added to the
action that the template has got.
It is also possible to delete the action that was selected when you created the alert by doing click on
the red cross that is on the right of the action or to add new actions selecting them from the combo.
Filling the From and TO data and pressing on the "Add" button.

21.5.1.3. Deactivating Alerts from the Alert Submenu
Once the alert has been created, it is possible to deactivate it by doing click in the light bulb that is
on the right of the name of the alert.

The alerts that are availables are in blue and the alerts that are not availables are in yellow.
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21.5.1.4. Deleting Alerts from the Alert Submenu
It is possible to delete any Alert pressing on the red cross that is at the right of the Alert.

21.5.2. Managing Alerts from the Agent
21.5.2.1. Alert assignment from the Agent
Other option to add an alert is doing it from the Agent. Press on the Manage Agents Submenu from
the Administration Menu, where are all Pandora agents.

Choose an agent and click on Alerts box.
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Next we are going to detail the fields that should be filled in:
• Module: To writte the module that will be use in order the alert fires.
• Template:Trough a combo you can select the template that you want to configure the alert.
• Actions: Allows to choose between all the actions that have been configured. The choosen
action will be added to the action that is defined in the template. It is possible to select more
than one action.
At the moment of selecting an action two new files are shown. These fields are From and To. In
these fields are defined the number of alerts that should be appear to execute the action.
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21.5.2.2. Modifying Alerts from the Agent
Once an alert has been created, it is only possible to modify the actions that have been added to the
action that the template has got.
It is posible to delete the action that was choosen to create the alert by pressing on the red cross
that is on the right side of the action or by adding new actions selecting them from the combo.
Filling the From and To and pressing on the "Add" button.

21.5.2.3. Deactivating Alerts from the Agent
Once an alert has been created, it is possible to deactivate it by pressing on the light bulb that is on
the right side of the alert name.

The alerts that are availables are in blue and the alerts that are not availables are in yellow.

21.5.2.4. Deleting Alerts from the Agent
It is possible to delete any Alert by pressing on the red cross that in on the right side of the Alert.
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21.6. Scaling Alerts
Alert scaling consists of the possibility or doing different actions depending on the severity of the
situation. The severity of the situation is established by the number of times that a value out of
range appears. For example, if an alert is fired when the CPU of a system is at 90% , then it is
possible to configure it to send an email at any case and an SMS when the value out of range has
been taken place more than 5 times.
This alert scaling is done by configuring more than one action in one alert and filling in well the
fields From and To.

21.7. Full alert examples
21.7.1. Sending SMS alerts
In this example we are goint to see something very frequent: to send an SMS when something
happen or it's about to happen.
To made this, we will use a script published in our website (http://pandorafms.org) in the Module
Exchange Library section. This script uses a commecial Perl API to send SMS using a commercial
HTTP gateway (you need to create an account and pay money). This is very easy, because once
you've setup the account and configured the script (just put your user & pass), it's ready to be used.
Let's suppose you have configured your SMS account and installed the script in the Pandora FMS
server. Run the command:
> sendsms
You must give three parameters: <source> <destination> 'Full message'
Don't forget to send the message with single quotes (), and put the destination
number
with international code (346276223 for spanish phones, for example)
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Our first step, after being sure that SMS sendsms command is ready to be used, is to define the
"alert command". We define the command in the Pandora FMS administration interface:

In this command, we send "346666666666" as source of message. We could use a word
(alphanumerical) but some mobile operators doesnt manage well the alphanumeric ID's. Field1 and
Field2 will be used to defined the command behaviour. In the photo of the mobile phone receiving
the SMS I use a string identifier: "Aeryn". Field1 will be the destination phone, and field2 the text,
defined in the Alert Action.
Now define the alert action. This execute the command defined before, replacing field1 and field2
with custom values, in this specific case, template alert doesnt put any data on the SMS; all
information is defined in Alert Action.
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Field1 is my phone number (a bit obfuscated, I don't want you to call me in the night ;). In Field2
it's the SMS text message, I'm using here a few macros, which will be replaced in the runtime, when
alert is produced.
Final step!: We are going to create an Alert Template (skip this if you have a valid one). We want to
create a very simple Alert Template, just to "fire up", when a module will be CRITICAL. That alert
will fire once per day max, but if it recovers, will fire again each time it recover and fire again.
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Now, just assign a module with an alert template and an alert action:

To get this alert fied, module must be on CRITICAL. In following screenshot, I will review the
module configuration to see if their CRITICAL threshold are defined. If it was not, alert will never
fire because is waiting to have a CRITICAL status. In my case I've set to 5. When a value of 6 is
received, module will set on CRITICAL and alert will fire.
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All ready. We can "force" the alert to execute and test it. To force the alert, go to the agent alert
view, and click on the round green icon:

An SMS should be appear in my mobile phone, just as the following photo. I get a "N/A" data
because when you force the alert, no real data is received by the module.
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21.8. Correlation
The Alert Correlation allows to use more than one module to generate a Pandora FMS reaction.
These modules could be from the same agent or from different ones.
The management of Correlated Alerts is done at Administration>Manage Alerts >Correlation.

21.8.1. Creating Correlated Alerts
To create a correlated alert click on the "Create" button that is at Administration>Manage Alerts
>Correlation.

Once you have clicked on "Create" it will appear this:
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Next are detailed the fields that you should fill in:
• Name: Field to put the correlated alerts name
• Asigned to: Combo in which you have to select the agent to assign the alert to.
• Description: Describes the template function, and it is useful to identify the template
between others in the Alert General View.
• Condition:In this section are shown the conditions that the correlated alert should fulfill.
To add conditions you should select one group and one agent. One these have been chosen all the
alerts that this agent has will appear.
To add the alert click on the "+" symbol that is on the right of the selected alert.

When two alerts have been chosen, either from the same agent or from different ones, then a
combo will appear where you could choose the logical operator that will be used to verify the
conditions. The operators that could be selected are the following ones:
AND: The two conditions must be fulfilled.
NAND:Neither of them must be fulfilled.
NOR: At least one condition is not fulfilled.
NXOR: Or at least one of the two condition is fulfilled at the same time of neither of them
are fulfilled.
• OR: Debe cumplirse al menos una de las condiciones pudiendo cumplirse las dos.
• XOR: One or other is fulfilled but not both of them .
•
•
•
•
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Each time that a new condition is added you should choose the logical operator. The checking that
Pandora does is a sequential one. In the example that is showed above the two first condition or the
third one instead should be fulfield.

Finally the alert will be this:

Once all the conditions have been selected, click on "Next".
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One screen like this will appear:

The fields that are established here are the same fields that are used when a "common" alert
template is defined.
Once you have filled in all the fields click on the "Finish" button.

21.8.2. Editing Correlated Alerts
It is possible to edit the correlated alerts that have been created from Administration>Manage
Alerts >Correlation,

To edit a correlated alert you only need to press on the alert name.
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21.8.3. Deactivating Correlated Alerts
Once an alert has been created, it is possible to deactivate it by pressing on the light bulb that is on
the right of the alert name.

The alerts that are activated are in blue and the ones that are not activated are in yellow.

21.8.4. Deleting Correlated Alerts
It is possible to delete the correlated alerts that have been created from Administration>Manage
Alerts >Correlation

To delete a correlated alert you only need to press on the red cross that is on the right of the alert.

21.9. Cascade Protection
The cascade protection is a Pandora FMS functionality that allows to avoid a "rain" of alerts when a
group of agents could not been reached due to a connection fail. This kind of things happens when
an intermediate device such as a router or a switch is down and all the devices that comes after it
simply finish to be reachables from Pandora FMS. Probably the devices are working correctly, but as
Pandora FMS can not see them through ping, then it consider them as downs.
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The cascade protection is activated from the agent configuration menu. Pressing the "cascade
protection" box and it is deactivated unchecking this box.

When the cascade protection is activated in an agent, then the alerts with father CRITICAL state are
checked either this would be simple or correlated. In this way if any father has a critical alert fired,
the the alerts configured in the agent will not be fired. These alerts will be fired if the agent father
does not have any module in a CRITICAL state or if they are fired by the father with an state lower
than CRITICAL. It is understood that the agent will launch the alerts if the required conditions are
fullfied.
So as the cascade protection works well, it is convenient to configure in all the fathers an alert with
a CRITICAL state that check if the device is down. Besides, in order to avoid that an alert from an
agent defined as a father and the other alerts have the CRITICAL state.

21.9.1. Examples
You will have the following monitors:
 ROUTER: a ICMP check and a SNMP check using a Standard OID to get the ATM port status. Also
may have a Latency check for your parent/provider router.
 WEB SERVER: you have several internal checks running with the Pandora FMS agent: CPU usage,
MEM usage and process check of your Apache. You have also a latency check for a 4step navigation
HTTP check.
 DATABASE SERVER: you have several internal checks running with the Pandora FMS agent: CPU
usage, MEM usage and process check of your Database. Also a few database integrity checks. You
also check remote connectivity to database using a plugindefined test to login, make a query and
exit, timing the answer.
Now you define several SINGLE alerts:
ROUTER: ICMP Check / CRITICAL > Action, send MAIL. SNMP Check / CRITICAL > Action,
send MAIL. Latency > 200ms / WARNING > Action, none, just compound.
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WEB SERVER
CPU / WARNING > Action, none, just compound. MEM / WARNING > Action, none, just
compound. PROCESS / CRITICAL > Action, send MAIL. HTTP LATENCY / WARNING > Action,
none, just compound.
DATABASE SERVER
CPU / WARNING > Action, none, just compound. MEM / WARNING > Action, none, just
compound. PROCESS / CRITICAL > Action, send MAIL. SQL LATENCY / WARNING > Action,
send MAIL.
You define ROUTER as parent for DATABASE and WEB servers. You enable the Cascade Protection
in both agents (Database and Web).
You now define one correlation alert assigned to DATABASE:
Router ICMP Check NOT Fired AND Router SNMP Check NOT Fired AND WEB Server Process NOT
Fired AND Database Server Process Critical
THEN Send MAIL: "Service DOWN: Database Failure" You now define one correlation alert assigned
to DATABASE:
Router ICMP Check NOT Fired AND Router SNMP Check NOT Fired AND WEB Server Process Fired
AND Database Server Process NOT Fired THEN Send MAIL: "Service DOWN: WebServer Failure"
And more complex alerts like: Router ICMP Check NOT Fired AND Router SNMP Check NOT Fired
AND
WEB Server HTTP Latency NOT Fired
AND
DATABASE Server SQL Latency Fired
AND
DATABASE Server CPU NOT fired
AND
DATABASE Server MEM Fired
THEN
Send MAIL: Database is getting exhausted. Please check it ASAP.
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21.10. Special days list
From version 5.0 of Pandora FMS has special days feature. It allows to define holidays and special
working days for alert template. Days defined in special days list are treated as the same day of the
week you selected.

21.10.1. Creating a special day
The new special days are created clicking on the Create button at Special days list, in the Manage
Alerts menu, from the Administration menu.

Once clicked on Create a screen as follows appears.

Next are the fields that you should fill in:
• Date: Special days date. The data format is YYYYMMDD. If you want to define same day
every year, you can use '*' for YYYY.
• Same day of the week: Select a day. The above date is treated as the same as selected day.
• Description: Special day description.
For example, assume that is a holiday, May 03, 2012. When you define '20120503' with 'Sunday',
that day is treated as the same as Sunday.
Once you have filled the fields, click on the Create button.

To enable special days list, "Use special days list" should be set on the alert template
(step 2)
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21.10.2. Editing a special day
It is possible to edit the special days created from option Special days list at the Manage Alerts
menu of Administration menu.

To edit a special day just click on the date.

Once these changes have been done, click on the "Update" button.

21.10.3. Deleting a special day
In order to delete a special day, click on the red cross located at the right hand side of the day.
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22 EVENTS
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22.1. Introduction
Pandora FMS uses an Event System to "inform" about whatever happens in the monitored systems.
Pandora has an event visor where it's shown everything: When a monitor is down, when an alert
has been fired, or when Pandora FMS itself has any specific problem.
This system allows a teamwork because events can be validated and deleted by different users. In
case of validating an incident, it will be shown the user who did it.
Events can be managed in Operation> View events, where the next screen will be displayed.

This is an example of the event visor:

The event itself is shown in the event visor. It is a descriptive text of the problem, the origin (agent)
which generated it, and, of course, the date of this event. Sometimes there is other data associated,
such as the module of the agent that generated the event, the group, tags associated to the module,
etc. If we click on the eye icon, we could see all the event details:
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By default, the events are shown through an specific search, and this could be modified, showing
the filtered information, older, by an specific agent, looking for a word, etc. To do this, we take out
the filter window, clicking in the filter section:

As we can see here, by default (although it can be modify in the setup options), Pandora FMS shows
events that has at maximum eight hours old or less. It show grouped events and shows only those
that are not validated. An user that has only access to one group, will only see the events to this
group.
Exists a possibility to save a search. Also, you can apply previously created filters.
The events are the core of a monitoring system
The operators, seeing this screen, could know the current state (active events) and the historical
(seeing all the validated events), without having to look agent by agent, look global figures, data
trees and names or visual screens.
The operators should see a "clean" event console that shows only the active problems. This way, you
won't have to create alerts, only looking at the screen we will know what happens at any time.
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22.2. Custom Events View
Since Pandora FMS 5.0 you can customize custom events view. To custom events view, go to
Administration>Manage events>Custom events.
By default, the fields shown are
•
•
•
•

Event name
Agent name
Status
Timestamp

You select the fields you want displayed in the list "Fields available" and move it by the arrows.
Then, you click on "Update" button.
If you click on "Default" button, you could see default event fields:

22.3. Creating Event Filters
To create event filters, go to Administration>Manage events. In this view, you can create, remove
and edit filters.
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If you click on "Create filter" button, you can fill event fields:

22.4. Viewing Events
To see events, go to Operation>View events.Consider that, when you see the events, these have a
predefined filter that makes that only the unresolved and those from the last 8 hours would be
opened.
It shows the list with all the events that the system has got.

The list of events has distributed information in the following columns:
Status
Event status. Status could be: new, in process, validate, not validate.
Event Name
Field that shows the event name. Clicking on the name it put a filter that shows all events with the
same name.
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Agent Name
Field that shows the agent that has started the event. Clicking on the field you go to the Main agent
tab.
Timestamp
Shows the time that went by since the event was received
Action
allows to validate event.
delete event.
shows event detail.
open an incident with the event.
Box for selecting the event
Allows to select the event to execute the deleting or multiple validation of events.

22.5. Filtering Events
From the event view page it is possible to filter in the event list in order to look for specific events.
To filter events, go to the event list at Operation>View events; click on “event control Filter”

It shows the filter that is by default when you open the Event list.
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The fields to filter are these:
• Group: Combo where you can choose the group the agent which created the event belongs
to.
• Event Type: Combo where you can choose the kind of event. There are the following kinds:
• Alert Ceased
• Alert fired
• Alert Manual Validation
• Alert Recovered
• Error
• Monitor Down
• Monitor up
• Recon host Detected
• System
• Unknown
• Severity: Combo where you can choose by the severity of the event.The following options
are availables:
• Critical
• Informational
• Maintenance
• Normal
• Warning
• Event Status: Combo where you can choose by the event state. There are the following
options:
• All event
• Only pending
• Only validated
• Free search: Field that allows a free search of a text.
• Agent Search: Combo where you can choose the agent origin of the event.
• Max hour old: Field where the hours are shown.
• User Ack: Combo where you can choose between the users who have validated an event.
• Repeated: Combo where you can choose if showing the repeated events or showing all
events.
Besides the search fields in the Event Control filter menu, there is the option Block size for
pagination, where you can choose between the event number that it will be in each page when
paginating.
You can save the filter.

22.6. Creating an Incident from an Event
To create an incident from an event, go to the event list at Operation>View events and click on the
button that is showed on the image.
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By clicking on the button, the system will take us to the incident create page where some fields are
already completed.

22.7. Validation and Status of one event. Self validation
An event could have three different status:Validated, Not validated or assigned.
An event could have different criticities: Normal, Critical, Warning. These belongs to the different
status of a monitor in Pandora, that are the ones that mainly generated the events.
An event, by default, as soon as it enter into the system is on "Not validated" status. It could happen
that it had been generated by a monitor, for example "Disk space", when going from normal to
critical status.
If the same monitor of the same agent pass again, without doing anything, to the "Normal" status,
then automatically we'll receive an event informing about this, and we'll have two events, one
informing that the disk was in Critical status and after, other informing that the disk was in Normal
status.
When something like that happens, the system automatically "validate" the event when it receives
information that this problem was solved. We call this Event self validation. This only happens
when the event that arrives new is kind "normal" and it finds an event kind warning or critical
WITHOUT validation.

386

Event Assignment

22.8. Event Assignment
When we find an event, we can validate it: this will do that the system memorize the date and the
user who validated the event. It is also possible to write a comment; i.e: "We revised it and empty
some part of the disk in the server":

When clicking the validate button, the screen will be refreshed and the validated event "disappears".
This is because by default, the event view shows only the events not validated or assigned, but not
the validated ones.

If I refresh again the event view, filtering and showing all events, I will see my event,validated (with
a green cross at left) with the information of who has validated it, when, and with the text that he
introduced at this moment.
Besides, if when validating an event, instead of validating it I select it as "in process", as we can see
here:

I could have an event "stopped" or locked, in a way that it doesn't self validate, and that you could
still see it in the event views, as pending of work. It will "group" the rest of events of the same kind
that enter (see event grouping) but it won't be self validate. The event look will be similar to this
one:

387

Event grouping

22.9. Event grouping
Some systems may generate a big amount of events. Pandora FMS let's you group these events to
work with them in a more convenient way. Explained below is the way event grouping works:

• Equal events from the same agent are shown as a single event.
• The status of this event will be in process if any of the grouped events is in in process
status, normal if any of the grouped events is in normal status or validated if all of the
grouped events are in validated status.
• Events in in process status are always shown, even if they are out of the filter's time
window.
When working with grouped events, status changes work in the following way:
• When validating grouped events, all of them are validated (including those that are out of
the filter's time window).
• When setting grouped events to in process status, only the most recent event is set to in
process status (in representation of the rest).
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22.10. Deleting an Event
Another way of managing events is to have the capacity of deleting those which are interesting any
more. For this task use the deleting events option.There are two ways of deleting an event from the
event list at Operation>View events.
Click on the red "X" at the "Action column".

Select the desired events to delete clickng in the last column and then click on the "Delete" button.

22.11. Other ways of viewing events
Besides the event event classic view that is at Operation>View events, they are published in a news
channel such as sliding Marquee (list that is moving at the top of the browser with the rest of the
screen in black).

22.11.1. RSS Events
Pandora FMS has a RSS event provider in order you could subscribe to it from your favorite news
reader. To see the events in a news channel or RSS, click on Operation>View events>RSS, and
subscribe to it from the news reader.
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To access to event RSS feed you need to configure what IPs are allowed to access. You
can do it in the field IP list with API access inside Setup

22.11.2. Events in the Marquee
It shows the last events in sliding text line format. This option could be used to visualize the last
events in a monitor like a text screen. You can easily customize the nº of visualized events or the
size, color and filter of the messages, modifying the code at operation/events/events_marquee.php.

To access to event RSS feed you need to configure what IPs are allowed to access. You
can do it in the field IP list with API access inside Setup

22.11.3. Sound Alerts
From version 3.2 , Pandora will have a new way of communicating events. This new way is audible
from the console. This way, it's much more easy to manage a system without having to check always
the Pandora's console. You will be able (having loudspeakers with enough volume) to hear the
different tunes when an event occurs, even if you are far from the computer. The tune will be heard
until the sound event pauses or when you press the OK button.
The list of sound events that generate sound are:
• An alert firing
• Module change to warning state.
• Module change to critical state.
It's also possible to filter the events by group.

22.11.3.1. Configuration
As we've said before, there are three kinds of events that the Sound Alert is going to watch, so from
the Pandora's Console setup, it's possible to configure the tune that is needed for each kind of event.
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Even from the setup page you could hear the tune ("and test if the browser is compatible with
multimedia contents")pressing on the play button that you'll find on the right of each kind of event.

22.11.3.2. Advanced Configuration
It's possible to extend the list of tunes for the sound events. For it, you should go to the Pandora
Console server, and in the Pandora Console directory (usually /var/www/pandora_console/) and in
the include/sounds/ directory, you could put the files with the new tunes. But, you should
consider several things for the right performance:
• The file has to be in WAV format
• Try that the file would be the smallest possible, because, for it sound in your browser
window, this file should be sent to the browser. There are several tricks to do this:
• Select only an extract of some seconds (or least) as main tune, so as we've said, the
tune will be executed in loop.
• Convert the tune to mono.
• Change the coding to "16bits signed" or even least. We'll lose quality, but we are
going to gain space.
• To edit or to create the tunes, we recommend to use tools such as Audacity that is Open
Source, multi platform and very easy to use.

22.11.3.3. Use
Sound Events are scanned every 10 seconds in an asynchronous way, and when an event comes, the
tuned configured (previously, or by default) will start playing for this event. The window will start
flickering in red, and also, depending on its browser/operative system configuration, the window
will keep the light and will be placed before the rest of open windows.
To have access to the sound events window, you only have to go to the Pandora Console left menu
and choose View Events in Operation. There, in the Event Window, on the header, if you press on
the button that has the musical note icon, it'll show you a new window smaller than the other ones.
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And this small window will be the one that'll manage all the sound events, so this is why you should
leave it open to it sounds when any event fires. In the window, we have 3 different controls:
• Group: The group where we want to check alerts. Remember that you should consider that
your user should have permissions for this group.
• Type: The kind of event to watch. You can check events "fired alert", "module changes to a
critical state" and "module changes to a warning state ". Of them, you could enable or disable
one or several through the checking boxes.
• Play Button: This button, when the green arrow is shown doesn't scan the events (it's on
pause), but when it is pressed it enables the surveillance of events and the button changes to
the orange one with the pause symbol. A normal use of this one is for example when you
have to go out of your working place and it's not necessary that the events sound while you
are out.
• OK Button: This red button with the word OK is used to stop the tune that is playing
because an alarm has fired, but it's important to say that it doesn't enable neither alerts
nor events, and for this, you should do it through the Pandora Console as usual. Neither it
does it for the events surveillance. It's only for the sound, and it'll continue watching.
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22.11.4. Exporting Events to a CSV
It is possible to export the event list to a CSV file in order the events could be processed or
incorporated in other applications
To export the events to CSV, press at Operation > View events > CSV File

22.11.5. Events Statistics
It is possible to have access to the event statistics from Operation > View events > Statistics

22.12. Event Alerts. Event correlation
From Pandora FMS 4.0 version, it is possible to define alerts on events, that allows to work from a
completely new approach much more flexible. This is an Enterprise feature.
To create the new event alerts, click on the Create button in the Event alerts menu from the
Administration menu.

393

Event Alerts. Event correlation

An event alert is composed by different rules, linked between them by logical operators (and, or,
xor, nand, nor, nxor).

To could work easier with them, the configuration parameters of an event alert are identical to the
module alert. Here could be find a detailed explanation of any of them. There are only two specific
parameters of the event alerts:
• Rule evaluation mode: In mode drop, if one rule is not fulfilled the rest of the alert rules stop
to evaluate. At pass mode the rest of rules remain being validated.
• Group by: Allows to group the rules by agent, module, alert or group. For example, if a rule
is configured to it fires when we receive two critical events, and it's grouped by agent, there
should arrive two critical events from the same agent. It's possible to switch off.
Each rule is configured to fire with an specific kind of event. The alert will be fired when the logical
equation defined by the rules and its operators is fulfilled

The configuration parameters of one rule that are possible are:
•
•
•
•
•
•
•
•
•
•
•
•
•

Name: Name of the rule.
User comment: Free comment.
Event: Regular expression that matches with the event text.
Window: The events that have been generated out of the time window will be rejected *
Count: Number of events that have to match with the rule to it could be fired.
Agent: Regular expression that matches with the name of the agent that generated the
event.
Module: Regular expression that matches with the name of the module that generated the
event.
Module alerts: Regular expression that matches with the name of the alert that generated
the event.
Group: Group the event belongs to.
Criticity: Event criticity.
Tag: Tags associated to the event.
User: User associated to the event.
Event type: Kind of event.
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For example, we could configure a rule that matches with the events generated by any module that
is named cpu_load of any agent of the Servers group that has associated the tag System when the
module goes to critical status:

Given the high number of events that the Pandora FMS database could store, the server
works on an event window that is defined in the pandora_server.conf configuration file
through the parameter event_window. The events that have been generated out of this
time window won't be processed by the server, so it doesn't make sense to specify in a
rule a time window higher to the one configured in the server
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23 TEMPLATES AND PLUGINS

396

Introduction

23.1. Introduction
Pandora FMS performs all checks through modules. These can belong to different types for the
different data types Pandora FMS can process. The complete default module list for Pandora FMS
can be seen in section Administration > Manage modules:

On clicking on this menu, on the right hand side of Pandora FMS's web console, the available
modules will be shown:

As we can see, diverse module types and groups exist:
• async: asynchrounous data.
• generic: generic data.
• keep_alive: special keepalive module, useful to control the status of the last contact to an
agent.
• icmp: ICMP check (ping).
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• snmp: SNMP check.
• tcp: TCP check.
• web: web check.
Most of them can have several check types:
• data: numeric data.
• proc: boolean value. For web checks it means that if the value exists, returns 1 and 0
otherwise.
• string: text string.
• inc: incremental data (for example, the ammount of packets sent by an interface will always
grow).

23.1.1. What is a component ?
A component is a "generic module" that can be repeatedly applied on an agent, as if it was a
module's "master copy", generating a module associated with an agent. This way, having a database
of our organisation's most used components, it turns very easy when it comes to monitoring, since
we have our own components adapted to the technologies we use to use, and we simply have to
apply these components to the new agents.
There exist two types of components, network components, which group all remote modules (wmi,
tcp, snmp, icmp, plugin, web, etc), and local components, which are the definition of the modules
defined in the software agents configuration, defined as text "snippets" ready to be cut and pasted in
the agents configuration.

23.1.2. What are the Template Components?
A template is no more than a set of network components that can be directly applied on an agent,
making easier the monitoring task, since we simultaneously create various modules by means of the
components associated to a network template. The Recon server uses the network templates to
automatically create a series of modules on a detected host, allowing thereby for a very fast and
automatic deployment of the monitoring.

23.2. Network components
As previously stated, the network components are the elements that enable remote network checks.
Pandora FMS has about 40 predetermined network checks, whereas the Enterprise version enjoys
over 400 ones.
Pandora FMS's network components can be checked out and created from their managment page,
at Administration > Manage modules > Network components.
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In it you'll be able to search for the already existing components (filtering by grupos or by free
search text), see their configuration and details, modify them and even create new ones.
To see any module's properties, simply click on its name, it has a link that will take you to its page
for details:

As plain to see in the figure, all details of network component Host Alive are shown. When applied
to a module, it will get the network component's details, except the IP address field, where it will
automatically store the main IP adress of the agent, the component is applied to. All parameters can
be edited (e.g: change user/password of WMI modules) later.
If the template is modified, its values will apply to modules created from that instant on, not to
the already created ones.
Component values can be modified, simply click on the name of one them and modify the desired
values, e.g. the interval. Once done, click on the Update button at the page's end. Its changes will be
stored and applied from that moment onwards to the agents you add such module to.
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23.2.1. Create new network components
You can create three types of network components:
• Network.
• Plugin (server add on).
• WMI.
In this version you still cannot yet create WEB components.
To create a new network component, go to the main network components management page,
Administration > Manage modules > Network components, go to the bottom of the page, select a
network component out of the three posible ones (WMI, Red o Plugin) in the pulldown menú: and
click on Create button.

After that, a screen will be displayed for you to set up all component's fields. Fill in the needed ones
and click on the Create button. Next, the WMI component creation screen is displayed:

400

Network components

As you fill in the required fields, bear in mind that you are filling in the description of a "generic"
module that will be applied to different agents. Some parameters such as snmp community, user or
password can differ among the agents to which the module applies, and you'll need to modify them
manually in order to make them work, but if you have a common user policy for your systems, you
can leave the modules completely configured inputting here users, passwords and other data
common to all agents. Obviously you can also leave them blank.
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The same process applies to componets of type Plugin.

23.3. Local components
Local components are those that can be applied to software agents. If you have the Pandora FMS
Enterprise version, these components are applied in an automatic and remote way through policies
or in a manual way in the agent remote configuration editor. Please check the policy section in
order to know how to apply local components to software agents in a remote way in your Pandora
FMS Enterprise.
Local components can also be used in Pandora FMS's Open version. They just won't be applied
automatically, being necessary to manually copy and paste the code. Pandora FMS's Enterprise
version has tens of local modules to apply to the policies and to the agents in an automatic way,
ordered by categories.
Local components work in a very similar way to network components, once gone to their
management page, Administration > Manage modules > Local components:

402

Local components

This screen displays the already existing local modules, which can be filtered by different
parameters (group, operating system, free text query) and one can also display, modify and create
new components.
To see any module's properties, just click on its name, it has a link that will bring you to its details
page:

As plain to see, the configuration of local components is very simple. The configuration elements
are:
• Name: component's name. This name will be visible at the component selection when
creating a modulo for an agent.
• OS: operating system, the component is for.
• Group: the group, the module will be in. Useful to filter and sort on monitoring
technologies.
• Description: module description. There already exists a default description that can be
changed.
• Configuration: component configuration, like the module configuration for software agents.
For more examples or to get complementary information, please check section Modules
Definition in Configuration chapter.
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23.3.1. Create new local components
To create a new local component, go to the main local components management page,
Administration > Manage modules > Local components and click on Create button located at the
bottom right hand side of the page.
A page with the form for creation of new local components will be displayed:

The form will just have to be filled in with the information mentioned previously and the Create
button be clicked.
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23.4. Module Templates
Module templates are those which contain network check modules. These templates, once created,
can be directly applied to agents, avoiding thereby the need to add modules one by one, or be
applied when performing one network recon task of the ones described in chapter 9.
To manage the module templates, click on Administration > Manage modules > Module
templates.

The template management screen will be displayed, which has many default ones.

You can click on any template to see its details, or you can click on the X in the right hand side
column to delete it, or you can create a new template clicking on the Create button.
Clicking on a template's name its details will be displayed, for example, the shpshot below shows
the details of the template for the Basic Network Monitoring modules.
In it, the template's name and description can be seen in the first two fields of the form.
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Below, there's the list of modules included in this template.
Finally, there's the form for module addition, enabling you to filter by module group, then select the
module, and add it.
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To delete a module, simply select it in the right column (if you select the upper cell of the right
hand side, you'll select them all) anf click the Delete button.

23.4.1. Create new module templates
To create a new module template, go to main component template management page,
Administration > Manage modules > Module templates and click on the Create button located at
the bottomright hand side of the page.
A page with the creation form for the new local component will be displayed:

Input a name and a description for the new template and click on the Create button.
Next, the page will be shown, where you'll be able to add modules to the template:
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Select the modules at the bottom, filtering by group if necessary, and click on the Add button.
Remember you can delete the unwanted modules by selecting them and clicking the Delete button.

23.4.2. Apply a module template to an agent
To apply one of the existing monitoring modules template or a recently created one, go to an
agent's configuration at Administration > Manage agents:
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And select the modules of one of the agents:

Once in this screen, click on the Templates tab, at the top of the page.

In the following screen, modules that already have an agent as well as the existing module
templates are displayed to select one and apply it to the agent:

Select a template and click on the Assign button, the modules contained in this template will
automatically be added. Once applied the template can delete some of the modules clicking on the
X in the column of the right hand side, or you can edit them clicking on the tool's icon, also at the
right hand side.

Templates applied to the agent are not displayed, just the modules contained in there
are
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23.5. Component groups
In order to help in component sorting and classifying, component groups exist. Components are
associated in groups at cration time.
To see the existing component groups go to Administration > Manage modules > Component
groups:

Existing groups and their description will be displayed on screen:

You can see the details on the groups by clicking on their name, delete them by clicking on the X at
the right hand side, or create new ones by clicking on the Create button at the bottom.
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If you want to create a new components group, click on the Create button, and fill in the form
fields:

You just need to provide a name for the group and select if it has a parent among the existing
groups. Then click on the Create button.
Now you can add new components to your just created component group.
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24.1. Introduction
Pandora FMS Enterprise version allows to keep an inventory of the devices that the servers
monitored by Pandora have. With this inventory, it is possible to keep a list with the CPU, cards,
RAM memory, patches, software, etc... or the company servers.
The inventory is independent from the monitoring and could be obtained in a local way (through
the Pandora FMS agents) or in a remote way.

24.2. Data collection for the inventory
The data collection for the system inventory is done in two different ways in a remote way through
inventory modules, through scripts integrated in Pandora FMS that execute WMI queries, or
executable scripts through SSH with Expect or similar methods.
When the data collection is local, with the Pandora FMS agent, it is done through plugins in the
agent or a kind of special module, in case of Windows systems.

24.2.1. Inventory Modules
The inventory modules are the remote modules that execute a command against a remote machine.
These modules work in a similar way that a plugin. The same modules could be defined as "locals"
when they obtain data through an agent.

24.2.2. Remote Inventory
24.2.2.1. Creating Remote Modules
The creation of a remote inventory module by the administrator is not usual. These come already
"precharged" with Pandora FMS Enterprise. Regardless, Pandora FMS allows you to create your own
inventory modules or modify the ones that already exist through the inventory module editor.
To create a remote module go to Administration> Manage modules> Inventory modules where
there are all the inventory modules that have been already created.
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To create a new module press on "Create".

Next describe the existing fields.
Name
Field where you should write the Module name.
Description
Field to write the Module description:
OS
Combo where you can choose the Operative System the module is created for. It is very important
to choose well the Operative System because by adding inventory modules into an agent there will
appear only these modules where the Operative System of the module matches with the Operative
System of the agent.
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Interpreter
Field where you can put the command interpreter that is used in the module. It can be Shellscript,
Perl or other valid interpreter for the inventory server that is executed on a Linux system.
Format
Field where are the fields separated by the sign "; ", that the module will return.
Code
Module code, usually it is Perl or ShellScript code. If it was binary code it will need a different load
procedure that should be introduced through peripheral scripts.
Once the module has been created press on "Create".
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24.2.2.2. Editing Remote Modules
To edit a remote module go to Administration> Manage modules> Inventory modules, where are
all the inventory modules that have been created. Press on the module you want to edit or on the
icon that is on the right of the red X.

The module creation page will appear again.

Change the fields you want to change and press "Update".
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24.2.2.3. Deleting Remote Modules
To delete a remote module go to Administration> Manage modules> Inventory modules where are
shown all the inventary modules that have been created. Press on the red x that is on the right of
the module that you want to delete.

24.2.2.4. Asigning Remote Modules
The Inventory modules assignment is done in the agent in the agent administration flap.
In Administración>Manage Agent click on the agent name to which you want to assign inventory
modules.
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Click on Inventory flap

There is the page where you can add the Inventory Modules.

Next are described the fields that you should complete to add an Inventory Module.
• Module: Combo where you can choose the Inventory Module that you want to add. It will
only show the modules which Operative System will match up with that from the agent.
• Target: IP or servername from you want to get the inventory.
• Interval: Combo where you choose the time interval in which the Inventory Module will ve
executed.
• Username: User that will ve used to execute the Inventory Module.
• Password: User Password that will be used to execute the Inventory Module.
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Once the form has been filled in, click on "Add" in order the module would be added to the
inventory modules.

24.2.2.5. Editing an Assigned Inventory Module
It is possible to edit the Inventory modules. This edition is done in the same page where they are
created. To edit an Inventory Module click on the module name or on the icon that is on the image.

24.2.2.6. Deleting an Assigned Inventory Module
It is possible to delete the Inventory Modules. The deleting is done in the same page where they are
created. To delete an Inventory Module click on the red x that is on the right of the module name.

24.2.3. Local Inventory through Software Agents
It is possible to obtain the Inventory Data from a machine through the Software Agents. You will
only need to apply the required Inventory Modules in the Software Agent configuration.Same as in
the remote modules it is also necessary to add these modules as Inventory Module in Operación >
Manage modules> Inventory modules.
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24.2.3.1. Creating Local Modules
To create a Local Module go to Administration> Manage modules> Inventory modules where there
are all the Inventory Modules that have been created. You should create all the modules that are
defined in the Agent.

To create a new module click on "Create".
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For the remote modules it is not necessary to complete all the fields. Next we describe the fields
that should be fill in:
• Name:field to put the Module name.
• Description: field where to put the module description.
• OS: combo where to choose the Operative System for which the module is created. For the
locate modules you should choose the option "Agent".
• Format: field where to put the fields separated by ; the the module will return.
Once you have created the module, press on "Create".
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24.2.3.2. Inventory Module in Windows Systems through Software Agents
The Windows Software Agent Module uses, in a local way, predefined WMI to collect information
about different aspects of the machine, both Software and Hardware.
The module syntax is the following:

Next are described all the fields that you should complete to add the Inventory Module in Windows
Systems:
module_begin
Beginning of any module of a Software Agent.
module name Inventory
Field where is the name for the module, in this case is "Inventory".
module_interval 3
Field that fix the module execution interval (in days).Fix how often (in days) the module will be
executed. In this example are 3 days. BEWARE of previous erratas in documentations, is not
module_inventory_interval, is module_interval ! If the value is 0 the information will be sent in
each agent execution.
module_type generic_data_string
Value that defines the kind of data in Pandora FMS, the kind of data of the Inventory Modules is:
“generic_data_string”.
module_inventory CDROM Patches Software
Field where are defined the inventory objects that we want to collect.In this example are collected
the CDROM, the patches and the software.In this field are defined the different parameters where
the inventory objects that we want to collect. To add more objects you only need to add the name of
them in the module line_inventory. It is possible to collect the following objects:
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•
•
•
•
•
•
•
•
•

CPU: gets information about CPus.
RAM: gets information about RAM modules.
CDROM: gets information about CDROM devices.
Video: gets information about Video cards.
Hds: gets information about Hard Drivers.
Patches: gets information about the installed patches.
Software: gets information about the installed software.
Services: gets information about the services installed on the machine(running or not).
NIC: gets information about Network cards, Network Interface Controlers.

module_description Inventory
Field where to put the module description.In this example is Inventory.
module_end
End of any module of a software agent. To activate the inventory module you only have to copy the
code previously described in the field pandora_agent.conf of the software agent. This activation can
be done in a local way in the machine or in a remote way from the agent remote configuration.

24.2.3.3. Inventory Module in Unix Systems through Software Agent.
The Unix software agent module uses, in a local way, a plugin to get information about different
aspects of the machine, both from Software and Hardware.
The module syntax is this:
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The module consist of one line with the following parameters:
• Module activation

• Field where is fixed how often(in days) the module will be executed. If the value is 0 the
inventory information is sent in each agent execution.

• Field where the inventory objects that are collected are defined.

Same as in the Windows agent, it is possible to collect the following objects:
•
•
•
•
•
•
•
•
•
•
•
•

CPU: gets information about CPUs.
cdrom: gets information about CDROM devices.
video: gets information about Videocards.
hd: gets information about Hard Drivers.
nic:gets information about Network cards, Network Interface Controlers.
Patches: gets information about the installed patches.
software: gets information about the installed software.
process: processes in execution at this moment in the server.
ram: gets information about RAM modules.
filesystem: gets information about system partitions.
users: get information about users.
init_services: get infotmation about init services

The plugin that the inventory collects is at the directory /etc/pandora/plugins
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Is also possible to set the plugin to gather all information available. In this example, the plugin will
get all information daily: inventario:
# Plugin for inventory on the agent (Only Enterprise)
module_plugin inventory 1

To activate the Inventory Module you need only to copy the code previously described at the
pandora_agent.conf file from the software agent. This activation could be done in a local way in the
machine or in a remote way from the agent remote configuration.

24.2.3.4. Assigning Local Modules
It is not necessary to activate the modules in the Agents defined at the console. If the modules have
been created at Administration> Manage Modules > Inventory modules and they are configured in
the Software agent, then, they will appear directly in the Agent at the console.
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24.3. Data Display for the Inventory
The Inventory Data that have been collected from a system, either in a local way or in a remote
way, could be seen from the agent or from the Console Inventory Menu.

24.3.1. Inventory Data Display in the Agent
To see the collected data from an agent with inventory from the agent, go to the Agent Operation
Menu and click on the Inventory flap.
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It is possible to filter the information through the inventory or through a open search.
To search through the module, choose the module and click on “Search"

To search through the open field, write the text to search in the search field and click on “Search”.
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24.3.2. Inventory Data Display in the Inventory Menu
From Operation > Inventory, it's possible to see the Inventory Data of all agents, to do searches and
to export data to a CSV.

The fields that could be used for searches are these:
•
•
•
•

Group: Combo where you can choose the group of agents you want to filter through.
Module: Combo where you can choose the inventory module you want to filter through.
Agent: Field where you can write the name of the agent you want to filter through.
Search: Field where you can write a text in order to do a search through all the inventory
fields.

Through searches it is possible to see the modules of all agents that have inventory, selecting all in
the search options and clicking on “Search”.
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Or an specific module in all agents with inventory, selecting the module and clicking on “Search”.

24.3.3. Exporting the Inventory Data to CSV
From Operation > Inventory is possible to export the Inventory Data that are the result of a filter to
a CSV file.
Choose the filter and once that there would be data click on “Export CSV”.

It is created a file with the Inventory Data separated by semicolon.
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25 DATA DISPLAY:GRAPHS, REPORTS,
VISUAL MAPS AND MODULE LIST
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25.1. Introduction
Pandora FMS collects the state or level of any parameter of a device, application, sensor, network,
etc. Pandora FMS keeps this state or level for a long time ( the time that user defines) in a
Database. Pandora FMS is able to represent graphically all these data in different ways.
Pandora FMS has several options that allows the user to see his systems, either it would be the state
in an specific moment or its evolution along time. These options are simple graphs, combined
graphs, customized reports, visual maps or modules list.

25.2. Typography and Languages
Pandora FMS includes a collection of fonts that could be used in graphs,maps and reports.Among
the fonts included, by default is used (code.ttf), which support characters such as latin, arabic,
hiragana, katakana and other more.
The fonts are at /include/fonts where you could copy new fonts if you need them.

25.3. Graphs
Graphs show the data collected by Pandora in a temporary scale defined by the user. Pandora FMS
graphs show data in real time, this is, they are generated each time the operator requires any of
them and they show the more updated state (the last state). There are two kinds of graphs: the
agent automatic graphs and the graphs that the user make customizable with one or more modules.

25.3.1. Agent Graphs
Agent Graphs are the graphs of the modules that could be seen from the Agent Operation Menu. To
have access to these graphs you should choose an agent from Operation>view agents> Agents
Details

431

Graphs

After filtering, click on the agent name, for example, Farscape, to have access to the agent operation
menu. In menu, click on data.

In the data flap we have a list with all the agent modules. One of the columns of these list is called
“Graph” and in each module it has a link to access to the monthly graph(M), weekly(W), daily (D)
and for hours (H).

If you click on any of the icons with the M,W,D or H, you will have access to a new window with
the module graph. This graph will have the temporary rank according with the icon that has been
clicked.
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There is also a quick view to data and to the 24 hr graph (last 24 hours ~ 1 day), from the main
view, on the graph icon, on the right of the data column.

The graphs are done in Flash or in PNG format ( if the Flash has been deactivated). In case of Flash
graphs, these are interactives, so putting the mouse over any point of the graph back side they show
the specific data of this point. The graphs have a configuration menu that allows (putting the mouse
over the flap on the left of the graph window), to reconfigure the graph.
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The graph configuration menu is this:

Next are the fields detailed:
• Refresh time:field where the graph refresh time is defined.
• Avg. Only:if you select it, it will show only the medium data, without minimum and
maximum.
• Begin Date: with a calendar it is possible to set the moment from data will start to be
shown.
• Zoom Factor: with a combo you can enlarge or reduce the graph.
• Time range: with a combo you can choose the graph time range.
• Show Events: if you click it, it will show the the module events.
• Show Alrmas: if you click it, it will show the module alarms.
Once you have change the values, click on “GO” for they apply. It is possible to change the graph
color at Administracion>Setup>Visual Configuration.
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25.3.2. Combined Graphs
Combined Graphs allow to the user to define graphs with a variable size, that have values of
different modules that own to one or more agents. In this way you can visually compare
information that comes from several sources.

25.3.2.1. Creating Combined Graphs
To add a Combined Graph go to Administration>Manage Reports >Graph Builder.

Next the fields are detailed:
Width
You should write the value that the graph width will have.
Render Now
Mediante un combo se elige si se muestra la gráfica o no se muestra.
Height
To write the value that the graph height will have.
Period
With a combo you can define the temporary period used to create the graph.
View Events
With a combo you can select if the event that have take place on the module will be shown or not.
Stacked
With a combo you can select the kind of graph choosing between Area, Line, Stacked Area and
Stacked Line.
Factor
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Press on “Preview” to para que aparezca la gráfica.

Click on “Preview” in order the graph will appear.

The defined graph is shown.
To add new modules you must press on Graph Editor button, and you will see this form that allow
you to add modules from any agent.
The defined graph is shown, with one menu to add more modules and to store the created graph.
To add more new modules you only need to press on the Graph Editor button and you will see a
form that will allow you to add new modules of any agent.
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The factor option allows to select the value of the data standarization factor in case that you want
to use it. The standarization is used to could compare graphs of different levels and multiplies the
data by the defined factor. For example, if we want to put in the same graph CPU with values
between 0 and 100 and number of connections between 1000 and 10000, then it's convenient to
multiply the CPU by 10.
There is no limit in the number of elements to visualize, but from five the quantity of information
shown makes difficult to interpret it, unless you use big size graphs (800x600, etc).
Due to the simplicity that the combined graph creation has, these can't be edited, except when you
are creating them, and when they are being created, the only thing you can do is to delete one
module that has been added to add it again with other configuration.
Once the graph has been created, it's important to store it to could see it again or use it in a report.
To store the graph, name it, write a description and select if it should be private or not and press on
"Store".
At the image that is bellow you can see a combined graph with two modules, cpu_ser of the
farscape Agent, cpu_user from ARTK_galaga. The graph has been saved as “Example cpu_user”.
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25.3.2.2. Displaying Stored Combined Graphs
To see a combined graph that has been stored, go to Operation>Reporting >Custom Graph where
are all the stored graphs.To see a graph, press on the name of it.

You go to the graph that is recalculated with the values that are availables at this moment.
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From this page it is possible to modify any display parameters such as the time rate, the kind of
graphic (line, area, stack line and stack area) and the zoom (Graph defines, Zoom x1, Zoom x2 and
Zoom x3).
Next you can see an example with the different kinds of graphs(the area type is on the previous
image).
• Line Type
Show as an static graph (Png).

• Stack area Type
In this case is shown as Flash Graph Type(interactive):
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• Stack line Type
Shown as static graph (Png).

25.3.2.3. Deleting Combined Graphs that have been stored
To delete a Combined Graph that has been stored, go to Operation>Reporting >Custom Graph
where there is a list with all the stored graphs. Click on the red x that is on the right of the graph
and it will be deleted.
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25.4. Network Enteprise Console
With Pandora FMS Enterprise we have the possibility of create editable network maps that are more
interactive comparing with the Open version that is currently on the "See agents" submenu.
On the contrary to the Open version, the Networkmap Enterprise provide us with more features,
such as:
• Networkmaps much bigger, of more than 1000 agents to monitor.
• Monitoring in teal time of all the network topology of their systems.
• Different views of its network topology, defined in a manual way or generated automatically
with agent groups.
• To link differebt views of its topology through fictitious points.
• To manipulate the topology represented in the view:
• Adding new nodes, one by one of in a massive way.
• Editing the nodes features.
• Organizing them inside the view:
• The nodes position.
• The relationships between the nodes.
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It's possible to have access to the Networkmap Enterprise through the left menu. It's at Operations
Section with the name "Network Console".

The network maps could contain:
• Real nodes, which represent in an unique way the agents added in the map there. These
nodes have an icon that represent the agent operative system and a circle (with circular
shape by default, but it's also possible to select between other different shapes) of the agent
status that could be:
• Green, it's right status.
• Red,some module it's on critical status.
• Yellow, some module is on warning status.
• Orange,some of the alarms has been fired in the agent.
• Grey, the agent is on unknown status.
• Fictitious nodes, which represent the link to other network map or simply one point simply
for personal use in the map, could have any shape of the availables ones (circle, rhombus,
square), any size and the text, of course. If it's a link to another map the color follows the
following rules, it the color can't be customized.
• Green, if all the nodes of the linked map are right.
• Red,if any of the nodes of the linked map is on critical status.
• Yellow, if any of the nodes of the map is on warning status and there is any one on
critical status.
• Orange, grey following the same rule that the other colors.
• Relationship lines between the nodes.

442

Network Enteprise Console

25.4.1.1. Minimap
This minimap gives us a global view that shows all the map extension, but in a smaller view, and
besides, in contrast with the map view, all the nodes are shown, but without status and without
relationships. Except the Pandora fictitious point, that is shown in green. And a red box is also
shown of the part of the map that is being shown.
It's on the upper left corner, and could be hidden pressing on the arrow icon.

25.4.1.2. Control Panel
From the control panel you can do tasks more complex on the network map.
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It's hidden on the right upper corner. Same as with the minimap, it could be shown pressing on the
arrow. And the available options are:
• To change the refresh frequency of the nodes status.
• To force the refresh.
• To add the agent, through the intelligent control that allows to search the agent in a quick
way and to add it. The new node is shown in the point (0,0) of the map that is on the left
upper side of the map.
• To add several agents, filtering them by group, which will show the agents of this group that
are not yet in the map in a list of multiple selection
• To do a screenshot of the visible part of the map.
• To add a fictitious point, where you can select the text as name of this point, the size defined
by the range, the point shape, color by default, and, if you want that the fictitious point
would be a link to a map.
• To search agent, also through an intelligent control, once selected, the map will go
automatically to the point where the agent node is.
• Zoom, change the network map zoom level

25.4.1.3. Detail View Window
The detail view window is a visual view of one agent. It is refreshed at the same velocity that the
map that has opened, and the windows are completely independents, so you can have several
windows opened.
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• It shows a box which rim will be of the same color that the agent status.
• The agent name is a link to the Pandora agent page.
• Inside the box are all the modules that are not in unknown status, which, depending if the
module status is green or red.
• It's possible to click on these modules and they shown a tooltip with the module main
data.
• In the box rim are the modules kind SNMP Proc,that use to be for network interfaces when
an agent related with network systems is monitored.
Palette of fictitious point

If you select see details on a fictitious point, this will show you a pop up window with a palette of
options to modify the fictitious point

We have a form with these options:
•
•
•
•
•

Name of the fictitious point.
Radio of the fictitious point.
Shape of the fictitious point.
Color of the fictitious point.
Map that links the fictitious point.
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25.4.2. Creating a Network map
If you want to create a network map, you can do it as:
• Show of all the agents contained in one group.
• Creation of an empty network map

We are going to summarize the fields that the creation form has availables:
• Name: Name of the network map
• Group: the group for the ACL, and also the group which map we want to generate with the
agents that are contained in this group.
• Creating the network map from: option only available in the creation. It's the way to create
the network map if we do it from the agents that are in the previously selected group, or on
the contrary we want an empty network map.
• Size of the network map: where it's possible to define the size of the network map, by
default it's of 3000 width and 3000 high.
• Method for creating of the network map:the method of distribution of the nodes that will
make up the network map, by default it's radial, but there are the following ones:
• Radial: in which all the nodes will be placed around the fictitious node that the
Pandora represents.
• Circular: In which the nodes will be placed in concentric circles en el cual se
dispondrá los nodos en círculos concentricos.
• Flat: In which the nodes with tree shape will be placed.
• spring1, spring2: are variations of the Flat.
• Networkmap Refresh: the refresh velocity of the status of the nodes contained in the
networkmap, by default is any 5 minutes.
The rest of the fields disabled, as for example "resizing map" is because there are only actives in the
edition of one map already created.
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25.4.3. Editing a Network Map

To could edit at map, besides having ACL permissions kind "IW", you will have, as it's shown in the
image, the access to edit through the "wrench" icon.

The network map edition form is exactly the same than the one for creation, except for these two
things:
• Generating the network map from: so the map is already generated.
• Generation method: for the same reason that the previous one.
But we have other fields actives:
• Resize of the network map: in which it send an asynchronous request to the server to it
analyzes the network map already generated and search the best way to get it shorter so if
there is any empty parts (without nodes) out of a minimum framing, reduce the map
dimensions to this framing.
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25.4.4. Duplicated in a Networkmap
From the networkmap list and having the "IW"ACL permissions, you can duplicate a network map
with all its content and all their configurations, except the name that is "Copy of..." and after if there
is more than one "Copy of...N".

25.4.5. Interaction with the network map
The network map interaction could be done through:
• The mouse, accepting actions of dragging and dropping, double click, main and secondary
button and mouse wheel. El ratón, aceptando acciones de
• The keyboard, through the control keys it's possible to modify to start multiple selection.

448

Network Enteprise Console

25.4.5.1. Actions on the Map
Moving through the Map

• Keep pressing on an empty part of the map it's possible to drag and move through the
network map.
• On the minimap, with the mousse drag keep pressing the main button or click on the zone
you want to visualize.
• In the dashboard you have a search box that once the agent is introduced, the map moves
automatically to the point where the node of this agent is located.
Forcing the Map to refresh

With the mouse secondary button, pressing on an empty space a contextual menu is shown, then
you select the option "Refresh", that forces to refresh the node status.

To center the Map

With the mouse secondary button, pressing on an empty link. a contextual menu is shown. Then
you select the option "Center here" fix the network map center in the clicked point, to the rest of
times it opens this map the point appear. Besides,by default, if you don't select any center, de center
by default is the Pandora fictitious node.
Editing the nodes

25.4.5.1.1.1.

Change the position

It's possible to change its position Keeping it pressing on a node of the map
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25.4.5.1.1.2.

Linking one node with other

With the mouse secondary button, pressing on a node, the contextual menu will be shown, then
select the option "Select as child".

Start the link operation of one node with other. To do this, you should click with the secondary
button on another node (fictitious or not) and you will have a contextual menu that shows "select as
parent" or " Cancel the operation".
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And when finishing the operation the node will be shown linked with the other node and the marks
on the nodes will disappear.

25.4.5.1.1.3.

To pile up the Nodes

With the mouse secondary button, pressing on a node, a contextual menu will be shown, select the
option "Sent to the front" sent the node to the front to if they are piled up or ones superimpose to
anothers, the selected one be painted over the rest of them.
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As long as the map is painted, it will be show over it.

25.4.5.1.1.4.

Deleting the nodes

With the mouse secondary button, if you click on a node, a contextual menu will be shown, then
choose the option "Delete".
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25.4.5.1.1.5.

To change the shape of the status ring

With the mousse secondary button, pressing on one node, a contextual menu will appear. Then you
will have the popup list in the shape of the ring. With it you can choose the shape of the ring.

25.4.5.1.1.6.

Deleting the relationships between the nodes

With the mouse secondary button, pressing on one node, a contextual menu will be shown. At the
end of it shows the relationship list, a list of the relationships that the node could have. You can
delete them pressing on the X.
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Massive edition of Nodes

Keeping press the "control" key, a translucent square will be shown to could select several nodes at
the same time.Once several of them have been selected, you can do:
• With the main button, you can drag all of them at the same time.
• With the secondary button, you have available a menu with the options. linking by
relationship with another node, send to the front, delete, open de detail view and change the
way of the status ring (and if it's a fictitious node, the shape of it).

Seeing information about the nodes

• With the mouse main button, doing double click on one node.
• With the mouse secondary button, pressing on a node, a contextual menu will be shown,
then select the option " Show details" it shows in pop up window a detail view of the agent.
If it's a fictitious node that opens a pop up window showing a palette of options to edit the
fictitious node.Con
Creating agent nodes

Creating agent nodes from the initial load if you select some group in the map creation, you can
add new agent nodes once it has been created. This should be done from the control panel, and
there are two ways of doing it.
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25.4.5.1.1.7.

Single creation of a node

In the control panel, at the adding agent area, it has an intelligent control that filters and shows an
list of possible agents.
Once it has been selected, do click on the button "add the agent" in the panel and it show a new
node of this agent in the center of the part that is showing now the map.

25.4.5.1.1.8.

Massive creation of a node

In the control panel, in the pop up list that is called "Filter group", you can select the group from
which you want lo load the agents to add inthe list above. In this list will be shown the agents of
this group that aren't in the map.
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Once selected, when clicking on the button "add", they will be shown piled up in the point (0,0) of
the map, that is on the left upper corner .
Creating fictitious nodes

Besides, from the control panel, it's possible to create fictitious nodes. In the form it's possible to
define the shape (circle, square, rombus), to color it, name it, give it a size, and, even to choose in
the networkmap list a map with which to link it.

Modify the zoom level

When the map is shown, it's done at level 0, that is the closest level.
• mouse wheel, con el la rueda del ratón puedes variar el nivel de zoom sobre el mapa, que
por defecto siempre se abre en el máximo nivel de zoom, el máximo nivel se muestra el
icono de sistema, en niveles superiores no se muestra y el texto de cada nodo es de una
fuente menor. Hay 5 niveles de zoom.
• A través del panel de control puedes elegir el nivel de zoom, que esta al fondo de el panel.
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25.5. Network map (Open Version)
Ther is an Open version of network map. This functionality allow to show in a graphical way
through nodes and relationships, agents and modules and groups available to user. There are three
types of network maps:
• Topology map
• Group map
• Policy map
Network map is available in View agents > Network map subsection:

Create a new network map is really easy, for example in order to create a topology map, you have
to follow nex steps:
Click on New map.
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A screen like this will be shown:

After that click on the green arrow, you can modify name, filter by group, show/hide interfaces,
modify network map shape, configure if name are overlaped or not, show simple nodes (without
images and names), regenerate map each time the page is reloaded and the font size. Next click on
update.
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To finish click on Save map button.

Other maps are created in the same way.

25.5.1. Topology map
Shows agents according to network topology, showing relationships between fathers and children
nodes. This can be used in combination with recon script. This combination allows to display the
network topology graphically. Asociating with each agent will be colored with the agent's state.
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25.5.2. Group map
Shows agents and modules classified by group (of agents and modules). You can filter by agents
groups and module groups, network map shape(radial, flat, circular, etc.), depth (agent or
modules), overlaped names or not, if module with alerts are showed or not, if policy modules are
hidden, if nodes are simple, if it is wanted to regenerate network map everytime is reloaded the
page and font size.

25.5.3. Policy map
Shows agents and modules of policies. It is possible to filter by agents group, module groups, it is
possible to modidy network map shape (radial, flat, circular, etc.), depth (agents or modules), if
names are overlaped, if modules with alerts are showed, if modules are simple, if it is wated to
regenerate netowkr map everytime is reloaded the page and font size.

25.5.4. Fullscreen mode
Last, it is possible to show network map in Fullscreen mode clicking on the following button:
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25.6. Reports
With Pandora FMS, it's possible to create customized reports with information about agents, with
information such as: calculus derived from them or even to import data or tables for other places
with Url import or similar. It's possible same as with the user graphs to select different modules of
different agents. Data is visualized in different ways depending the kind of the report element that
we want to add.

25.6.1. Creating a Report
To add a Report, go to Administration>Manage Reports >Report Builder. It'll show you a list with
all the created reports. To create a report, click on "Create Report".

There will show one screen were is the name of the report is defined, and also the group to which it
belongs, if it's private or not and the description. Once the fields have been filled, press on "Create".
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25.6.2. Editing a Report
To edit one report go to Administration>Manage Reports >Report Builder. There is a list with all
the created reports. To edit a report, click on the report name.
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25.6.3. Deleting a Report
To delete a report, go to Administration>Manage Reports >Report Builder. There is a list with all
the created reports. To delete a report, press on the red cross that is on the right of the report name.

25.6.4. Tabs
25.6.4.1. Main Tab
The main tab is the only one that is available in a new report, so this one defines de report's basic
data (name, access group and description). After storing it properly, you'll have access to the rest of
tabs.
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The fields that you have in this form are:
• Name, where you define the name of the form.
• Group, where you define the access group that is visualized at the report
• Description, this description, for giving more information about the report to the users, will
be shown in the report list. It will also be shown in the visualization of the report as XML
and PDF.

25.6.4.2. List Items Tab
With this tab you'll get a global visualization of all items that make up the report. The items in the
list will be shown in the order that they'll have in the report. From this tab it's possible :
• To modify the item (by doing click on the adjustable spanner).
• To modify the order in an automatic way in the header cells with the white arrows,
classifying them by alphabetically element kind or by agent name.
• To modify the order manually through the green arrows on the left.
• To eliminate the item clicking on the red cross
If it's a big report with several items, it has a form on top in order to filter by different criteria.

The columns that this tab show are:
• S. : Column with green arrows to order manually.
• Type: column where the kind of items is shown.
• Agent: column where is the agent name. It could be in blank to kind of items like S.L.A.,
Custom Graph, Import text from URL, SQL, Query, Simple Graph and Text.
• Module:column where is the module name from data will be get in order to do the report. It
could be in blank for kind of items such as Agent detailed view, Alert report agent, Custom
Graph, Event report agent, Import text from URL, S.L.A., SQL query y Text.
• Period: the time period that it will get at the back in the specific moment where the report is
generated.
• Description: column that shows the description you have given to the item in order to make
easier working on it.
• Options: column that shows the buttons/icons to edit the item or to delete it.

25.6.4.3. Item Editor Tab
Item Editor tab is more complex than the others, because from it, you'll be able to create the form
items or to edit them. Besides, the form is dynamic depending on the kind of item to create. In the
edition, all the fields (expept the kind) can be edited. If you need to change the kind, the way to do
464

Reports

this is to eliminate the current one and create it again with the same configurations.
The common fields for all kinds are:
• Type: pop up list with the kinds of items for the report, which by selecting the kind,
authorizes and unauthorizes the necessary fields to configure this kind of item. The available
kinds are: Agents/Modules, Agent detailed view, Alert report agent, Alert report module,
Avg. Value, Custom graph, Event report agent, Event report module, Import text from URL,
MTBF, MTTR, Max. Value, Min. Value, Monitor report, S.L.A., SQL query, Serialize data,
Simple graph, Sumatory, TTO, TTRT y Text.
• Description: Text box where you should describe the report item.
Kinds of Items

25.6.4.3.1.1.

Agents/Modules

Shows a matrix of agents and modules of a module group and also shows modules states.

25.6.4.3.1.2.

Alert Report Agent

Shows a list with the alerts fired by the agents of the report group in the defined period.
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The fields of this form are:
• Period: the time period that will take until back in the temporary point in which the report is
generated.
• Agent: the intelligent control to select the agent for this item.
And in the HTML version of the report an item of this kind is generated. For example:
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25.6.4.3.1.3.

Alert Report Module

Shows a list with the alerts fired by the module in the report in the defined period.

The fields of this form are:
• Period: the time period that it will take until back in the temporary point where the report
will be generated.
• Agent: the intelligent control to select the agent for this item.
• Module: displayable list that is loaded in a dynamic way with the agent modules selected in
the previous control.
25.6.4.3.1.4.

Avg. Value

Average value for a module in the defined period. This period is calculated in the moment of
visualizing the report. In the configuration menu are added the fields Source Agent, where the
Agent is selected, and Module and, after, the module from which the average value is shown.
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The fields for this form are:
• Period: time period that will take until back in the temporary point in which the report will
be generated.
• Agent: intelligent control to select the agent for this item.
• Module: deployable list that is loaded in a dynamic way with the modules of the agent that
was selected in the previous control.
And in the HTML version of the report, an item of this kind is generated. For example:

25.6.4.3.1.5.

Custom Graph

Combined graph defined by the user. A field is added with a combo to select the graph that we
want to add.

The fields of this form are:
• Period: time period that will take until back int the temporary point where the report will be
generated.
• Custom graph: deployable list with the graphs defined by the user. You can create these
graphs from Administration, Manage reports en Graph builder.
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And in the HTML version of the report an item of this kind is generated. For example:

25.6.4.3.1.6.

Event Report Agent

Shows a list with the events that occurred in the agents in the defined period.

The fields of this form are:
• Period: time period that will take until back int the temporary point where the report will be
generated.
• Agent: intelligent control to select the agent for this item.
And in the HTML version of the report an item of this kind is generated. For example:
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25.6.4.3.1.7.

Event Report Group

Shows a list with the events that occurred in the report group agents in the defined period.

The fields of this form are:
• Period: time period that will take until back int the temporary point where the report will be
generated.
• Group: combo to select group.
And in the HTML version of the report an item of this kind is generated. For example:
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25.6.4.3.1.8.

Event Report Module

Shows a list with the events occurred in the module of an agent in the report in the defined period.

The fields in this form are:
• Period: period time that will take until back in the temporary point in which the report has
been generated.
• Agent: intelligent control to select the agent for this item.
• Module: deployable list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
25.6.4.3.1.9.

Exception

This shows values of several modules that fulfill a logical operator (greater than, less, OK or Not
OK) ordered ascending, descending or by agent name inside the given period.
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25.6.4.3.1.10.

General

Shows values of several modules ordered (ascending, descending or by agent name) or/and group
by agent.

25.6.4.3.1.11.

Group report

Shows a table with the next information of a given group:
• Agents
• Total number
• Number of unknown status agents
• Modules
• Total number
• Number of normal status modules
• Number of critical status modules
• Number of warning status modules
• Number of unknown status modules
• Number of not init status modules
• Alerts
• Number of defined alerts
• Number of fired alerts
• Events
• Number of events of this group in the last 8 hours

The fields of the form are:
• Group: combo to select the group.
And in the HTML version of the report is generated an item of this kind. For example:
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25.6.4.3.1.12.

Import Text from URL

This item shows the text extracted from an external server to which the Pandora Console will have
access to. You should consider that in the HTML report format it will show it like that, but in the
PDF version of the report, it will only show the text in plain format.

The fields of this form are:
• URL: field text where you should introduce the external server address to extract the text.
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25.6.4.3.1.13.

Inventory

This item shows the selected inventory of one or various hosts in a date or last knowed.

The fields of this form are:
• Description: Text field with the item description.
• Group: Combo that filter the agents that appear in the next field. It's not showed in the
report, it's only a form tool.
• Agents: Agents of the hosts where the inventory will be gathered. In this field will be showed
only the agents with inventory modules.
• Modules: The common inventory modules of the selected agents.
• Date: Date of the showed data. If Last is picked, only will be gathered the latest inventory
data of the selected modules.
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25.6.4.3.1.14.

Inventory changes

This item shows the changes of inventory registered in one of various hosts in a selected period.

The fields of this form are:
• Description: Text field with the item description.
• Period: Period when the changes has been registered
• Group: Combo that filter the agents that appear in the next field. It's not showed in the
report, it's only a form tool.
• Agents: Agents of the hosts where the inventory will be gathered. In this field will be showed
only the agents with inventory modules.
• Modules: The common inventory modules of the selected agents.
25.6.4.3.1.15.

MTBF

Average time between faults
• It is calculated: MTBF= TTO / #F

• where:
TTO=total time for operation in the period
#F= total number of fails
• It gives the average time of regular operation between faults.
• RELIABILITY indicator.
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The fields of this form are:
• Period: the time period that will take until back in the temporary point where the report is
generated.
• Agent: intelligent control to select the agent for this item.
• Module: deployable list that is load in a dynamic way with the modules of the agent selected
in the previous control.
25.6.4.3.1.16.

MTTR

Is the average time to restore the performance of one system, machine, line or process after a
functional fault.
• It includes time to analize an diagnose the fault, time to get refurbished, time for planning,
etc
• It's a mesuring of a system performance.
• It's the time interval get dividing the total time of reparations between the total number of
faults in a system.
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The fields in this form are:
• Period: the time period that will take until back in the temporary time where the report is
generated.
• Agent: The intelligent control to select the agent for this item.
• Module: Deployable list that is charged in a dynamic way with the modules of the selected
agent in the previous control.
25.6.4.3.1.17.

Max. Value

Maximum value of a module in the defined period. This period is calculated at the moment of
visualizing the report.

The fields of this form are:
• Period: The time period that it takes until back in the temporary point where the report is
generated.
• Agent: The intelligent control to select the agent for this item.
• Module: Deployable list that is loaded in a dynamic way with the modules of the selected
agent in the previous control.
And in the HTML version of the report is generated an item of this kind. For example:
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25.6.4.3.1.18.

Min. Value

Minimum value of a module in the defined period. This period is calculated in the moment of
visualizing the report.

The fields of this form are:
• Period: the period of time that it will take until back in the temporary point where the report
is generated.
• Agent: the intelligent control to select the agent for this item.
• Module: deployable list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
And in the HTML version of the report, an item of this kind is generated. For example:
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25.6.4.3.1.19.

Monitor Report

It shows the time percentage that a module has been wrong and/or right in the defined period.

The fields of this form are:
• Period: period time that it takes until back at the temporary point where the report is
generated.
• Agent: the intelligent control to select the agent for this item.
• Module: deployable list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
And in the report HTML version is generated an item of this kind. For example:
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25.6.4.3.1.20.

S.L.A.

Allows to measure the service level (Service Level Agreement) of any monitor of Pandora FMS.

The fields of this form are:
• Period: time period that it takes until back in the temporary point where the report is
generated.
This form is more complex, and besides the common fields of other items, has above a list of the
module subitems to calculate the S.L.A with the following columns:
• Agent: the agent to use in the SLA is selected from a combo box.
• Module: the module to use in the SLA is selected from a combo box.
• SLA min (value): to fix the SLA minimum value.Minimum values of this value will trigger
the SLA.
• SLA max (value): to fix the SLA maximum value. The maximum values of this value will
trigger the SLA.
• SLA Limit (%): set the time percentage that will trigger the SLA. When the module has been
within the minimum and maximum limit values, during that time percentage, the SLA will
be shown as right, on the contrary it will be shown as wrong.
It is possible to add new modules to the SLA to do combined SLAs of modules from the same or
different systems.
In the case of the combined SLAs, the SLA performance will depends on the performance of all the
SLAs that have been configured.
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25.6.4.3.1.21.

SQL Query

This item shows the report data from the Pandora database in tables. It's a customized data report
with data extracted directly from the DB.
There are two ways of describing the SQL query:
• One handed written in the text box:

• The other selected through the Custom SQL template dropdown, that only through the
Enterprise version could be edited in an easy way:
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The fields for this form are:
• Query SQL: box text to write the SQL query to extract data from the Pandora's DB.
• Serialized header:text field to write, separated by | to define the table headers that will be
shown in the report. For each column that will be show as a result in the SQL query.
• Custom SQL template: dropdown list that contains the SQL templates of stored queries for
its management. These could be managed through Administration, Manage reports in
Custom SQL.

Due security restrictions, there are some tokens or words you cannot use: *, DELETE,
DROP, ALTER, MODIFY, UNION, password, pass, INSERT or UPDATE

25.6.4.3.1.22.

SQL graphs

This kind of reporting allow you to define your own graphs to be used in reports. That graphs will
be created using your own SQL code. This code should return always a variable called "label" and
other variable called "value". This is an example of SQL used to create graphs:
SELECT tagente.nombre AS label, datos AS value FROM tagente, tagente_estado,
tagente_modulo
WHERE tagente_estado.id_agente_modulo = tagente_modulo.id_agente_modulo AND
tagente_modulo.nombre = "module_1" AND
tagente_modulo.id_agente = tagente.id_agente

This will be a sample on how to define the graph, its pretty similar to the SQL query report but
doesn't use headers, and only need the SQL code.

These are a few samples of the three different graphs you can draw with Pandora FMS: Pie graphs,
Vertical bars, Horizontal bars. They are using different UTF encodings in the description (western
latin, Japanese and Arabic) just to show the powerful true multilanguage UTF support of Pandora
FMS (also for PDF reporting).
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Due security restrictions, there are some tokens or words you cannot use: *, DELETE,
DROP, ALTER, MODIFY, UNION, password, pass, INSERT or UPDATE

This kind of items must be used with caution because they could overload Pandora
FMS
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25.6.4.3.1.23.

Simple baseline graph

With this graph you can show future estimation values for the selected module. For example if you
select a week period and today is Tuesday you will see real data from Monday and Tuesday and
estimations for the other days.

The fields of this form are:
• Period: the time period it will take until back in the temporary point where the report is
generated.
• Agent: the intelligent control to select the agent for this item.
• Module: dropdown list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
And in the report HTML version is generated an item of this kind. For example:

This kind of graphic could overload Pandora FMS if you use a lot of data to make the
future estimations
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25.6.4.3.1.24.

Serialize Data

Shows an item in the table format report from the data stored in the table tagente_datos_stringin
the Pandora FMS database. For it, the agent should serialize the data separating them with a line
separating character and other that separates fields. All lines should contain all fields.This kind of
item, for example, is used for the agent that extract the management data of the SAP platform
(http://en.wikipedia.org/wiki/SAP_AG).

The fields for this form are:
• Period: the time period that it will take until back in the temporary point where the report is
generated.
• Agent: the intelligent control to select the agent for this item.
• Module: dropdown list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
• Serialized header: text field where to put the divided by | to define the table headers that
will be shown in the report. For any column that will be shown when separating the
compacted field.
• Field separator: separator for different fields the serialized text chain.
• Line separator: separator in different lines (composed by fields) of the serialized text chain.
25.6.4.3.1.25.

Simple graph

Shows one module simple graph.
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The fields of this form are:
• Period: the time period it will take until back in the temporary point where the report is
generated.
• Agent: the intelligent control to select the agent for this item.
• Module: dropdown list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
And in the report HTML version is generated an item of this kind. For example:
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25.6.4.3.1.26.

Summatory

Shows the summatory of one module values in an specific period.

• Period: the time period it will take until back in the temporary point where the report is
generated.
• Agent: the intelligent control to select the agent for this item.
• Module: dropdown list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
And in the report HTML version is generated an item of this kind. For example:
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25.6.4.3.1.27.

TTO

Is the operation total time (the time sum where the monitor has been OK).

This form fields are:
• Period: the time period it will take until back in the temporary point where the report is
generated.
• Agent: the intelligent control to select the agent for this item.
• Module: dropdown list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
25.6.4.3.1.28.

TTRT

Is the total sum of times where the monitor hasn't been OK.
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The fields of this form are:
• Period: the time period it will take until back in the temporary point where the report is
generated.
• Agent: the intelligent control to select the agent for this item.
• Module: dropdown list that is loaded in a dynamic way with the modules of the agent
selected in the previous control.
25.6.4.3.1.29.

Text

This item shows in the reports a formatted text, to, for example, add more information of the
company to the report.

The fields of this form are:
• Text: text box that allows to format the text, and also adding links and images from a
remote server.
Example of shootscreen of the window to add the link:
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Example of shootscreen of the window to add image:

25.6.4.3.1.30.

Top n

Shows N values discriminated by maximun, minimun or average over the total of modules selected,
ordered ascending, descending or by agent name.
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25.6.4.3.1.31.

Projection graph

This kind of item will project in the future an estimation of the module data. This estimation is
based on linear regression [1] and is implemented following the least squares method [2].

In order to configure this item you have to fill this information:

• Period: Period of time to make the estimation.
• Projection period: Period of time in the future where the module data will be projected.
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25.6.4.3.1.32.

Prediction date

This type of item returns a date in the future where a module reach an interval. It uses least squares
method like the Projection graph [3].

In order to configure this item you to fill this information:

• Period: Period of time to make the estimation.
• Data Range: Interval that the module needs to reach to return the associated date.
For example, for the module disk_temp_free and choosing 2 months and searching for the date
where the module reach the interval [50] the result will be 04 Dec 2011 18:36:23. This is a graphic
vision of the explanation:
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25.6.4.4. Wizard Tab
This tab belongs to the Pandora FMS Enterprise version. This tab allow us to do in an automatic
way with a few clicks, and in only one time, several items for a report, with common configurations,
but applied to several agents and/or modules.
Once the kind, the period, the agents, and if it's necessary the modules, have been chosen, then you
should click on the add button and it'll be generated so many items in the report as many agents or
modules have been selected.

The fields that compose the form of the tab are:
• Type: deployed list where you select the kind of item that will be generated in a massive
way. There are not all, so due to obvious reasons there are kinds of items that need a finer
configuration. But the available kinds that you have are: Alert report agent, Alert report
module, AVG Module, Event report agent, Event report module, Monitor report y Simple
graph.
• Period: intelligent control to give the time period or data time segment to represent in the
report item from the moment when it's generate, this is: if the period is one month, and you
generate the report for the current moment, the items will get out data from one month
back.
• Agents: the agent list that you have available acording your permission group. From this list
you can select one or several agents, and for each selection in the module control, there'll be
shown the ones that are commons to the selected ones.
• Modules: this common module list of the selected agents is available for one or several ones.
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25.6.4.5. Wizard SLA tab
This tab belong to Pandora FMS Enterprise version, This will allow you to create a SLA report with
a wizard. It is possible to add modules in common from different agents in an easy way.

25.6.4.6. Global tab
This tab belong to Enterprise Pandora FMS version, and will allow us to create Exception, General
or Top n reports in an easy way through a Wizard. With this you can add different modules from
different agents.
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25.6.4.7. Advanced options Tab
This tab belongs to the Pandora Enterprise version. In this one you can do the reports much more
customizable. Among other things, you can select the font where the PDF report will be generated,
select the logo that will be shown in the PDF header, edit the header and the PDF footline and to
edit the report front page.

And the fields that compose this form are:
• Font family: is a deployable list in all the fonts where you have installed in your Pandora
Console in the directory <pandoraconsole>/enterprise/include//mpdf50b/ttfonts. The
default font is Times Roman. And if you want to make bigger the font range, then you
should consider that it should have read access to the apache group and that there are in
TTF format. IMPORTANT NOTICE: If you want to use Arabic, Chinese, Japanese or other
UTF8 text in your PDF, you need to use a supported TTF font for that characters. We provide
the "code" font with actually have all language characters.
• Custom logo: Is a deployable list with the possible logs that could be shown in the header of
each PDG page. The logo images are kept in
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<pandora_console>/images/custom_logo/. The one by default is pandora_logo.jpg. By clicking
on it you can see a previous view above this form.
• Header: is a very complete editor where you can copy and past the formated text of an
application or edit it though the button box. This text will be the one that will be shown in
the header.
• First page: as the Header field, this is another text editor very complete to create and edit
the PDF front cover page.
• Footer: same as with the two other fields, but for editing and creating each PDG page
footers.
25.6.4.7.1.1.

Macros

By now, these are the implemented macros:
• (_DATETIME_): that is replaced by the date at the moment where the report is generated, in
the data format configured at the Pandora Console options.

25.6.4.8. Preview Tab
This tab shows the report such as it is when it's generated in HTML format, to could see the results
in an easy way. It will show the report as you see the report in the real operation/view report
option.

25.6.5. Visualizing a Report
To visualize a report already created go to Operation>Reporting>Custom Reporting.

Reports could be visualized in HTML, XML, CSV or PDF.
To see a report in HTML click on the
icon. Once the report is opened in HTML is possible to
select from which date and hour it is generated.
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To see a report in XML, click on the

To see a report in PDF, click on the

icon.

icon
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25.6.6. Automatic Report Sending by Email
In Pandora FMS Enterprise Version there is an extension that allows to send, in an scheduled way,
the reports generated by email. The report is sent in pdf format.
To have access to the extension go to Operation>Extensiones>Cron Jobs.
To add the task of Report Sending by Email, you should fill in the following fields:
•
•
•
•
•

Task: to select the option: “send custom report by email”.
Scheduled: to select how often the report will be sent.
First Execution:to select the date and hour of the first execution.
Report build:to select the report that you want to send.
Send to mail: to writee the mail adress to send the report.
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Once you have filled the data, click on create and the task in the scheduled tasks will be shown.

Once you have created the scheduled task, it is possible to force its execution clicking on the green
circle that is on the right of the task or to delete it clicking on the red x that is on the left.

25.6.6.1. Configuration
This
funcionality
need
a
config.
The
configuration
is
in
the
file
/enterprise/extensions/cron/email_config.php in the Pandora Console host, by default the file is
empty:
<?php
//Please setup your config to send emails in cron job
$cron_email_from = array('pandora@pandorafms.org' => 'Pandora FMS');
$cron_email_smtpServer = 'mail.artica.es';
$cron_email_smtpPort = 25;
$cron_email_username = 'info@artica.es';
$cron_email_password = ;
?>

The parameters for to config are:
• From: with the email acount, and between the quotes you can write the Name
acount.contacto
• SMTP Server: in this line write the url server SMTP.
• username: the user name of conection.
• password: password of conection.
By example, this is a fictional configuration file:
<?php
//Please setup your config to send emails in cron job
$cron_email_from = array('bot_report@company.cat' => 'Bot report');
$cron_email_smtpServer = 'mail.company.cat';
$cron_email_smtpPort = 25;
$cron_email_username = 'bot_report@company.cat';
$cron_email_password = 'opensesamo';
?>

Remember, anybody can see the file who is access to host that have the Pandora
Console, don't write your personal email acount, by example you could make a email
acount for this task
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25.7. Report templates
(Implemented since Pandora 5.0 Enterprise)
Report templates are components that allow to parametrize report creation. Later allow to apply
them over a set of agents and create a lot of reports in an easy way.

25.7.1. List of templates
From administration menu: Administration > Manage reports > Report builder and click over list
templates button:

In this section you can create new templates, edit the existing ones, copy, and delete them.

25.7.2. Template edit
Inside a template you can edit general parameters of a template:

25.7.3. Item list
In this section you can see, edit, sort and delete items inside a report template.
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25.7.4. Item editor
In this section you can create new items. Item types are the same like in Report section with two
differences: Agent name is a regular expression, for example oracle_agent[.]* will match with agent
names: oracle_agent_1, oracle_agent_2, etc. If you left it blank then this item will be applied over all
agents selected in template Wizard.
Module name can be filled literally doing check in Module exact match or by a regular expression
without doing click in that checkbox.

25.7.5. Advanced options
In this section you can edit visual aspects in the result report like font, logo, header, first page or
report footer.
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25.7.6. Wizard
Last, in order to apply templates you have to choose a template, target agents (by clicking in the
tick icon you can select all), clik on the arrow pointing to the left and clicking on Apply template
button. The default behaviour is to create one report with all template items. But if you click on
Create report per agent checkbox then template application will create one report per agent selected.

As mentioned earlier if an item is filled with agent name (a regular expression), template will be
only applied over agents whose names match with that regular expression. For example, if an item
have been filled with an agent name 192.168.50.1[.]* then template will be only applied over
agents 192.168.50.1 and 192.168.50.10 but not over 192.168.50.2 agent.

The result can be seen in the list of reports:
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In order to delete all reports created by previous template applications you can select a template
and click in the cleanup button (broom button).

25.8. Visual Maps
Pandora FMS allows to create visual maps where each user could create his own monitoring map.
The new visual console editor is much more practical,although the older visual console editor had
also lot of good things. In the new visual console we have been successful imitating the sensation
and touch of a drawing application (as for example GIMP), and also we have simplified the editor
separating into several subject matters tabs: "Data", "Preview", "Wizard", "List of elements" and
"Editor".
The elemets that a map can have are: static image, percentage bar, module graph and simple value.

25.8.1. Creating a Visual Map
To create a visual map go to Reporting>Visual console.It shows a list with all the created maps.To
create a new one click on “Create”.
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There is a window where you should write the name of the map.Choose the group and select the
map that you are going to use. Once you have filled all the fields, click on create.

25.8.2. Visualizing a Visual Map
To see the Visual Maps that have been created go to Reporting>Visual Console. There is a list with
all the created Maps.
The visual console items have the characters "_", "," , "[" , "(" for the first letter, it is show in the left
menu into "Visual Console" submenu.
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To see the Map click on the name of the Map that you want to see.

Bellow the map there is a combo where to choose the refresh time of the map. The map could be
seen at full screen by clicking on this icon
clicking on this icon

. It is possible to go to the map edition page by

Also in this view is possible to show a public link to the current visual map

that it's accessible without login in Console

25.8.3. Deleting a Visual Map
To delete a Visual Map go to Reportint>Visual console.It shows a list with all the created Maps. To
delete the Map click on the cross in the row of the target visual map.
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25.8.4. Tabs in the visual map editor
25.8.4.1. Data
In this one, you can edit and create the visual console basic data. It will be the only one visible for a
new map until you save it. The essential values that it has are: visual console name, the group for
the ACL management, and the background image.
By creating it, the size of the visual console is determined by the background image size, but by
editing it, if you change the background, the last size that was defined by the user or the previous
background will be kept.
The background images are stored at the Pandore Console
var/www/pandora_console/) at the /images/backgrounds/ directory.

directory

(usually

Captura de pantalla del formulario de la pestaña data.

25.8.4.2. Preview
The visual console view is an static view, so, if the state of the elements contained there, they will
not be drawing again as it happens with the visual console view that hangs on the Visual Console
menu.

example of Screen shot of a preview where you can see the four kinds of elements on the Africa map
image.
506

Visual Maps

25.8.4.3. Wizard
Here, there is an small questionnaire to create several elements of static imagen kind at the same
time in the visual console with only two clicks.
As you can see in the shootscreen, the form consist of:
• The image, that will be the same for all the elements created in the batch.
• The distance between the elements, that will be one after the other in a horizontal line from
position (0, 0).
• Agent selection box, to select one or several agents (to select one or several agents, batch
elements will be created for the visual console).
• Module selection box, which is a dynamic control and will be filled with the modules of the
agents that you choose in the agent selection box . There you could choose the modules
from which you want the Static image elements at the visual console will be created.

Wizard tab screen shot.

25.8.4.4. List of elements
This tab gives a questionnaire tabulated in files of the elements that the visual console that you are
editing has. It is a quick way of editing the different elements, besides being a useful tool for the
users that need to adjust certain values of the elements.
The actions allowed in this questionnaire are: editing (but not to change the kind of element) and
deleting elements but not creating them. This action should be done with the Editor tab.
The first line is the background image configuration.
The rest of the lines will be the map elements, that as we can see in the screen shot are gather in
lines of two each element and separated by an horizontal black line.
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example of screen shot of the List of elements tab.

25.8.4.5. Editor
This tab has most of the part of the functionality of the visual console editor, because is where you
could create the elements, edit and place them. It is a dynamic page, so it will be necessary that
your browser support correctly the javascript languaje. As you can see in the screen shot, the screen
is divided in two areas that are well defined: the button box, the work area (where you will "draw"
the visual console) and the option palette ( that is not visible in this screen shot).

Captura de pantalla de ejemplo de la pestaña Editor.
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Button box

The buttons that compose the tool are:
• Buttons to create the different kinds of elements, located at the left side. They are: Static
Graph, Percentile Item (Bubble and percentile type), Module Graph, Simple Value Label and
Icon.
When you click on them, the palette of options with the fields to fill in order to create the element
of this kind will appear.They can be deactivated if you are editing an element or creating an
element. In this last case, if it is active, when you do click, it closes the palette of options.
• Delete Item, that is deactivated by default until you select an element ( except background).
By doing click it eliminates for ever the element of this visual console deleting it from the
database. Warning! this action can't be undo.
• Edit Item, also initially deactivated until you select any element of the visual console. By
doing click it will display the palette of options of this element in order you can edit their
values.
Working Area

The working area has the size of the 100% of your Pandora Console wide and it's 500 pixels hight.
As you can see, it has scroll bars to make easier working with visual consoles of big size. Another
thing you have to consider, is that the visual console size is the size of the background image. In the
working area will be shown the different elements that has been created in the default position
(0,0), that is the left upper corner.
Advanced Options

Position
By default, the position is 0x0, where the first number is the X axis and the second one is the Y axis.
These values are in pixels, and consider that the Y axis is inverted where the highest part is 0 and it
grows downwards. The X axis is defined in the classical way. It starts in the left corner and it
increases to the right side.
You don't need to fulfill this control with the position, unless you want a very precise position,
because after creating the element, you can locate it dragging through the visual console, same way
as with a drawing tool.
Parent
To represent the link between elements from the visual console, we use lines that are drawn
between them. It could be very useful in a visual way. Besides, the line gives an specific colour
depending on the state of the parent element. In the control it will be displayed a list of elements
that are in this visual console that could be the parent of the element.
Map linked
The element can also be the gate to another visual console to get more usability, such for example:
you have two visual consoles, one that represent the machines inside a building that you manage,
and also you have another visual console that represents a world map. So the usual thing is that in
this last one you have an element that even could change the state (only with the Static Image) that
represent the building you are managing, and also could to have access in an easy way to this one.
This control will give you a dropdown that shows the visual console already created to link it.

509

Visual Maps

Label color
If you prefer it (for esthetic reasons, or to improve the label text visibility if the map background is
very dark), you can change the color of the text, that is black by default. It is also an intelligent
control, and besides you can write by hand the color in the classical HTML hexadecimal format. You
can display a popup with the typical color palette.

color palette screen shot in the label color.

Background

It is an special kind of element, so it can't be created nor destroyed. Only the following values could
be edited:
• The background image through the choice palette.
• The size that is created through the image selected as background. The 0x0 value, same as
in the static image, is an special value that means that it takes the original value of width
and hight of the background image file.
• It is possible to apply original size of bacground clicking on the button Original size.
• Also it's possible to modify heightweight ratio of the brackground image so it's possible to
respect between this two values. These canbe done by clicking in the Proportional width and
Proportional height buttons.
Since 5.0 version.
• Grid: You can show a grid so you can move elements squared to that grid and finally all
elements will be aligned. If this option it's deactivated then elements can be moved free
again.

Grid option in the palette
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Background image with the grid activated
Since 5.0 version.
• Save current edition: Also you can deactivated the autosave functionality that works by
default with Visual console. And then force the save action by clicking in the disk button.
This is really useful in low connections when you don't have the security that the autosave
have been done correctly.

Option to autosave the current visual map in the option palette

Example of screen shot that shows the choice palette when editing the background.
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25.8.5. Choice Palette
It is shown when you double click on the item to edit, or when clicking on the edit button on the
button box. The form of the option palette has the following controls for all elements, but the
elements has some control more the you can check in its section on the article. .

25.8.5.1. Label
The text that will be shown in the element in the visual console.

25.8.5.2. Agent
An intelligent control with which you could search an agent of your Pandora installation through
the IP or the name of the agent.

Screenshot of one search in the agent intelligent control.

25.8.5.3. Module
This control respond to the selection of the control of the agent and autofills with the modules that
the agent contains.

Screenshot of the control module filling authomatically with the agent modules.

25.8.6. Elements which can be used in a visualmap
25.8.6.1. Static Image
This element shows an static image. Depending on the state of the module, agent or map, it's show
an image or another, in a current Pandora installation you will have them availables at
(/var/www/pandora_console/images/console/icons), and eve you could upload them with the file
included tool.The image nomenclature is: <image_name>_<state>.png where the state could be:

512

Visual Maps

Example of images with the name and the status.
• "" When the agent, module, or the visual console have any state.
• "bad" When the agent has some module that fails, or the module fails or the visual console
that links has some some element in bad.
• "ok" When the agent, module or the visual console that could link are ok.
• "warning" When the agent has any module in warning, or the module is in warning o the
visual console that links has any element in warning.
Creating an static image
To create an static image, simply click on the Static Graph button that is the first one on the button
box left side, and it'll be displayed a palette with the options for a new image. The common options
could be seen at the entry Choice palette, but the ones that are exclusives for the static image are in
the following section.
Static Image Options
• Image: where with a drop down control you can choose the image that will be shown, and
could even see under the control an image preview.
• Advanced options:

• Size: in this control game, you can give a size to the image.By default it comes with
the value 0x0 that means that takes the original size of the image.
Screen Shots

Palette showing the image preview that is going to be added to the visual console.
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View of the choice palette of a fair static image view
Tricks
• To create a floating text

• It's an easy method, you need only to create an static image, but without image.
25.8.6.2. Icon
This element shows a static image not associated to any module.

Icon in visual map editor.
In
a
normal
Pandora
instalation
you
will
have
available
the
images
in
(<pandora_home>/images/console/icons) directory, you will also upload any new image through
the file manager tool. Like any other element in visual console you can associate a label, a initial
position, size, a parent element and link to another visual map.
All of this in the visual map editor:
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Example of icon creation.
Icons linked against other pages
Since 5.0 version. Through label field you can associate a complete URL in order to link with
another
web
page.
Example: In order to link an icon in visual console with SNMP console you have to create one
element of icon type. This icon will have a label with the complete URL of the SNMP console:
http://<pandora_home>/index.php?sec=snmpconsole&sec2=operation/snmpconsole/snmp_view

In the preview mode of the visual console you can click over the icon and will redirect to tje SNMP
console.

25.8.6.3. Percentile Bar Item
Percentile items allow to see module state in a very descriptive way.They can be of bubble or
percentile (progress bar) type.
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Example of percentile bar percentage, this example shows the result of a module monitoring CPU.
Percentile Item options
The percentile bar has much less controls that the rest of the elements, but it has four controls that
we are going to explain:
• Width: that will be the percentile bar width in pixels.
• Max value: is the maximun value that the module to represent could have. By this reason,
it's a good thing that you examine well the module to monitor just to see which is the
maximum value, for example, in the case of the screen shot it's the CPU module that goes
from 0 to 100.
• Type: This allow to configure if the item type will be bubble or percentile. This is the
graphical way of represent this item.

Element with percentile type

Element with bubble type
• Value to show: This allow to choose between percent of accomplishment or the last value of
the module.

• Advanced Options: this element has not any different advanced control from the basic
ones.
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Example of screen shot of the choice palette for the percentile bar.

25.8.6.4. Module Graph
As its name shows, in the visual console will be shown a graph that gives the information of the
activity of one agent module.

Example of screen shot of a module graph element, where you can see in a graph the last data of a CPU
module from one hour ago.
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Module Graph Options In the graph, it is necessary to define width and hight, so it goes from
being hidden in the advanced options to be shown.
• Period: the period or time frame that goes until the present time. Consider that this graph
will change with time.
• Size: width and hight of the image that will be the graph, not only the graph itself, but of
the graph and the ciphers of axes.

• Advanced options: this element hasn't nay advanced control different from the basic
ones.

Screen shot where is possible to see the graph choice palette of a module that is being edited.

As the graphs have to be calculated and create images, it's not an instantaneous process,
so depending on the architecture where you have built Pandora, it can be almost
instantaneous or take a few seconds and see only the label of the element in the map
without the graph image
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25.8.6.5. Simple Value
This element only show a text of the <label> <valor modulo>on the visual console. So you will
only need to define a label(if you want), select the agent and the module that will show the last
value in the visual console drawing.

Screen shot fragment where is shown an example of a simple value of a CPU module.
Simple Value Options
The simple value choice palette hasn't its own controls.

Screen shot that shows the simple value choice palette.

25.8.6.6. Label
In order to create a label without associated content you can use this item. Only it's necessary to
field the label field.

Label item edition
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25.9. Agents/modules view
Going to Monitoring > Agent/Module view, shows a matrix with modules and agents and the state
of single every single module.
Go to the extension from Operation>Extansions>Agents/Modules view.
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25.10. Modules Group
This section allows to have a total vision in a module table by its state, regarding the module group
and the module. Go to the extension from Monitoring > Module group

As you can see at the image, there is a matrix with the modules number by agent group and with
different colors depending on if there are modules in Critical,Warning or OK state.
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25.11. Tree view
Allows visualizing the agent monitors in a tree. Go to this view from Operation > Monitoring >
Tree view

It is possible to classify the agents by: Modules, Policies, Module Group, Group and Operative
System. By default, is sorted by group. At this level, shows a count of the number of agents ok
(green), critical (red), warning (yellow) and unknown (grey). Clicking on the agent's name appears
information about it: name, address, operative system and event and access graph. Can be filtered
by module state (Normal, Critical, Warning or Unknown) and search by agent name.

25.12. Mobile console
Pandora FMS 3.2 comes with a new mobile console. This is a reduced version of the default console,
and allow any user with a mobile device with at least 240x320 px of screen resolution to browse all
information provided by Pandora FMS: agents, monitor view, alerts, agent detail (graphs included),
group view, last events, etc.
Mobile interface is at /mobile url, so if your console is at http://yourdomain.com/ your mobile
console is at http://yourdomain.com/mobile.
These are a few screenshots of Pandora FMS mobile interface, taken on a HTC Jade, running
Windows Mobile 6.1 and Internet Explorer.
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Login screen in the mobile web interface

Tactical view mobile web interface
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General agent view in the mobile web interface

Detailed agent view, mobile web interface.
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General module view in the mobile web interface

Contextual menu, in the event view, mobile web interface
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26 DASHBOARD
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26.1. Introduction
The dashboard is a Pandora FMS (Enterprise version) functionality that allows that any user could
build his own monitoring page. It is possible to add more than a page and in it is possible to add
monitoring maps, graphs, etc...
Dashboard configuration is done from the same place where it's possible to have access to them at
Operation > Dashboards,on the right side of the Pandora FMS web console:

When you click on Dashboard the pages that the user have configured will be shown.
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26.2. Creating a Dashboard
Dashboards are customizable. Each user configures his own Dashboard and could only see those
ones that he has configured.
To create a Dashboard,click on Operartion > Dashboards. All users have a dashboard named
"default". Click on the add button.

Write the name you want to put to the dashboard tab in the window that appears and click on
"Add".
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As a new tab has been created, now there are two tabs:default and the new one. The following step
is to add objects. For doing it, click on "Add Widget".

It shows a new window where are all the objects that could be added.
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26.2.1. Adding Objects in the Dashboard
You could add several different objects, each of them with its features.

26.2.1.1. Group Status Report
To add a report with the Pandora FMS group status click on this icon.

By clicking on the icon appears the configuration window of the object.

Write the title, select the groups that should be in the report and click on "update". Then a window
like this will appear.

Clicking on the group name you could have access to the corresponding group in the operation
menu.
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26.2.1.2. Graphs Defined by the User
To add a graph defined by the user click on this icon:

By clicking on the icon it will appear the object configuration window.

In the configuration window you should configure the following parameters:
• Title: title that will appear at the top of the graphic.
• Graph: combo where you can choose the graph that will appear. You should choose between
the graphs created by Pandora FMS.
• Period: combo where you can choose the graph period.
• Stacked: select it if you want that the different values of a combined graph would be one
above the other.
Click on the “update” button and it will appear a window like this:
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26.2.1.3. Last Events List
To add a list with the last events that have been place in Pandora FMS, click on this icon:

when you click on the icon, the object configuration window appears.

In the configuration window you should configure the following parameters:
• Title: title that will be shown above the graph.
• Event Type: combo where you can choose between the different kinds of events that exist
(Critical,Warning,...).
• Interval: combo where you can define the time interval that you are going to use.
• Limit: combo where the maximum number of events that will appear is defined.
• Event Status: combo where you can choose the state of the event, validated without
validate, or all of them.
• Groups: select the group from which the events will be shown.
Click on the "update" button and a window like this will appear:
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If you click on the agent name you will have access to the agent configuration window.

26.2.1.4. State of the System
To add a report with the state of Pandora FMS monitors, click on this icon:

If you click on the icon the system state object will appear.
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26.2.1.5. Pandora FMS Welcome Message
To add the Pandora FMS welcome message, click on the following icon:

When you click on the icon the object with the welcome message will appear.

26.2.1.6. Agent Module Graph
To add a graph of one of the Pandora FMS agent modules, click on this icon:

If you click on the icon the object configuration window will appear:
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You should configure the following parameters in the configuration window:
•
•
•
•
•

Title:title that will appear above the graph.
Group:combo to choose the group the agent belongs to.
Agent:combo to choose the agent.
Module:combo to choose the module.
Period:combo to choose the time period that the graph will have.

Click on "update" and you will see a window like this:

26.2.1.7. Visual Maps Report
To add a report of Pandora FMS visual maps, click on the following icon:
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If you click on the icon the object configuration window will appear:

Write the title, select the maps of the visual console that should appear in the report and click on
"update". It will show a window like this:

If you click on the map name you will have access to the map in the visual console.

26.2.1.8. Network Map
To add one Pandora FMS network map, click on this icon:
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If you click on this icon the configuration window of the object appears.

In the configuration window you should configure the following parameters:
•
•
•
•
•
•

Title: title that will appear above the map.
Group: combo to choose the agent group that will appear on the map.
Layout: combo to choose the location of agents depending on the kind of map.
No overlap: if you select it, the agents will not be overloap.
Simple: if you select it the agents will appear without icons.
Font size: combo to choose the font size used to write the name of the agent.

Click on the "update" button and it will appear a window like this:

538

Creating a Dashboard

26.2.1.9. Visual Console Map
To add a map from the Pandora FMS visual console, click on this icon:

If you click on the icon, the configuration window of the object will appear.

Write the title and chose the map that should appear in the object from a combo.
Click on the "update" button and a window like this will appear:

Maps will have to be created before from Administration > Visual console builder
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26.2.1.10. Show URL content
To show Url content in Pandora FMS, click on this icon:

If you click on the icon, the configuration window of the object will appear.

In the configuration window you should configure the following parameters:
• Title: Title that will appear above the widget.
• URL: Combo where you can choose font size used for agents name.
• Height in px (zero for auto): Height of the widget.
Then click on update button and a window like this will be shown:
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26.2.1.11. Tactical view
To add a tactical view of Pandora FMS click on this icon.

If you click on the icon, the configuration window of the object will appear.

In the configuration window you should configure the following parameters:
•
•
•
•

Title: title that will appear above the widget.
Status and Monitor checks: Show information about modules.
Server performance: Summary of server statistics.
Summary: Summary information about agents and modules.
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Click on the update button and a window like this will be shown:

26.2.1.12. Panel with a message
To add a panel with a message in Pandora FMS click on this icon.

If you click on the icon, the configuration window of the object will appear.
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In the configuration window you should configure the following parameters:
• Title: Title that will appear above the widget.
• Text: Free text with the message content.
Click on the update button and a window like this will be shown:

26.2.1.13. User defined reports
To add user defined reports in Pandora FMS click on this icon

If you click on the icon, the configuration window of the object will appear.
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In the configuration window you should configure the following parameters:
• Title: Title that will appear above the report.
• Report: Name of the report that will content the widget.
Click on the update button and a window like this will be shown:

26.2.2. Putting Objects in the Dashboard
Clicking with the mouse on the Dashboard objects it is possible to move them and putting them
where the user wants.

26.2.3. Editing Objects on the Dashboard
To edit the configuration parameters of a Dashboard object, click on the icon with a notebook and a
pencil that is on the upper right side of the object that you want to edit.

Once you have click on the icon, the configuration menu of the object will appear. Modify it and
click on "update" to save the changes.
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26.2.4. Deleting Objects on the Dashboard
To delete the configuration parameters of an object from the Dashboard, click on the red x icon that
is on the upper right side of the object you want to delete.

26.3. Editing a Dahsboard
The only Dasboard value that could be edited is the name. To rename a Dashboard already created
click on the triangle that si on the tab that you want to edit. The rename and delete options will
appear on the Dashboard.

Click on the "Rename Dashboard" option.

Write the name you want and click on "Update".
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26.4. Deleting a Dashboard
To delete a Dashboard already created, press on the triangle that is on the tab you want to delete. It
will show the rename and delete dashboard option.

Click on the "Delete Dashboard" option.
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27 PANDORA GIS
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With the version 3.1 Pandora FMS will start to support positional information and interactive maps
to show the position of the agents. This is a completely OpenSource feature. Only for Unix agents

27.1. Setup
27.1.1. Agent Configuration
The agent now accepts new parameters to send the positional data, so in the agent.conf now there
some new parameters for longitude, latitude, altitude and position_description. Other parameter for
an alternative way of get the coordinates is in the file now: gis_exec. This parameter has a script
path that will return a string with the coordinates in the format "latitude,longitude,altitude".
This is one example of use:
# Agent position parameters
# Those parameters define the geographical position of the agent
# gis_exec: Call a script that returns a string with "latitude,longitude,altitude"
# i.e.: 41.377,-5.105,2.365
#gis_exec /tmp/gis.sh
# latitude
latitude 42.70456
# longitude
longitude -3.897187
# altitude
altitude 600
# Position description
position_description Madrid, centro

27.1.2. Server Configuration
The GIS features must also be enabled on the server, for that there is a new flag called activate_gis,
when this flag is set to 1 the server will process all the GIS information received from the agents.
With the positional data now there is the possibility of storing agent positions on Pandora FMS, but
this data is coming from a source without high accuracy, it's possible to store a lot of different
points very close to each other without an important difference on the position. To avoid this the
location_error parameter sets the distance that it's considered as the same location, this is an error
threshold on the positio, and all data received from an agent having a position within the distance
(in meters) established on this parameter will be stored as new data received in the same point,
until the position received gets out from the error distance defined, setting then a new location.
Recon server and positional information:
Using a reverse geolocation algorithm and a database with the relation of IPs and positional
information, the Recon server can guess now the position of the agents discovered. For this it can
use a file in MaxMind GeoIP GeoLiteCity format, or a couple of tables on the database with that
information.
So there is tree new parameters that define the new behavior of the Recon sever, the
recon_reverse_geolocation_mode [disabled, file or sql] the recon_reverse_geolocation_file only
used to point to the file with the reverse geolocation information using MaxMind GPL
GeoLiteCity.dat format if the mode is file. And the last parameter is recon_location_scatter_radius
used to place the agents discovered randomly around the point defined by the reverse geolocation
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algorithm and within the range (in meters) defined by the recon_location_scatter_radius
parameter.
Also you can use the reverse geolocation provided by Google API and Openstreet Maps. You can
activate the Google reverse geolocating setting the parameter google_maps_description to 1. You
can
activate
Openstreet
Maps
reverse
geolocating
setting
the
parameter
openstreetmaps_description to 1.
Be careful using this feature because it decreases the Pandora FMS server performance, also
keep in mind you need direct connection to Internet to use Google API and Openstreet Maps and
of course it depens on service provider availability.
Configuration Example:
# Flag to activate GIS (positional infomration for agents and maps) by default it is
deactivated
activate_gis 1
# Radius of the Error in meters to consider two gis locations as the same location.
location_error 10
# Recon reverse geolocation mode [disabled, sql, file]
#
* disabled: The recon task doesn't try to geolocate the ip discovered.
#
* sql: The recon task tryes to query the SQL database to geolocate the ip
discovered
#
* file: The recon task tryes to find the geolocation information of the ip
discovered in
#
the file indicated in the recon_reverse_geolocation_file
parameter
recon_reverse_geolocation_mode file
# Recon reverse geolocation file (databases with the reverse geolocation information
using
# MaxMind GPL GeoLiteCity.dat format).
recon_reverse_geolocation_file /usr/local/share/GeoIP/GeoLiteCity.dat
# Radius (in meters) of the circle in where the agents will be place randomly when
found by a recon task
# The center of the cycle is guessed by geolocating the IP.
recon_location_scatter_radius 1000
# This enable realtime reverse geocoding using Google Maps public api.
# This requires internet access, and could have performance penalties processing GIS
# information due the connetion needed to resolve all GIS input.
google_maps_description 1
#
#
#
#

This enable realtime reverse geocoding using Openstreet Maps public api.
This requires internet access, and could have performance penalties processing GIS
information due the connetion needed to resolve all GIS input.
You can alter the code to use a local (your own) openstreet maps server.

openstreetmaps_description 1
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27.1.3. Console Configuration
In the Console, to use the GIS features, first it must be activated on the main setup:

With this some new sections of the user interface are available:

27.1.3.1. GIS Connections
On the admin setup, the first step is to define the connections that can be used to connect to map
servers to provide maps for the GIS features.
The connection has several basic parameters:

• A name for the configuration, so it can be recognized when selecting a connection on the
map definition screen.
• The group that owns the connection, this will be used to filter the connections available on
the map builder depending on the ACLs.
• The number of zoom levels defined on the map.
• The default zoom level recommended for the map (this can be redefined on the map) and
it's the zoom level used when the map is open.
Once the basic parameters are set, the administrator must select a type of connection, and
depending on the type there will be different options, so those are the types of connections and
their options.
Open Stret Maps

The default installation of Pandora FMS has predefined a connection with Open Streets Maps so the
users can directly see and test the GIS features, but usually the Pandora FMS server is in a place
without direct access to the Internet or the user would prefer to use it's own map server to have
more flexibility, to be faster, or to define it's own kind of tiles (check
Pandora:Current_development:Pandora_GIS_Backend for a possible way to achieve this).
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To use a Open Street Maps kind of map, the only paremeter needed is the url of the tile server as
shown in the image:

This can be something like:
http://tiles.example.com/${z}/${x}/${y}.png

Google Maps

Pandora FMS also suport the connection to Google Maps, for this a valid key for the pandora
console server must be obtained from Google (see Google Maps API policy ) and placed on the
corresponding field of the connection definition.

With this key it's possible to define several connections using different kinds of base maps (Hybrid,
Physical or Satelite).
Static Image

Another type of connection supported is to use a Static Image as a map. To use this kind of map the
image must be on a EPSG:4326 projection.
In this case the parameters needed for the definition of the map are url of the image, the height
and the width of the image, and the positional limits (longitude and latitude) of the sides of the
image (right, left, top and bottom).
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Map Center and Default Position:
The last thing to define for a map connection is the center of the map and the default position for
agents without positional data. To define them it's possible to preview the map and click on map to
set this parameters, depending on which parameter is selected with the Change in the Map
selector.
In this preview map it's possible to move around the map using the green arrows on the top left,
change the zoom level with the + and  icons or use the magnifier to set the full zoom.
Of course it's possible to set the position entering the values on the corresponding input boxes.

Once all the connection parameters are set, it's possible to save the connection to use it on the maps
builder clicking on the save button.
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27.1.3.2. GIS Map builder
Once the connections are defined, they can be used to define maps in the GIS Map Builder

The menu takes the user to a screen with the defined maps, where it's possible to edit a map (by
clicking on the name), view the map (clicking on the view icon) set the default map with the radio
button, or delete maps (with the delete icon).
And also there is a button to create new maps.
The administrator must establish a default map that will be the one used on the agent view to
display the position of the agent.
Crete GIS Map

Once in the Map creation page, the first thing to do is to give it a Map Name and Add a Map
connection from the ones available (it's possible to add more than one, that will be available later
on as base layers... this means only one can be active at the same time). When the connection is
selected (or when the default connection for the map is changed) the Pandora FMS console asks if
you want to use the default data from the connection for the map, if the answer is Accept, the
console will fill (or update) all the positional data (center longitude, center latitude, center
altitude, default longitude, default latitude and default altitude) from the ones defined on the
connection, and the user will only have to set is the default zoom level'. If the answer is Cancel no
changes will be done in those fields and just the connection will be added
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Layer definition

Once the basic map parameters are set, it's time to define the layers of the map that will be used to
select which elements to show in the map (except if it's the default map that you don't need to
define any layer because it will be used to show the agent position on the agent view).
Each map has one or more layers to show the agents. Each layer can show the agents of a group
and/or a list of agents. This way it's easy to set up the agents that will be shown on each Layer.
The layers can be set as visible or hidden, and select the group with the selector or add agents with
the box. Once the layer is defined (it will not be completely saved until the whole map is saved) it
will be moved to the left column of defined layers, where it is possible to order (move up and move
down) them, delete, or edited again.

Once the definition of the layers of the map is finished, all can be saved with the save button
(update button in the case of an edition of a map).

27.2. Operation
Once there is at least a map defined it's possible to start the operation with the GIS features.

27.2.1. GIS Maps
The GIS Maps menu displays all the maps defined. Each link takes to one of the maps that will be
open using the parameters defined on the GIS Map Builder
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27.2.1.1. Move around the Map
The controls for the map include four green arrows on the top left corner that allows to move on
th map on each one of the four cardinal point directions. A + and a  icons to increase and decrease
the level of zoom, and a zoom bar to select directly the desired level of zoom.
By dragging the map it's also possible to move arround.
The agents shown in the map are clickable to show more information about the agent (and once
the bubble with the extra info is displayed the name of the agent is a link to the agent view, and
there is a red box with a cross to close the bubble).
Also there is a special layer defined by the system called Hierarchy of agents, if this layer is visible
it will show red dashed lines connecting an agent to it's parent (if both are visible).

27.2.1.2. Hide / Show / Select Layers
The white + on green background on the right, will open the layers controls, if clicked. It displays a
green box where it is possible to select the base layer (the connection to the map server, if more
than one were defined for the map), and which layers are visible.

27.2.1.3. Filters
On the top of the map there is also five buttons to filter the agents shown by it's state:
•
•
•
•
•

The green button will show the agents on Ok state.
The grey button will show the agents on Unknown state.
The yellow button will show the agents on Warning state.
The red button will show the agents on Critical state.
The All button will show All the agents defined by the layers without taking on account their
state.

27.2.1.4. Map Refresh
Next to the filter buttons there is a combo box tagged Refresh to select the update rate for the
map. The Map uses [AJAX] calls to refresh the agents in the map using the selected period.

27.2.1.5. Map Edit and Full Screen
The last two buttons on the top of the map are a link to the GIS Map Builder to edit the Map, and
the full screeen button to see the map on full screen.
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27.2.2. Agent View
The agent view of Pandora FMS console also have new GIS features.
First of all, in the main view now shows the longitude, latitude and altitude of the agent.

27.2.2.1. GIS Historical View
There is a new button on the top bar (if GIS is activated) to show the GIS view of the agent.
This view shows the current position of the agent on the default map. with a table showing the
history of the previous positions of the agent, and a path of this positions on the map.
Each position in the map is represented by a dot (except the current one that it's represented by the
agent icon or the group icon if the agent doesn't have an icon defined). It is possible to click on
any of this dots to get the information related to that position, and also it is possible to click on the
agent icon to show the current information of the agent. The next image shows the path reported
by the Pandora FMS agent for Android devices.
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Also you can show the table with all information reported by the agent, including a reverse
geolocation system that shows you the address of the agent with the street, the city and the country
where Pandora FMS agent is.

27.2.3. Agent GIS Setup
Among the administration tabs of the agent, there is a new tag to manually set the agent position,
and also the agent manage tab has some parameters that affect the GIS features.

27.2.3.1. Ignore GIS data
On the agent manage tab there is a new switch called Ignore GIS data. If this switch is activated,
the server will ignore all the positional information received from the agent and keep using the last
valid values for this agent. This is useful in case an agent is reporting a wrong position or it's
desired to place it on a fixed place.
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27.2.3.2. Manual position of the agent
This view shows the default map where it is possible to click to set the new position of the agent, or
also it is possible to set the position using the input boxes under the map.

Setting the agent position will also activate the ignore GIS data switch to avoid the next
data package with positional information from the agent to reset again the position. If
this is not the desired behavior, don't forget to deactivate the Ignore GIS data swich
before clicking the update button

27.3. Useful links
This is a collection of interesting links to implement your own tile server, and expand the features
of current code.

27.3.1. OpenLayers
•
•
•
•
•

Wikipedia page de OpenLayers
Openlayer documentation made with Natural Docs Openlayers doc
More information about Openlayers Official documentation about Styles
Help with OpenLayer styles: OpenLayers Styles
Debuggin with Firebug Openlayers Debug

27.3.2. Mapnik
• Mapnik setup with OpenStreetMap
• Rendering with Mapnik
• Ubuntu Installation

27.3.3. OpenStreetMap
•
•
•
•
•

Some samples of OpenLayers
Make your first map OpenStreetMap + osm2pgsql + PostGIS + Mapnik
Using OpenStreetMap
Tiles download OSM
Osm2qgsql

27.3.4. OS Geo
• The Open Source Geospatial Foundation

27.3.5. Geo Server
• Main website geoserver.org
• Stable version
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27.3.6. PostgreSQL
• Documentation for GIS extensions for PostgreSQL 8.1

27.3.7. Blogs (Spanish only)
• GIS & Chips
• Weait
• Portal de GIS y Cartografía de la UPV CartoSIG
• Recursos sobre Cartografía y SIG
• Imagen Virtual: OpenSUSE + Software de GIS
• Cálculo de distancias teniendo en cuenta la curvatura terresre en Franchu's lair
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28.1. Introduction
In this chapter are discussed several topics on daily management of Pandora FMS, such as: group
administration, user creation, etc.

28.2. Profiles, Users, Groups and ACL
Pandora FMS is a Web management tool that allows multiple users to work with different
permissions in multiple defined agent groups. Before adding users, groups and profiles must be well
defined, as well as the data visibility we want each user to have.

28.2.1. Profiles in Pandora FMS
The permissions an user can have are defined in profiles. Profiles are managed at
Administration>Manage Profiles

The following list defines what ACL control allows in each feature at the console:

Feature

ACL Control

View agent data (all tabs)

AR

Tactical view

AR

Network map view

AR

Group view

AR
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Visual console edition

IW

Create report

IW

Create used custom-defined graph

IW

View report, visual map and/or custom graph

IR

Create incident

IW

Read incident

IR

Delete Incident

IW

Become owner of another incident

IM

Delete incident of another user

IM

View event

AR

Validate event

IW

Create incident from event

IW

View user

AR

SNMP Console view

AR

Validate traps

IW

Message

IW

Cron jobs

PM

Tree view

AR

Update manager (Operation & Admin)

PM

Extension Module Group

AR

Agent management

AW

Remote agent configuration management

AW

Assign alerts to agents

LW

Define, alter and delete alert templates, actions and
commands

LM

Group management

PM

Create inventory modules

PM

Module management (includes all suboptions)

PM

Massive management operations

AW

Create agent

AW

Duplicate remote configurations

AW

Downtime management

AW

Alert management

AM

User management

UM

SNMP Console management (alerts and MIB load)

PM
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Profile management

PM

Server management

PM

System audit

PM

Setup

PM

Database maintance

DM

Administrator extension menu

PM

Search bar

AR

Policy management

AW

28.2.1.1. Adding a Profile
To add a profile, go to Administration>Manage Profiles and click on “Create”. The following form
will be displayed:

To create a profile, give it a name, choose the permissions it will have and click on “Create”.
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28.2.1.2. Editing a Profile
To edit a profile, go to Administration>Manage Profiles and click on the name of the profile to be
edited.

28.2.1.3. Deleting a Profile
To delete a profile go to Administration>Manage Profiles and then click on the red "x" at the right
hand side of the name of the profile to be deleted.
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28.2.2. Pandora FMS Groups
The accesses are related with the groups that are used to group agents. An user could have different
permissions in each of the groups to which it has access. The agents could only belong to one group.
The groups are defined at Adminitration>Manage Agents>Manage Groups.

28.2.2.1. Adding a Group
To add a group go to Administration>Manage Agents>Manage Groups and click on “Create
Group”.
Following form is displayed:
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Next, form fields are discussed.
Name: Group name
Icon: Combo box to choose the icon the group will have.
Parent: Combo box to assign another group as parent of the group under creation.
Alerts: If enabled, agents belonging to the group will be able to send alerts, if not marked
they won't be able to do so.
• Custom ID: Groups have an ID in the Database, in this field you can input another
customized ID to be used by an external program in an integration (e.g.: CMDB's).
•
•
•
•

Once the fields have been filled in click on the “Create” button.

28.2.2.2. Editing a Group
To edit a group got o Administration > Manage Agents > Manage Groups and click on the name of
the group you want to edit.

28.2.2.3. Deleting a Group
To delete a group go to Administration > Manage Agents > Manage Groups and click on the red x
at the right hand side of the name of the group to be deleted.
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28.2.3. Users in Pandora FMS
Once the profiles and groups that are going to be used in Pandora FMS have been defined, it's time
to define users.
Users are managed at Administration > Manage users, where one can see the list of defined users,
as well as the created profiles.

28.2.3.1. Adding a User
To add a user go to Administration>Manage users and click on “Create User”.
The following form is displayed:
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Next, form fields are discussed:
User ID: Identifier the user will use to log into the application.
Full Display Name: Field to store the full name.
First Name: Field to store the person name.
Last Name: Field to store the family name.
Password: Field to input the password.
Password confirmation: Field to input the password again for confirmation.
Global Profile: Choose among Administrator or Standar User. An administrator will have
absolute permissions on the application for the assigned groups. An standard user will have
the permissions defined in the assigned profile.
• Email: Field to store the user's email.
• Phone Number: Field to store the user's phone number.
• Comments: Field to store comments on the user.
•
•
•
•
•
•
•

Once the form is complete, click on “Create”. The created user appears, as a new section does, to
input the groups the user will have access to, and the applicable profile.
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A user can be given access to as much groups as you want. Select a profile and the group and click
on the blue + symbol.

In case you want to remove access to a group, click on the red "x" at the right hand side of the
access to be removed.

In addition, the user can be given access to foreign political groups. This allows him to access all the
content of these policies regardless of which group they belong to.

To know more about this setup visit Extra access to policies

28.2.3.2. Displaying a User
On top of the option at Administration>Manage users it is also possible to see the users at
Operation>View Users.
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28.2.3.3. Editing the Own User Settings
If the user has administrator permissions, he can modify certain parameters of her configuration at
Operation>View Users>Edit my User.
The user creation form is displayed, where everything can be edited except group permissions.
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In case of lacking administrator permissions, following page will be displayed:

28.2.3.4. User Edition by the Administrator
To edit a user completely, including the permissions
Administration>Manage users and click on the user's name.

and

groups

part,

go

to

28.2.3.5. Removing an User
To completely remove an user, go to Administration>Manage users and click on the red "x" at the
right hand side of the user's name.
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28.3. The "All" Group
Pandora FMS has a system of groups that are entities in which the agents will be classified and that
are used to disperse privileges. In that way, it gives the users some permissions framed into one or
several groups, and they will have then, the possibility of seeing and interact with the agents and
the others objects from its environment.
To make easier the assignation and filtering of the groups, we have a tool named "All" group. The
"All" group means, depending on the context, ALL groups , or ANY of them. Theoretically speaking,
it's the same in version 3.1, but its implementation has changed.
In version 3.0 the "All" group is an special group contained in the database with Identifier 1.
This one was booked, in this way, to this group. So, throughout the console code, the group with id
1, was managed as an exception, with the necessity of the subsequent control when the groups
where listed, and where it was necessary to omit this group sometimes.
In version 3.1 the "All" group has disappear from the Database, so the identifier 1 has been
released for the use of any normal group. Now, the identifier reserved for the "All" group is the 0,
with the difference, that it is completely controlled through code, and there doesn't exist this group
as before. Simply, now it's controlled that the objects associated with the 0 group will be associated
to all groups, without needing to control if a group token out from the database is special or not.
When we take out the agents from a group or vice versa, there isn't any problem, so an agent
belongs only to a group. But, for example, when extracting the groups to which an user belongs to
or the users that belong to one group, you should consider that when we list the users that belongs
to a group, we should show the ones that belong to all of them (group 0) and if we show the groups
of an user, then we should show all of them in case that this user belongs to the "All" group (group
0)

28.4. Enterprise ACL System
The Open Source ACL model is based on “unix style” role/action/group/user (4 items).
The Enterprise ACL system, implemented in version 3.1, will allow to define per profile, which
pages (defined one by one or by “groups”) has user access. This will allow for example, to let a user
view only “Group” view, and “Detailed” agent view, skipping pages as “Alert view” or “Monitor
view”, grouped already in Pandora FMS classic ACL system as “AR” (Agent Read privileges).
This even allow to restrict administration per page. Very useful to let specific lowlevel operations
allowed.
Both models are “paralel” and compatible, and this is an Enteprise feature only. Classic ACL system
will continue to exist, and provides as now, a very easy ACL system for Pandora FMS.
In order to use the new ACL system, first this should be activated in setup. This option is only visible
if you're running the enterprise version
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To use the Enterprise ACL system, go to the specific option for ACL Enterprise at Administration >
Setup. In this screen you can add new items in the new ACL System and see the items defined by
profile. You can also delete items from the Enterprise ACL system.

Enterprise ACL systems, if activated, restrict ALL pages to ALL groups (even the Administrator!) to
pages defined (allowed) in the Enterprise ACL system. If a user with "Administrator" profile, has no
pages included in the Enterprise ACL system, he cannot see anything.

Please be careful with this because you can loose console access if you set incorrect
Enterprise ACL configuration to your running user!

To disable enterprise ACL system from command line, execute:
/usr/share/pandora_server/util/pandora_manage.pl /etc/pandora_server.conf
--disable_eacl

You can define "page by page", "whole sections" or set a "any" rule.
To include a Pandora FMS page into "allowed pages" you must select the profile to which the acl
will be applied to and then choose the section and the page allowed.

Another option is to select a section and set the value "All" for "Page". This will allow the selected
profile to see "everything", just as would be without the Enterprise ACL system for that profile. In
the same way if you select "All" in both controls this profile could se "all" of "all" sections.
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Any page not "allowed" will not be shown in the menu, and will not allowed to be used, even if the
user enter the URL "manually". Any page not allowed by "Classic" Pandora FMS ACL system, will not
be allowed by the enterprise ACL system (this runs over the classic ACL system). This is an example
with several filters:

28.5. Workspace
28.5.1. Chat
This tool allows to interact with other pandora users connected to the console in realtime. This is
helpful to share comments or issues about the service with other operators/administrators.

28.5.2. Users connected
This extension shows other users connected to Pandora FMS console different that our own user.
This functionality have importance because Pandora FMS Console allows conections from different
users.
Go to the extension from Operation>Extansions>Users connected.

28.5.3. Messages
Pandora FMS has a tool that allows that the different users could send messages between them.
Pending messages has a blinking icon in the header.

28.5.3.1. See Messages
When a user has a message, an icon (envelope) appears on the right at the top of the console.
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You can see the messages that have an user at Operation> Messages

Clicking on the envelope you can read the message that is over the messages list.
Clicking on "Reply" you can answer the message.

Once answered, send by clicking on "Send Message".
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Sending Messages

To send a message, go to Operation> Messages> New Message

Once you have written the message, send it clicking on "Send Message".
Deleting Messages

To delete the messages that have an user, go to Operation> Messages, and press on the red "X" that
is on the right of the message.

28.6. Incidents
In the system monitoring process, besides receiving and processing data to monitor systems or
applications, you need also to monitor the possible incidents that could take place in these systems.
For it, Pandora FMS has an incident manager where any user could open incidents explaining what
has happened in the network and updating them with comments and files any time that there
would be any new.
This system allows a work team, with different roles and «workflow» systems that allows that an
incident could go from one group to another, and that members from different groups and different
people could work on the same incident, sharing information and files.
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28.6.1. Seeing all Incidents
To see all the created incidents go to Operación> Manage Incidents

There is a list with all the incidents, classified by update order
In the list of incidents, each of them is with information distributed in the following columns:
ID Incident identifier.
State
State of the incident with the following icons:

Incident name
Name for the incident
Priority
Shows the priority that the incident has assigned through the priority icons.

Group
Defines the group the incident has been assigned to. An incident only could belong to one group.
Updated the Last time that there was an incident update.
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Origin
Tab that is applied to assign an origin to the incident. It could be selected from a list that is kept on
the database. Though the origin list is fixed and predefined, it could be modified by the
administrator in the database.
Owner
User that has assigned the incident at present. Do not confuse it with the incident creator, so the
incident could have changed of owner. The owner can always assign the incident to another user.
Other any user could also do the same thing, as long as it has incident privileges management on
the group the incident belongs to.

28.6.2. Incident Tracking
To see an specific incident, click on the incident Id or on the incident name.

The incident is shown at an screen with three sections:
• Incident Data

In this section is shown the incident basic data
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You can update the fields: Incident, Owner,State, Origin,Group,Priority, and the description.
Once they have been updated, click on "Update Manager".
• Notes that the users write

In this section are the notes from the different users that have participated on the incident.
To add notes to the incident, click on «Insert Note». It will show a page that has a text area. Write
the note and click on «Add».

Any user with permission for reading an incident could add a note. Only the incident or the note
owners could delete them.
• Attached Files

In this field are the attached files that the different users who have take part add.
To add a file click on " Add file".
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Two entry fields will be shown. Look for the file in the local system and, if you want, write a
description. When you have finished click «Upload» to start the file upload to the server.
To see the file click on the file name.
Any user that has permission for reading an incident could add a file. Only the incident or file
owners could delete them.

28.6.3. Searching Incidents
There are some fields for searching incidents that could be combined.

It is possible to filter by the following fields:
• Filter by incident state.Where you can filter by incident state between the following values:
• All incidents
• Active incidents
• Closed incidents
• Rejected incidents
• Expired incidents
• Filter by priority. Where you can filter by incident priority between the following values:
• By all Priority
• By informative priority
• By low priority
• By medium priority
• By serious priority
• By very serious priority
• By maintenance
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• Filter by user: it is possible to filter by user owner of the incident.
• Free text: where it is possible to filter by searching a text.
• Filter by groups. Where it is possible to filter by incidents associated to each of the groups
that are in Pandora FMS.

28.6.4. Opening a New Incident
To open a new incident, go to Operación> Manage Incidents and click on "Create Incident".

It shows the page to create it.
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28.6.5. Changing the Owner of an Incident
To change the owner of an incident, go to Operación> Manage Incidents, select the chosen incident
in the last column and click on "Become Owner".

This way, the user that does the operation will be the incident owner.

28.6.6. Deleting an Incident
To delete an incident, go to Operación> Manage Incidents. Select the chosen incident in the last
column and click on “Delete Incident”.

28.6.7. Incident Statistic
At Operation>Manage Incident>Statistic you can have access to five kinds of the incidents graphic
statistics:
•
•
•
•
•

Incidents state
Priorities assigned to the incidents.
Users that have an incident opened.
Incidents by groups.
Incidents Origin.

28.6.8. Self generated Incidents (servidor recon)
With the recon server integration we have also added the incidents selfgenerated from the events
processed by the recon server, such as the detection of new systems in the network we are working
with. This incidents are exactly the same to the rest of them and they also are listed in the
«Managing Incidents» section from the «Operation» menu.

28.7. Manage incidents (Pandora FMS and Integria integration)
Integration between Pandora FMS and Integria allows to share all information that have these
applications and work on it in a syncronized way.
First, it is necesary to enable integration between Pandora FMS and Integria. To see configuration
about this parameters see Setup (Integria URL, API password and Integria inventory).
In Operation > Manage Incidents section will appear Integria incidents:
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Incidents search is similar to Pandora FMS incidents (previouly described).
You can see on Integria all incidents created in Pandora FMS:

You can see details like group, severity, source, resolution, state (new, unconfirmed, assigned, etc.),
description, etc.
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You can add workunits that keep communication between incident source and the resolutor. Also
you can see time used by entry, if it is public or has cost.

You can upload files associated to incidents:

Last, you can keep track of all interactions between users by each incident:
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28.8. Servers
The servers detailed view is used to know, besides the Pandora FMS servers general state, its load
level and its delay. We are going to show one snapshot with the servers state. To get it go to the
Operation menu > Pandora Servers.

In this view we could see several important data. In each column is showed the following
information:
Server name, usually uses the system hostname.
State (green = right, red = not fired, stopped or down.)
Kind of server: data server, network server, etc.
progressing bar: that shows the load percentage of the total of modules to this kind of
server. In this case all servers are to 100% except recon, that has no associated tasks, so it is
at 0%
• Nº of modules of this kind executed by the server regarding to the total nº of modules of this
kind.
• Server Lag: Higher time that the oldest module has been waiting for data/Nº of modules
that are out of its life time.In this example there are near 3000 modules out of its life time,
whit a lag time (lag) of 10 minutes, 13 seconds. This indicator is useful to know if we have
al lot of modules and to know if the server is at the limit of its load capacity, such it is at this
case, that thought it is not an excessive delay (10 minutes, 13 seconds) for modules that
have an average life time lower, being only 19 modules with lag (of 10 minutes) from a total
of almost 1500 modules.
• Total nº of threads configured at the server: total nº of modules in queue waiting for be
attended. These parameters show
•
•
•
•

states of excessive load.There should not be hardly ever modules in queue. This shows the
incapacity of the server to process data.
• Nº of seconds since the server updated its data. Each server has a "Keepalive" that updates its
state in order to make sure that it is active, updating its statistics too.
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28.9. Backup
Extension that allows to do a DDBB Backup and restore it. Go to the extension from
Administration>Extensions> Backup To do the Backup write the backup description and click on
"Create":

When the Backup is done it will appear in the Backup list with the running icon.

Once the Backup has been created it is possible:
• Download it clicking on the image icon.

Doing a rollback clicking on the image icon.

The rollback applies a backup that have been created before and restore it. This will destroy all
existing data in the console and will apply data that already exist in the backup where the rollback
is done.
• Delete it clicking on the image icon.
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28.10. Cron Job
(Only for Enterprise version)
Extension that allows to schedule the fulfilment of tasks from Pandora FMS server.
Go to the extension from Operation>Extensions>Cron jobs

To add a task, you should fill in the following fields:
• Task: Combo to choose the task that is going to be done.
• Send custom report by email
• Execute custom script
• Backup Pandora database
• Save custom report to disk
• Scheduled: Field to choose how often the task will be executed.
• Not Scheduled: These tasks will be executed only once, at the specified time
• Hourly
• Daily
• Weekly
• Monthly
• Yearly
• First Execution: Field to choose the date and hour of the task first execution.
• Parameter: Field that allows to introduce parameters in the task to fulfill. It is changeable
depending on the task to fulfill.
• Backup Pandora database: Description.
• Send custom report by email: report to send and destination email.
• Execute custom script: script to execute.
• Save custom report to disk report to save and destination folder.
Once you have filled all data, click on create and the task will be shown in the Scheduled task list.
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Once you have created the scheduled task, it is possible to force its execution by clicking on the
green circle that there is on the right of the task or deleting it clicking on the red cross that is on the
left.

28.11. Planned Downtime
Pandora FMS has an small scheduled downtime management system. This system allows to
deactivate the alerts in the intervals where there is down time by deactivating the agent. When an
agent is deactivated, it doesn't collect information either, so in a down time, for most of the metrics
or kinds of reports, the intervals where there is a down time are not taken into account in the
reports because there aren't data in those intervals in the agents.
In order to create a downtime, we should go to the Agent's management > Downtimes and click on
the button to create one:
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When we create a downtime, we should specify the group and the date hour intervals where it start
working

Finally, we specify the specific agents that we want to include in this downtime.
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When an scheduled downtime is "working", it couldn't be neither modified nor deleted.

When this downtime ends, we can modify or delete it again.

28.11.1. Alternatives to the Service Downtime Management in the Console
There are often some "cyclical" situations that we should take into account and the service
downtime management method is too specific. For example, we want to deactivate all agents in a
quick and precise way or to schedule a general downtime each week in a precise range of hours. For
this kind of operations, there are ways to do it from the command line.
There are two ways more "fast" of putting all agents in service mode
1. Through the Pandora management tool pandora_manage.plthrough the command line:
./pandora_manage.pl /etc/pandora/pandora_server.conf --enable_group 1
Pandora FMS Manage tool 3.1 PS100519 Copyright (c) 2010 Artica ST
This program is Free Software, licensed under the terms of GPL License v2
You can download latest versions and documentation at http://www.pandorafms.org
[*] Pandora FMS Enterprise module loaded.
[INFO] Enabling group 1
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This activate all agents. To deactivate them it would be the same, but:
./pandora_manage.pl /etc/pandora/pandora_server.conf --disable_group 1

2. This can also be done through the MYSQL interface by modifying the data directly:
echo "UPDATE tagente SET disabled = 1" | mysql -u pandora -ppassword pandora

Obviously, where "password" is written, you should write the access password to the DDBB. Using
the SQL method, you could do a more granular operation, for example to specify by name of agent:
echo "UPDATE tagente SET disabled = 1 WHERE nombre LIKE '%_XXXX%'" | mysql -u
pandora -ppassword pandora

28.12. Audit Log
Pandora FMS keeps a log of all important changes and actions that take place in Pandora FMS
console. This log could be seen at Administration > System Audit Log.

28.12.1. See the System Logs
At Administration>System Audit Log you could go to the system logs.
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In the logs list, each of them has the information distributed in the following columns:
•
•
•
•
•

User: User that caused the log.
Action: Action that causes the log.
Date: Date when the log takes place.
Source IP:Origin IP of the machine that causes the log.
Comments: Log comments.

28.12.2. Filtering the System Logs
From the log view at Administration>System Audit Log it is possible to filter the logs by the field
"action".
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The filter fields show all the fields that there are at the moment of executing the filter. If the
TESTING agent has been deleted, it will be an action “Agent TESTING Deleted” to filter.
In the image you can see an example of actions you can filter with.

28.13. Managing the Database from the Console.
Pandora FMS core is its Database. It it are kept all data collected from the monitored systems, the
agents configuration, the alarms, the events, the audit data, the different users and his data. This is,
all system data.
The efficiency and reliability of this module is vital to Pandora FMS right working. The maintenance
of Pandora FMS Database in good state is critical for it could work well.
To do a regular maintenance of the Database, the administrators could use MySQL standard
commands from the command line or could manage the Database from the console without being
an expert on Mysql.
The Database management is done from Administration>DB Maintenance, where there are the
following options:
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28.13.1. Getting Information from the Database
To manage correctly the database is essential to know well the data that it has and the time these
data has been in the database. From Pandora FMS database it is possible to obtain information from
the database of different kinds:

28.13.1.1. Obtaining General Information
By clicking on Administration>DB Maintenance you could get a page with general data of the
database. This page shows the time that the system takes to compact and the time that the system
are kept in the system.
Packing consist on reducing the amount of kept data, without losing important information. As time
goes by, not all data will be obtained, but statistic interpolations that allow to do graphs with the
processed data.

By putting the mouse over the graph you could obtain data from any piece of the cake.

28.13.1.2. Getting Information about Agents and Modules
To obtain information about the number of modules and the data from each agent of Pandora FMS,
click on Administration>DB Maintenance> DB Information.
It will show two bar charts, one that shows the modules by agent, and another that shows the
packets by agent.
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In the graphs is showed general information. If you want to get more specific information in text
mode, click on “Press here to get database information as text”.

You will get the information by text with the agent name, the number of assigned modules and the
data amount of this agent. The list is classified by agent data and it has all agents configured in
Pandora FMS.
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28.13.1.3. Getting Information about Data by Date
From Administration>DB Maintenance> Database Purge you could obtain the number of packets of
less of three months, one month, two weeks,one week, three days or one day.

You could obtain data from all agents or of one specific agent.
To obtain data from an specific agent, choose the agent you want in the combo and, automatically,
you will obtain the agent data.
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28.13.1.4. Getting Data from the Audit Log
From Administration>DB Maintenance> Database Audit you could get the total number of audit
logs, and also the data of the first and last log.

28.13.1.5. Getting Data about Events
From Administration>DB Maintenance> Database Event you could obtain the total number of
events, and also the first log data and the last log data.

28.13.2. Purging the Database
Pandora FMS gives tools for the data purge. It will be done, in a general way, by dates of the data,
when is detected that a system is too slow or, in an specific way, when a wrong data is detected and
you want to delete it from a module.

28.13.2.1. Agent Data Purge by Date
To purge agent data by date in the Database, click on Administration>DB Maintenance> Database
Purge Select in the combo the data that is gone to be deleted and click on the "delete" button.
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Is possible to purge data of more than three months, one month, two weeks, one week, three days
or one day. The time the system spend purging the selected data will depend on the amount of
them.

28.13.2.2. Purging Specific Data from a Module
When you detect that there are modules with wrong data, it is possible to standardize them from
Administration>DB Maintenance> DataBase Debug.
Select the Agent and the Module. Fix the maximum and minimum limits and click on "Delete".

All data that is out o the interval [minimum,maximum] will be deleted.

28.13.2.3. Purging Audit Data
To purge audit data in the Database, click on Administration>DB Maintenance> DataBase Audit.
Select the data that you want delete in the combo and click on "Do it"

It is possible to purge data of more than ninety days, thirty days, fourteen days, seven days, three
days or all data.The time that the system spend purging the selected data will depend on the
amount of them.
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28.13.2.4. Purging Event Data
To purge event data in the Database, click on Administration>DB Maintenance> DataBase Event.
Select in the combo the data that you are going to delete and click on “Do it”.

It is possible to purge data of more than ninety days, thirty days, fourteen days, seven days, three
days or all data.The time that the system spend purging the selected data will depend on the
amount of them.

28.13.3. DDBB Maintenance
Pandora FMS infrastructure does not need external maintenance, but it is very important to purge
the old data and to keep compacted the database and also to delete modules that have never been
started, this is, that are in the agents but have never received data. To do this, you should execute a
Pandora FMS internal script that does the regular maintenance (daily) of the DDBB. For more
information, see the chapter Management and Administration of the server.
Nevertheless, you can do some of the task that this script does from the console, as we are going to
see in this subsection.

To execute these tasks, click on Administration>DB Maintenance> DataBase Sanity.
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28.13.3.1. Sanitizing
This tool allows to "sanitize" the modules and delete those unfinished structures and/or bad
performed( by a pending deleting, e.g)that, in some cases, could do that Pandora FMS works more
slow that usual.

28.13.3.2. Purging Non Initialized Modules
Many times modules are created and assigned to agents that are not initialized, due to they never
receive data. It would be advisable to get the non initialized modules out from time to time.
To execute this task from the console, click on “Delete noninitialized modules now” at
Administration>DB Maintenance> DataBase Sanity.

Do not forget that these two operations are done in an automatic way with the database
maintenance tool described in Server Management and Administration chapter.
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28.13.4. DB Interface
Extension that allows to execute commands in the DDBB and to see the result. It is an advanced tool
that should only be used by people who know SQL and the Pandora DDBB structure in detail.

If this tool is used in a wrong way, it could destroy data or could make the application
useless in a permanent way.

Go to the extension from Administration>Extensions> DB interface.

Writte this command in the blank field and click on Administration>Extensions> DB interface.

28.14. Plugin Register
Section that allows to log server plugins in an easy way. Go to the extension from Administration >
Server > Plugin register.

To log one plugin, choose the file clicking on Examine and click on "Upload".
You can find more information about the server plugins in the Developing and Extension chapter.
You can see in Server plugin development section which is the .pspz format.
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28.15. Insert data
This extension allow to import data in an commasepareted file (CSV) to a agent module. You can
access to this extension from Administration > Manage Agents > Insert Data.

CSV file format must be date;value by each line. Date format will be Y/m/d H:i:s format. For
example:
77.0;2011/08/06 12:20:00
66.8;2011/08/06 12:20:50

28.16. CSV Import
(Enterprise feature)
Extension that allows to import a file separated by any divider at the Pandora FMS server.
Go to the extension from Administration > Server > CSV import.

Choose the field to import clicking on "Examine". Choose the server where the export will be done
and select the divider from a combo. Once the fields before mentioned are completed, click on "Go".
The CSV file should contain the following fields in this order:Agent name, Ip Adress, Operative
System id, Interval and Group id the agent should belong to.
602

Resource registration

28.17. Resource registration
With this extension you can inport .prt files which contains the definition of network components,
smnp components, local components or wmi components. Also you can add these components (not
local components) to a template.

28.17.1. File definition for .prt
<?xml version="1.0"?>
<pandora_export version="1.0" date="yyyy-mm-dd" time="hh:mm">
<component>
<name></name>
<description></description>
<module_source></module_source>
<id_os></id_os>
<os_version></os_version>
<data></data>
<type></type>
<max></max>
<min></min>
<max_cri></max_cri>
<min_cri></min_cri>
<max_war></max_war>
<min_war></min_war>
<historical_data></historical_data>
<ff_treshold></ff_treshold>
<module_interval></module_interval>
<id_module_group></id_module_group>
<group></group>
<tcp_port></tcp_port>
<tcp_send></tcp_send>
<tcp_rcv_text></tcp_rcv_text>
<snmp_community></snmp_community>
<snmp_oid></snmp_oid>
<snmp_version></snmp_version>
<auth_user></auth_user>
<auth_password></auth_password>
<privacy_method></privacy_method>
<privacy_pass></privacy_pass>
<auth_method></auth_method>
<security_level></security_level>
<plugin></plugin>
<plugin_username></plugin_username>
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<plugin_password></plugin_password>
<plugin_parameters></plugin_parameters>
<wmi_query></wmi_query>
<key_string></key_string>
<field_number></field_number>
<namespace></namespace>
<wmi_user></wmi_user>
<wmi_password></wmi_password>
<max_timeout></max_timeout>
<post_process></post_process>
</component>
<component>...</component>
<component>...</component>
<template>
<name></name>
<description></description>
</template>
</pandora_export>

28.18. Translate string
This extension it's in godmode menu and allows to translate strings on Pandora FMS interface in
order to personalize it.

Here are the fields to fill in:
• Language: Allows to filter string by language.
• Free text for search (*): String content to personalize.
Three columns will be displayed: the first one will show the original string, the second one will
show the current translate string and the third one will contain the custom translate that you want
to add.
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29 SETTING UP THROUGH CONSOLE
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29.1. Introduction
Console configuration allows you to change and tune configuration parameters of Pandora FMS
console. However some general parameters are common for the whole applications including
Pandora FMS servers and could affect the application performance.
Inside Administration > Setup you can configure several options of Pandora FMS, they will be
explained below.
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29.2. Setup
From Administration > Setup you can go to the configuration page of the console general
parameters page.

The next screen will be shown:
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Next are described the fields that you can configure:
Language code for Pandora
Combo where you can select the console language
Remote config directory
Field to identify the directory where the remote configuration of agents is kept. By default is
/var/spool/pandora/data_in. This only make sense in the Pandora FMS version.
Auto login (hash) password
Defines an static and symmetrical password, used to create a hash and to make possible the
automatic validation through URL. It is used to incorporate Pandora in other WEB application that
gives it as parameter a user name and that using a hash generated by the user name. This password
should allow the automatic validation in Pandora FMS, without needing to introduce a password.
To see an example of this integration see the file /extras/sample_login.php from Pandora FMS
console.
Time source
Combo where you can select the origin of the date and hour between database and system. The first
one is used when the DDBB is in a system that is different from the console.
Automatic check for updates
Field where is configured the automatic update check in the Open Update Manager. This does that
the console contact each time that you start session with the Pandora FMS update provider (Artica
ST), sending anonimous information about the Pandora FMS (nº of agents) usage.
Enforce https
Field that allows to force the readdress to https. If you enable it, you must activate the use of
Pandora FMS with https in your WEB server. If you have enabled it and you have not configured your
Apache to uses HTTPS you cannot access WEB console again, and you will to disable off this option
again going straight to the database through MySQL and using following SQL syntax:
update tconfig

set `value` = 0 WHERE `token` = 'https';

Attachment store
The attachment directory is used as "temporary" for Pandora FMS. In it are also kept the incident
attached data. By default is /var/www/pandora_console/attachment. You should have
permissions to write for the WEB server. The maps images and other temporary files are generated
there too.
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List of IP with access to the API
This is a list of IP address (not FQN), one per line, which will have access to Pandora FMS
Webservices API and other minor functions, like the RSS Event feed or the Marquee view. You can
use "*" as wildcard, using just "*" to define "any" ip address and define 125.56.24.* to give access to
all the subnet 125.56.24
API password
Authentification method for Pandora API access. See section Pandora FMS external API
Enable GIS features in Pandora Console
Enable/disable GIS features in Pandora FMS Console. See section Consola GIS
Enable Integria incidents in Pandora Console
Change incident sytem in order to synchronize it with Integria. After enable it, in this view will be
shown three new fields for Integria credentials.

• Integria URL: URL of the Integria installation. Example: http://exampledomain.com/integria
• Integria API password: API access password setted on the Integria setup.
• Integria Inventory: Inventory object of Integria that will be associated with the incidents
created from Pandora FMS. Empty until connection.
Once configured and updated, the warning icon near URL text box will disappear and Integria
inventory combo box will has the Integria inventory objects to choose one of them.

Enable Netflow
Enable/disable netflow.
Timezone setup
Defines timezone when Pandora Console is located. Combo where it's possible to choose zone and
timezone.
Sound for Alert fired
Combo where it's possible to choose alert fired sounds.
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Sound for Monitor critical
Combo where it's possible to choose sounds when module is in "critical" state.
Sound for Monitor warning
Combo where it's possible to choose sounds when module is in "warning" state.
Licence information
Enterprise key licence or open version.

29.2.1. Enterprise options
Next are described the fields that you can configure if your version is Enterprise:

Forward SNMP traps to agent (if exist)
Option that allows that any time that a trap comes, it will be transformed into a Pandora module
associated to the agent that has the same IP that the Trap origin IP. (Only enterprise version).
Use Enterprise ACL System
This will activate Enterprise ACL System that is a more flexible system that standard ACL system.
See Enterprise ACL system section.
Activate Metaconsole
Enable/disable metaconsole functionality on Pandora Console. See Metaconsole section.
Collection size
This configure maximun size of collections. See Collections section.
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29.3. Authentication
From Administration > Setup > Authentication you can access to authentication configuration
page.

You will see a page in which you can select the authentication method.
There are several options:
•
•
•
•
•
•

Active directory
LDAP
Local Pandora FMS
Remote Babel Enterprise
Remote Integria
Remote Pandora FMS

Due to security issues the users with admin users always use Pandora FMS local
authentication
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29.3.1. Active directory
The following screen will appear when you click on this option.

The configuration parameters are the following:
Autocreate remote users
Enabled/Disabled remote user creation automatically. This option allows Pandora FMS to create the
users automatically once the logged in using Active Directory. If its enabled the three following
fields will be available, if not the fields will be blocked.
Autocreate profile
If automatic remote user creation is enabled, this field makes possible to assign a profile to these
users which are create automatically. By default the available profiles are:
•
•
•
•
•

Chief Operator
Group Coordinator
Operator (Read)
Operator (Write)
Pandora Administrator

You can see all available profiles in section Administration > Manage Users > Manage Profiles.
Autocreate profile group
If automatic remote user creation is enabled, this field allows you to assing groups to users created
automatically. The default groups are:
•
•
•
•
•

Servers
Firewalls
Databases
Network
Unknown
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• Workstations
• Applications
• Web
You can create new groups or list all groups available in section Administration > Manage Agents >
Manage Groups.
Autocreate blacklist
An user list, comma separated, which are not allowed to be created automatically.
Active directory server
Active Directory server address.
Active directory port
Activde Directory server port.
Start TLS
Switch ON/OFF Transport Layer Security (TLS) protocol for communications between client and
server.
Domain
Active directory Domain to be used.

29.3.2. LDAP
When you select this option you will see the following screen.

The fields shown in this screen are described below:
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Autocreate remote users
Enabled/Disabled remote user creation automatically. This option allows Pandora FMS to create the
users automatically once the logged in using LDAP. If its enabled the three following fields will be
available, if not the fields will be blocked.
Autocreate profile
If automatic remote user creation is enabled, this field makes possible to assign a profile to these
users which are create automatically. By default the available profiles are:
•
•
•
•
•

Chief Operator
Group Coordinator
Operator (Read)
Operator (Write)
Pandora Administrator

You can see all available profiles in section Administration > Manage Users > Manage Profiles.
Autocreate profile group
If automatic remote user creation is enabled, this field allows you to assing groups to users created
automatically. The default groups are:
•
•
•
•
•
•
•
•

Servers
Firewalls
Databases
Network
Unknown
Workstations
Applications
Web

You can create new groups or list all groups available in section Administration > Manage Agents >
Manage Groups.
Autocreate blacklist
An user list, comma separated, which are not allowed to be created automatically.
LDAP server
LDAP server address.
LDAP port
LDAP server port.
LDAP version
LDAP server version.
Start TLS
Switch ON/OFF Transport Layer Security (TLS) protocol for communications between client and
server.
Base DN
Distinguised
Name
(DN)
used
ou=People,dc=edu,dc=example,dc=org

by

LDAP

server.

For

example:
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Login attribute
Login attribute used by LDAP server during authentication process. For example UID (User
Identification Code).

29.3.3. Local Pandora FMS
When you select this option no more fields will appear to be configurated.
This options performs authentication using internal database of Pandora FMS.

29.3.4. Remote Babel Enterprise
When you select this option the following screen will appear:

The parameters of this screen are explained below:
Autocreate remote users
Enabled/Disabled remote user creation automatically. This option allows Pandora FMS to create the
users automatically once logged in using Babel Enterprise database. If its enabled the three
following fields will be available, if not the fields will be blocked.
Autocreate profile
If automatic remote user creation is enabled, this field makes possible to assign a profile to these
users which are create automatically. By default the available profiles are:
•
•
•
•
•

Chief Operator
Group Coordinator
Operator (Read)
Operator (Write)
Pandora Administrator

You can see all available profiles in section Administration > Manage Users > Manage Profiles.
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Autocreate profile group
If automatic remote user creation is enabled, this field allows you to assing groups to users created
automatically. The default groups are:
•
•
•
•
•
•
•
•

Servers
Firewalls
Databases
Network
Unknown
Workstations
Applications
Web

You can create new groups or list all groups available in section Administration > Manage Agents >
Manage Groups.
Autocreate blacklist
An user list, comma separated, which are not allowed to be created automatically.
Babel Enterprise host
Babel Enterprise server address.
MySQL port
MySQL port of Babel Enteprise database.
Database name
Babel Enteprise database name.
User
User to access Babel Enterprise database.
Password
Password to access Babel Enterprise database.
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29.3.5. Remote Integria
When you select this option the following screen will appear:

The parameters of this screen are explained below:
Autocreate remote users
Enabled/Disabled remote user creation automatically. This option allows Pandora FMS to create the
users automatically once logged in using Integria IMS database. If its enabled the three following
fields will be available, if not the fields will be blocked.
Autocreate profile
If automatic remote user creation is enabled, this field makes possible to assign a profile to these
users which are create automatically. By default the available profiles are:
•
•
•
•
•

Chief Operator
Group Coordinator
Operator (Read)
Operator (Write)
Pandora Administrator

You can see all available profiles in section Administration > Manage Users > Manage Profiles.
Autocreate profile group
If automatic remote user creation is enabled, this field allows you to assing groups to users created
automatically. The default groups are:
•
•
•
•
•

Servers
Firewalls
Databases
Network
Unknown
617

Authentication

• Workstations
• Applications
• Web
You can create new groups or list all groups available in section Administration > Manage Agents >
Manage Groups.
Autocreate blacklist
An user list, comma separated, which are not allowed to be created automatically.
Integria host
Integria server address.
MySQL port
MySQL port of Integria database.
Database name
Integria database name.
User
User to access Integria database.
Password
Password to access Integria database.

29.3.6. Remote Pandora FMS
When you select this option the following screen will appear:

The parameters of this screen are explained below:
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Autocreate remote users
Enabled/Disabled remote user creation automatically. This option allows Pandora FMS to create the
users automatically once logged in using Pandora FMS database. If its enabled the three following
fields will be available, if not the fields will be blocked.
Autocreate profile
If automatic remote user creation is enabled, this field makes possible to assign a profile to these
users which are create automatically. By default the available profiles are:
•
•
•
•
•

Chief Operator
Group Coordinator
Operator (Read)
Operator (Write)
Pandora Administrator

You can see all available profiles in section Administration > Manage Users > Manage Profiles.
Autocreate profile group
If automatic remote user creation is enabled, this field allows you to assing groups to users created
automatically. The default groups are:
•
•
•
•
•
•
•
•

Servers
Firewalls
Databases
Network
Unknown
Workstations
Applications
Web

You can create new groups or list all groups available in section Administration > Manage Agents >
Manage Groups.
Autocreate blacklist
An user list, comma separated, which are not allowed to be created automatically.
Pandora FMS host
Pandora FMS server address
MySQL port
MySQL port of Pandora FMS database.
Database name
Pandora FMS database name.
User
User to access Pandora FMS database.
Password
Password to access Pandora FMS database.
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29.4. Performance
From Administration > Setup > Performance you access to performance configuration page. This
section allow you to configure general parameters related to Pandora FMS console performance.
For example the historical data range or if you want to show the access chart of agents.

You will see the following screen.
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The fields of this section are described below:
Max. days before delete events
Maximum number of days before delete events.
Max. days before delete traps
Maximum number of days before delete traps.
Max. days before delete audit events
Maximum number of days before delete audited evetns.
Max. days before delete string data
Maximum number of days before delete string data.
Max. days before delete GIS data
Maximum number of days before delete GIS data.
Max. days before purge
Maximum number of days before purge database.
Max. days before compact data
Maximum number of days before compact data.
Compact interpolation in hours (1 Fine20 bad)
Interpolation range. 1 is the best and 20 the worst. It is recommended to use 1 or values near to 1.
SLA period (seconds)
Default time, in seconds, to calculate SLA in agents SLA tab. Calculates the SLA automatically in
modules defined in an agent based on Critical or Normal values.
Default hours for event view
Default number of hours for event filter. If the value is 24 hours, the event views will only show the
events which happened in the last 24 hours.
Use realtime statistics
Enabled/Disabled real time statistics.
Batch statistics period (secs)
If realtime statistics are disaabled, here you define the refresh time for batch statistics.
Use agent access graph
Agent access graph, renders the number of agent contacts per hour in a graph with a daily scale
(24h). This is use to know the frecuency of contact for each agent. It could take a long time to
processs the date, so if you have low resources its recommended to disable it.
Max. days before delete unknown modules
Maximum number of days before delete unknown modules.
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29.5. Visual Styles
From Administration > Setup > Visual styles you access to visual styles configuration parameters
for Pandora console.

You will see the following screen:

The configuration parameters are described below:
Date format string
Date format. You can see all options in console help.
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Timestamp or time comparation
Defines which date/hour is used. («Timestamp in rollover») system timestamp or («Comparation in
rollover») database timestamp. Its very useful when database belongs to another system different
from console.
Graph color (min)
Color for minimum value in module graphs.
Graph color (avg)
Color for average value in module graphs.
Graph color (max)
Color for maximum value in module graphs.
Graphic resolution (1low, 5high)
Defines the graphic resolution.
Style template
Defines the web style of Pandora FMS console. You can add new skins or templates by including
CSS files in folder include/styles.
Block size for pagination
Pagination block size.
Use round corners
Switch ON/OFF round corners of progress bar and other Pandora FMS graphics.
Status icon set
This combo allow you to select the icons used to visualize module status. By default the colors: red,
yellow, and green are used. If users with color blindness you can replace the colors by other
conceptual icons which allow you to diferentiate module status.
Font path
Font selector combo. This TrueType font is used in Pandora FMS graphics.
Font size
Font size of Pandora FMS graphics font.
Flash charts
Allows you to select the graphic render engine: Flash or PNG.
Custom logo (Only OpenSource version)
This options allows you to show your logo in Pandora FMS console header. You can use any PNG
picture. There is a default size for picture 60x139 pixels.
You can upload your logo using file manager to path /images/custom_logo directory.
Global default interval for refresh
This parameter sets the globla refresh interval, it will affect to all pages except Visual Console.
Default interval for refresh on Visual Console
This parameter sets the refresh interval for Visual Console pages.
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29.6. File Manager
File Manager is a very useful tool to upload files to Pandora FMS. From Administration > Setup >
File Manager you access to file manager page of Pandora FMS.

You will see the following screen.
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In this section its shown the content of "images" folder inside your Pandora FMS installation.
You could browse through directories, create folders, create files and even upload files from your
local hard disk and also download files.
Yo do that you must use the following buttons.

This buttons are: create folder, create text file and upload file.

29.6.1. Create folder

After click on create folder button the field above above will appear.
Just enter the name of the folder and press "Create" button. If you click on "Close" button this dialog
will close.

29.6.2. Create text file

After click on create file button the field above above will appear.
Just enter the name of the file and press "Create" button. If you click on "Close" button this dialog
will close.

29.6.3. Upload files

After click on update file button the field above above will appear.
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Just press on "Browse" button and browse your local disk, select the file you want to upload.
It is possible to upload several files at once. By selecting a zipped file and if you select the
"Decompress" option. The file will be unzipped and all your files zipped inside will appear in the
folder.

29.7. GIS map connection
In Pandora FMS is possible to follow the agent location using interactive maps. Inside this section
you can configure all parameters related to connection to GIS map provider. For example
OpenLayers of Google maps.
You can find all documentation about GIS in this section GIS Console.

29.8. Links
From Administration > Setup > Links you access to link manage page of Pandora FMS console.

You will see the following screen:
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The process to create or update a link is very similar.
To create a new link click on "Add".
To update a link click on link name.
Both situations show the same screen. In the first case the screen is empty and in the second
situation the screen shows the data of the link to be modified.

Link name: Link name.
Link: link address.
After all fields have been filled you must click on "Create" or "Update" buttons to create or modify
the link.
To delete a link just click on the red cross in the same row of link you want to delete.

29.9. Site news
From Administration> Setup>Site news it is possible to add news which appear in console home
page.

To create a news click on "Add" and the following page will appear:

Write the title and text for this news and click on Update. It's possible to delete a news by clicking in
the red cross on its right or editing a news by clicking on its name.
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29.10. Edit OS
In this section you can edit or create new Operating System.

To create/edit an Operating System you will use the following view.

The fields to fill are the following:
• Name: OS name.
• Description: OS description.
• Icon: OS icon.
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29.11. History database
This section allow you to enable Pandora FMS history database options. This feature allows you to
save old data in an auxiliar database. This system accelerates queries and access to data.

Here are explained the fields:
• Enable history database: Enabled history database feature.
• Host: Hostname of history database.
• Port: Port of history database.
• Database name: Database name for history database.
• Database user: User to access to history database.
• Database password: Password to access to history database.
• Days: Number of days since data will be transfered to history database.
• Step: Size of buffer for data transferring. The lower step the slower data transferring, but
lower performance reduction on main database.
• Delay: delay time between data transferences between main and history database.

29.12. Enterprise ACL Setup
This feature is explained in section Enterprise ACL System.

29.13. Metaconsole
This feature is explained in section Metaconsola.
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29.14. Skins
This feature allows you to customize the look of Pandora FMS console interface. This is made
through changes in CSS style files and the icons associated.
To create a new skin you must replicate the folder structure of console:
• images: this folder will have skin icons and images.
• include/styles: this folder will have the CSS files of the skin.
An skin called Example will have the following structure:
Example/
|
|_______images/
|
|_______include/
|
|_________styles/

This structure will be inside the path <pandora_root>/images/skin. All file structure and the content
must be compressed in a zip file.
A skin could be applied to two levels:
• Usuario: Only for the user..
• Grupo: Applied to all user that belong to this group.
If an user has a skin for itself and the group it belongs another one, the user skin has higher
priority.
This is the view to access to available skins:

To create/configure a skin you will use this view:
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Here are explained the configuration fields:
• Name: Skin name.
• Relative Path: During creation, this field will ask you to upload the zip file. During
modification, this field will contain the name of zip file uploaded.
• Description: Skin description.
• Group/s: Groups assigned to this skin.
• Disabled: Disable skin that won't apply to any user.

29.15. Pandora FMS Diagnostic Tool
Tool to detect an instalation profile of Pandora FMS. It will show information such as: Pandora
version, PHP version, database volumetry information, etc
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29.16. Update Manager Settings
This feature is explained in section Update manager.

29.17. System info
This tool is an extension which allow you to see logfiles using Pandora FMS console. You can see
information about Pandora Diagnostic Tool, information about the system and logs. It is possible to
execute using command line but you must be root. For example:
sudo php /var/www/pandora_console/extensions/system_info.php -d -s -c

29.18. Translate string
This extension is explained in section Translate string.
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30 UPDATING LANGUAGES
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To update any language of Pandora FMS console you only need to go to Launchpad translation
download page ([1]), select the languages you want to update and the MO file format, then click
on Request download button and wait for an email with indications and place to download the files.
Once you have downloaded the files you must copy them into folder:
/include/languages/

of Pandora FMS console, and your languages are updated.

To download the translations you need to create an account in Launchpad
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31 REMOTE SYSTEMS MANAGEMENT WITH
PANDORA FMS
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31.1. Introduction
Pandora FMS is a monitoring tool, and it doesn't use the agents so we could connect with the
systems.This way it isn't useful to control remotely the monitored systems. Some systems, such as
routers and switches could be managed through Telnet or SSH and in order to have access to them
you will only need to fire the right command.
Pandora FMS includes "by default" a Java plugin to be able to connect from the WEB console, via
VNC to the remote servers, using the IP configured by them. This could be easy if we are in the
same local network segment and if we have direct connection. In other cases, it is more
complicated.
We can distinguish between complex and simple environments. These would be the characteristics
of a simple environment:
• The server IP doesn't change.
• The access (paths, firewalls) from the operator PC to the servers has open ports and it knows
how to get through normal TCP/IP.
• We could install a remote control software in the server host system, or this has already one.
Unlike this, the characteristics of a complex environment would be the following ones:
• The server IP changes (it's dynamic).
• There is no direct access from the operator PC to the server that we want to monitor.
• We couldn't install remote control software in the remote system.
There are also intermediate cases, for example, the machines have fixed IP, but we don't have direct
remote access via TCP/IP to the server from the operator PC. In any case, there are three possible
ways to have remote access to these systems:
1. Directly, it's possible to install, for example a SSH server, activate the Remote Desktop or to
install a VNC server in the host system. From the operator PC, it'll be enough if we write the
remote system IP in the client program that is running in the operator PC and it'll be ready.
This is right only for the "Simple" environments. Here we strongly recommend UltraVNC.
2. To use an inverse system. We are referring to those remote control systems that, instead of
waiting to connect, with an open TCP port, connect with a server in the internet which
allows, when the operator PC communicates with this same server in Internet, to "connect"
both computers so they can "talk". This way, between them, the internal network wouldn't
communicate at all. This system, useful in complex environments, has many disadvantages,
such as the speed, or the fact that if the server that we need to control doesn't have access to
Internet, we won't be able to communicate with it. Here we recommend TeamViewer.
3. Use a direct connection system with UltraVNC allows to configure one proxy, so it'll be the
one that connects with the remote server. We will connect with the intermediate server
(proxy) and this one with the end server. This is called "Ultra VNC Repeater". You can find
more information about this in this page http://www.uvnc.com/docs/uvnc
repeater.html.This would be the working basic sketch:
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The UltraVNC tool itself allows to do the setup in a graphic way:

The connection to the VNC server would use the proxy to connect with the destination server, as we
can see in this screenshot:
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31.2. Using VNC integrated in Pandora FMS
It's possible, through the Pandora FMS "VNC" extension, to have access, from the WEB console
itself, without having to install additional software or doing anything extra. To do this, the only
requisites are these:
• Having installed a VNC server that includes the Java applet, listening in the port 5800 of
each server we want to manage remotely.
• Having the Java plugin installed in its browser.
• Having direct connection from the PC where the operator is connected to the Pandora
console, to the monitored server that we want to manage remotely. The connection has to
allow the port 5800/TCP
If we fulfil these requisites, we only have to press on the flap with the extension "VNC" in the
operation view of one agent and we'll see the following:

Look of the VNC flap (first one by left)
When the communication is reestablished, it's necessary to introduce a password that is configured
when the VNC server is installed in the machine.

Once we have introduced the password, we have access to the server " as if we were there".
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We recommend the use of the UltraVNC [1], so, besides being very strong, support connection
coding, and allow file transfer from one machine to other, it's OpenSource and free.
The limitations of this system are mainly the following:
• Needs connection between your PC and the machine to monitor remotely. If it's behind one
firewall or a Router, in Internet, it won't be able to connect.
• Needs to know the IP. With Pandora FMS, it could tell to the agent that notifies the current
IP to Pandora, and this will know which one is the IP, but sometimes it won't work well (if it
has several network adapters, if it doesn't update the IP in an standard way or due to other
possible causes)
• Needs to install the UltraVNC software, may be that due to security policies it won't be able
to install it.
In case that the problem is the first point, you could use the direct connection method through
proxy, but the method shown there won't work, so you will need to download a client program and
execute it manually from your PC in order to connect with the remote system.

31.3. Using TeamViewer with Pandora FMS
TeamViewer is a powerful system of remote management that uses intermediate servers in Internet
to connect with their equipments, regardless of changes in the IP, firewalls or other problems we've
previously mentioned. You will only need three things:
• Internet connection in both ends (the server to monitor and the operator's PC).
• Take note of the machine ID and remember the password.
• Install the TeamViewer software in the remote server.
Once it has been installed, you'll assign an ID to this machine and you'll have the chance to
configure one password of permanent access. The TeamViewer IDs has the format i.e: UltraVNC
[2]. For this, we use the Enterprise feature "Customized fields" to create this field in all the agents
and write there the ID of each machine.
I create the custom field (Configuration > Agents > Manage customized fields > Create)

Once created, I can store there the ID of this machine, in this case 623 596 886
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Now, I only have to go to the TeamViewer page, [3] introduce my ID and go to the system:

31.3.1. Technical details about Teamviewer
TeamViewer is extremely powerful and it also allows to transfer files from one system to other one.
These tools are connected with remote servers, and the security could be a "problem" if we are
specially " demanding" with these concepts (due to legal questions and/or privacy of data. With the
commercial version there are, obviously, some advantages regarding this point.
This is a list of the connections fixed in the server managed remotely with a fixed TeamViewer
connection:
TCP
TCP
TCP
TCP

desktop:1379
desktop:1380
desktop:1381
desktop:1382

server530.teamviewer.com:http ESTABLISHED
master4.teamviewer.com:http ESTABLISHED
server311.teamviewer.com:http ESTABLISHED
server311.teamviewer.com:http ESTABLISHED
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31.4. Connecting remote systems using SSH/Telnet from Pandora FMS
Since 4.0.2 version, Pandora FMS has a new extension to let users connect directly with devices by
telnet or SSH. This is done with the Remote Gateway extension. You need to do a special setup for
this component, not usually installed "by default". This is an opensource feature, based on anytermd
software, published under GPL2 licence.

Pandora FMS uses a tool called "anytermd" to create a "proxy" between user browser and remote
destination. This tool launches as a daemon, listeting in a port, and executing a command,
forwarding all output to the user browser. That means all the connections are done FROM the
pandora server and it has to be installed the telnet and ssh client. This is a basic architecture
schema:
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31.4.1. Install and setup
Sources are placed in extras/anytermd.
Make sure you have installed gnu c++ compiler (gccc++), make, boostdevel and zlibdevel.
Run:
make

Later, install manually the binary to /usr/bin
cp anytermd /usr/bin

To run the server daemons, you need to do manually, Pandora FMS server / console doesn't start up
automatically. Pandora FMS SSH/Telnet extension will search for a different instance of anyterd
running in 8023 for Telnet connections and 8022 for SSH connections.
You have a start/stop daemon in contrib/anytermd. Copy to /etc/init.d/anytermd and execute it like
this:
/etc/init.d/anytermd start

By default uses "pandora" user for execution, if you want to change it, alter the script file for any
other httpd based user your system may have.

This will use ports 8023 and 8022, be sure that ports are "open and clear" from the user
browser to the console webserver system. No firewalls there
Now you're free to use the extension and connect remote servers by telnet or SSH.
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32 MASSIVE OPERATIONS
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32.1. Introduction
Massive operations allow to perform actions over agents/modules/users/alerts and policies in a
massive way. The importance of massive operations grown in environments with a big volume. This
functionality have been developed in order to facilitate administrators' work to deal with systems
with a huge amount of components.
You can access to massive operations at Administration > Massive operations section:

Advice: PHP needs a correct configuration of the timeout parameters. To do this, open the
configuration file (php.ini), for example:
sudo vi /etc/php5/apache2/php.ini;

And setting timeout parameters:
max_execution_time = 0
max_input_time = -1
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32.2. Massive operations: Agents
It is possible to edit or delete agents with massive operations.
In edition subsection it is possible to filter by destiny agents group and changed general parameters
like parent agent, group, execution interval or operating system.

In delete section it is possible to filter by group.
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32.3. Massive operations: Modules
Massive operations over modules are three:
• Delete
• Copy one module from one agent to other
• Edition
Module deletion allows select the modules to edit in two modes:
• Modules selection: If selection by module is choosed, will be able filter by type of module,
select modules of this type and at the end select the agents associated to these modules.
• Agents selection: If selection by agent is choosed, will be able filter by group, select agents of
this group and at the end select the modules of the selected agents.

Module edition allows edition by module or through agent. If the seach is by module it is possible to
filter by module type and finally by modules and agents. After this it is possible to edit general
modules parameters like warning values, execution interval, post process, etc.
Module edition allows select the modules to edit in two modes:
• Agents selection: If selection by agent is choosed, will be able filter by group, select agents of
this group and at the end select the modules of the selected agents.

• Modules selection: If selection by module is choosed, will be able filter by type of module,
select modules of this type and at the end select the agents associated to these modules.
After that, general parameters will be able to edit as warning and critical values, execution interval,
postprocess, etc.
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Module copy allow copy information of one module to other module agent. In order to do this is
needed to choose group and source agent, after this you can choose modules. Finally, you can
choose destiny agent filtering by group.
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32.4. Massive operations: Users
It is possible to add or delete profiles associated to users. This can make more easy user
management because they can be managed massively.
In order to add new profiles you can choose profile, group and finally user.

In order to delete profiles you have to fill profile, group and user information.
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32.5. Massive operations: Alerts
In this section is possible to add, delete or add actions, delete actions, enable/disable or standby
alerts. All this operations can be performed massively.
In order to add new alerts it is possible to filter by group and it is needed to select agent, module
and the template to add.

In order to delete alerts it is possible to filter by group and also is needed to select a template,
group, agent and finally modules.

In order to add actions to alerts it is possible to filter by group and select agents, templates and
finally select the action to add.
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In order to delete alert actions it is possible to filter by group and select agents, templates and
finally tha actions to delete.
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To enable/disable alerts it is possible to filter by group and it is needed to fill information about
agents, templates and two columns about enable/disable options of alerts.

In order to set standby state to an alert is possible to filter by group and it is needed to fill
information about agents, templates and alerts that user want to set it standby state.
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32.6. Massive operations: Policies
In this section it is possible to perform to actions: add and delete alerts in policies.
In order to add alerts is needed to fill the destiny policy, template to add, a regular expression to
match with policy agents and modules of the policy.

To delete policy alerts is needed to fill destiny policy, template to delete, a regular expression to
match with policy agents and policy modules.
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33 POLICIES
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33.1. Introduction
Pandora FMS is able to manage thousand of devices with thousand of modules and alerts. As the
systems that are the target of the monitoring could be composed by a high number of components
and with the purpose of making the administrator work easier, we have developed the policy
functionality.
The policy appliance will allow to propagate modules, alerts, external alerts and collections to the
agents in a centralized and homogeneous way, modifying its configuration files through the remote
edition feature Agent Configuration.
The available operations in a policy are these:
•
•
•
•
•
•
•
•

To create/Delete/Duplicate one policy
To add/To delete one or several existing agents
To create/Edit/Delete one module
To create/To Edit/To delete one alert
To create/To Edit/To delete an external alert
To add/To delete a collection that already exists
To add/To delete one inventory module that already exists
To link the policy to one or several adopted modules

The operations that are done in a policy will be not effective until the policy would be applied.
The application of the different policies is managed by one queue, in which they could be
introduced in order to apply an agent or all the policy. It is also possible to introduce the application
of one policy that is only from the database, if the changes that have been done don't affect to the
remote configuration.
The policy management is done at section Administration > Manage policies,at the left side of the
Pandora FMS web console:

33.2. Adding a Policy
When clicking on the Administration > Manage policies menu, all the available policies will be
showed.
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To create one new policy, click on the "Create" button. You have here a policy creation screen,
where we should introduce the name, the group where it will be classified, and an optional
description.

33.3. Deleting a Policy
To delete a policy, it couldn't have any agent associated to it.
If one policy has agents, the delete button will be disabled, and a button to delete all its agent will
be shown next to it. This button will introduce in the queue the one that has been deleted, and
when it had been processed, the policy deleting button will be active again.

33.4. Duplicating a Policy
There is also a button to duplicate a policy between the policy operation buttons

The copy of the policy that will be created will be shown as no applied regardless of the origin
policy state.

33.5. Configuring a Policy
In order to configure the policy you should click on the policy name at Administration > Manage
policies or directly on a direct access of one of those that are shown when moving the mouse on the
policy you want to configure.
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In the policy configuration,there are also the following windows:
•
•
•
•
•
•
•
•

Agents
Modules
Inventory Modules
Alerts
External alerts
Collections
Linking
Queue

The different actions that could be done will be not applied until the policy will be applied. If we ad
an agent to the policy we can create several modules and alerts, for example, but until we apply the
policy they will not be effective.
Same way, if we have one policy applied and we modify or delete elements, the changes will be not
done until the next execution.
All changes will be shown in the "Queue" window, and you could introduce the policy to the process
queue there, where it'll wait its turn to be applied.

33.5.1. Policy Propagation
Policy propagation means the activation of the modules, alerts and collections that are configured in
the agents that have been defined. This means that these modules and alerts will be added to the
agents.
A policy can be propagated in an specific agent or in a complete policy.
To do it on an agent, we should go to the Agents section and choose which in agent we want to
apply it . If what we want is to apply all the policy, then we should go to the Queue section.

33.5.2. Policy Queues Management

In the policy operations queue there is a summary of the elements that have been changed since the
last aplication:
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In this list we have the elements that need to be updated and the ones pending to delete:
• Pending to Update
• Agents
• Adopted modules pending to link
• Adopted modules pending to unlink
• Pending to Delete
• Agents
• Modules
• Inventory modules
• Alerts
• External alerts
• Collections
This summary will show us if you should apply or not the policy. Some times, next to the icon of
agents pending to apply, a button will be shown to apply them.
If the pending changes only affect to the database (for example changes in alerts) this button will
do changes only on these level, so the application will be quicker.

But if the configuration that affects to the configuration files has been changed (for example if
collections or local modules have been modified) the application will be complete.

Under the summary there is a button to apply all, regardless of the kind of modifications pending.

When we select to apply we will be adding the policy agents to the application queue. The Pandora
FMS server will be in charge of applying the pending policies in the queue. If we refresh the screen,
we can see the progress of the application and when it finish, it will be in the queue as completed,
with the time that it has passed since it finished.
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33.5.3. Agents
In this window it's possible to add or to delete agents from the policy.

33.5.3.1. Massive actions
The upper part is to add/delete agents in a massive way.

They could be filtered by group and with a substring. It's possible to do a multiple selection to add
them to the policy by pressing on the arrow that points to the right. These agents will go to the box
that is on the right, being associated to the policy but pending to apply.
Same way, the agents of the policy could be deleted with multiple selection with the help of a filter
in the same way to pass them to the box at the left with the arrow that points to the left. When you
select this way, one or several agents to delete from the policy, they will be shown as crossed out in
the box at the right, and they could be re associated to the policy when selecting them again in the
left box and linking them as if they were not.
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33.5.3.2. Unit Actions
In the window that is bellow,there is a list with all the agents associated to the policy, including
those that are pending to delete from it.

The agent list has a filter by group, substring or application state:
It shows:
•
•
•
•
•
•
•

The agent name
The remote configuration
The agent state in the policy
The number of modules unlinked in the agent
The button to introduce this agent in the queue to could apply it
The date and hour of the last application
The button of delete/undo remove

When an agent is removed, it will be shown with the name crossed out and in the place of the
deleted button a new one to undo the deleting and link the agent to the policy again.

33.5.4. Modules
The modules menu allows to configure the modules that are going to be added to the policy.
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To add modules you have to choose the kind of module in the dropdown menu, select one module
from the six that are available (dataserver,network, red, plugin, WMI, prediction and Web) and
press on the Create button

33.5.4.1. Creating one Data server module
The data server modules are the modules that are added to the software agents, to work with these
modules, it's necessary that the agents have the remote configuration enabled.
To create one data server module select the option “Create a new data server module” and click on
Create.

After this an screen will be shown to could configure all the module fields. The field "Data
configuration" is the one that allows to introduce the code of the module that will be applied to the
agents that will be subscribed to this policy. This change will be shown in the file
“pandora_agent.conf” of this agent.
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Clicking on Advanced Options you could have access to the advanced options.

It's possible to see the description of these screen fields in the Templates and components section.
There are two options:To fill in the fields or to have defined a local component previously.

33.5.4.2. Creating a Network Server Module
The network server modules are the modules that are managed through the Network server.
To create a Network server module, select the option “Create a new network server module” and
press on the Create button.

Then, a screen will be shown in order you could configure all the module fields.
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Clicking on Advanced Options you will go to the advanced options

It's possible to see the description of these screens fields in the Template and components section.
Once that all the fields have been filled in, press on "Create"
Consider that most of the time that the modules repeats, instead of filling in the fields any time that
one module is added, the best option is to define it previously as a component and to use this
component.
To use a component, fill in the combo that is on "Using module component" where it's possible to
choose between the different groups of components

Once the group has been selected, another combo is selected where you can choose the component
to use.
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In the example, we have select the component “Catalyst CPU Usage” of the Cisco Mibs Group.

Once the component is chosen, it's possible to modify any of the fields. Once all the fields have been
filled in, press on "create"

33.5.4.3. Creating a module of the Complement Server
The modules of the complement servers are the modules that are managed through the complement
server.
To create a module of the complement server choose the option “Create a new Plugin server
module” and press on Create.

An screen will be shown as you could configure all the module fields.
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Pressing on Advanced Options you can have access to the advanced options.

You can see the description of these screen fields in the Template and component section.
Once you have filled in all the fields press on the "Create" button.
As most of the times the modules repeats, instead of filling in the fields any time that a module is
added, is better to define it previously as one component and use this component. The use of
components is explained in the Creating a network module section

33.5.4.4. Creating a module of the WMI Server
The modules of the WMI server are the modules that are managed through the WMI server.
To create a module of the Network server, select the option “Create a new WMI server module” and
press on the Create button.

Then an screen will be shown to you could configure all the module fields.
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Clicking on Advanced Options you go to the advanced options.

It's possible to see the description of these screen fields in the Template and components section.
Once all the fields have been filled press on "Create"
As most of the times the modules repeats, instead of filling in the fields any time that a module is
added, is better to define it previously as one component and use this component. The use of
components is explained in the Creating a network module section

33.5.4.5. Creating a module of the Prediction server
The modules of the Prediction server are the modules that are managed through the Prediction
server.
To create a module of the Prediction server, select the option “Create a new prediction server and
press on Create

After doing this, a screen will be shown in order you could configure all the module fields.
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Clicking on Advanced Options you go to the advanced options

You can see the field description of these screens in the Template and components section.
Once all the fields have been filled in, press on "Create"
In case of the prediction modules there aren't components.

33.5.4.6. Creating a Module of the Web server
The modules of the Web server are the modules that are managed from the Web server.
To create a module of the Web server, select “Create a new web server module” and press on Create

Then it will show a screen to you could configure all the module fields
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Clicking on Advanced Options you go to Advanced options.

You can see the description of the fields of these screens in the Template and components section.
Once all the fields have been filled in, press on "Create".
In case of the Web modules there aren't components.

33.5.4.7. Modifying a previously created Module
It is possible to modify any of the modules created in a previous policy

To do it press on the module name to the module configuration options would be shown
Once they have been modified press on Update
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33.5.4.8. Deleting a Module already created
To delete the module from the policy and remove it from the agents that have it installed, click on
the X that is on the module line. Once you have done it, the module will still be showed but crossed
out and the deletion button will be replaced by one that undo the action.

33.5.4.9. Using Plugins in the Policies
The format used is quite simple. To do it, you only need to "cheat" the system, declaring one module
for each kind of module that the plugin returns.In order to do this, you need to know previously
how many modules the plugin could return. If we aren't completely sure, we could choose to
register the plugin once and that the modules that are going to be created will do it out of the
policy. The data will arrive, but we can't parametrize them with the policies so they are modules
that will arrive without being associated to the policy.
All the data linked to one policy have to be previously defined. The policies don't contain "Non
defined" information specifically.
Supposing that we are going to execute this plugin, that returns, in a dynamic way, the free space in
bytes that all the unities of the system. In this example, the plugin exit returns several unities (C:,
D: y Z:)
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You should define, if you want to manage them as policy modules, several modules, and only in one
of them to define the real call to the plugin leaving in other cases, the field module_plugin empty:
module_begin
module_name C:
module_type generic_data
module_plugin cscript //B "%ProgramFiles%\pandora_agent\util\df.vbs"
module_end
module_begin
module_name D:
module_type generic_data
module_plugin
module_end
module_begin
module_name Z:
module_type generic_data
module_plugin
module_end

33.5.5. Inventory Modules
It is also possible to create inventory modules in a policy by choosing one from the list of the
available ones in the system, an interval and the credentials.

Same as with the rest of the elements of the policies, if we remove an inventory module, it will be
shown as crossed out, and instead of the deleting button, another one will be shown to undo the
action.
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33.5.6. Alerts
The Alert menu allows to configure the alerts that are going to be added to the policy.

33.5.6.1. Adding Alerts
To add one alert is very easy, you have only to link it to one of the templates previously defined or
with one of the modules with one module that belongs to the policy and press on "Add".

33.5.6.2. Modifying Alerts
It's possible to add actions, put on standby or deactivate one alert.
If you want to change the module or the template, you should delete and create a new alert.

33.5.6.3. Deleting Alerts
To delete the alert from the policy and remove it from the agents that have it installed, click on the
X that is on the alert line. Doing this the alert will remain in the list but with its name crossed out
and the deleting button will be replaced by a button to undo the deletion.
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33.5.7. External Alerts
The External Alerts are similar to the Alerts. The difference is that these allow to link alerts with
agent modules that are not in the policy module main list. It's very useful to assign alerts, only to
some agent modules and not only to all of them.

33.5.7.1. Adding External Alerts
To create one External Alert you should fill in the following form, the first field is useful to select
the agent modules. There will be shown only the ones that are not in the policies. In the second
field you could select the alert template.

33.5.7.2. Modifying External Alerts
Considering how easy is to add External Alerts and the little variables that are, the possibility of
modifying External Alerts doesn't exist. To modify an External Alert you should delete and create a
new one.

33.5.7.3. Deleting External Alerts
To delete the External Alert from the policy and remain it from the agents that have it installed, you
should click on the X that there are on the External Alert line.

The deletion system is the same as that of the normal alerts. It will be not effective until the policy
would be apply, and instead of the deleting button it will show a button to undo the deletion.
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33.5.8. Kind of modules
When a policy is applied, it's possible to see different modules in the agent view. If you go tho the
Manage Agents > Modules menu, you could see three different kind of modules .

33.5.8.1. Adopted modules
These modules were created in the policy with the same name of a module already existing in the
agent. When applying the policy Pandora FMS will use the data of the existing module instead of
creating a new module.

When you delete a policy, the adopted modules are not deleted from the agents. They will be only
selected as nonadopted modules, and the line for this modules will be like this one:

33.5.8.2. Linked Modules
These modules are created in the policy and when you apply the policy, they will be created in the
agent too. These are the average modules created in the policies.

You can link an unlink modules going to Manage Agent > Modules, then select the chosen module
and press this button to don't link the module.
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And this button to link the module.

When you delete a policy, the modules linked and not linked are deleted from the agents.

33.5.8.3. Unlinked Modules
When a module is not linked, the future changes done in the policy will not be applied on them.
The modules not linked are useful because they allow to fix "individual exceptions" to modules that
belongs to some policy. This way we can "customize" an agent in a policy without taking it out from
the policy, and only for an specific module.

The changes in the policies will be applied only when the module returns to be linked.

33.5.9. File Collections
A file collection is not only an option to policies, but is usually used in policies. A file collection is a
group of files (script, and /ore executables) that are automatically copied to an specific directory of
the agent (Windows or Unix). The file collections allow that they could be propagated with the
policies, so they could be used by a group of agents, using a "package" of scripts and modules that
use them.
First we learn how to use the file colletions in the agent view, manual way, agent by agent, without
collections, and how to do the same with policies.
Our first task is to do a compilation of files. To do this, go to the agent administrator and after we'll
see a "suboption" called "Collections":do click in it to create a new collection, as we can see in the
following screen shot:
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Once we have created a file colletion, we upload any file to this collection.This can be of binaries,
scripts or data files.All files will go to the same base directory. Each collection has its own base
directory, that is extremely important. In the console, these are stored as
/pandora_console/attachment/collection directory with a name like fc_XXX, where the XXX is
the collection numeric ID. The file collection could contain subdirectories. The file collections are
transferred as ZIP files to the agent through. The file collections are only supported with the
Tentacle transference mode.
Now we can see how the collection that we have created (fc_3) has two files download:

In this case, if we come back to the mail collection screen, we can see both collections as a
triangular icon, what shows that there is a problem. This happens because the collections aren't
synchronized and we should synchronize them clicking on this triangular icon.

When a file collection is synchronized, an icon with a blue arrow is shown, as we can see here:

Once we have synchronized the collection, it will be applied to the agent, this time without using
policies. Go to the agent administrator mode and search the collection tabulator (one icon similar to
a disk). There will be shown the available collections, so we can choose one of them and apply it to
the agent, in this case, of the previous example (Windows utilities):
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Now it has been applied. Next time the agent contact with the server we will get the file and also a
little modification in the .conf file, that in this case will be this:
file_collection fc_3
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33.5.9.1. File Collections and Policies
This works in a similar way to the single agent collections, but instead of applying a collection on an
specific agent it's applied to one policy, as we can see here:

If you want to use a module that works with a file included in the collection,it is very easy:refer
only to the directory that contains the collection, using its fixed id.This is an example using a plugin
module:

To know how the policies workwith pluginssee the specif section in this chapter.
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33.5.9.2. Location of the File Collections in the agent
Each file collection has a "short name". In this example, it is called "fc_3", this means that the
utilities, scripts or executables that are in the collection will be at %Archivos de programa
%\pandora_agent\collections\fc_3.It is important to know that the collection is compressed for its
sending to the agent, so this one should have the unzip tool to could this way unzip the file. Since
the agent 3.2 version, this utility is installed at %Archivos de programa%\pandora_agent\utils.
You should know this to could use modules that work using these files, to could specify the
complete "real" path. Let's see another example:
If the short name of the collection is "fc_18", the location will be (in case of a computer in english):
%ProgramFiles%\pandora_agent
\collections\fc_18.
Each file collection is stored in a different address in order to avoid that different file collections
would be overwritten or have conflicts between them.
Any file locally modified (in the same system where the agent is executed) will be overwritten by
the agent when this one contact with the server. This is done to avoid local modifications and make
sure that the collections are identical in all the systems where these ones have been displayed. This
mechanism uses the same method that the remote configurations management uses, and it's based
on md5 hashes.
This is an example of use of one plugin, that uses the "df_perfecnt.vbs" file, contained in one
collection called "fc_3" for a Windows agent:
module_plugin cscript //B "%ProgramFiles
%\pandora_agent\collections\fc_3\df_percent.vbs"

33.6. Extra access to policies
It is possible to enable extra access to a policy for users that haven't access to the policy group. This
will be done in the editing of users:

Keep in mind that an user with extra access to a policy will see all the components of the policy:
agents, modules, alerts, collections ...
This access is limited to those items.
For example:
You have a Pandora FMS user.
The system has the groups A, B and C.
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There is an agent "age" in the group A with 1 module named "mod".
There is also a policy "pol" with one module "mod_pol" in the group B. In this
policy, the agent "age" is added.
Your user has access to the group C and is given extra access to the policy "pol".
In your list of agents, you can see all the group C agents and the agent "age" too.
In the module list of the agent "age", you can see the policy module "mod_pol" but
NOT the module of the agent named "mod".
If the agent "age" was also in other policy, that policy modules only be displayed
if you have access to policies. This access is possible because you have extra
access to policies, or because the policy is in group C, to which you have already
access.</pre>
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34 EXPORT SERVER
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34.1. Introduction
Pandora FMS Enterprise Version implements, through the export server, a data scaling device that
allows you to do a virtually distributed implementation able to monitor an unlimited number of
information, as long as you design it properly and break it up into different information profiles.
The main idea consist on creating a hierarchical structure that distribute the information from down
to top, being the top point the more global one, that collect only an extract of basic information of
Pandora FMS installations at the lowest level, instead of collecting a bigger number of information,
and that allows to the Pandora FMS highest installation to have a «filter» vision and more
information density.

The server that exports is hierarchically bellow the server that gets this information. In a different
sketch of the filter vision, you could use this technology to do a reply of all data reported by a
server, though it could affect to the server performance in an important way.
Each independent installation of Pandora FMS could export those data that the administrator prefer
to one or several servers.
It is possible to export data that comes from modules, so a Pandora FMS installation that is
hierarchically higher could receive the important data.
The processing of events, view, reports, users and permissions will be different for each installation
of Pandora FMS.They will be installations totally different at all purposes. Higher request could not
be executed in real time data refresh petitions, so these data is obtained in a passive way and there
is not access to the monitored elements of lower petitions , so the access security, information
partition and access to privileged information is totally guarantee by the architecture design.
The server that gets data, receive it through an XML, similar to the one that an agent would
generate, in a way that it only need to have available a data server. The higher server, the one that
receives data, only receives data, it does not receive events, and it can not reuse the alerts defined
in the server that first receives data, this is, it should define its own alerts, and also its own reports,
customized graphs, etc
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34.2. Adding a Target Server
To export module data, the first step is to define a scaling server with different configuration
options that would allow the export link between a server that exports (or client) and a server that
imports.
In Administration> Manage Servers> Export Targets click on "Create".

Once you have click on Create it will show you an screen like this:
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Next we are going to detail the fields:
Name
Pandora FMS server name.
Export Server
Combo to choose the server petition of export server that will be used to export the data.
Prefix
Prefix that is used to add to the agent name that send the data. For example, when the data of an
agent named "Farscape" is resent, and its prefix in the export server is "EU01",the resent agent data
will be seen in the destination server with the agent name EUO1Farscape. This allow to know the
data origin in case of that in a server we receive different sources of information, coming from
different Pandora FMS servers, so we force that there would be name duplicity. The server will
always add the "_" character after the prefix , so though it would be empty , the "_" character will be
put before the agent name in the destination server.
Interval
Define the time interval, and how often (in seconds) you want to send the data that is unresolved.
Data will always be collected from the original source, this is: if an agent collect data every 300
seconds and here it configures 1000 seconds, it means that the server will send what it has collected
until this moment. In this case, three packages from this agent with interval 300.
Target directory
It will be the target directory (used for SSH or FTP only), where it will leave remotely the data.
Address Data server address that is going to receive the data.
Transfer Mode: files transfer mode. You can choose between:
• Local:The server that receives the data is on the same machine that the server which export
them.
• SSH: the transfer if made through SSH. It is necessary to copy the certificate of the server
that export the data at the server that receives them.
• FTP: the transfer is made through FTP.
• Tentacle: the transfer is made through Tentacle (recommended).
User
User for FTP
Password
FTP user password
Port
Port used in the files transfer. For Tentacle it is the 41121 standard port.
Extra options
Field for additional options such as the ones that Tentacle needs to work with certificates.
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You could see an example in the following image.
Once that all the fields have been completed, click on "Add". The server has been created.

34.3. Editing a Target Server
To edit a target server, click on the target server name or on the icon that is selected on the image.
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34.4. Deleting a Target Server
To delete a target server,click on the red x that is on the right of the target server name.

34.5. Linking a Target Server to a Module
To scale the information, you should select one by one those modules that could send information
to a higher instance. In order to do this, the Pandora FMS console module editor implements an
option that allows to assign one export server for each data.
To edit one module in an agent choose one agent from Administration>Manage agents.
After filtering, click on the Module direct access that is below the agent name (this direct access is
shown by puting the mouse on the agent name).

To edit a module, click on the module name, in the example the cpu_user is chosen.
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If you click on the module name, its configuration screen will appear. To export the data you need
to get to the advanced options. To do this click on the Advanced Options.

Once you have opened the advanced options, choose the server you want to export the data to in
the combo that is on the Export target option, where the "none"option is choosen by default.

Click on "Update" in order that Pandora FMS starts to export the data to the choosen server.
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35 META CONSOLE
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35.1. Introduction
Pandora FMS Enterprise version, thanks to the Meta Console, implements a way for distributing the
monitoring between different Pandora FMS servers that are physically independent. Each server has
its own database, console and server. Besides, it also has its owns agents, alerts and reports. And
what is more: it has users, groups and policies.

The Meta Console doesn't process information, it only "reads" the information from its original
source, that is: from the Pandora's server, where the information is kept , only that the meta console
can search an agent in ALL Pandoras, and show the data views of each agent of each Pandora,
simply by linking automatically the views of "Local" data of each Pandora. This is possible through
the delegated authentication (through hash) that implements Pandora FMS from version 2.1, that
allows that an user previously authenticated in the meta console does not have to authenticate in
one of the Pandoras asociated to the metaconsole.
This way, It doesn't exist a theoretical limit of maximum number of systems to monitor so we
can keep adding Pandora's servers in a linear way to get the scalability that we want, as you can see
in the following example, where, if we suppose that each server processes 1200 agents, we can see
that we can easily exceed the 6000 agents monitored adding 5 servers:
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35.2. Configuration
The first step is activating the meta console, that by default is deactivated. It's important to say, that
a Meta Console System SHOULD NOT manage its own agents. For it, the best thing to do is to use
the Enterprise ACL system in order to limit the access to the normal menus, even to the
administrator.
To activate the meta console, you only need to activate the following option of the configuring main
menu:

Once the meta console has been activated, we could see some changes. In the header, for example,
there is neither search bar, nor options nor information of the server state.
The following step is to define, one by one, the Pandora FMS systems that we are going to manage
from the meta console. For this, after activating the meta console, we could see a new option in the
administration menu, called "Meta console". In this specific section of the meta console
configuration, we should define the access to one Pandora's server. For it, it will ask for a few data:
• Name: In case we have several, just to know which of them we refer to.
• Database address, the name of it, the user and the password to have access to it: To could
extract the database info and show it in the meta console.
• Console access URL : To could create the links of access to the direct information in the
console of destination.
• Authentication Token to could implement the delegated authentication: Word that should be
defined in the Pandora console of destination if we want that users of the meta console
could enter in the destination console.
• For some of the metaconsole operations it's necessary to define the IP (or the character* for
all access from any IP, but it it's unsafe) in any of the Pandora Console managed by the
metaconsole.
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35.2.1. Use of the Delegated Authentication
Is based on one token that generates one hash with the user name, in a way that, by making a call
to the console of each one of the Pandoras included in the meta console, this will give as good the
authentication done in the meta console. This means that if I have one user "pepe" in "pandora2"
and I want to enter in pandora2 as "pepe", then the first thing I should do is to enter as "pepe" in the
meta console. For doing it, I first should have an user created in the meta console with "pepe" as
username.
To allow in the Pandora "normal" consoles that any could enter with the delegated authentication,
you should define one "token" in any of them, as we can see at the following shoot screen:
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Configuration of the authentication token, at the Pandora FMS configuration main screen.

35.3. Visualization
La meta console, besides looking for an agent between the Pandora FMS different systems which it
manages, also allows to visualize a general table of statistics by server and/or group. We can use
several basic tools to visualize general information:
•
•
•
•

By server (totals)
By group /server
Events. Mixing Events, mixing the information of all servers.
Search of agents

You have to consider that the info that you see corresponds to the information of the a access
profiles (ACL) that the current user of the meta console has in any of the servers. That is: if the user
"Juan" of the meta console would have only access to the group of "Servers" of Pandora1 , and to
the "Tools" group of Pandora2, then it will only see the data of these groups in these servers,
ignoring the rest of the information to which it won't have access to.
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35.4. Multiple Systems Simultaneous Management
Meta console is not only useful to visualize information. It's also useful to:
•
•
•
•
•

Synchronize users. User Manager
Synchronize alerts (templates, actions and commands). Alerts Manager
Copy policies from a Pandora FMS system to another one. Policy Manager
Synchronize module libraries (either network as local modules). Component Manager
Move agents between Pandora FMS systems. Agent Manager
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35.4.1. User Manager
From this section it is possible to synchronize users between different Pandora FMS systems.
It is really easy and intuitive to do this job.

Below are described all the available elements in this section:
• Source: Select here the Pandora FMS system from which to select the users to synchronize.
• Users: Select here the desired user(s) to synchronize. It is possible to select just one user or
several users at the same time.
• Target: Select here the Pandora FMS system with which to synchronize the previously
selected users.
• Button "Sync": press here to proceed with the synchronization
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35.4.2. Alerts Manager
From this section it is possible to synchronize alerts (including their templates, actions and
commands) between different Pandora FMS systems.
It is really easy and intuitive to do this job.

Below are described all the available elements in this section:
• Source: Select here the Pandora FMS system from which to synchronize the alerts.
• Targets: Select here the Pandora FMS system(s) with which to synchronize the alerts. It is
possible to select just one Pandora FMS system or several systems at the same time.
• Button "Sync": press here to proceed with the synchronization

35.4.3. Policy Manager
From this section it is possible to synchronize policies between different Pandora FMS systems.
It is really easy and intuitive to do this job.
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Below are described all the available elements in this section:
• Source: Select here the Pandora FMS system from which to select the policy to synchronize.
• Policy: Select here the desired policy to synchronize.
• Targets: Select here the Pandora FMS system(s) with which to synchronize the previously
selected policy. It is possible to select just one Pandora FMS system or several systems at the
same time.
• Button "Sync": press here to proceed with the synchronization

35.4.4. Component Manager
From this section it is possible to synchronize module libraries (either network as local ones)
between different Pandora FMS systems.
It is really easy and intuitive to do this job.

Below are described all the available elements in this section:
• Source: Select here the Pandora FMS system from which to synchronize the components.
• Target: Select here the Pandora FMS system(s) with which to synchronize the components.
It is possible to select just one Pandora FMS system or several systems at the same time.
• Button "Sync": press here to proceed with the synchronization.
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35.4.5. Agent Mananger
From this section it is possible to synchronize agents between different Pandora FMS systems.
It is really easy and intuitive to do this job.

In order to use this functionality you have to write the IPs in to the list of IPs with
access to the API. See Setup

Below are described all the available elements in this section:
• Source: Select here the Pandora FMS system from which to synchronize the agents.
• Target: Select here the Pandora FMS system with which to synchronize the agents.
• Group filter: Select here, if desired, the group with which to filter. It will be displayed just
the agents within that group.
• Agents: Select here the agent(s) to synchronize. It is possible to select just one agent or
several agents at the same time.
After filling the previous fields, you should clic on the triangular button which is between the two
agents lists. With it, we will move the selected agents from the source system to the target system.
To proceed with the operation, you must press "Move" button, and finally the synchronization
between both systems will be processed.
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36 NETFLOW
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36.1. Introduction
From versión 4.1, Pandora FMS is able to monitor the IP traffic using the NetFlow protocol. It
allows to show patterns and general data of the traffic that are very useful.
Netflow is a network protocol developed by Cisco Systems to collect IP traffic information. Netflow
has become an industry standard for network traffic monitoring, and is currently supported by
several platforms besides Ciso IOS and NXOS, like Juniper devices, Enterasys Switches and
operating systems like Linux, FreeBSD, NetBSD and OpenBSD.

36.1.1. Net flow
Netflow capable devices (netflow probes) generate netflow records consisting of small chunks of
information that are sent to a central device or netflow server (netflow collector), which stores and
processes that information.
Data is transmitted using the Netflow protocol via UDP o SCTP. A netflow record is a small packet
that only contains statistical information about a connection, not the whole raw data or the
payload.
There are several Netflow implementations that may differ from the original specification and
include additional information, but most of them provide at least the following:
•
•
•
•
•
•
•

Source IP address.
Target IP address.
Source UDP or TCP port.
Target UDP or TCP port.
IP protocol.
Interface (SNMP ifIndex)
Type of service.
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With time, some manufacturers have designed similar protocols with different names but the same
purpose:
•
•
•
•
•
•
•

Jflow o cflowd de Juniper Networks
NetStream de 3Com/H3C|HP
NetStream de Huawei
Cflowd de Alcatel Lucent
Rflow de Ericsson
AppFlow
sFlow

36.1.2. Netflow collector
A Netflow collector is a device (PC or server) placed in a network to gather all the Netflow
information sent by routers and switches.
A Netflow server is needed to receive and store that information. Pandora FMS uses nfcapd for this
purpose, and it must be installed before Pandora FMS can process Netflow data. Pandora FMS starts
and stop this server automatically as needed.

36.1.3. Netflow probe
Probes are usually Netflow capable routers configured to send Netflow data to the Netflow collector
(in our case, a Pandora FMS server with nfcapd running).

699

Installation and requisites

36.2. Installation and requisites
Pandora FMS uses an OpenSource tool callednfcapd to process all the netflow traffic. This daemon
is automatically started by Pandora FMS Server. This system stores the data in binary files, in an
specific location. You should install nfcapd in your system before working with Netflow, nfcapd by
default listen in the port 9995/UDP. Please, consider this if you have firewalls to open this port.

36.2.1. Installation of nfcapd
nfcapd must be manually installed. Pandora FMS will not install nfcapd. For more information on
how to install it go to the nfcapd project official page.
Pandora FMS by default uses the directory /var/spool/pandora/data_in/netflow to store Netflow
data. nfcapd will point to this directory when started by the Pandora FMS Server. Do not change it
unless you know what you are doing.
Pandora FMS needs nfdump version 1.6 to process Netflow data.
To manually test your nfcapd installation run:
nfcapd -l /var/spool/pandora/data_in/netflow -D

Bear in mind that the Pandora FMS Console, and more specifically the Web server that hosts it,
needs access to /var/spool/pandora/data_in/netflow to read Netflow data files.

36.2.2. Netflow probe installation
If a Netflow capable router is not available, but you use a Linux server to route your traffic, you can
install a software Netflow probe that sends netflow information to the Netflow server.
In Linux there is available a program called fprobe that gets the traffic and send it to a NetFlow
server.With this program you can generate Netflow traffic that goes through its interfaces,i.e:
/usr/sbin/fprobe -ieth0 -fip 192.168.70.185:9995

Once the traffic has been generated, you could see stadistics of this traffic in the command:
nfdump -S -R /home/netflow_data/

That should show you information similar to the following one:

Aggregated flows 1286
Top 10 flows ordered by packets:
Date flow start
Duration Proto
Addr:Port
Packets
Bytes Flows
2011-12-22 20:41:35.697
901.035 TCP
192.168.50.2:22
2105
167388
2011-12-22 20:41:35.702
900.874 TCP
192.168.60.181:50935
1275
202984
2011-12-22 20:48:15.057
1.347 TCP
192.168.50.15:40044
496
737160
2011-12-22 20:48:14.742
1.790 TCP
192.168.50.15:60101
409
607356

Src IP Addr:Port

Dst IP

192.168.60.181:50935 ->
4
192.168.50.2:22

->

4
157.88.36.34:80
1
91.121.124.139:80
1

->
->
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2011-12-22 20:46:02.791
76.616 TCP
192.168.60.181:40500
370
477945
2011-12-22 20:48:15.015
1.389 TCP
157.88.36.34:80
363
22496
2011-12-22 20:46:02.791
76.616 TCP
192.168.50.15:80
303
24309
2011-12-22 20:48:14.689
1.843 TCP
91.121.124.139:80
255
13083
2011-12-22 20:48:14.665
1.249 TCP
192.168.50.15:38476
227
335812
2011-12-22 20:48:21.350
0.713 TCP
192.168.50.15:47551
224
330191
Top 10 flows ordered by bytes:
Date flow start
Duration Proto
Addr:Port
Packets
Bytes Flows
2011-12-22 20:48:15.057
1.347 TCP
192.168.50.15:40044
496
737160
2011-12-22 20:48:14.742
1.790 TCP
192.168.50.15:60101
409
607356
2011-12-22 20:46:02.791
76.616 TCP
192.168.60.181:40500
370
477945
2011-12-22 20:48:14.665
1.249 TCP
192.168.50.15:38476
227
335812
2011-12-22 20:48:21.350
0.713 TCP
192.168.50.15:47551
224
330191
2011-12-22 20:48:15.313
1.603 TCP
192.168.50.15:52019
212
313432
2011-12-22 20:48:14.996
1.433 TCP
192.168.50.15:36940
191
281104
2011-12-22 20:51:12.325
46.928 TCP
192.168.60.181:40512
201
245118
2011-12-22 20:52:05.935
34.781 TCP
192.168.60.181:40524
167
211608
2011-12-22 20:41:35.702
900.874 TCP
192.168.60.181:50935
1275
202984

192.168.50.15:80
->
1
192.168.50.15:40044 ->
1
192.168.60.181:40500
1
192.168.50.15:60101
1
178.32.239.141:80
1
137.205.124.72:80
1

->
->
->
->

Src IP Addr:Port
157.88.36.34:80
1
91.121.124.139:80
1
192.168.50.15:80
1
178.32.239.141:80
1
137.205.124.72:80
1
89.102.0.150:80
1
212.219.56.138:80
1
192.168.50.15:80
1
192.168.50.15:80
1
192.168.50.2:22
4

Dst IP
->
->
->
->
->
->
->
->
->
->

Summary: total flows: 1458, total bytes: 5.9 M, total packets: 15421, avg bps:
49574, avg pps: 15, avg bpp: 399
Time window: 2011-12-22 20:40:46 - 2011-12-22 20:57:21
Total flows processed: 1458, Records skipped: 0, Bytes read: 75864
Sys: 0.006s flows/second: 208345.2
Wall: 0.006s flows/second: 221177.2

If you have this system working, the following thing will be to configure Pandora FMS to it could
use this configuration.

36.3. Working with Netflow in Pandora FMS
Pandora FMS does not store Netflow data in its database, information is processed on demand to
render reports.
Pandora FMS works with Netflow data using filters, which are sets of rules that match certain traffic
patterns. A rule can be as simple as 'all the traffic from the 192.168.70.0/24 subnet', or it can be a
complex pcap expression.
Once filters are created, we have to define reports that determine how the information matched by
those filters is going to be displayed (charts, tables...) and the time frame. Netflow reports can be
accessed on demand like any other Pandora FMS reports.
Una vez definidos los filtros, definiremos los informes, que son, como queremos ver los datos
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(graficos, listas...) y en que intervalo de tiempo. Al definir filtros e informes, dejamos definida esa
información, de forma similar a como se opera con los informes de Pandora, para utilizarla bajo
demanda cuando queramos.
Los informes Netflow aparecerán también como "tipo de informe" en la seccion de Informes
generales de Pandora, para poderlos "incorporar" también a los informes "normales" de Pandora.
There is also a live Netflow viewer to analyze traffic, modify and create rules on the spot. It can be
very useful to investigate problems or temporarily display a chart that we don't want to save for
later usage.

36.3.1. Enterprise version: Analysis in Pandora
The Enterprise version allows you to store average traffic values for any filters as Pandora FMS
modules. This allows you to configure alerts, generate combined charts or work with it as with any
other Pandora FMS module. For more information see section Netflow monitoring with Prediction
server

36.3.2. Configuration
First of all, we have to authorize Netflow to it would be accessible from the Operation and
Administration menus.

In the Administration menu, in the Configuration chapter, we find the Netflow option in which we
specify the path in which are the files captured of the Netflow traffic. For example:/tmp/netflow. It
is also important to verify that the path to the nfcapd daemon is correct.

702

Working with Netflow in Pandora FMS

Once netflow configuration is enabled, Pandora FMS server must be restarted to start nfcapd server.
This server must be accesible on system path and properly installed. Check server logs on any
doubt. This server will not appear in Pandora FMS server view because it is not a Pandora server.

36.4. Filters
The creation and edition of filters is at "Administración / Netflow / Filters".In this snapshot there is
a list of the filters already created and that can be changed and deleted.
The Netflow filters allows to define some features that we are going to explain now.
• Name: It's advisable that the name of the filter would be descriptive.
• Group:An user could only create one filter or edit one filter of one group to it has access to.
• Filters: There are two types of filters, basic and advanced. Advanced filters allow using
advanced expressions in the same format as nfdump. Basic filters can filter traffic by source
Ip, destination Ip, source port or destination port. Lists of comma separated Ips or ports are
accepted.
• Added: The traffic will be grouped following some of these points:

IP Origin: shows the traffic for each IP of different origin
IP Destination: shows the traffic for each IP of different destination
Origin Port: shows the traffic for each port of different origin Destiny Port: shows the
traffic for each port of different destination
Protocol: shows the traffic for each different protocol.
Any: (the data will be total).
• Exit format: The result could be shown at:

Packages.
Bytes.
Bits by second.
Bytes by package.
Basic web traffic filter example:
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Advanced intranet traffic filter example:

36.5. Reports
Information about the creation and edition of reports is at "Administración / Netflow / Manage
Reports". In this view we find a list of the reports already created that could be modified and
deleted.
When we create a report, we need to define general things like these:Name,Group and Description.

Once we save it, we could add elements to this report going to the item editor or to the list of items
that are on the upper right side. Creating items we could define:
• Interval: Period of time showed
• Filter: Select filter previously created (section Filters)
• Max. Value added : In case that the filter has addition, the maximum number of values that
are going to be shown is fixed.
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• Elements: Kind of graphic or table. If in the filter an item has been fixed, the kind of
element could be:area graph, pie chart, value table an addition by period. If, on the
contrary, there is no addition selected (total), the kind of graphic should be only an area one
.
It's possible to select so many elements as you want to write the report.

36.6. Report Visualization
To visualize the reports that have been created, we go to "Operation / Netflow".Then, a list of
reports will be shown, from which we could select the one that we are interested in. The date and
interval of the report could be modified in this view.
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36.7. Netflow live view
Filters can be visualized live from "Operation / Netflow / Live view". This tool allows you to preview
changes made to a filter and save it when the desired result is achieved. It is also possible to load
and modify already existing filters.
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37 HIGH AVAILABILITY

707

Introduction

37.1. Introduction
Pandora FMS is a very stable application (thanks to the test and improvements included in each
version and to the hundred of fails opened by users and that have been solved.In spite of this, in
critical environments and/or with much load, it is possible that it would be necessary to distribute
the load in several machines, being sure that if any component of Pandora FMS fails, the system will
not be down. Pandora FMS has been designed to it would be very modular. Any of its modules
could work in an independent way. But it has also been designed to work with other components
and for being able to take the load from those components that have been down.
The Pandora FMS standar design could be this one:

Obviously, the agents are not redundants. If an agent is down,it makes no sense to execute another
one, so the only cause for than an agent downs is that data could not be obtained because the
execution of any module is failing, and this could not be solved with another agent running in
parallel, or because the system is isolated or fails. The best solution is to make redundancy of the
critical systems regardless if they have Pandora FMS agents or not and so to make redundancy or
these systems monitoring.
It is possible to use HA in several scenaries:
•
•
•
•
•

Data Server Balancing and HA.
Network Servers,WMI, Plugin, Web and Prediction Balancing and HA
DDBB Load Balancing.
Recon Servers Balancing and HA.
Pandora FMS Console Balancing and HA.
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37.1.1. Data Server Balancing and HA
This is the more complex setting, so in the level of Pandora FMS it is not necessary to have specific
knowledges about the server installation.You should use another tool to implement HA and the load
balancing instead: commercial hardware tools that implements HA and balancing or through
OpenSource solutions such as vrrpd, LVS or Keepalive.
For the Pandora FMS dataserver you will need to install two machines with one configured Pandora
FMS dataserver (and differents hostname and server name). You should also configure a Tentacle
server in each of them and, if it would be necessary, an SSH/FTP server.Consider that you need to
copy the keys of each machine in the server (SSH). It is easier through Tentacle, so you only need to
reply the configuration. Each machine will have a different IP, and the balancer will give (sa,e as
with MySQL cluster) only one IP address to which the agents will connect with to send data.The
balancer will send the data to the corresponding server.
If one fails, the HA device «promote» one of the active servers that are availables and the Pandora
FMS agents will connect with the same address that they used before, without noticing the change,
but in this case, the load balancer will not send the data to the server has failed, but to another
active server.You do not need to change anything in Pandora FMS dataserver.Even each server
could keep its own name, useful to know if any of them has down in the server state view.Pandora
FMS data modules could be processed by any server and a preassignation is not necessary. It is
designed this way so it would be possible to implement HA in an easier way.
Another way to implement the HA is though the sending from the agents, to two different servers,
one of them for reserve (HA Active/Passive) just in case that the main one fails, or two different
ones at the same time, replying data in two different and independent instances of Pandora FMS.
This is described next as "Balancing in the Software Agents"
At the end of the chapter is described the mechanism to implement HA and Load balancing with
LVS and Keepalive on a TCP service that could be the Tentacle port (41121) or the SSH port, FTP or
another one.The same procedure could be used to cluster two or more systems. In this case the
Pandora FMS Web will be useful through an Apache.
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37.1.1.1. Balancing in the Software Agents
From the software agents it is possible to do a balancing of Data servers so it is possible to configure
a Data server master and another one for backup.
In the agent configuration file pandora_agent.conf, you should configure and uncomment the
following part of the agent configuration file:
# Secondary server configuration
# ==============================
# If secondary_mode is set to on_error, data files are copied to the secondary
# server only if the primary server fails. If set to always, data files are
# always copied to the secondary server
secondary_mode on_error
secondary_server_ip localhost
secondary_server_path /var/spool/pandora/data_in
secondary_server_port 41121
secondary_transfer_mode tentacle
secondary_server_pwd mypassword
secondary_server_ssl no
secondary_server_opts

There are the following options (for more information, go to the Agents Configuration chapter.
• secondary_mode: Mode in which the secondary server should be. It could have two values:
• on_error: Send data to the secondary server only if it could not send them to the
main server.
• always: Always sends data to the secondary server not regarding if it could or not
connect with the main server.
• secondary_server_ip: Secondary server IP
• secondary_server_path: Path where the XML are copied in the secondary server,usually
/var/spoo//pandora/data_in
• secondary_server_port: Port through the XML will be copy to the secondary server in
tentacle 41121, in ssh 22 are in ftp 21.
• secondary_transfer_mode: transfer mode that will be used to copy the XML to the
sercondary server, tentacle, ssh, ttp etc
• secondary_server_pwd: Password option for the transfer through FTP
• secondary_server_ssl: Yes or not should be put depending if you want to use ssl to transfer
data through Tentacle or not.
• secondary_server_opts: This field is for other options that are necessaries for the transfer.

37.1.2. Balancing and HA of the Network Servers, WMI, Plugin, Web and Prediction
This is easier. You need to install several servers, network,WMI, Plugin, Web or Prediction, in
several machines of the network (all with the same visibility for the systems that you want
monitor). All these machines should be in the same segment (so as the network latency data
whould be coherents)
The servers could be selected as primaries.These servers will automatically collect the data form all
the modules assigned to a server that is selected as «down».Pandora FMS own servers implement a
mechanism to detect that one of them has down thorugh a verification of its last date of contact
(server threshold x 2).It will be enough if only one Pandora FMS server would be active for that it
could detect the collapse of the other ones. If all Pandora FMS are down, there is no way to detect
or to implement HA.
The obvious way to implement HA and a load balancing in a system of two nodes is to asign the
50% of the modules to each server and select both servers as masters (Master. In case that there
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would be more than two master servers and a third server down with modules expecting to be
executed, the first of the master server that would execute the module will "selfassign" the module
of the down server. In case of the recovering of one of the down servers, the modules that have
been assigned to the primary server would automatically be assigned again.

The load balancing between the different servers is done in the Agent Administration section in the
"setup" menu.

In the field "server" there is a combo where you can choose the server that will do the checking.
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37.1.2.1. Configuration at Servers
In Servers there are two modes of work:
• Master Mode.
• NonMaster Mode.
The differences between them, and the importance that they have to work in HA mode, consist on
that when there are several servers from the same kind( e.g: Network Servers).When a server falls,
the first master server that could, will be in charge of the network modules of the down server that
are waiting to be executed. The nonmaster servers does not do this.
This option is configured in the file /etc/pandora/pandora_server.conf through the master 1 token.
Being the value 1 to active it and 0 to deactivate it.

37.1.3. Load Balancing in the DDBB
It is possible to configure a database cluster to implement at the same time HA and the load
balancing. The database is the more critical component of all architecture, so a cluster would be the
best option. You only need to convert the DB sketch in tables compatibles with a MySQL cluster.
This setting has been tested and it works well, but it is necessary to have an advanced knowledge in
cluster administration with MySQL5 and that the modules would have lot of RAM memory. A
minimum of 2GiB in a setting of two nodes for a maximum of 5000 modules (in total).
In this case it would not be necessary an special configuration of Pandora FMS.

You have several proposals to implement the MySQL HA, see more about this in out annexes
(MySQL Cluster, MySQL HA Binary Replication and DRBD).

37.1.4. Balancing and HA of the Recon Servers
In the Recon Server the redundancy is very easy to apply. You only need to install two recon servers
with alternate tasks.So is one of them is down, the other one will continue executing the same task.
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37.1.5. Balancing and HA of Pandora FMS console
In this case, you do not neither need an special configuration of Pandora FMS. It is very easy,you
will only need to install another console.Any of them could be used at the same time from different
locations by different users. Using a Web balancer in front of the consoles, you could have access to
them without knowing exactly to which one are you having access into, so the performaces system
is managed through cookies and this will be kept in the browser. The balancing procedure
implementing LVS and the HA using KeepAlived is described after.

37.2. Annex 1: HA implementation and Load Balancing with LVS and
Keepalived
For the load balancing we advise to use Linux Virtual Server (LVS). To manage the High Availability
(HA) between the services, we advise to use Keepalived.
LVS
At present, the main function of the LVS project is to develop an advanced IP system of load
balancing through software (IPVS), load balancing through software at application level and
components for the management of a services cluster.
IPVS
Advanced IP system of load balancing through software implemented in the Linux own kernel and
that has been already included in versions 2.4 and 2.6.
Keepalived It is used to manage the LVS. Keepalived is being used in the cluster to make sure that
the SSH servers, both Nodo 1 and Nodo2 are alive, if any of them falls, Keepalive show to the LVS
that one of the two nodes is down and it should to readdress the petitions to the node that is alive.
We have chosen Keepalived as HA service so it allows to keep a persistence of session between the
servers. This is, if any of the modules falls, the users that are working on this node will be conduced
to the other module that is alive, but these will be exactly in the same place that they were before,
doing that the fall will be fully transparent to its work and sessions ( in the case of SSH it will not
work due to the SSH encrypting logic, but in simple TCP sessions, such as Tentacle without SSL or
FTP, they will work without problem).With Tentacle/SSH the communication should be try again
and this way the information of the data packet will not be lost.
The configuration file and the orders for use of KeepAlived are in the Annex 2.
Load Balancing Algorithm Algorithm
The two more used algorithms nowadays are:«Round Robin» and «Weight Round Robin». They are
very similar and they are based on an assignment of work by turns.
In the case of the «Round Robin»,it is one of the process planning algorithms more simple in an
Operative System that assigns to each proccess an equitable and ordered time share, considering all
processes with the same priority.
On the other hand, the «Weight Round Robin» algorithm allows to assign load to the machines
inside the cluster so as a number of specific petitions will go to one or other node, depending on its
weight inside the cluster.
This has no sense in the topology that we consider here, so both machines have exactly the same
hardware features. For all these we have decided to use «Round Robin» as load balancing
algorithm.
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37.2.1. Action when a node is down
Keepalived will detect is one of the services is down. So, if it happens it will eliminated the module
that have failed from the LVS active modules to the node that has failed, so all the petitions to the
node that have failed will be readdressed to the active node.
Once the possible problem will be solved with the service that has fallen, you should restart
keeoalived:
/etc/init.d/keepalived restart

With this restart of the service, the nodes will be inserted again in the LVS available nodes list.
If one of the nodes falls, it would be not necessary to do a manual insertion of the nodes using
ipvsadm, so Keepalived will do it once it would restart and check that the services that are supposed
to do an HA service are running and are accessibles by its «HealthCheckers».

37.3. Annex 2. LVS Balancer Configuration
Use of ipvsadm:
Installing of the manager Linux with ipvsadm:
ipvsadm -A -t ip_cluster:22 -s rr

The options are:
• A Add service
• t TCP service with Ip format
• s Sheduler, in this case you should use the "rr" parameter (round robin)
Install the nodes (real servers) to which the petitions to the 22 port will be readdress.
ipvsadm-a -t ip_cluster:22 -r 192.168.1.10:22 -m ipvsadm -a -t ip_cluster:22 -r
192.168.1.11:22 -m

The ipvsadm situation without active connections is the following:
Prot LocalAddress:Port Scheduler Flags
-> RemoteAddress:Port
Forward Weight ActiveConn InActConn
TCP cluster:www rr
-> nodo-2:ssh
Masq
1
0
0
-> nodo-1:ssh
Masq
1
0
0

Using the «Round Robin» algorithm, both machines have the same weight in the cluster. So the
connexions will be shared. Here you can see an example of LVS balancing connexions against the
cluster:
Prot LocalAddress:Port Scheduler Flags
-> RemoteAddress:Port
Forward Weight ActiveConn InActConn
TCP cluster:ssh rr
-> nodo-2:ssh
-> nodo-1:ssh

Masq
Masq

1
1

12
11

161
162
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37.4. Annex 3. KeepAlived Configuration
Keepalived is the one that verifies that the files selected in its configuration file
(/etc/keepalived/keepalived.conf)are empty, and keep the different host in the balancing cluster. If
any of these services falls, get out the host of the balancing cluster.
To start Keepalived:
/etc/init.d/keepalived start

To stop Keepalived:
/etc/init.d/keepalived stop

The configuration file used for the cluster is the following one:
# Configuration File for keepalived
global_defs {
notification_email {
email@valido.com
}
notification_email_from keepalived@domain
smtp_server 127.0.0.1
smtp_connect_timeout 30
lvs_id LVS_MAIN
}
virtual_server 192.168.1.1 22 {
delay_loop 30
lb_algo rr
lb_kind NAT
protocol TCP
real_server 192.168.1.10 22 {
weight 1
TCP_CHECK {
connect_port 22
connect_timeout 3
nb_get_retry 3
delay_before_retry 1
}
}
real_server 192.168.1.11 22 {
weight 1
TCP_CHECK {
connect_port 22
connect_timeout 3
nb_get_retry 3
delay_before_retry 1
}
}
}
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38.1. Database management
Pandora FMS infrastructure does not need external maintenance, but it is very important to purge
old data, and maintain the database compacted. There is an essential tool for the proper functioning
of Pandora FMS. This tool must be launched only once by night. If you have multiple physical
servers, start it from one of them. This tool must be launched from a system where there is a
Pandora FMS server, if you have two systems and one has the server and another one the console,
run it from the server where server is the Pandora FMS. This tool is at:
/usr/share/pandora_server/util/pandora_db.pl

This tool, hereinafter pandora_db.pl is included in the package Pandora FMS server.
This tool performs all maintenance database automatically and is essential for the proper
functioning of Pandora FMS so be sure it works properly. Its functions are:
• Delete old data.
• Compact existing data, interpolated at various intervals, so that graphics are the same but
the space needed for storage is much lower (this is one reason why Pandora FMS is capable
of processing such information).
• Check the consistency of the database for nonexisting modules, or modules which are not
used because they can not be initiated (these modules appear in print as uninitialized
modules ).
• Eliminates the daily information contact the agent. Pandora FMS does not need more than
historical 24hr contact agent, and if it builds up, slows down in the access to the database.
• The enterprise version, moving all the old data to the standby database as historic.
This task should be performed every night, and it is very important to do it, taking time to
understand and fixing the cron task. The installation should have been programmed correctly, but
you should check that this has been done. This chapter explains how program it manually, so you
can verify whether the installation on your system is working properly.
To install this tool on standard Linux systems, we recommend the following procedure:
• Create a new file called /etc/cron.daily/pandora_db that contains following lines:
#!/bin/bash
/usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf

• Alter permissions of file:
chmod 750 /etc/cron.daily/pandora_db

• Change ownership
chmod root:root /etc/cron.daily/pandora_db
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• Reload cron configuration
/etc/init.d/cron reload

From now on, every night it will run the maintenance tool database Pandora FMS, ensuring that the
database is always in optimum condition.
Finally, to ensure that you have left everything up correctly, or to ensure that the system, after
installing the tool has been programmed correctly, manually run it once:
/etc/cron.daily/pandora_db

It should show a message like this (perhaps with less information, depending on their level of
verbosity in the configuration file of Pandora FMS):
Pandora FMS DB Tool 3.0-dev PS090930 Copyright (c) 2004-2008 Artica ST
This program is Free Software, licensed under the terms of GPL License v2
You can download latest versions and documentation at http://www.pandorafms.org
Pandora DB now initialized and running (PURGE=60 days, COMPACT=15 days, STEP=1) ...
Starting at 2009/10/10 02:02:18
[PURGE] Deleting old event data (More than 60 days)...
[PURGE] Deleting old data...
[PURGE] Delete old data (string) ...
[PURGE] Delete pending deleted modules (data table)...
[PURGE] Delete pending deleted modules (data string table)...
[PURGE] Delete pending deleted modules (data inc table)...
[PURGE] Delete pending deleted modules (status, module table)...
[PURGE] Delete old session data
[PURGE] Delete old data from SNMP Traps
[PURGE] Deleting old access data (More than 24hr)
[CHECKDB] Deleting non-init data...
[CHECKDB] Checking database consistency (Missing status)...
[CHECKDB] Checking database consistency (Missing module)...
[CHECKDB] Deleting non-existing module 1189 in state table
[CHECKDB] Deleting non-existing module 1190 in state table
[COMPACT] Compacting data until 2009092502:02:18
Ending at 2009/10/10 02:02:31

38.2. Manual Execution of Maintenance Tool
It is possible to execute manually the maintenance tool once the script has been created. Its use is
very easy. From a shell console, execute:

In installed systems this could take hours. It is recommended to leave the process in
second level

/usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf
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To execute manually the maintenance tool and leave it in second level, execute:
nohup /usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf

The process will take some time until it load throughly in second level. After, you could close the
shell console window without problems, while the process will continue executing.

In some installations the tool directory could change. The most common one
is:
/usr/share/pandora_server/util/

In Pandora FMS previous versions, it could be find at:
/usr/share/pandora/util/

It is very important that you make sure to use the current version of the tool, and not the one from
a previous version. If you execute the program without arguments, it will show the tool version at
the head of the message.

38.3. Database Backup
A simple command mysqldump, will do a dump of the database contents.To restore data it will be
necessary an empty database with the same name that the original one (usually Pandora).
Doing the Backup
mysqldump -u root -p pandora > /backup/pandoradb_backup.sql

Restore the Backup
mysql -u root -p
create database pandora;
use pandora;
source /backup/pandoradb_backup.sql

Probably, it will be also necessary to create new permissions to the console user:
grant all privileges on pandora.* to pandora@localhost identified by 'mypassword';

If you want to do a complete backup of the system, do not forget to do a backup of the whole
directory /etc/pandora, to keep the information of the configuration of the local agents and the
servers.
It is important to emphasize that this ONLY do a backup/restoration of the database files.
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38.4. Backup and Complete Recovery of Pandora FMS
There is an script in the Pandora FMS server distribution that is useful to do a backup and a
complete restoration of all Pandora FMS.This script is though to do copies and restoration in
systems where the server and the console are located in the same machine. If in your environment
there are several components, then you should use the tool with the most adequate parameters for
its use or modify them so they could be adapted to their circumstances.
In order it could do its tasks, this script needs to be executed as root.
This script is located at:
/usr/share/pandora_server/util/pandora_backup.sh

If we execute it without parameters, it will give us some help:
Pandora FMS Command line backup tool. http://www.pandorafms.org
(c) 2009 Sancho Lerena <slerena@gmail.com>, Artica Soluciones Tecnologicas
Syntax:
-c
-d
-s
-f
-q
-b

Path to Pandora FMS console, p.e: /srv/www/htdocs/pandora_console
Destination path for backup file. p.e: /tmp
Source filename for backup restore. p.e: /tmp/pandorafms
Restore also files
Quiet. No output message (used for scripts/cron)
No database backup/restore

Please BE SURE TO USE RESTORE (-s) option. This will OVERWRITE ALL your
PandoraFMS install, including files, configuration and data. Please backup first!

This script is designed to do security copies and restoration of the following components:
•
•
•
•

Server Configuration File(s).
Files waiting for execution, and also agent remote configuration files.
Complete DB.
Complete WEB Console.

Origin and Destination Options of the Copy
This script obtains the credentials to have access to the DB directly from the WEB console
configuration. Is because of this that you should go, with the cparameter the complete path to the
WEB console. This same parameter is used also to show it where it will find the WEB console to do
its backup.
The backup destination is specified with the d parameter. In this path, it will leave the backup file
compressed, with a name similar to pandorafms_backup_xxxxxxx.tar.gz.
The source origin of the restoration is the complete name and path of the backup generated file by
this same tool.
File Restoration, not only Data Restoration
The f option also allows to restore the files (overwriting the current ones) of a security copy, not
restoring the data from the database. As overwriting the current configuration files could have
serious consequences, it is necessary to use f if we want to do a backup recovery and we want to it
restore all the Pandora files (Console and Server).
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File Restoration, without Data
Same as with the previous option, we could restore only the files, without dumping the data. To do
it, use the boption.
Data Restoration, without Files
It is the default option. For doing this, you will not have to use neither the b option nor the f
option.

38.4.1. Examples of Use
Create backup
Execute as root:
/usr/share/pandora_server/util/pandora_backup.sh -c /var/www/pandora3 -d /tmp/

It will return something similar to this:
Backup completed and placed in /tmp//pandorafms_backup_2009-10-10-01-35-31.tar.gz

This means that the backup is at /tmp//pandorafms_backup_20091010013531.tar.gz
Restoring Backup
To restore the backup in an automatic way, you are supposed to have a console with the
authentication credentials on the DDBB correctly defined.
Execute as root:
/usr/share/pandora_server/util/pandora_backup.sh -c /var/www/pandora3_broken/ -s
/tmp/pandorafms_backup_2009-10-10-01-35-31.tar.gz

It will give back something similar to:
Detected Pandora FMS backup at /tmp/pandorafms_backup_2009-10-10-01-35-31.tar.gz,
please wait...
Dropping current database
Restoring backup database
Restoring files and configuration
Done. Backup in /tmp/pandorafms_backup_2009-10-10-01-35-31.tar.gz restored

Restoring Backup in case of disaster
If you have lost the Pandora FMS console but you have a backup generated by this tool,then, first
you will have to restore the console directory. For it, decompress manually its backup:
cd /tmp
tar xvzf pandorafms_backup_2009-10-10-0

This will unpack your WEB console complete directory in /tmp. In the case of the generated backup
of the previous example, it creates a directory named:
/tmp/var/www/pandora3/
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Copy the content of all this directory to to your web publication directory, that could change
depending on the distribution you use:
cp -R var/www/pandora3 /var/www

Then restore the backup as usual.

38.5. Manual startup/shutdown for Pandora FMS servers
To start and / or stop the server manually Pandora FMS is running the following in a console shell':
Stop daemon:
/etc/init.d/pandora_server stop

Start daemon:
/etc/init.d/pandora_server start

Restart daemon:
/etc/init.d/pandora_server restart

38.6. Watchdog implementation for Pandora FMS
In the repository there is a small script that is used as a "watchdog" (Watchdog). This script
performs a monitoring Pandora (who monitors who monitored?). Thus we can perform a recovery
operation (trying to lift Pandora), and if that fails, we can tell the event.

38.6.1. pandora_watchdog.sh
#!/bin/bash
# Copyright (c) 2005-2012 Artica ST
# Author: Sancho Lerena <slerena@artica.es> 2009
# Licence: GPL2
#
# daemon_watchdog
#
# Generic watchdog to detect if a daemon is running. If cannot restart, execute
# a custom-user defined command to notify daemon is down and continues in
# standby (without notifying / checking) until daemon is alive again.
# Default configuration is for Pandora FMS Server daemon
# =====================================================================
# Configuration begins here. Please use "" if data contain blank spaces
export DAEMON_WATCHDOG=pandora_watchdog.sh
# DAEMON_WATCHDOG: Name of this script. Used to check if its running already
export DAEMON_CHECK="/usr/bin/pandora_server /etc/pandora/pandora_server.conf"
# DAEMON_CHECK: Daemon monitored, please use full path and parameters like
#
are shown doing a ps aux of ps -Alf
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export DAEMON_RESTART="/etc/init.d/pandora_server restart"
# DAEMON_RESTART: Command to try to restart the daemon
export DAEMON_DEADWAIT=90
# DAEMON_DEADWAIT: Time this script checks after detect that
#
daemon is down before to consider is really down.
export DAEMON_ALERT="/usr/bin/pandora_alert"
# DAEMON_ALERT: Command/Script executed if after detecting daemon is down,
#
and waiting DAEMON_DEADWAIT, and daemon continues down.
export DAEMON_LOOP=7
# DAEMON_LOOP: Interval within daemon_wathdog checks if daemon is alive.
#
DO NOT use values under 3-5 seconds or could be CPU consuming.
#
NEVER NEVER NEVER use 0 value or gets 100% CPU!.
# Configuration stop here
# =====================================================================
# Check if another instance of this script
RUNNING_CHECK=`ps aux | grep "$DAEMON_WATCHDOG" | grep -v grep |wc -l`
if [ $RUNNING_CHECK -gt 2 ]
then
echo "Aborting, seems that there are more '$DAEMON_WATCHDOG' running in this
system"
logger $DAEMON_WATCHDOG aborted execution because another watchdog seems to
be running
exit -1
fi
# This value always must be 0 at start. Do not alter
export DAEMON_STANDBY=0
# This function replace pidof, not working in the
distros
function pidof_daemon () (
# This sets COLUMNS to XXX chars, because
# in a "strech" term, ps aux don't report
# characters and this will not work.
COLUMNS=300
DAEMON_PID=`ps aux | grep "$DAEMON_CHECK"
'{ print $2 }'`
echo $DAEMON_PID
)

same way in different linux
if command is run
more than COLUMNS
| grep -v grep | tail -1 | awk

# Main script
if [ ! -f `echo $DAEMON_CHECK | awk '{ print $1 }'` ]
then
echo "Daemon you want to check is not present in the system. Aborting
watchdog"
exit
fi
while [ 1 ]
do
DAEMON_PID=`pidof_daemon`
if [ -z "$DAEMON_PID" ]
then
echo "Checkpoint #1 $DAEMON_PID "
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if [ $DAEMON_STANDBY == 0 ]
then
# Daemon down, first detection
# Restart it !
logger $DAEMON_WATCHDOG restarting $DAEMON_CHECK
$DAEMON_RESTART 2> /dev/null > /dev/null
# Just WAIT another DAEMON_DEADWAIT before consider it DEAD
echo "Going to DAEMON_DEADEWAIT"
sleep $DAEMON_DEADWAIT
DAEMON_PID=`pidof_daemon`
if [ -z "$DAEMON_PID" ]
then
# Is dead and can't be restarted properly. Execute
alert
echo "I cannot startup again the process"
logger $DAEMON_WATCHDOG $DAEMON_CHECK is dead,
alerting !
$DAEMON_ALERT

2> /dev/null > /dev/null

# Watchdog process puts in STANDBY mode until
process get alive again
logger $DAEMON_WATCHDOG "Entering in Stabdby mode"
DAEMON_STANDBY=1
fi
fi
else
echo "Checkpoint #1B $DAEMON_PID "
DAEMON_STANDBY=0
fi
sleep $DAEMON_LOOP
done

38.6.2. /usr/bin/pandora_alert
This is the script that acts when the watchdog process cannot start the process that monitors
(pandora). In our case, besides alert by SMS, it disables Tentacle.
There will be given rights with chmod 750 / usr / bin / pandora_alert

#!/bin/bash
sendsms +34458474843 "Pandora FMS Server stopped and can't be started"
/etc/init.d/tentacle_serverd stop
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38.6.3. Watchdog Startup
If you have copied pandora_watchdog.sh to /usr/bin, the manual way to start the wathdog will be:
nohup /usr/bin/pandora_watchdog.sh &

38.6.4. Remarks
Having a watchdog running on the system can cause unpleasant consequences if we do not consider
that there is a watchdog. If for example, we want to make a Pandora to disconnect maintenance,
the watchdog will automatically rise again, so we will go "crazy" if we do not stop watchdog first.

38.7. History database
A history database is a database where old module data is moved to make the main Pandora FMS
database more responsive for everyday operations. That data will still be available seamlessly to the
Pandora FMS console when viewing reports, module charts etc.

38.7.1. Setting up a history database
To configure a history database follow these simple steps:
• Create the new history database.
• Create the necessary tables in the new database. You can use the pandoradb.sql script
provided with the Pandora FMS console:
cat pandoradb.sql | mysql -u user -p -D history_db

• In your Pandora FMS console navigate to Setup>History database and enter the host, port,
database name, user and password of the new database.
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Data older than Days days will be moved to the history database in blocks of Step rows, waiting
Delay seconds between one block and the next to avoid overload.

This is an Enterprise feature
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39 OPTIMIZATION AND PROBLEM SOLVING
OF PANDORA FMS
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39.1. Introduction
Pandora FMS server can monitor about 2000 devices.To do that,it is necessary to refine the
configuration of the database.
In this section are also explained some techniques to detect and solve problems of your Pandora
FMS installation.

39.2. Optimizing Pandora FMS
39.2.1. MySQL Optimization for enterprise grade systems
39.2.1.1. General Advises
The first thing you should do if you really want to have a HUGE system with tables bigger than
2GiB and that MySQL recommends, is to use a system of 64Bit.Also, we suggest this: the more RAM
memory and more CPU is used, the better performance.
According with out experience, the RAM memory is more important than the CPU. If you are
thinking about using 1GiB or a lower memory quantity for your SQL system, please think it again.
The minimum for an enterprise system should be 2GiB. One good option for a big system is 4GiB.
Remmember that bigger RAM memory could speed up the key updates through the maintenance of
the key pages more used in the RAM.
Other advise, if you are using transfer tables that are not sure or you have hard disks very big and
you want to avoid long file checking, would be to use a UPS. In this case, it is a good idea to be able
to remove the system in case of failure. For systems where the database is in an specific server, you
should have a look to 1G Ethernet.The latency is as important as the performance.
The disk optimization is very important for databases that are very big: you should cut the
databases and the tables in different disks. In MySQL is possible to use symbolic links for this. Use
different discs for the system and the database and, very important:try to use a hard disk of low
capture, so the application would be compromised by the disk capture velocity, that increases in N
log N when it gets more data.
Under GNU/Linux use hdparmm16 d1 in the disks when starting to prepare the reading and
writing of several sector in an specific time, and also DMA. This could increase the answer time in
550%.Other excellent idea would be to set the disks with async(in a predetermined way) and
noatime, this group does not update the time access to the files in each reading/writting. For any
specific application, it would be a good idea to have a RAM disc for some very specific tables. It
would be an option lightly risky if it is switched off without storing it in a non volatile disk. Please,
consider it carefully.
Use skiplocking (activate in a predetermined way in some systems) if it is possible.This will put
out the external blockade and will give a better performance.
If you start the client and the MySQL in the same machine,use sockets instead of TCP/IP connexions
when connecting with MySQL (this could result in an improvement of the 7.5%). You could do this
without specifying the host name or the localhost when connecting with the MySQL: disauthorize
the star of the binary session an the replicationif it only fires one MySQL host server.
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As a general advice for a better performance, check this two items:
• Don't use binary replication logs if you will not use replication.
• Don't use slowquery or debug logs.
• Check your MySQL configuration files, default values are *SLOW*.
About MySQL Versions

Some people which uses high loaded Pandora FMS servers are using Percona modified MySQL
versions which offers better performance.
MySQL performance is also better in last versions (5.5) and you can get an improvement on
performance about 20% respect 5.0 version.

39.2.1.2. Tools for MySQL configuration check
There are many tools to "optimize" the setup of your MySQL server. Some of them could be very
useful, just to keep a look and be sure you don't pass any important parameter.
MySQL Tuning Primer, from Mattew Montgomery, is a tool (command line) to check your MySQL
performance, and give you a few tips and suggestions to improve it. Check it at
https://bugs.launchpad.net/mysqltuningprimer

39.2.1.3. Disable binary replication
It is enabled by default on most Linux distros. To disable it, edit the my.cnf file, usually in
/etc/my.cnf and comment the following lines:
# log-bin=mysql-bin
# binlog_format=mixed

Comment both lines, and then restart the MySQL Server.

39.2.1.4. Avoiding Disk Flush in Every Transaction
By default, MySQL fix autocommit=1 for each connection. This is not so bad for MyISAM, so what
one person writes is not guaranteed in the disk, but for InnoDB it means that any insert / update /
delete in an InnoDB table will be result in a register on the disk.
So, why would it be bad that it writes on the disk? Nothing at all. It assures that when there's any
commitment, it will be for sure that the data will be there when the database will be restarted after
an accident. The problem is that the DDBB performance is limited by the physical velocity of the
disk. Given that the disk has to write the data in a disk before the writing has been confirmed, this
will take some time.
Even when we consider a searching average time of 9ms for the disk writing, we are being limited
to approximately 67 commits/ sec1, this is very slow. And while the disk is busy trying that the
sector would be written, it's not reading. InnoDB can avoid some of this limitation through the
association of some writing together, but, even with this, the restriction exists.
We can avoid that it writes at the end of each transaction, doing that it uses an "automatic" system
of writing, that writes approximately every second. In case of failure, we could lose the data from
the last second, something more bearable considering that we are trying to gain efficiency. For
doing this, we need to use the following configuration token:
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innodb_flush_log_at_trx_commit = 0

Reference: http://tag1consulting.com/InnoDB_Performance_Tuning

39.2.1.5. Bigger Size for the KeyBuffer
Depending on the system total RAM, it's a very important global parameter, thats speeds up
DELETES and INSERT.
key_buffer = 400M

39.2.1.6. Other important buffers
There are some buffers not configured by default in some MySQL/Linux distributions. Modify these
default parameters (or add it if there are not present) could be very important for the final
performance. It's very important to check if they are present in the my.cnf file, if not, add it, and of
course, change some values (raise a bit if you have lots of RAM).
query_cache_size = 64M
query_cache_limit = 2M
join_buffer_size = 16M

39.2.1.7. Improving InnoDB Concurrency
There is a parameter that can affect Pandora MySQL server performance pretty much. This
parameter is innodb_thread_concurrency. This parameter is used to specify how many "concurrent
threads" can run MySQL. Misconfiguration of this parameter can make it go slower than the default,
so it is especially important to pay attention to several parameters:
• MySQL version. In different versions of MySQL this parameter behaves VERY differently.
• Real number of physical processors.
Here you can read the official MySQL documentation [1].
The recommended value is the number of CPUs (Physical) multiplied by 2 plus the number of disks
where is located InnoDB. In later versions of MySQL (> 5.0.21) the default is 8. A value of 0 would
mean that "opens up so many threads as possible."
Different people [2] [3] have done tests and have found problems with performance on servers with
multiple physical CPUs when using a very high number, with relatively old versions of MySQL
(we're talking 2008).

39.2.1.8. Using a table space for each table
( From the MySQL
tablespaces.html)

manual at

http://dev.mysql.com/doc/refman/5.0/en/innodbmultiple

In MySQL 5.0, it's possible to store each InnoDB table and its index in its own file. This feature is
called "multiple tablespaces" because each table has its own table space.
The use of multiple space tables can be useful for users that want to move specific tables to
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separated physical disks or the ones who wanta restore table back ups without interrupt the use of
the rest of the InnoDB tables.
It's possible to activate multiple table espaces adding this line to the my.cnf Mysqld section
[mysqld]
innodb_file_per_table

After restarting the server, InnoDB will store each new created table in its own file name_tabla.ibd
in the database directory to which the table belongs to. This is similar to the MyISAM store motor
does, but MyISAM divides the table in a tbl_name.MYD data file and the tbl_name.MYI. index file.
For InnoDB data and index are kept together in the .ibd file. The tbl_name.frm file should be
created as usual.
If we take off the innodb_file_per_table line form my.cnf and we restart the server, then InnoDB
will create again the tables in the shared table space files
innodb_file_per_table affect only to the table creation. If you start the server with this option, then
the new tables will be created using.ibd files, but you could still have access to the existing tables in
the shared table space. If you remove the option, then the new tables will be created in the shared
space, but it will be still possible to have access to the tables created in multiple table spaces

39.2.1.9. Using MySQL Table Partitioning
To use MySQL table partitioning, you should also use "multipletablespace" described above.
MySQL 5.1 supports table partitioning, which allows you to split large table into multiple small
logical
subtables.
(See
MySQL
manual
for
more
details:
http://dev.mysql.com/doc/refman/5.1/en/partitioningoverview.html)
If you have large amounts of data in your Pandora FMS database and feel many console operations
which refer to these data (e.g. drawing graph) are quite slow, you will improve their performance
by using table partitioning.
For example, if you want to split tagente_datos table (which typically grow too large) into 100
logical partitions based on module id automatically, run the following query:
ALTER TABLE tagente_datos PARTITION BY HASH(id_agente_modulo) PARTITIONS 100;

This operation may take a long time depending on table size. As an example, it took about one and
half hours to split table which has about 7500 modules' data for 100 days (more than 50,000,000
rows):
mysql> ALTER TABLE tagente_datos
-> PARTITION BY HASH(id_agente_modulo)
-> PARTITIONS 100;
Query OK, 53391880 rows affected (1 hour 35 min 3.41 sec)
Records: 53391880 Duplicates: 0 Warnings: 0

In the case of this table, it took about one seconds to execute following query to partitioned table,
though it took more then 8 minutes for nonpartitinoed one.
SELECT datos,utimestamp FROM tagente_datos WHERE `id_agente_modulo` = '6332' AND
utimestamp > 1322838000 AND utimestamp < 1338390000 ORDER BY utimestamp ASC
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39.2.1.10. DDBB Rebuilding
Partial Rebuilding

The MySQL database management system, same as other SQL engines, such as Oracle (tm) is
degraded with the time due to causes as the data fragmentation produced by the deleting and
continuous insertion in large tables. In large environments with a lot traffic volume, there is a very
easy way to improve the performance and avoid that the performance would be degraded, this is, to
rebuild the DDBB in a periodic way
To do this, you should schedule a service stop, that could last approximately 1 hr.
In this service stop, you should stop the Pandora FMS WEB console and also the server (be careful,
leave the Tentacle server to it could receive data still and these will be processed as soon as the
server would be working again).
Once they have been stopped we do a DDBB dump (Export)
mysqldump -u root -p pandora3 > /tmp/pandora3.sql
Enter password:

We delete the DDBB:
> mysql -u root -p
Enter password:
Welcome to the MySQL monitor. Commands end with ; or \g.
Your MySQL connection id is 3279346
Server version: 5.0.67-Max SUSE MySQL RPM
Type 'help;' or '\h' for help. Type '\c' to clear the buffer.
mysql> drop database pandora3;
Query OK, 87 rows affected (1 min 34.37 sec)

We create the DDBB and do an import of the previous export:
mysql> create database pandora3;
Query OK, 1 row affected (0.01 sec)
mysql> use pandora3;
mysql> source /tmp/pandora3.sql

This could last approximately 1030 minutes, a little more if the system is large and the hardware is
not very powerful. For one system with 1500 agents and approximately 100.000 modules. It's
possible to automatize this process, but, because it's very delicate, the best option is to do this
manually every month or month a a half.
Total Rebuilding

This section affects only to Innodb databases. Pandora FMS is built on Innodb databases.
Unfortunately MySQL is degraded a lot with time, and this affects to the global performance of the
system.There is no other solution that doesn't involve to rebuild all the database schemes from 0,
rebuilding the data binary file that MySQL uses to store all the information and the files used to
rebuild the transactions.
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If you take a look to the /var/lib/mysql directory, you can see that there are three files, that have
always the same name, and that are, depending on the severity of the case, hugh. In my case of
example:
-rw-rw----rw-rw----rw-rw----

1 mysql mysql 4.8G 2012-01-12 14:00 ibdata1
1 mysql mysql 5.0M 2012-01-12 14:00 ib_logfile0
1 mysql mysql 5.0M 2012-01-12 14:00 ib_logfile1

The ibdata1 is the one that store all the system Innobd data. In a very fragmented system, that has
been a lot of time without "rebuilding" or without "installing", these system will be big a little
efficient. The innodb_file_per_table parameter, that we have mentioned before, regulates part of
this performance.
Same way, each database has in the /var/lib/mysql directory, one directory to define its structure.
You should delete them also.
The process is very easy:
1. Dump (via mysqldump) all the schemes to disk:
mysqldump -u root -p -A > all.sql

1.
2.
3.
4.

Stop MySQL.
Delete ibdata1, ib_logfile0, ib_logfile1 and the InnoDB database directories
Restart MySQL.
Import the backup file (all.sql)

mysql -u root -p
mysql> source all.sql;

The system should go much faster now.

39.2.1.11. Optional Indexes
There are some situations when you can optimize the MySQL performance, but sacrificing other
system resources.
This index optimizes speed on graph rendering (a lot), but it uses more disk storage space, and
could have a slightly decrease on INSERT/DELETE operation, due the Index overhead:
ALTER TABLE `pandora`.`tagente_datos` ADD
`id_agente_modulo` , `utimestamp` );

INDEX

`id_agente_modulo_utimestamp`

(

39.2.1.12. Slow queries study
In some systems, depending on the type of information we have, we can find some "slow queries"
that make the system worse off than normal. We can enable logging of this type of queries over a
short period of time (and that hurts the system performance) in order to consider trying to optimize
queries to tables with indexes. To enable this setings, do the following:
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Edit my.cnf and add the following lines:
slow_query_log = 1
long_query_time = 2
slow_query_log_file = / var / log / mysql_slow.log

In the OS:
touch / var / log / mysql_slow.log
chmod 777 / var / log / mysql_slow.log

Restart mysql.

39.2.1.13. Optimizing Specific tables
Other less "drastic" solution to solve the problem with fragmentation is the use of the MYSQL
OPTIMIZE tool to optimize certain tables of Pandora FMS. For it, directly from MySQL, execute:
OPTIMIZE
OPTIMIZE
OPTIMIZE
OPTIMIZE
OPTIMIZE
OPTIMIZE

table
table
table
table
table
table

tagente_datos;
tagente;
tagente_datos_string;
tagent_access;
tagente_modulo;
tagente_estado;

This will improve the performance, and it shouldn't be necessary to fire it more than once per week.
It could be done "IN THE HEAT OF THE MOMENT" while the system is working. In very big
environments the OPTIMIZE could be "blocked" not being an option. In this case the best option is
to rebuild the DDBB.
After doing these operations, you should execute:
FLUSH TABLES;

From the MySQL manual:
For InnoDB tables, OPTIMIZE TABLE is mapped to ALTER TABLE, which rebuilds the table to
update index statistics and free unused space in the clustered index.

39.2.1.14. Configuration Sample #1
This example of configuration uses an example system with 4CPU, 4GiB RAM, and InnoDB tables
for the installation of two databases, both of them with a powerful usage. Consider that the total
sum of obsolete memory, in reserve for each variable, should not be higher than the 80% of the
system total memory. Try to adjust the values for its installation, and have look to the MySQL
registers in the demon that starts.
As a general aspect for evaluating the performance, consider that the following things affect
seriously to the performance:
• DO NOT use binary logs if you are not going to use a MySQL configuration with replication.
• DO Not use logs of queries traceability or slow query logs.
1. Example MySQL config file for large system (4GB, 4 CPU’s)
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[mysqld]
skip-locking
key_buffer = 256M
# Very important to avoid "MySQL has gone away" messages
max_allowed_packet = 32M
table_cache = 2048
sort_buffer_size = 16M
read_buffer_size = 32M
read_rnd_buffer_size = 32M
myisam_sort_buffer_size = 64M
thread_cache_size = 32
query_cache_size = 64M
query_cache_limit = 2M
thread_stack = 192K
join_buffer_size = 8M
max_heap_table_size = 64M
binlog_cache_size = 1M
# Very important if you have several servers / consoles
max_connections
= 500
# OS Buffer to let connections waiting for Mysql thread.
back_log = 100
# Try number of CPU’s*2 for thread_concurrency
thread_concurrency = 8
# Print warnings to the error log file.
log_warnings
# You can set .._buffer_pool_size up to 50 - 80 %
# of RAM but beware of setting memory usage too high
innodb_buffer_pool_size = 2G
innodb_additional_mem_pool_size = 16M
innodb_thread_concurrency = 16
[mysqld_safe]
log-error=/var/log/mysqld.log

39.2.1.15. Configuration Sample #2
Hardware: Xeon Quadcore Processor, 24GB RAM, 4xSAS disks (RAID10) 15k

binlog_cache_size=5M
default_table_type=InnoDB
ft_min_word_len=5
innodb_additional_mem_pool_size=256M
innodb_buffer_pool_size=19G
innodb_data_file_path=ibdata1:100M:autoextend
innodb_file_per_table
innodb_flush_log_at_trx_commit=0
innodb_log_buffer_size=16M
innodb_log_files_in_group=2
innodb_log_file_size=1G
innodb_status_file=0
innodb_thread_concurrency=1
innodb_flush_method = O_DIRECT
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innodb_io_capacity=800
innodb_write_io_threads = 32
innodb_read_io_threads = 32
join_buffer_size=1M
max_allowed_packet=16M
max_connections=4000
max_heap_table_size=64M
max_prepared_stmt_count=1000000
query_cache_size=0
skip_grant_tables
skip_locking
sort_buffer_size=64K
table_cache = 65536
thread_cache_size=16
thread_concurrency=16
thread_stack=196K
tmp_table_size=64M
transaction_isolation=REPEATABLE-READ
local-infile=0
key_buffer = 256M
key_buffer_size = 16M
max_allowed_packet = 16M
table_cache = 65536
net_buffer_length = 8K
read_buffer_size = 4M
sort_buffer_size = 64M
myisam_sort_buffer_size = 64M
thread_cache_size = 128
max_heap_table_size = 32M
read_rnd_buffer_size = 32M
bulk_insert_buffer_size = 8M
query_cache_limit = 1M
query_cache_size = 64M
query_cache_type = 1
query_prealloc_size = 512K
query_alloc_block_size = 1M
low_priority_updates = 1
open_files_limit
= 50000
expire-logs-days
= 14
log-bin=/var/lib/mysql/log-bin/mysql-bin
relay-log=/var/lib/mysql/log-bin/mysql-relay-bin
innodb_data_home_dir = /var/lib/mysql
innodb_log_group_home_dir = /var/lib/mysql
innodb_log_arch_dir = /var/lib/mysql
slave_net_timeout = 10
innodb_lock_wait_timeout = 50

39.2.1.16. External references
References:
• http://dev.mysql.com/techresources/presentations/presentationoscon2000
20000719/index.html
• http://jeremy.zawodny.com/mysql/mysqloptimization.html

39.2.2. Measuring Pandora FMS for High Capacity
This section describes different methods in order to configure Pandora FMS in a high capacity
environment. It also describes different tools for doing load tests, useful to fix the environment to
the highest level of process.
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Pandora FMS has been configured to bear a load of 2000 agents in systems where database, console
and server are in the same machine. The recommended number is around 1200/1500 agents by
system, but this number changes a lot depending on if they are XML agents, remote modules, with
high or low intervals, with systems of high capacity or low memory. All these things changes a lot
the nº of agents that one system is able to manage in an efficient way.

39.2.3. Use of RAM (tmpfs) disks for the incoming directory
In some environments of high capacity for the XML processing coming from agents, the directory
directorio /var/spool/pandora/data_ has a high traffic and to have this file system available in a
memory storage can improve the XML processing performance in a 25%.
To create a partition in /var/spool/pandora/data_in_RAM, it will be enough with the command:
mount -t tmpfs -o size=100M,nr_inodes=10k,mode=770 tmpfs
/var/spool/pandora/data_in_RAM

It is possible to program in /etc/inittab so as this partition would be created when starting. The end
directory should be exist and be empty.
tmpfs /var/spool/pandora/data_in_RAM tmpfs size=100M,nr_inodes=10k,mode=770 0 0

Of course, as it is limited to 100MB, if the system is filled it will stop working properly. If you are
working with policies or remote configurations the directories that usually hang from /data_in (file
collections, md5, conf and others) should be located as links to their real paths in the disk, with an
structure based in the following commands:
mv /var/spool/pandora/data_in /var/spool/pandora/data_in_old
ln -s /var/spool/pandora/data_in /var/spool/pandora/data_in_RAM
ln -s /var/spool/pandora/data_in_old/md5 /var/spool/pandora/data_in_RAM/md5
ln -s /var/spool/pandora/data_in_old/conf /var/spool/pandora/data_in_RAM/conf
ln -s /var/spool/pandora/data_in_old/collections
/var/spool/pandora/data_in_RAM/collections

39.2.4. Many Request in the Same System
An special case to implement a bigger processing power in servers with several processors (of two
or more physical cores) consist of implementing several instances of Pandora Specific servers in the
same machine, some that has nothing to do with increasing the nº of threads of the server, so due to
the design of the Linux Kernel and of the Perl virtual machine, it is possible to take the most of the
cores with several processes than with more threads in the same process
You can use this technique when Pandora FMS is not able of processing all the information without
delaying to much. This options means that you should have to install another Pandora FMS server
with other incoming entry directory. Of course it will have its own pandora_server.conf and a
different server name. You should also do some changes in the server firing script and other smaller
customizations in the system.
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39.2.5. Example of High Capacity Servers Configuration
For example, for one machine with 16GB of RAM and 4 CPUs that we wanted to optimize for the
Data server maximum processing capacity (XML)

39.2.5.1. my.cnf
(Only the most important parameters are shown)
key_buffer
= 1G
innodb_flush_log_at_trx_commit = 0
innodb_file_per_table
skip-locking
innodb_thread_concurrency = 16
max_allowed_packet
= 160M
query_cache_limit
= 50M
query_cache_size
= 360M
innodb_buffer_pool_size=9000M
innodb_additional_mem_pool_size=800M
innodb_log_file_size=2500M
innodb_log_buffer_size=80M
innodb_lock_wait_timeout=50

39.2.5.2. pandora_server.conf
(Only the most important parameters are shown)
verbose 1
server_threshold 15
dataserver_threads 5
max_queue_files 1000

You should consider these things:
• A very high nº of threads(+5) only benefits to the processes with large E/S queues, like the
network or the plugin server, just in case that the dataserver, which is always a processing
one, could even penalize the performance. This is the reason why we use 5 here. In systems
with an slow DB, we should use even less threads. Test different combinations between 1
and 10. In case of optimizing the system for the networkserver, the nº would be higher,
between 10 and 30.
• A high threshold server(15) does that the DB suffer less, and the increase in the maximum
nº of files processed makes that any time that the server "looks for files" it fill the buffers.
These two elements of the configuration are linked. In the case of optimizing the network
server, it would be advisable to low the server threshold to 5 or 10.
• Some parameters of the configuration could affect a lot to Pandora FMS performance, such
as the parameter agent_access (configurable from the console).

39.2.6. Capacity analysis Tools(Capacity)
Pandora FMS has several tools that can help you to measure properly its hardware and software for
the data amount that it expects to obtain.One of them is useful to "attack" directly the database with
fictitious data (dbstress) and the other generates fictitious XML files(xml_stress)
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39.2.6.1. Pandora FMS XML Stress
This is an small script that generates XML data files like the ones sent by Pandora FMS agents. It's
placed on /usr/share/pandora_server/util/pandora_xml_stress.pl
The scripts reads agent names from a text file and generates XML data files for each agent according
to a configuration file, where modules are defined as templates.
Modules are filled with random data. An initial value and the probability of the module data
changing may be specified.
Run the script like this:
./pandora_xml_stress.pl <configuration file>

Sample configuration file:
# Maximum number of threads, by default 10.
max_threads 10
# File containing a list of agent names (one per line).
agent_file agent_names.txt
# Directory where XML data files will be placed, by default /tmp.
temporal /var/spool/pandora/data_in
# Pandora FMS XML Stress log file, logs to stdout by default.
log_file pandora_xml_stress.log
# XML version, by default 1.0.
xml_version 1.0
# XML encoding, by default ISO-8859-1.
encoding ISO-8859-1
# Operating system (shared by all agents), by default Linux.
os_name Linux
# Operating system version (shared by all agents), by default 2.6.
os_version 2.6
# Agent interval, by default 300.
agent_interval 300
# Data file generation start date, by default now.
time_from 2009-06-01 00:00:00
# Data file generation end date, by default now.
time_to 2009-06-05 00:00:00
# Delay after generating the first data file for each agent to avoid
# race conditions when auto-creating the agent, by default 2.
startup_delay 2
# Address of the Tentacle server where XML files will be sent (optional).
# server_ip 192.168.50.1
# Port of the Tentacle server, by default 41121.
# server_port 41121
# Module definitions. Similar to pandora_agent.conf.
module_begin
module_name Module 1
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module_type generic_data
module_description A long description.
module_max 100
module_min 10
module_exec type=RANDOM;variation=60;min=20;max=80
module_end
module_begin
module_name Module 2
module_type generic_data
module_description A long description.
module_max 80
module_min 20
module_exec type=SCATTER;prob=1;avg=40;min=0;max=80
module_end
module_begin
module_name Module 3
module_type generic_data
module_description A long description.
module_max 80
module_min 20
module_exec type=CURVE;min=20;max=80;time_wave_length=3600;time_offset=0
module_end

module_begin
module_name Module 4
module_type generic_data_string
module_description A long description.
module_max 100
module_min 10
module_exec type=RANDOM;variation=60;min=20;max=80
module_end
module_begin
module_name Module_3
module_type generic_proc
module_descripcion Module 3 description.
# Initial data.
module_data 1
module_end

Send and Receive the Agent Local Configuration

If you start in your "pandora_xml_stress.conf" the configuration value "get_and_send_agent_conf" to
1, you can do that the test load agents will act as normal agents, so they send their configuration
file and also the md5. And from Pandora Console Enterprise you can change the remote
configuration in orther that in next executions of the pandora_xml_stress it uses the customized
configuration from the Pandora Console Enterprise instead of doing it through the
"pandora_xml_stress.conf" definition.
Besides this, you can configure where to store in a local way the configuration of your testing agents
with the "directory_confs" configuration token in the file "pandora_xml_stress.conf".
Configuration File

• max_threads Number of threads where the script will be executed.This improves the E/S.
740

Optimizing Pandora FMS

•
•
•
•
•
•
•
•
•
•
•

•
•
•
•
•
•
•

agent_file Path of the name list file path, separated by new line
temporal Path of the directory where the fictitious XML data files are generated.
log_file Path of the log where it will inform about its execution script.
xml_version Version of the XML data file (by default 1.0)
encoding XML data files encoding (by default ISO88591).
os_name Name of the fictitious agent Operative System (by default Linux).
os_version Version of the fictitious agents Operative System (by default 2.6)
agent_interval Interval of the fictitious agents in seconds (by default 300).
time_from Time from which fictitious XML data files are generated, in format" YEAR
MONTHDAY HOUR:MIN:SEC"
time_to Time until which fictitious XML data files are generated, in format YEARMONTH
DAY HOUR:MIN:SEC"
get_and_send_agent_conf Boolean value 0 or 1. When it is active the fictitious agents will
try to download by remote configuration a more updated version of the standard
configuration file of an agent. And from the Pandora FMS Enterprise console you can edit
them.
startup_delay Time numeric value in seconds before each agent starts to generate the files.
It is used to avoid race conditions.
timezone_offset Numeric value of the time zone offset
timezone_offset_range Numeric value that is useful to generate the timezone in this range
in a random way.
latitude_base Numeric value. It's the latitude where the fictitious agents will be shown.
longitude_base Numeric value. It's the longitude where the fictitious agents will be shown.
altitude_base Numeric value. It's the altitude where the fictitious agents will be shown.
position_radius Numeric value. It's the range around. The circumference with this radius
where the fictitious agent is shown in a random way.

Module Definition

The definition of one module in the script configuration file and if you have activated the remote
configuration will also be the same. It is:

module_begin
module_name <nombre_del_módulo>
module_type <tipo_de_dato_módulo>
module_description <descripción>
module_exec
type=<tipo_generación_xml_stress>;<otras_opciones_separadas_por_punto_y_coma>
module_unit <unidades>
module_end

And you can configure each of them as:
• tipo_generación_xml_stress:Can have the values RANDOM,SCATTER,CURVE.
• Others: See the Pandora FMS modules configuration documentation
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39.2.6.1.1.1.

RANDOM

These have the following options:
• variation probability in % that it would change regarding the previous value.
• min Minimum value that the the value could have.
• max Maximum value that the the value could have.
Numeric
Generates random numeric values between the ranges value min and the value max
Boleans
Generates values between 0 and 1.
String
Generates a string of length between values minand max. The characters are random between A
and Z and includes capital and lower case letters and also numeric ciphers.
39.2.6.1.1.2.

SCATTER

It is only useful for numeric data, and the generated graphics are similar to the ones of a heartbeat,
that is, a normal value, and from time to time a "beat".
It has the following options:
•
•
•
•

min Minimum value that the value could have.
max Maximum value that the value could have.
prob Probability in % that it generates a "beat".
avg Average value that it should show by default if there isn't any "beat".

39.2.6.1.1.3.

CURVE

Generates module data following a trigonometric curve. They have the following options:
•
•
•
•

min Minimum value that the value could have
max Maximum value that the value could have
time_wave_length Numeric value in seconds of the duration of the "crest" of the wave
time_offset Numeric value in seconds from the starting of the wave from time zero with
module value zero (similar to the sine graph)
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Notes of Interest

Please, consider that the amount of generated files is the link between the starting time
(time_from)and the final date (time_to) and the interval setted in the agent (agent_interval),so is
there are long periods of time or small intervals, the script will generate lot of XML data files.

39.2.6.2. How to measure the Data server Processing Capacity
There is an small script called "pandora_count.sh" that is in the util/directory in the Pandora FMS
server directory. This script is used to measure the processing rate of XML files by the data server,
and it uses as reference all the files pending of processing at /var/spool/pandora/data_in so to can
use it you need thousand of packages pending of being processed (or to generate them with the tool
mentioned before). This script takes into account only the packages that are now, and it take them
away from the packages that were 10 seconds ago, then divide the result by 10, and these will be
the files that have been processed in the last 10 seconds, showing the rate per second. It's a
rudimentary solution but it serves to fix the server configuration.

39.2.6.3. Pandora FMS DB Stress
This is an small tool to test you database performance.It could also be used to «pregenerate »
periodical or random data (using trigonometric functions) and fill in fictitious modules.
you should create an agent and to assign it modules for automatic data injection with this tool. The
names should be these ones:
• random: to generate random data
• curve: to generate a coincidence curve using trigonometric functions. useful to use the
interpolating work with different intervals, etc.
• boolean: To generate random boolean data
This way it's possible to use any name that contains the words «random», «curve» and/or «boolean».
For example:
• random_1
• curve_other
You will only could choose the «data_server» module kind
Pandora FMS DB Stress Fine Adjustment

This tool is preconfigured in order to search, in all agents, the modules name «random», «curve» o
«boolean»,that use one interval between 300 seconds and 30 days.
If you want to modify this performance, you should edit the pandora_dbstress script and change
some variables at the start of the file:
# Configure here target (AGENT_ID for Stress)
my $target_module = -1; # -1 for all modules of that agent
my $target_agent = -1;
my $target_interval = 300;
my $target_days = 30;

The first line of variable corresponding withtarget_module, should be fix for a fix module or 1 to
process all the objectives that match. The second line of variable match with target_agent, for an
specific agent. The third line match with target_interval,defined in seconds and that represent the
module predefined periodical interval. The fourth line is target_daysand represent the number of
days in the past since the date , in the current timestamp.
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39.3. Problem Solving and Diagnostic tools in Pandora FMS
Sometimes, the user have problems and Pandora Developers can't help without more information
about the user systems. In 3.0 version we have created two small tools to help solving user
problems:

39.3.1. pandora_diag.php
This is a web diagnostic tool. You need to have an active session in order to use this resource. It
gives information about Pandora FMS database usage, and some setup values and version. This tool
is accessible from your console using the following URL:
http://localhost/pandora_console/extras/pandora_diag.php
If you have your PandoraFMS console in other URL just add /extras/pandora_diag.php to your home
url.
Sample of output
Pandora FMS Build
PC090512
Pandora FMS Version
v3.0-dev
Homedir /var/www/pandora_console
HomeUrl /pandora_console
tagente 2385
tagent_access
20049
tagente_datos
4342323
tusuario
19
Update Key
PANDORA-FREE
Updating code path
/var/www/pandora_console
Keygen path
/usr/share/pandora/util/keygen
Current Update #
0

This tool can be launched also from command line, and you need to pass the full path to your
Pandora FMS console homedir, for example:
php /var/www/pandora_console/extras/pandora_diag.php /var/www/pandora_console

And the output of this script will be printed on the standard console output.

39.3.2. pandora_diagnostic.sh
Is a tool placed on /usr/share/pandora_server/util and it gives a lot of information about the system:
•
•
•
•
•
•
•
•
•
•

CPU information
Uptime and CPU avgload
Memory information
Kernel/Release information.
A fully mysql config file dump.
A fully PandoraFMS Server config file dump (filtering passwords).
Pandora FMS logs information (but not the full log!).
Disk information
Pandora FMS processes information
A fully kernel log information (dmesg).
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All information is generated in a .txt file so users can sent this information to anyone who wants to
help them, for example in Pandora FMS user forums or in the Pandora FMS public mailing lists.
This information should not have any kind of confidential information. Note that you probably want
to run with root privileges if you want to get pandora_server.conf and my.cnf files parsed.
This is an example of execution:
$ ./pandora_diagnostic.sh
Pandora FMS Diagnostic Script v1.0 (c) ArticaST 2009
http://pandorafms.org. This script is licensed under GPL2 terms
Please wait while this script is collecting data
Output file with all information is in '/tmp/pandora_diag.20090601_164511.data'

And here there are some parts of file output
Information gathered at 20090601_164511
Linux raz0r 2.6.28-12-generic #43-Ubuntu SMP Fri May 1 19:27:06 UTC 2009 i686
GNU/Linux
=========================================================================
----------------------------------------------------------------CPUINFO
----------------------------------------------------------------processor
: 0
vendor_id
: GenuineIntel
cpu family
: 6
.
.
----------------------------------------------------------------Other System Parameters
----------------------------------------------------------------Uptime: 16:45:11 up 5:27, 2 users, load average: 0.11, 0.12, 0.09
----------------------------------------------------------------PROC INFO (Pandora)
----------------------------------------------------------------slerena 11875 0.9 2.1 114436 44336 pts/0
Sl
13:14
1:56 gedit
pandora_diagnostic.sh
slerena 24357 0.0 0.0
4452 1524 pts/0
S+
16:45
0:00 /bin/bash
./pandora_diagnostic.sh
----------------------------------------------------------------MySQL Configuration file
----------------------------------------------------------------#
# The MySQL database server configuration file.
#
# You can copy this to one of:
# - "/etc/mysql/my.cnf" to set global options,
.
.
.
----------------------------------------------------------------Pandora FMS Logfiles information
----------------------------------------------------------------total 3032
drwxr-xrwx 2 root
root
4096 2009-04-30 20:00 .
drwxr-xr-x 17 root
root
4096 2009-06-01 11:24 ..
-rw-r----- 1 root
sys
377322 2009-04-06 00:12 pandora_agent.log
-rw-r--r-- 1 root
root
0 2009-04-06 00:15 pandora_agent.log.err
-rw-r--r-- 1 root
root
13945 2009-04-02 21:47 pandora_alert.log
-rw-r--r-- 1 slerena slerena 2595426 2009-04-30 20:02 pandora_server.error
-rw-rw-rw- 1 root
root
9898 2009-04-30 20:02 pandora_server.log
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-rw-rw-rw- 1 root
root
65542 2009-04-30 20:00 pandora_server.log.old
-rw-r--r-- 1 root
root
94 2009-04-06 00:19 pandora_snmptrap.log
-rw-rw-rw- 1 root
root
4 2009-04-03 14:16 pandora_snmptrap.log.index
----------------------------------------------------------------System disk
----------------------------------------------------------------S.ficheros
Tamaño Usado Disp Uso% Montado en
/dev/sda6
91G
49G
37G 58% /
tmpfs
1003M
0 1003M
0% /lib/init/rw
varrun
1003M 260K 1002M
1% /var/run
varlock
1003M
0 1003M
0% /var/lock
udev
1003M 184K 1002M
1% /dev
tmpfs
1003M 480K 1002M
1% /dev/shm
lrm
1003M 2,4M 1000M
1% /lib/modules/2.6.28-12-generic/volatile
----------------------------------------------------------------Vmstat (5 execs)
----------------------------------------------------------------procs -----------memory---------- ---swap-- -----io---- -system-- ----cpu---r b
swpd
free
buff cache
si
so
bi
bo
in
cs us sy id wa
2 0
0 684840 119888 619624
0
0
15
10 258 474 3 1 95 0
0 0
0 684768 119888 619640
0
0
0
0 265 391 0 0 100 0
0 0
0 684768 119892 619636
0
0
0
56 249 325 1 1 99 0
0 0
0 684768 119892 619640
0
0
0
0 329 580 0 0 100 0
0 0
0 684776 119892 619640
0
0
0
0 385 1382 1 0 99 0
----------------------------------------------------------------System dmesg
----------------------------------------------------------------[
0.000000] BIOS EBDA/lowmem at: 0009f000/0009f000
[
0.000000] Initializing cgroup subsys cpuset
[
0.000000] Initializing cgroup subsys cpu
[
0.000000] Linux version 2.6.28-12-generic (buildd@rothera) (gcc version 4.3.3
(Ubuntu 4.3.3-5ubuntu4) )
#43-Ubuntu SMP Fri May 1
19:27:06 UTC 2009 (Ubuntu 2.6.28-12.43-generic)
.
.
----------------------------------------------------------------END OF FILE
----------------------------------------------------------------560e8fa02818916d4abb59bb50d91f6a /tmp/pandora_diag.20090601_164511.data
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40 PANDORA FMS ENGINEERING
DETAILS
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In this annex we are going to explain some of the Pandora FMS special features and design
principles.

40.1. Pandora FMS Database Design
Pandora FMS first versions, from the 0.83 to the 1.1, were based in a very simple idea: one data,
one insertion in the database. This was very easy to develop and allowed the program to do very
simple searches, insertions and other operations.
These had a lot of advantages and a big problem: scalability. This system has an specific limit in
maximum number of modules that could support, not having to implement difficult mechanisms of
clustering that would allow more load, and even with this, with certain number of data,the
functioning was not so quick (> 5 millions of elements).
The solutions based in MySQL cluster are not easy, and always add some minor problems.Neither
they offer even a long term solution.
Pandora FMS versions 1.3 and higher, implement a data compression in real time for each insertion.
They also allow to do a data compression based on interpolation. They also implement &mdasdh, as
in previous versions, and an automatic deleting of data from an specific date.
The new data processing system keeps only «new» data. If a duplicated value enter in the system, it
will not be kept in the database.It is very useful to keep the database reduced. This works for all
Pandora FMS modules:numeric, incremental, boolean,and chain. In the boolean data kind, the
compressing index is very high, so they are data that rarely change.Nevertheless, the «index»
elements are kept every 24 hours, so there is minimum information that is useful as a reference
when compacting the information.
This solves part of the scalability problem reducing the database usage in a 40%70%. There is also
another solution for scalability problems: the total breaking up of components in Pandora FMS, that
allows to balance the data files processing load and the network modules execution in different
servers. Now it it possible to have several Pandora FMS servers(network servers, data or SNMP),
like Pandora FMS Web consoles, and also a database or a high performance cluster (with MySQL5).
The adjustments imply big changes when reading or interpreting data. We have redesign and
implement from zero the graphic motor to could represent data in a quick way with the new data
storage model. With the new version, if an agent could not communicate with Pandora FMS, and
the Pandora FMS server does not receive data from the agent, then this absence of data could not
have a graphic representation. And regarding the module graph, it will be no changes.
You will get a graph with a perfect horizontal line.Pandora FMS, if does not get new values, will
think that there are not, and all things will appear exactly as they were in the last
notification.Similar to the MRTG performance, for example.
To see a graphic example, this image shows the changes for each data, received every 180 seconds.
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This would be the equivalent graphic for the same data, expect a connection failure, from 05:55 to
15:29 approximately.

In Pandora FMS 1.3 a new general graphic for the agent is introduced. It shows its connectivity, and
it shows the access rate from the module agents. This graphic complements the other graphs that
are shown when the agent has activity and is receiving data. This is an example of an agent that is
regularly connected with the server:

If you have peaks (lows) in this graphic, you could have problems or slow connections in the
Pandora FMS agent connectivity with the Pandora FMS server. It is also possible that you could
have connectivity problems from the network server.

40.1.1. Improvements in Index and Other Technical Aspects in the DDBB
We have implemented small improvements in the relational model of the Pandora FMS database.
One of the changes that we have introduced is the indexation by module kinds.In this way, the
access to the information is quicker, so the Pandora FMS logic agent, that is useful to "upload" all
the information about monitoring. It is distributed in small pieces of information that could came
form very different sources. In the new version of Pandora FMS we have planned until four kinds of
new specific servers that will offer a wider variety of information kinds to process.
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We also have added factors such as the numerical representation of time marks (in UNIX format, or
number of seconds from the 1 January 1970), speeds the searches of date ranks, comparisons of
these ones, etc. This work has allowed a considerable improvement in the search times an in the
insertions.

40.1.2. Database Main Tables
Next is shown an ER diagram and also a detailed description of the main tables of Pandora FMS
database.The rest of the tables are also commented briefly.

• taddress: Contains agent additional addresses.
• taddress_agent: Addresses asociated to an agent(rel. taddress/tagente).
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• tagente: Contains the information of Pandora FMS agents.
• id_agente: Agent unique identifier.
• nombre: Name of the agent (case sensitive).
• direccion: Agent address. It is possible to assign additional addresses through
taddress.
• comentarios: Free text.
• id_grupo: Identifier of the group the agent belongs to (ref. tgrupo).
• ultimo_contacto: last date of agent contact, either through a software agent or
through a remote module.
• modo:Way in which the agent runs, 0 normal, 1 training.
• intervalo: agent execution interval. Depending on this interval, the agent will be
showed as out of limits.
• id_os: Agent SO identifier (ref. tconfig_os).
• os_version: SO version (free text).
• agent_version: Agent version (free text). Updated by the software agents.
• `ultimo_contacto_remoto: Last date of contact received by the agent. In case of
software agents, and unlike the last contact, the date is sent by the agent itself.
• disabled: Agent state, enabled (0) or disabled (1).
• id_parent: Identifier of the agent parent (ref. tagente).
• custom_id: Agent customized identifier. Useful to interact with other tools.
• server_name: Name of the server the agent is assigned to.
• cascade_protection: Cascade protection. Disabled at 0. When is at 1 it avoid that he
alerts that are associated to the agent would be fired if a critical alert of the parent of
the agent has been fired. http://www.openideas.infowiki/index /wiki/index.php?
title=Pandora_3.0:Documentation_es:Alertas#Protecci.C3.B3n_en_cascada
• tagente_datos: Data received from each module. If for the same module the last received
data is the same as the immediate previous one it will be not added (but tagente_estado is
updated). The incremental and string type data are kept in different tables.
• tagente_datos_inc: Incremental data type.
• tagente_datos_string: String kind data.
• tagente_estado: Information of the current status of each module.
• id_agente_estado: Identifier.
• id_agente_modulo: Module identifier.(ref. tagente_modulo).
• datos: Value of the last received data.
• timestamp: Data of the last data received (could come from the agent).
• estado: Module status: 0 NORMAL, 1 CRITICAL, 2 WARNING, 3 UNKNOWN.
• id_agente: Agent identifier associated to the module (ref. tagente).
• last_try: Data of the module last successful execution.
• utimestamp:Data of the module last execution in UNIX format.
• current_interval:Module execution intervale in seconds.
• running_by: Name of the server that executed the module.
• last_execution_try: Date of the module execution last try.The execution could have
failed.
• status_changes: Number of status changes that have been occurred. It is used to avoid
continuous
status
changes.
http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:Operacion#FF_Threshold
• last_status: Module previous status.
• tagente_modulo: Module configuration.
• id_agente_modulo: Module unique identifier.
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id_agente: Agent identifier associated to the module(ref. tagente).
id_tipo_modulo: Kind of module (ref. ttipo_modulo).
descripcion: Free text.
nombre: Module name.
max: Module maximum value. Higher data than this value will be consider invalid.
min: Module minimum value. Lower data than this value will be consider invalid.
module_interval: Module execution interval in seconds.
tcp_port: Destination TCP port in network modules and plugin. Name of the column
to read in WMI modules.
tcp_send:Data to send in network modules. Namespace in WMI modules.
tcp_rcv: Expected answer in network modules.
snmp_community:SNMP community in network modules. Filter in WMI modules.
snmp_oid: OID in network modules. WQL Query in WMI modules.
ip_target: Destination address in network modules, plugin and WMI.
id_module_group:Identifier of the group the module belongs to (ref. tmodule_group).
flag: Flag of forced execution. If is at 1 the module will be executed though it would
be not entitled by interval.
id_modulo: Identifier for modules that could not been recognized by its
id_tipo_módulo. 6 for WMI modules, 7 for WEB modules.
disabled: Module status, 0 enabled, 1 disabled.
id_export: Identifier of the export server associated to the module (ref. tserver).
plugin_user: User name in plugin and WMI modules, useragent in Web modules.
plugin_pass: Passwork in plugin modules and WMI, number of reattempts in Web
modules.
plugin_parameter: Additional parameters in plugin modules, configuration of Goliat
task in Web modules.
id_plugin: Identifier of the plugin associate to the module in plugin modules (ref.
tplugin).
post_process: Value with the module data will be multiplied by before being kept.
prediction_module: 1 if it is a prediction module, 0 in any other case.
max_timeout: time to wait in seconds in plugin modules.
custom_id: Module customized identifier. Useful to interact with other tools.
history_data: If it is at 0 module data will not be kept at tagente_datos*, only
tagente_estado will be updated.
min_warning: Minimum value that activates the WARNING status.
max_warning: Maximum value that activates the WARNING status.
min_critical: Minimum value that activates the CRITICAL status.
max_critical: Maximum status that activates the CRITICAL status.
min_ff_event: Number of times that should be a condition of status change before this
change take place. It is is related with tagente_estado.status_changes.
http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:Operacion#FF_Threshold

• delete_pending: If it is at 1 it will be deleted by the maintenance script of
pandora_db.pl database.
• custom_integer_1: When prediction_module = 1 this field is the module id that is
used to predict. When prediction_module = 2 this field is the service id assigned to
the module
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•
•
•
•

custom_integer_2:
custom_string_1:
custom_string_2:
custom_string_3:

• tagent_access: A new entry will be inserted each time that it is received data from an agent
to any of the servers, but never more than one by minute to avoid overload the database. It
could be deactivated setting the agentaccess to 0 in the pandora_server.conf configuration
file.
• talert_snmp: Configuration of SNMP alerts.
• talert_commands: Commands that could be executed from actions associated to an alert
(eg. send mail).
• talert_actions: Command instance associated to one alert (eg. send mail to administrator).
• talert_templates: Alert templates.
• id: Template unique identifier.
• name: Template name.
• description: Description.
• id_alert_action: Identifier of the default action associated to the template.
• field1: Customized field 1(free text).
• field2: Customized field 2(free text).
• field3: Customized field 3 (free text).
• type: kind of alert depending on the shot condition ('regex', 'max_min', 'max', 'min',
'equal', 'not_equal', 'warning', 'critical').
• value: Value for alerts kind regex (free text).
• matches_value: To 1 it inverts the logic of the shot condition.
• max_value: Maximum value for max_min and max alerts.
• min_value: Minimum value for max_min and min alerts.
• time_threshold: Alert interval.
• max_alerts: Maximum number of times that an alert will be fired during an interval.
• min_alerts: Minimum number of times that the shot condition should be shown
during an interval to the alert will be fired.
• time_from: Time from which the alert will be active.
• time_to: Time to which the alert will be active.
• monday: To 1 the alert is active on Mondays.
• tuesday: To 1 the alert will be active on Tuesdays.
• wednesday: To 1 the alert will be active on Wednesdays.
• thursday: To 1 the alert will be active on Thursdays.
• friday: To 1 the alert will be active on Fridays.
• saturday: To 1 the alert will be active on Saturdays.
• sunday: To 1 the alert will be active on Sundays.
• recovery_notify:
To
1
activate
the
alert
recovery.
http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:Alertas#Plantilla_de_alerta
• field2_recovery: Customized field 2 for alert recovery (free text).
• field3_recovery: Customized field 3 for alert recovery (free text).
• priority: Alert criticity: 0 Maintenance, 1 Informational, 2 Normal, 3 Warning, 4
Critical.
• id_group: Identifier of the group the template belongs to (ref. tgrupo).
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• talert_template_modules: Instance of an alert template associated to a module.
• id: Alert unique identifier.
• id_agent_module: Identifier of the module associated to the alert (ref.
tagente_modulo).
• id_alert_template: Identifier of the templated associated to the alert (ref.
talert_templates).
• internal_counter: Number of times that the alert shot condition has occurred.
• last_fired: Last time the alert was fired (Unix time)
• last_reference: Start of the current interval (Unix time).
• times_fired: number of times the alert was fired (could be different from
internal_counter)
• disabled: At 1 the alert is deactivated.
• priority: Alert criticity : 0 Maintenance, 1 Informational, 2 Normal, 3 Warning, 4
Critical.
• force_execution: At 1 the action of the alert will be executed thought it has not been
fired. It is used for the alert manual execution.
• talert_template_module_actions: Instance of an action associated to one alert (ref.
talert_template_modules).
• talert_compound: Compound alerts, the columns are similar to the talert_templates.
• talert_compound_elements: Simple alerts associated to a compound alert, each one with
its correspondent logic operation (ref. talert_template_modules).
• talert_compound_actions:
talert_compound).

Actions

associated

with

a

compound

alert

(ref.

• tattachment: Attachments associated to one incident.
• tconfig: Console configuration.
• tconfig_os: Valid Operative systems in Pandora FMS.
• tevento: Event entries. The criticity values are the same ones than for the alerts.
• tgrupo: Defined groups in Pandora FMS.
• tincidencia: Incident entries
• tlanguage: Available languages in Pandora FMS.
• tlink: Links showed at the console menu lower side.
• tnetwork_component: Network components. They are modules associated to a network
profile used by the Recon Server. After they result in an entry at tagente_modulo, so the
columns of both tables are similar.
• tnetwork_component_group: Groups to classify the network components.
• tnetwork_profile: Network profile. Network components group that will be assigned to
recognition tasks of the Recon Server. The network components associated to the profile will
result in modules in the created agents.
• tnetwork_profile_component: Componentes de red asociados a un perfil de red (rel.
tnetwork_component/tnetwork_profile).
• tnota: Notes associated to an incident.
• torigen: Possible origins of an incident.
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• tperfil: User profiles defined at the console.
• trecon_task: Recon Server Recon tasks. http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:ReconServer
• tserver: Registered servers.
• tsesion: information on actions that toke place during an user session for administration and
statistical logs.
• ttipo_modulo: Kinds of modules depending on their origin and kind of data.
• ttrap: SNMP traps received by the SNMP console.
• tusuario: Registered users at the console.
• tusuario_perfil: Profiles asociated to an user (rel. tusuario/tperfil).
• tnews: News showed at the console.
• tgraph: Customized graphs created in the console.
• tgraph_source: Modules associated to a graph (rel. tgraph/tagente_modulo).
• treport: Customized reports created at the console.
• treport_content: Elements associated to one report.
• treport_content_sla_combined: Components of an SLA element associated to one report.
• tlayout: Customized maps created at the console.
• tlayout_data: Elements associated to a map.
• tplugin: Plugin definitions for the Plugin Server.
• tmodule: Kinds of modules (Network, Plugin, WMI...).
• tserver_export:
Configured
destinations
http://www.openideas.info/wiki/index.php?
title=Pandora_3.0:Documentation_es:ExportServer

for

the

Export

Server.

• tserver_export_data: Data to export, associated to a destination.
• tplanned_downtime: Programmed stops.
• tplanned_downtime_agents:
tplanned_downtime/tagente).

Agents

associated

to

a

programmed

stop

(rel.

40.1.3. Data Compression in Real Time
To avoid overload the database, the server does a simple compression in time of insertion.One data
won't be stored at the database unless it would be different to the previous one or it would be a
difference of 24 hours between both of them.
For example, supposing an interval of approximately 1 hour, then the sequence
0,1,0,0,0,0,0,0,1,1,0,0 is kept in the database as 0,1,0,1,0. It won't kept other consecutive 0 unless
24 h. have passed.
The graph that is shown next has been drawn from the data of the previous example. Only the data
in red has been inserted in the database.
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The compression affects to the algorithms of data processing. Either to the metrics as to the graphs,
and it's important to consider that you should fill in the blanks that are caused by the compression.
Considering all the previous things, in order to calculate with the data of a given module the
interval and the starting data, you should follow these steps:
• Search for the previous data out of the interval and date given. If it exists, you have to put it
at the beginning of the range. If it doesn't exist, then previously there was no data.
• Search the following data out of the range and data given until a maximum equal to the
module interval. If it exists, then you have to put it at the end of the interval. If not, you
have to extend the last available value until the end of the interval.
• All data should be check, considering that one data is valid until we get another data.

40.1.4. Data compaction
Pandora FMS has included a system to "compact" database information. This system is focus on
small / midsize deployments (250500 agents, < 100,000 modules) which want to have a long
history information but "loosing" some resolution.
Pandora FMS database maintance, which is executed each day do a scan of old data subject to be
compacted. This compactation is done using a simple linear interpolation, that means, if you have
10,000 points of information in a day, you will get a result of a process of interpolation, which
replace that 10,000 points for 1000 points.
This, obviously "loose" information, because is an interpolation, BUT also saves database storage
and on long term graphs (monthly, yearly) the graphs are mostly the same. In big databases this
behaviour coult be "costly" in terms on database performance, and should be disabled and you
should use the history database model instead.
Sample of non compact data
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Same graph after a compactation

40.1.5. History database
This is an Enterprise feature, and is used to store the information from a given point in time, for
example, data with more than one month in a different database. This database must be in a
different physical server (no virtualize here, please!). Automatically, when you request a data graph
for 1 year, Pandora FMS will look the first XX days in the "realtime/main" database and the other
information in the history database. In this way you can avoid to have performance penalties when
you
store
a
huge
ammount
of
information
in
your
system.
To configure this, you need to setup manually in another server, a history database (importing the
Pandora FMS DB Schema into it, without data), and setup permissions to allow access to it from the
main Pandora FMS server.
Go to Setup > History database and configure there the settings to access the history database.

Some settings interesting which need to be explained:
• Days: max days information is stored in main database. After that date, data will be moved
to history db. 30 days is a good default.
• Step: This acts like a buffer, database maintance script, will take XX registers from database,
will insert it in the history database and will delete it from main database. This is
timeconsuming, and size depends on your setup, 1000 is a good default
• Delay: After a block of step modules, script will wait for delay seconds. Useful if your
database performance is poor, to avoid locks. Use values only between 15.
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A good way to test this is to run the database maintance script manually:
/usr/share/pandora_server/util/pandora_db.pl /etc/pandora/pandora_server.conf

You should not get any errors there.

40.2. States of The Modules in Pandora FMS
In Pandora FMS the modules can have different states:Unkown, Normal, Warning, Critical or with
Fired Alerts.

40.2.1. When is Each State Fixed?
Each module has the Warning and Critical thresholds fixed in its configuration. These thresholds
define its data values for which these states will be activate. If the module gives data out of these
thresholds, then it will be considered that it's on Normal state.
Each module has also a time interval that will fix the frequency with which it will get the data. This
interval will be taken into account by the console to collect data. If the module has the double of its
interval without collecting data, then, it'll be considered that this module is in Unknown State.
Finally, if the module has configured alerts and any of them have been fired and have not been
validated, then the module will have the corresponding Fired Alert state.

40.2.2. Spreading and Priority
In Pandora's organization, some elements depend on others, as for example the modules of one
agent or the agents of one group.These can also be applied to the case of the Pandora's FMS
Enterprise policies, which have associated some agents and some modules that are considered
associated to each agent.
This structure is specially useful in order to evaluate easily the states of the modules. This is
obtained spreading up the states in this organization, giving state to the agents, groups and policies
this way.

40.2.2.1. Which State will have an Agent?
An agent will have the worst of its modules's states. Recursively, a group will have the worst of the
agent's states that belong to it, and the same for the policies, that will have the worst state of its
assigned agents.
This way, by seeing one group with a critical state, for example, we'll known that at least one of its
agents has the same state. When we locate it, we could get down another level to get to the module
or modules that have caused the spreading of the critical state to the upper level.
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40.2.2.2. Which should be the Priority of the States?
When we say that the worst of the states is spread, we should be sure which states are the most
important ones. This way, there is a priority list, being the first state in it the one that has highest
priority over the others and the last one the one that has the lowest. This one will be shown only
with all elements have it.
1.
2.
3.
4.
5.

Fired Alerts
Critical State
Warning State
Unknown State
Normal State

We can see that when a module has fired alerts, its state has priority over the rest, and the agent to
which it belongs will have this state and also the group to which this agent belongs to.
On the other hand, in order to one group, for example, has a normal state, all its agents should have
this state; which implies that all the modules of these groups will have normal state.

40.2.3. Color Code
Each one of the commented states has a color assigned, in order to could view in the network maps,
with a quick view, when something isn't working properly.
Fired alerts State
Critical State
Warning State
Unknown State
Normal State
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